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Preface

Preface

Contacting Micro Focus Fortify Customer Support

If you have questions or comments about using this product, contact Micro Focus Fortify Customer
Support using one of the following options.

To Manage Your Support Cases, Acquire Licenses, and Manage Your Account
https://softwaresupport.softwaregrp.com

To Call Support

1.844.260.7219

For More Information

For more information about Fortify software products:
https://software.microfocus.com/solutions/application-security

About the Documentation Set

The Fortify Software documentation set contains installation, user, and deployment guides for all
Fortify Software products and components. In addition, you will find technical notes and release notes
that describe new features, known issues, and last-minute updates. You can access the latest versions of
these documents from the following Micro Focus Product Documentation website:

https://www.microfocus.com/support-and-services/documentation
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Change Log

The following table lists changes made to this document. Revisions to this document are published
between software releases only if the changes made affect product functionality.

Software Release /

Document Version Changes
18.10/ Updated:
June 2018

o Application license settings for AutoPass licenses and licenses managed
by an AutoPass License Server (APLS). See "Application Settings:
License" on page 378.

Note: The APLS content applies only to customers who use an
APLS fo manage licenses acquired from the Micro Focus
entitlement portal and who purchased the APLS-enabled version of
Weblnspect.

18.10 Added:

o Process to perform a SmartUpdate for Weblnspect that is offline. See
"SmartUpdate" on page 262.

o Process and procedures for using multi-user logins and running a scan
across multiple threads (technology preview). See "Multi-User Login
Scans" on page 167.

Updated:

e Minor edits to incorporate branding changes.

17.20 Added:

o Description and procedure for reuse scan options. See "Reusing Scans
on page 192, "Manage Scans " on page 191, and "Reviewing and
Retesting" on page 243.

o Information about incremental scan and incremental scan processes for
continuous or deferred audit. See "Incremental Scan" on page 193.

¢ Information about merging scans. See "Manage Scans " on page 191 and
“Incremental Scan" on page 193.

¢ Information about web application firewalls, anti-virus software,
firewalls, and intrusion detection/prevention systems when preparing

Micro Focus Fortify Weblnspect (18.10) Page 23 of 427



User Guide
Change Log

Software Release /
Document Version

17.10

Changes

your system for audit. See "Firewalls, Anti-virus Software, and Infrusion
Detection Systems" on page 35.

Troubleshooting information. See "Troubleshooting" on page 424.

Updated:

WISwag tool information with support for the Open Data (OData)
protocol. See "Scanning a REST API Definifion" on page 275.

Weblnspect policies lists to include Client-side and Server-side policy
descriptions and to identify deprecated policies. See "Fortify Weblnspect
Policies" on page 394 and "Command Line Execution" on page 266.

The process for scanning a REST API to clarify that a scan can be
conducted using the Weblnspect user interface, command line interface,
or Weblnspect REST API. See "Scanning a REST API Definition" on
page 275.

The procedure for configuring the Fortify Weblnspect REST APl with
new and updated authentication features, and with new commands for
creating a self-signed certificate for testing the REST API service over
HTTPS. See "Fortify Weblnspect REST API " on page 286.

URL for the Seven Pernicious Kingdoms (7PK) taxonomy of software
security errors. See "Application Setfings: General" on page 374.

List of supported Regular Expression language code-country code
combinations to include Portuguese (Brazil) and Spanish (Spain). See
"Audit Settings: Attack Expressions" on page 371.

Guided Scan topics with new options available when Weblnspect is
intfegrated with Weblnspect Enterprise. See "Using the Predefined
Template" on page 101, "Using the Mobile Scan Template" on page 117,
and "Using the Native Scan Template" on page 134.

Removed:

References to Web Macro Recorder versions older than version 10.00.

All references to IBM Rational ClearQuest.

Added:

Descriptions and procedures for features accessed from the Basic Scan
Wizard. This information was previously missing from the User Guide.
See "Using the Site List Editor " on page 163, "Configuring the Proxy
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Profile " on page 164, and "Specifying Allowed Hosts " on page 166.

o Information about limitations to the Restrict to folder scan option, see
"Restrict to Folder Limitations" on page 174.

o Information about scanning single-page applications (SPAs). See the
following topics:

e "About Single-page Application Scans" on page 182

e "Scan Settings: Content Analyzers" on page 318

e "Using the Predefined Template" on page 101

¢ "Using the Mobile Scan Template" on page 117

e "Using the Native Scan Template" on page 134
Updated:

o URL for the Seven Pernicious Kingdoms (7PK) taxonomy of software
security errors. See "Application Settings: General" on page 374.

o Preparing Your System for Audit to include recommendations regarding
sensitive data. See "Preparing Your System for Audit " on page 35.

o Multiple topics o indicate that integration with Micro Focus Fortify
Software Security Center is optional. See the following topics:

o "About Fortify Weblnspect Enterprise " on page 28

¢ '"Integrating with Fortify Weblnspect Enterprise and Fortify Software
Security Center " on page 213

¢ "Publishing a Scan (Fortify Weblnspect Enterprise Connected) " on
page 212

e "Toolbars"on page 51
e "Summary Pane" on page 92
o "Enferprise Server Menu" on page 49

o Descriptions of filter options in scan settings to include new Prefix
option and full descriptions of the other options. See "Scan Settings:
Filters" on page 339.

¢ Procedure for Configuring the Fortify Weblnspect API. See "Fortify
Weblnspect REST API " on page 286.
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Micro Focus Fortify Weblnspect™ 18.10 is an automated Web application and Web services vulnerability
scanning solution. Fortify Weblnspect delivers the latest evolution in scan technology—a Web
application security product that adapts to any enterprise environment. As you initiate a scan, Fortify
Weblnspect assigns agents that dynamically catalog all areas of a Web application. These agents

report their findings to a main security engine that analyzes the results. Fortify Weblnspect then
launches "Threat Agents" to evaluate the gathered information and apply attack algorithms to
determine the existence and relative severity of vulnerabilities. With this smart approach, Fortify
Weblnspect continuously applies appropriate scan resources that adapt to your specific application
environment.

See Also

"Fortify Weblnspect Overview " below

Fortify Weblnspect Overview

The following is a brief overview of what you can do with Fortify Weblnspect, and how it can benefit
your organization.

Crawling and Auditing - Fortify Weblnspect uses two basic modes to uncover your security
weaknesses.

o A crawlis the process by which Fortify Weblnspect identifies the structure of the target website. In
essence, a crawl runs until it can access no more links on the URL.

o An audit is the actual vulnerability scan. A crawl and an audit, when combined into one function, is
termed a scan.

Reporting - Use Fortify Weblnspect reports to gain valuable, organized application information. You
can customize report details, decide what level of information to include in each report, and gear the
report for a specific audience. You can also save any customized report as a template, which you can
then use to generate a report using the same reporting criteria, but with updated information. You can
save reports in either PDF, HTML, Excel, Raw, RTF, or text format, and you can include graphic
summaries of vulnerability data.

Manual Hacking Control - With Fortify Weblnspect, you can see what's really happening on your site,
and simulate a frue attack environment. Fortify Weblnspect functionality enables you to view the code
for any page that contains vulnerabilities, and make changes to server requests and resubmit them
instantly.

Summary and Fixes - The information pane displays all summary and fix information for the
vulnerability selected in either the navigation pane or the summary pane. For more information, see
"Navigation Pane" on page 55 and "Summary Pane" on page 92.

It also cites reference material and provides links to patches, instructions for prevention of future
problems, and vulnerability solutions. Because new attacks and exploits are formulated daily,
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Fortify frequently updates the summary and fix information database. Use Smart Update on the Fortify
Weblnspect toolbar to update your database with the latest vulnerability solution information, or check
for updates automatically on startup. For more information, see "SmartUpdate" on page 262 and
"Application Settings: Smart Update" on page 391

Scanning Policies - You can edit and customize scanning policies to suit the needs of your
organization, reducing the amount of time it takes for Fortify Weblnspect to complete a scan. For more
information on how fto configure Fortify Weblnspect policies, see the Policy Manager help or the Tools
Guide for Fortify Weblnspect Products.

Sortable and Customizable Views - When conducting or viewing a scan, the left navigation panein
the Fortify Weblnspect window includes the Site, Sequence, Search, and Step Mode buttons, which
determine the contents (or "view") presented in the navigation pane.

« Site view presents the hierarchical file structure of the scanned site, as determined by Fortify
Weblnspect. It also displays, for each resource, the HTTP status code returned by the server and the
number of vulnerabilities detected.

¢ Sequence view displays server resources in the order Fortify Weblnspect encountered them during
an automated scan or a manual crawl (Step Mode).

o Search view enables you to locate sessions that match the criteria you specify. For more information,
see "Search View" on page 227.

« Step Mode is used to navigate manually through the site, beginning with a session you select from
either the site view or the sequence view. For more information, see "Running a Manual Scan " on
page 178.

Enterprise-Wide Usage Capabilities - Intfegrated scan provides a comprehensive overview of your
Web presence from an overall enterprise perspective, enabling you to conduct application scans of all
Web-enabled applications on the network.

Web Services Scan Capabilities - Provides a comprehensive scan of your Web services vulnerabilities.
Enables you to assess applications that contain Web services/SOAP objects.

Export Wizard - Fortify Weblnspect's robust and configurable XML export tool enables users to export
(in a standardized XML format) any and all information found during the scan. This includes comments,
hidden fields, JavaScript, cookies, web forms, URLs, requests, and sessions. Users can specify the type
of information to be exported.

Web Service Test Designer - Allows you o create a Web Service Test Design file (filename.wsd) that
contains the values for Fortify Weblnspect to submit when conducting a Web service scan.

Enhanced Third-Party Commercial Application Threat Agents - Fortify Weblnspect enables users
to perform security scans for any web application, including the industry-leading application platforms.
Some standard commercial application threat agents with Fortify Weblnspect include:

¢ Adobe ColdFusion

¢ Adobe JRun

e Apache Tomcat

e IBM Domino

o IBM WebSphere

o Microsoft.NET
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Oracle Application Server

Oracle WebLogic

See Also

"Contact Customer Support" on page 425

About Fortify Weblnspect Enterprise

Micro Focus Fortify Weblnspect Enterprise employs a distributed network of Fortify Weblnspect
sensors controlled by a system manager with a centralized database. Optionally, you can integrate
Fortify Weblnspect Enterprise with Fortify Software Security Center to provide Fortify Software
Security Center with information detected through dynamic scans of Web sites and Web services.

This innovative architecture enables you to:

Conduct a large number of automated security scans using any number of Fortify Weblnspect
sensors to scan web applications and SOAP services.

Manage large or small Fortify Weblnspect deployments across your organization to control product
updates, scan policies, scan permissions, tools usage, and scan results all centrally from the Fortify
Weblnspect Enterprise console.

Track, manage, and detect your new and existing web applications and monitor all activity associated
with them.

Optionally upload scan data to Fortify Software Security Center.

Independently schedule scans and blackout periods, manually launch scans, and update repository
information using Fortify Weblnspect or the Fortify Weblnspect Enterprise console. For more
information, see "Blackout Period " on page 304,

Limit exposure to enterprise-sensitive components and data by using centrally defined roles for
users.

Obtain an accurate snapshot of the organization's risk and policy compliance through a centralized
database of scan results, reporting, and trend analysis.

Facilitate integration with third-party products and deployment of customized web-based front ends
using the Web Services application programming interface (APD.
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Fortify Weblnspect Enterprise Components

The following illustration depicts the main components of the Fortify Weblnspect Enterprise system.
These include the Fortify Weblnspect Enterprise application, database, sensors, and users.

[ —

@

Component Descriptions

The following table provides descriptions of the Fortify Weblnspect Enterprise user interfaces and
architecture.

ltem Component Description
1 Windows Console User = This console is a thin-client application that provides
Interface administrative functionality, policy editing, and the toolkit.
2 Web Console User This console is a browser-based application that provides user
Interface functionality. It does not provide administrative functionality,
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Iltem Component Description
policy editing, or the toolkit.

3 HTTP or HTTPS The Fortify Weblnspect Enterprise components use these
communication protocols.

4 Fortify Software Integration with Fortify Software Security Center provides a way
Security Center to publish scans to a central repository of all static and dynamic
(optional) scans. It provides somewhat centralized accounts, although

permissions are still managed separately, the ability to submit
scan requests, and more extensive reporting than a standalone

installation.
5 Fortify Weblnspect This is a Microsoft Windows server with an IS application
Enterprise Manager platform. It is a Web service whose main functions are user

authentication and authorization, data repository, and remote
scan scheduling.

6 Sensors These Weblnspect sensors are installed on Microsoft Windows
or Windows Server operating systems. Sensors have no GUI and
execute remote scans that are configured at the Web Console.
You use the Web Console to control all scan configurations,
results, reports, and updates.

7 Microsoft SQL Server This Microsoft Windows server has a SQL database that stores
all users, permissions, and administrative settings. The database
also stores all scan data and reporting.

FIPS Compliance

You can run Fortify Weblnspect and Fortify Weblnspect Enterprise in either normal mode or FIPs-
compliant mode.

About FIPS Compliance in Fortify Weblnspect Products

In FIPs-compliant mode, Fortify Weblnspect programs meet the encryption standards required to be
compliant with Federal Information Processing Standard (FIPS). When running in FIPS-compliant
mode, data is encrypted using the AES algorithm established by the National Institute of Standards and
Technology (NIST). This includes the transmission of data to and from Fortify Weblnspect as well as
saved scan data.
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Because FIPS-compliance uses different cryptography modules from those used by the default Fortify
Weblnspect product (all versions earlier than 10.20, and 10.20 when not in FIPS-compliance mode), you
cannot access scan data generated on a non-FIPS compliant installation. If you used an earlier version
of Fortify Weblnspect and now want to run Fortify Weblnspect in a FIPS-compliant environment, the
scan data you generated in the non FIPS-compliant version will not be available to you unless you use
the Micro Focus FIPS Migration Tool to decrypt the data and then re-encrypt it using the AES
algorithm. When running multiple instances of Fortify Weblnspect in your environment, these instances
must all be either FIPS-compliant or non FIPS-compliant if you intend to share data among them.

Since the 10.20 release, Fortify Weblnspect, Fortify Weblnspect Enterprise, and the Fortify Weblnspect
Agent all have FIPS-compliant modes.

Selecting FIPS-compliant Mode

Installing Fortify Weblnspect in a FIPS-compliant environment triggers the option to run Fortify
Weblnspect in normal mode or FIPS-compliant mode. You cannot switch from one mode to another, so
make sure that you do not have dependencies that require you fo maintain backward compatibility with
non FIPS-compliant data before choosing this option. When running in FIPS-compliant mode, you will
not notice any changes in the day-to-day operation of Fortify Weblnspect.

Related Documents

This topic describes documents that provide information about Micro Focus Fortify software products.

Note: You can find the Micro Focus Fortify Product Documentation at
https://www.microfocus.com/support-and-services/documentation.

All Products

The following documents provide general information for all products. Unless otherwise noted, these
documents are available on the Micro Focus Product Documentation website.

Document / File Name Description
About Micro Focus Fortify Product This paper provides information about how to access Micro
Software Documentation Focus Fortify product documentation.

About_Fortify_Doc_<version>.pdf Note: This document is included only with the product

download.

Micro Focus Fortify Software System | This document provides the details about the
Requirements environments and products supported for this version of

Fortify Soft .
Fortify_Sys_Reqs_<version>.pdf ortity sottware
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Document / File Name
Fortify_Sys_Reqgs_Help_<version>

Micro Focus Fortify Software Release
Noftes

FortifySW_RN_<version>.txt

What’s New in Micro Focus Fortify
Software <version>

Fortify_Whats_New_<version>.pdf

Fortify_Whats_New_Help_<version>

Micro Focus Fortify Open Source and
Third-Party License Agreements

Fortify_OpenSrc_<version>.pdf

Description

This document provides an overview of the changes made
to Fortify Software for this release and important
information not included elsewhere in the product
documentation.

This document describes the new features in Fortify
Software products.

This document provides open source and third-party
software license agreements for software components used
in Fortify Software.

Micro Focus Fortify Weblnspect

The following documents provide information about Fortify Weblnspect. Unless otherwise noted, these
documents are available on the Micro Focus Product Documentation website.

Document / File Name

Micro Focus Fortify Weblnspect
Installation Guide

WI_Install_<version>.pdf

PDF only; no help file

Micro Focus Fortify Weblnspect User
Guide

WI_Guide_<version>.pdf

Micro Focus Fortify Weblnspect (18.10)

Description

This document provides an overview of Fortify
Weblnspect and instructions for installing Fortify
Weblnspect and activating the product license.

This document describes how to configure and use
Fortify Weblnspect to scan and analyze Web applications
and Web services.

Note: This document is a PDF version of the Fortify
Weblnspect help. This PDF file is provided so you can
easily print multiple topics from the help information
or read the help in PDF format. Because this content
was originally created to be viewed as help in a web
browser, some topics may not be formatted properly.
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Document / File Name

Micro Focus Fortify Weblnspect Tools
Guide

WI_Tools_Guide_<version>.pdf

Micro Focus Fortify Weblnspect
Runtime Agent Installation Guide

WI_RT_Agent_Install_<version>.pdf

WI_RT_Agent_Install_Help_<version>

Micro Focus Fortify Weblnspect Agent
Rulepack Kit Guide

WI_Agent_Rulepack_Guide_
<version>.pdf

PDF only; no help file

Description

Additionally, some interactive topics and linked
content may not be present in this PDF version.

This document describes how to use the Fortify
Weblnspect diagnostic and penetration testing tools and
configuration utilities packaged with Fortify Weblnspect
and Fortify Weblnspect Enterprise.

This document describes how to install the Fortify
Weblnspect Runtime Agent for applications running
under a supported Java Runtime Environment (JRE) on a
supported application server or service and applications
running under a supported .NET Framework on a
supported version of IIS.

This document describes the detection capabilities of
Fortify Weblnspect Agent Rulepack Kit. Fortify
Weblnspect Agent Rulepack Kit runs atop the Fortify
Runtime Agent, allowing it fo monitor your code for
software security vulnerabilities as it runs. Fortify
Weblnspect Agent Rulepack Kit provides the runtime
technology to help connect your dynamic results to your
staticones.

Micro Focus Fortify Weblnspect Enterprise

The following documents provide information about Fortify Weblnspect Enterprise. Unless otherwise
noted, these documents are available on the Micro Focus Product Documentation website.

Document / File Name

Micro Focus Fortify Weblnspect
Enterprise Installation and
Implementation Guide

WIE_Install_<version>.pdf

PDF only; no help file

Micro Focus Fortify Weblnspect (18.10)

Description

This document provides an overview of Fortify Weblnspect
Enterprise and instructions for installing Fortify Weblnspect
Enterprise, integrating it with Fortify Software Security
Center and Fortify Weblnspect, and troubleshooting the
installation. It also describes how to configure the
components of the Fortify Weblnspect Enterprise system,
which include the Fortify Weblnspect Enterprise application,
database, sensors, and users.
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Document / File Name Description
Micro Focus Fortify Weblnspect This document describes how to use Fortify Weblnspect
Enterprise User Guide Enterprise fo manage a distributed network of Fortify

Weblnspect sensors to scan and analyze Web applications
WIE_Guide_<version>.pdf P . Y PP
and Web services.

Note: This document is a PDF version of the Fortify
Weblnspect Enterprise help. This PDF file is provided so
you can easily print multiple topics from the help
information or read the help in PDF format. Because this
content was originally created to be viewed as help in a
web browser, some topics may not be formatted
properly. Additionally, some interactive topics and linked
content may not be present in this PDF version.

Micro Focus Fortify Weblnspect This document describes how to use the Fortify Weblnspect
Tools Guide diagnostic and penetration testing tools and configuration
utilities packaged with Fortify Weblnspect and Fortify

WI_Tools_Guide_<version>.pdf )
Weblnspect Enterprise.
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This chapter describes how to prepare your system for audit, update SecureBase, and start a scan so
that you begin using Fortify Weblnspect right away. It also provides a tutorial on how to scan web
services at zero.webappsecurity.com, which is Fortify's demo website.

Preparing Your System for Audit

Fortify Weblnspect is an aggressive web application analyzer that rigorously inspects your entire
website for real and potential security vulnerabilities. This procedure is intrusive to varying degrees.
Depending on which Fortify Weblnspect policy you apply and the options you select, it can affect server
and application throughput and efficiency. When using the most aggressive policies,

Fortify recommends that you perform this analysis in a controlled environment while monitoring your
servers.

Sensitive Data

Fortify Weblnspect captures and displays all application data sent between the application and server. It
might even discover sensitive data in your application that you are not aware of. Fortify recommends
that you follow one of these best practices regarding sensitive data:

« Do not use potentially sensitive data, such as real user names and passwords, while testing with
Fortify Weblnspect.

« Do not allow Fortify Weblnspect scans, related artifacts, and data stores to be accessed by anyone
unauthorized to access potentially sensitive data.

Network authentication credentials are not displayed in Weblnspect and are encrypted when stored in
setftings.

Firewalls, Anti-virus Software, and Intrusion Detection Systems

Weblnspect sends attacks to servers, and then analyzes and stores the results. Web application firewalls
(WARP), anti-virus software, firewalls, and intrusion detection/prevention systems (IDS/IPS) are in place
to prevent these activities. Therefore, these tools can be problematic when conducting a scan for
vulnerabilities.

First, these tools can interfere with Weblnspect’s scanning of a server. An attack that Weblnspect sends
to the server can be intercepted, resulting in a failed request to the server. If the server is vulnerable o
that attack, then a false negative is possible.

Second, results or attacks that are in the Weblnspect product, cached on disk locally, or in the database
can be identified and quarantined by these tools. When working files used by Weblnspect or data in the
database are quarantined, Weblnspect can produce inconsistent results. Such quarantined files and
data can also cause unexpected behavior.
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These types of issues are environmentally specific, though McAfee IPS is known to cause both types of
problems, and any WAF will cause the first problem. Fortify has seen other issues related to these tools
as well.

If such issues arise while conducting a scan, Fortify recommends that you disable WAF, anti-virus
software, firewall, and IDS/IPS tools for the duration of the scan. Doing so is the only way to be sure
you are getting reliable scan results. If it is not practical to disable these tools, you should allow
exceptions within these tools for every issue that they detect related to Weblnspect or a Weblnspect
scan.

Effects to Consider

During an audit of any type, Fortify Weblnspect submits a large number of HTTP requests, many of
which have "invalid" parameters. On slower systems, the volume of requests may degrade or deny access
to the system by other users. Additionally, if you are using an intrusion detection system, it will identify
numerous illegal access attempts.

To conduct a thorough scan, Fortify Weblnspect attempts to identify every page, form, file, and folder
in your application. If you select the option to submit forms during a crawl of your site, Fortify
Weblnspect will complete and submit all forms it encounters. Although this enables Fortify Weblnspect
to navigate seamlessly through your application, it may also produce the following consequences:

o If, when a user normally submits a form, the application creates and sends e-mails or bulletin board
postings (to a product support or sales group, for example), Fortify Weblnspect will also generate
these messages as part of its probe.

¢ If normal form submission causes records to be added to a database, then the forms that Fortify
Weblnspect submits will create spurious records.

During the audit phase of a scan, Fortify Weblnspect resubmits forms many ftimes, manipulating every
possible parameter to reveal problems in the applications. This greatly increases the number of
messages and database records created.

Helpful Hints

o For systems that write records to a back-end server (database, LDAP, and so on) based on forms
submitted by clients, some Fortify Weblnspect users, before auditing their production system,
backup their database, and then reinstall it after the audit is complete. If this is not feasible, you can
query your servers after the audit to search for and delete records that contain one or more of the
form values submitted by Fortify Weblnspect. You can determine these values by opening the Web
Form Editor.

o If your system generates e-mail messages in response to user-submitted forms, consider disabling
your mail server. Alternatively, you could redirect all e-mails to a queue and then, following the audit,
manually review and delete those e-mails that were generated in response to forms submitted by
Fortify Weblnspect.

o Fortify Weblnspect can be configured to send up to 75 concurrent HTTP requests before it waits for
an HTTP response to the first request. The default thread count setting is 5 for a crawl and 10 for an
audit (if using separate requestors). In some environments, you may need to specify a lower number
to avoid application or server failure. For more information, see "Scan Settings: Requestor" on
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page 320.

o If, for any reason, you do not want Fortify Weblnspect to crawl and attack certain directories, you
must specify those directories using the Excluded URLSs feature of Fortify Weblnspect settings (see
"Scan Settings: Session Exclusions" on page 325). You can also exclude specific file types and MIME
types.

o By default, Fortify Weblnspect is configured to ignore many binary files (images, documents, and so
on) that are commonly found in web applications. These documents cannot be crawled or attacked,
so there is no value in auditing them. Bypassing these documenfts greatly increases the audit speed. If
proprietary documents are in use, determine the file extensions of the documents and exclude them
within Fortify Weblnspect's default settings. If, during a crawl, Fortify Weblnspect becomes extremely
slow or stops, it may be because it attempted to download a binary document.

o Forform submission, Fortify Weblnspect submits data extracted from a prepackaged file. If you
require specific values (such as user names and passwords), you must create a file with Micro Focus’s
Web Form Editor and identify that file to Fortify Weblnspect.

« Finally, Fortify Weblnspect tests for certain vulnerabilities by attempting to upload files to your
server. If your server allows this, Fortify Weblnspect will record this susceptibility in its scan report
and attempt to delete the file. Sometimes, however, the server prevents file deletion. For this reason,
search for and delete files with names that start with "CreatedByHPE" as a routine part of your post-
scan mainftenance.

See Also
"Fortify Weblnspect Overview " on page 26

"Quick Start " below

Quick Start

This topic provides information to help you get started with Fortify Weblnspect. It includes links to
more detailed information.

Update SecureBase

To ensure that you have up-to-date information about the Fortify Weblnspect catalog of
vulnerabilities, use the following procedure to update your vulnerabilities database.

1. Start Fortify Weblnspect.

Note: If Fortify Weblnspect is installed as an interactive component of the Fortify Weblnspect
Enterprise, and if the enterprise server is currently using this Fortify Weblnspect module to
conduct a scan, then you cannot start Fortify Weblnspect. The following message will be
displayed: "Unable to start Weblnspect. Permission denied."

2. On the Start Page, click Start Smart Update.
The Smart Update window opens and lists available updates.
3. Click Update.
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Note: Update the product each time you use it. You can select an application setting that runs
Smart Update each time you start the program. For more information, see "Application Settings:
Smart Update" on page 391.

For more information, including instructions for updating Weblnspect that is offline, see "SmartUpdate"
on page 262.

Prepare Your System for Audit

Before performing an audit, be aware of the potential impact on your website, and what you can do to
prepare for a successful audit. For more information, see "Preparing Your System for Audit " on
page 35.

Start a Scan

After you update your database, you are ready to determine your web application’s security
vulnerabilities.

On the Fortify Weblnspect Start Page, click one of the following selections:

« Start a Guided Scan (see "Guided Scan Overview "on page 99)

« Start a Basic Scan (see "Running a Basic Scan" on page 152)

« Start a Web Service Scan (see "Running a Web Service Scan " on page 149)
o Start an Enterprise Scan (see "Running an Enterprise Scan " on page 175)
See Also

"Preparing Your System for Audit " on page 35

"User Interface Overview" on page 42

Scanning Web Services at zero.webappsecurity.com

Web services are programs that communicate with other applications (rather than with users) and
answer requests for information. Most Web services use Simple Object Access Protocol (SOAP) to send
XML data between the Web service and the client Web application that initiated the information
request.

A client Web application that accesses a Web service receives a Web Services Definition Language
(WSDL) document so that it can understand how to communicate with the service. The WSDL
document describes the programmed procedures included in the Web service, the parameters those
procedures expect, and the type of return information the client Web application will receive.

This tutorial illustrates how to conduct a Web service scan of zero.webappsecurity.com using a
predefined Web service design (wsd) file containing the values that Fortify Weblnspect will submit
when conducting the scan. For information on how fo use the Web Service Test Designer to create a
Web service design file (filename.wsd) for your site, refer to the Web Service Test Designer help.
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Conducting a Web Service Scan

To conduct a web service scan:

1. Select Start a Web Service Scan from the Fortify Weblnspect Start page.

2. Accept the default name or enter a new Scan Name and select Configure a Web Service Scan.

Note: "Service:" is auto-filled at the start of the scan name.

Tip: If you were conducting a scan on your site, the Web Service Scan Wizard Step 3 of 4
would prompt you to open the Web Service Test Designer tool to create a .wsd file for your
site. Then for subsequent scans of the same WSDL, you would re-use the .wsd file you created
and select Scan with existing Design File on the Web Service Scan Wizard Step 1 of 4.

Web Service Scan Wizard Image Step 1 of 4

.| Web Service Scan Wizard » HIEM

Web Service Scan Step 1 of 4

Find vulnerabilities from a Web Service Definition File

Scan Name: |Sernce: http://legacy.webappsecunty.com/CustomerAccounts/WebService.asmxPwsd|

* Configure a Web Service Scan

Input the address for the WSDL file into the WSDL Location field or use the browse button to select a saved WSDL from the file system. Perform
some basic scan configuration settings and use the Web Service Test Designer to specify valid inputs for web service operations.

WSDL Location:  http:/flegacy.webappzecurity.com/Customericcounts/ WebService asmx?wsd vl
Scan with existing Design File
Select a previously saved design file for use in a new web service scan.

File:

Settings (Default) = Back | Mext> || Cancel |

3. Accept the default URL for the WSDL Location.

Tip: If you were conducting a scan on your site, you would enter or select the fully qualified
path to the WSDL file on your site.

4. Click Next.
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Web Service Scan Wizard Image Step 2 of 4

= Web Service Scan Wizard

Authentication and Connectivity

Q: P Provide the necessary credentials and environment information to gain access to the target web site.

M network Proxy

Proxy Profile: | Use Internet Explorer = ._ Edit...
L Network Authentication
Method:

User Name: Password:

Settings (Default) =

» IEN
Step 2 of 4
Next = Cancel

5. If you need to access the target site through a proxy server, select Network Proxy and then

choose an option from the Proxy Profile list.

6. If server authentication is required, select Network Authentication and then select

an authentication method and enter your network credentials. For this exercise, accept the default.

7. Click Next.
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Web Service Scan Wizard Image Step 3 of 4

S Web Service Scan Wizard ?

Detailed Scan Configuration Step 3 of 4

Design Web Service operations and configure specific settings.

Web Service Test Designer

Use the Web Service Test Designer to specify data that will be sent to the web service application, configure security, and verify that the system
performs as designed.

Mame: |Legacy Zero Test Design Design
Settings
Traffic Analysis 10f2

Enable options to analyze HTTP traffic.

o
i :
U Launch and Direct Traffic Through Web Proxy
Web Proocy is a stand-alone, self-contained proxy server that you can configure and run on your desktop. With it, you
can monitor traffic from a scanner, a browser, or any other tool that submits HTTP requests and receives responses

from a server. It is a tool for debugging and penetration scanning; you can see every request and server response
while browsing a site.

O Enable Traffic Monitor

WeblInspect displays in the navigation pane only the hierarchical structure of the Web Site or Web Service, plus those
sessions in which a vulnerability was discovered. The Traffic Monitor allows you to display and review every HTTP
request sent by Weblnspect and the associated HTTP response received from the server.

Naiims TAamkifiad Cales asiruae 2 ~F 9

Settings (Default) ~ | <Back | [ Next> || cCancel |

8. Accept the defaults and click Next.

Tip: If you were conducting a scan on your site and had not created a .wsd file, the Web
Service Scan Wizard Step 3 of 4 would prompt you to open the Web Service Test Designer tool
to create a .wsd file for your site.

9. Click Scan.
Fortify Weblnspect conducts the Web Service scan.
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When you first start Fortify Weblnspect, the application displays the Start Page in the client area, as
illustrated below.

Start Page Image

Note: When Fortify Weblnspect is connected to Enterprise Server, there is a button labeled
"Weblnspect Enterprise WebConsole" to the right of the SmartUpdate button. This button launches
the Web Console.

& Micro Focus WebInspect [_[O[x]

Fle Edt View Tools Enterprise Server Reports  Hslp

art | Resume ause p udi ew ~[50pen ~ | &) Compliance Manager [ Policy Manager /7] Repor chedule martpdate
Start | R P sk audic |3 N o Campliance M Policy M 5 Report (2 schedul Smartlpdat

-~ StartPage 4bx

Manage Scans | Manage Schedule”

|| (~) Recently Opened Scans dlear list
Start a Gmded Scan | clear WeblInspect Agent Disabled Sample
clear WeblInspect Agent Enabled Sample
clear Sample Scan

Create a scan that is optimized for your Web site.

Start a Basic Scan ~) Scans Scheduled for Today
Scan a single Web site for vulnerabilities.

~) WebInspect Messages

Start a Web Service Scan delete -] Welcome to Micro Focus WebInspect
delete || Micro Focus Security Fortify Software Security Content Update 4

Find vulnerabilities in a Web service.

v What's new in WeblInspect!

Start an Enterprise Scan

Schedule an enterprise scan.

Generate a Report
Analyze a scan using system reports.

Start SmartUpdate
Update security checks and patches.

The Activity Panel

The left pane (the Activity Panel) displays hyperlinks to the following major functions:

o Start a Guided Scan (see "Guided Scan Overview "on page 99)

o Start a Basic Scan (see "Running a Basic Scan" on page 152)

o Starta Web Service Scan (see "Running a Web Service Scan " on page 149)
o Start an Enterprise Scan (see "Running an Entferprise Scan " on page 175)
o Generatfe a Report (see "Generating a Report" on page 248)

o Start SmartUpdate (see "SmartUpdate" on page 262)
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Closing the Activity Panel

You can close the Activity Panel by clicking the Left Arrow on the bar above the pane.
Start Page with No Activity Panel Image

B Micro Focus WebInspect [_ 5]
File Edit WView Toos  Enterprise Server  Reports  Help

[ B el " [ %)
Start { Resume [ Pause [ Skip G Audt |1[] New ~[Z50pen ~ | (&4 Compliance Manager [€] Folicy Manager 3] Report (£ Schedule \gY SmartUpdate |

Start Page b X

“Tome Manage Scans 'Manage Schedule T}

~) Recently Opened Scans clear list

clear WebInspect Agent Disabled Sample
clear WebInspect Agent Enabled Sample

clear Sample Scan

~) Scans Scheduled for Today

~ WeblInspect Messages
delete -1 Welcome to Micro Focus WebInspect
delete -] Micro Focus Security Fortify Software Security Content Update 4

v What's new in WebInspect!

The Button Bar

The contents of the right pane are determined by the button selected on the Button bar identified in
the following image.

& Micro Focus WebInspect =1 B3

Fle Edit iew Tools  Enterprise Server  Reports  Help
F o ’ e : | =
Start { Resume [l Pause [ Skin G Audt |3 [] New - (25 0pen - | €4 Compliance Manager [€5] Policy Manager 7] Report (£) Schedule \gY SmartUpdate |

Start Page 4b X

Welcome to Micro Focus WeblInspect PHBME Manage Scans | Manage Schedule |

The choices are described in the following table.

Button Displayed List

Home Displays a list of recently opened scans, as well as scans scheduled to be
conducted today, recently generated reports, and messages downloaded from
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Button Displayed List

the Micro Focus server.

If you hover the pointer over a scan name, Fortify Weblnspect displays summary
information about the scan. If you click the scan name, Fortify Weblnspect
opens the scan on a separate tab.

Manage Displays a list of previously conducted scans, which you can open, rename, or

Scans delete. Click Connections to choose a database: either Local (scans stored in a
SQL Server Express Edition database on your machine) or Remote (scans stored
in a SQL Server Standard Edition database configured on your machine or
elsewhere on the network), or both. For more information, see "Manage Scans "

on page 191.
Manage Displays a list of scans that are scheduled to be performed. You can add a scan
Schedule to the schedule, edit or delete a scheduled scan, or start the scan manually. For

more information, see "Managing Scheduled Scans " on page 197.
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Panes Associated with a Scan

Each time you open or conduct a scan, Fortify Weblnspect opens a tab labeled with the name or
description of the target site. This work area is divided into three regions, as depicted in the following
illustration.

& Micro Focus WebInspect
Edit

File View Tooks Sean  EnterprissSsrver  Reports  Help

i[> Skart fResume || Pause |0 Skp ) Audl |@ARescan - | [EF Compare Ii._g Mew - [F0pen | &y Compliance Manager [&] Policy Manager [T]Report (<) Schedule \GH Smartlipdate

Start Page” _ Site: hitp:/izerowe

Scan Info (]
resources AW @ Dashboard
scripts
Traffic Monitor
shats °
T]attachments

¥ False Postives

1" Session Vulnerabilities: http:// zero.webappsecurity.com/debug.txt

Summary: Web Server Misconfiguration: Unprotected File
Vulnerability ID: 1388

CWE ID: 284, 200

Kingdom: Environment

The file debug ixt was located. This type of file is usually left by a developer or web master to test a certain funclion of the web application or
web server. Leaving test scripts available on the server is a very unsecure practice. The types of information that can be gleaned from test

scripts include fixed cation session id's, and locations or painters fo confidential areas of the web site, and
P e proprietary source code. Wilh this type of information available to an altacker . they can either use it to fotally breach the securily of he sile
eethot [ HTTP Request or use it as a stepping stone fo refrieve other sensitive data. Recommendations include removing this file from the production server.
rqot-passuol B s
forgotten-pass P -
e bl % Stack Traces Fix
-2 How to remediste the issue.
desc html. oid [ Detais
dex.old
o_ L ogin bt 3 steps For Security Operations: b
B manager & Links Remaove the application from the sarver. Inform pers and admi to remove test fions from servers when they are no
Comments longer needed. While they are in use, be sure o prolect them using HTTP basic authentication
B online-banking,
~ (& READHE.bt B Tee For Development:
o [ search.himl T Hiddens | )

o[ sendresdback.
server-status
i@ signinhtml =
4] | r
[k xcluded Hosts | e alowed Host3

5] site

Type filter criteria... A~ @ ¥

Path Method | Vuln Param Parameters  Kingdom Application Response Length

=1 Web Server Misconfiguration: Unprotected File (5 items)

http://zero webappsecurity.com/debug.bxt - Environment

i Sequence hetp://zero.webappsecurity.comfag.html.bak GET - Environment 12623
http://zero webappsecurity.comindex html.ald GET - Environment 3651
i Search http://zero webappsacurity.com/index.old GET E Environment 3601
ey hitp://zero. webappsecurity.com/server-status GET - Environment 5523
S Shephiede = ) Medium (5 items) =
1 @ vulnerabilities [ @ Information | [7] Best Practices | ] Scan Log | W Server Information | 1

& :

Item Description
1 Navigation Pane
2 Information Pane

3 Summary Pane

If you have a large number of scans open at the same time, and there is no room to display all tabs, you

can scroll the tabs by clicking the arrows ** * on the extreme right end of the tab bar. Click the X to
close the selected tab.

See Also

"Menu Bar " on page 47
"Toolbars " on page 51

"Start Page " on the next page

"Navigation Pane" on page 55
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"Summary Pane" on page 92

"Information Pane " on page 65

Start Page

The left-hand pane of the Start Page contains a list of activities related to the vulnerability scan of your
Web site or Web service:

o Start a Guided Scan (see "Guided Scan Overview "on page 99)

o Start a Basic Scan (see "Running a Basic Scan" on page 152)

o Start a Web Service Scan (see "Running a Web Service Scan " on page 149)

« Start an Enterprise Scan (see "Running an Entferprise Scan " on page 175)

¢ Generate a Report (see "Generating a Report" on page 248)

o Start SmartUpdate (see "SmartUpdate" on page 262)

The contents of the right-hand pane are controlled by the buttons on the Button bar.

& Micro Focus WebInspect

Fle Edt View Tools Enkerprise Server Reports  Help
Start { Resume Pause [ Skip fudit P Mew - [5Open - | &y Compliance Manager [l Policy Manager 7] Repart (<) Schedule \g¥ SmartUpdate
4k x

I :'< | Manage Scans | Manage Schedule | &

Home

When Home is selected (the default), Fortify Weblnspect displays a list of:

o Recently opened scans.
If you hover the pointer over a scan name, Fortify Weblnspect displays summary information about
the scan. If you click the scan name, Fortify Weblnspect opens the scan on a separate tab.

o Scans scheduled to be conducted today
¢ Recently generated reports

« Messages downloaded from the Micro Focus server

Manage Scans
When Manage Scans is selected, Fortify Weblnspect displays a list of previously conducted scans, which
you can open, rename, or delete. Click Connections to choose a database: either Local (scans stored in

the SQL Server Express Edition database on your machine) or Remote (scans stored in the SQL Server
database, if configured), or both. For more information, see "Manage Scans " on page 191.

Manage Schedule

When Manage Schedule is selected, Fortify Weblnspect displays a list of scheduled scans. You can add
a scan to the schedule, edit or delete a scheduled scan, or start the scan manually. For more information,
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see "Managing Scheduled Scans " on page 197.

See Also

"User Interface Overview" on page 42

Menu Bar

Menu options are:

"File Menu" below

"Edit Menu " on the next page

"View Menu " on the next page
"Tools Menu "on page 49

"Scan Menu "on page 49

"Enterprise Server Menu" on page 49
"Reports Menu " on page 50

"Help Menu" on page 51

File Menu

The File menu commands are described in the following table.

Command Description

New Allows you to select either Basic Scan or Web Service scan, and then launches
the Scan Wizard, which steps you through the process of starting a scan.

Open Allows you to open either a scan or a generated report.

Schedule Opens the Manage Scheduled Scans window, which allows you to add, edit, or
delete a scheduled scan.

Import Scan Allows you to import a scan file.
Export This command is available only when a tab containing a scan is selected. You
may:

e Exportascan
o Export scan details

o Export a scan to Software Security Center

Close Tab When multiple tabs are open, closes the selected tab.
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Command Description

Exit Closes the Fortify Weblnspect program.

Edit Menu

The Edit menu commands are described in the following table.

Command Description

Default Scan Displays the Default Settings window, allowing you to select or modify options

Settings used for scanning.

Current Scan Displays a settings window that allows you fo select or modify options for the

Settings current scan. This command is available only when a tab containing a scan is
selected.

Manage Settings Opens a window that allows you to add, edit, or delete settings files.

Application Displays the Application Settings window, allowing you to select or modify
Settings options controlling the operation of the Fortify Weblnspect application. For
more information, see the Application Settings.

Copy URL Copies the selected URL to the Windows clipboard. This command is available
only when a tab containing a scan is selected.

Copy Scan Log Copies the log (for the scan on the selected tab) to the Windows clipboard. This
command is available only when a tab containing a scan is selected.

View Menu

The View menu commands are described in the following table.

Command Description

Word Wrap Inserts soft returns at the right-side margins of the display area when viewing
HTTP requests and responses. This command is available only when a tab
containing a scan is selected.

Toolbars Allows you to select which toolbars should be displayed. For more information,
see "Toolbars " on page 51.
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Tools Menu

The Tools menu contains commands to launch the tool applications.

Scan Menu

The Scan menu appears on the menu bar only when a tab containing a scan has focus. Scan menu
commands are described in the following table.

Command
Start/Resume
Pause

Skip

Audit

Rescan

Description
Starts or resumes a scan after you paused the process.
Halts a crawl or audit. Click Resume to continue the scan.

If an audit is in progress, skips to the next audit methodology. If a crawlis in
progress, skips to the audit.

Assesses the crawled site for vulnerabilities. Use the command after completing
a crawl or exiting Step Mode.

This command launches the Scan Wizard prepopulated with settings last used
for the selected scan.

Enterprise Server Menu

The Enterprise Server menu contains the following commands:

Command

Connect to
Weblinspect
Enterprise or
Disconnect

Download Scan

Publish Scan

Description

Establishes or breaks a connection to the Fortify Weblnspect
Enterprise server.

Allows you to select a scan for copying from the server to your hard drive.

Displays a dialog box that allows you to review vulnerabilities and
fransmit them to an enterprise server which, in furn, fransmits them to a
Micro Focus Fortify Software Security Center server. For more information,
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Command Description

see "Publishing a Scan (Fortify Weblnspect Enterprise Connected) " on
page 212.

Note: This option is available only if Fortify Weblnspect Enterprise is
integrated with Fortify Software Security Center.

Upload Scan Allows you to select a scan for transferring data to the server. This is used
most often when the application setting "auto upload scans" is not selected.

Transfer Settings Allows you to select a Fortify Weblnspect settings file and transfer it to the
server, which will create a Scan Template based on those settings. Also
allows you to select a Scan Template and transfer it to Fortify Weblnspect,
which will create a settings file based on the template. For more
information, see "Transferring Setfings to/from Enterprise Server" on

page 210.
WebConsole Launches the Fortify Weblnspect Enterprise Web Console application.
About Enterprise Displays information about Fortify Weblnspect Enterprise.

Server

Note: A Fortify Weblnspect installation with a standalone license may connect to an enterprise
server at any fime, as long as the user is a member of a role in Fortify Weblnspect Enterprise.

Reports Menu

The Reports menu commands are described in the following table.
Command Description
Generate Report Launches the Report Generator.

Manage Reports Displays a list of standard and custom report types. You can rename, delete, or
export custom-designed reports, and you may import a report definition file.
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Help Menu

The Help menu commands are described in the following table.

Command Description
Weblinspect Help Opens the Help file.
Search Opens the Help file, displaying the search options in the left pane.

Support ¢ Request an Enhancement - If the support channel is enabled (see
"Application Setftings: Support Channel" on page 391), displays a window
allowing you to submit enhancement requests to Micro Focus.

o Support Tool - Launches the Fortify Support tool, which allows you to
upload files that may help Fortify Customer Support personnel analyze and
resolve any problems you encounter.

¢ Technical Support - Displays instructions for contacting Fortify Customer

Support.
Tutorials Allows you to download tutorials and other Fortify Weblnspect documentation.
About Displays information about the Fortify Weblnspect application, including license
Weblinspect information, allowed hosts, and attributes.

Toolbars

The Fortify Weblnspect window contains two toolbars: Scan and Standard. You can display or hide
either toolbar by selecting Toolbars from the View menu.

Buttons Available on the Scan Toolbar

Button Function

You can pause a scan and then resume scanning. Also, a
completed scan may contain sessions that were not sent
(because of timeouts or other errors); if you click Start, Fortify
Weblnspect will attempt to resend those sessions.

= Skart f Resume

[l Pause Interrupts an ongoing scan. You can continue scanning by
clicking the Start/Resume button.
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Button Function

When conducting a sequential crawl and audit, you can skip

[0 skip

processing by whichever engine is running (if you selected Test
each engine type per session) or you can skip processing the
session (if you selected Test each session per engine type).
For more information, see the "Sequentially" crawl and audit
option in "Scan Seftings: Method " on page 309.

% Aud If you conduct a crawl-only scan or a Step Mode scan, you can
afterwards click this button to conduct an audit. For more
information, see "Running a Manual Scan "on page 178.

m This button appears only if you select a tab containing a scan. If
el you select Scan Again from the drop-down menu, it launches
the Scan Wizard prepopulated with settings last used for the
selected scan. If you select Retest Vulnerabilities, it starts a
scan that examines only those portions of the target site in
which vulnerabilities were detected during the original scan. For
more information, see "Reviewing and Retesting" on page 243.
m This button appears only if you select a tab containing a scan. It
allows you to compare the vulnerabilities revealed by two
different scans of the same target. For more information, see

"Comparing Scans " on page 185.

This button appears only if Fortify Weblnspect is connected to
Fortify Weblnspect Enterprise and a scan is open on the tab that
has focus. It allows you to send the scan settings to Fortify

F Run in WebInspeck Enterprise

Weblnspect Enterprise, which creates a scan request and places
it in the scan queue for the next available sensor. For detailed
information, see "Running a Scan in Enterprise Server" on

page 210.

£ synchrarize This button appears only after connecting to Fortify Weblnspect
Enterprise. It allows you to specify a Fortify Software Security
Center project and version. Fortify Weblnspect then downloads
a list of vulnerabilities from Fortify Software Security Center,
compares the downloaded vulnerabilities to the vulnerabilities in
the current scan, and assigns an appropriate status (New,
Existing, Reintroduced, or Not Found) to the vulnerabilities in
the current scan. For detailed information, see "Integrating with
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Button Function

Fortify Weblnspect Enterprise and Fortify Software Security
Center "on page 213.

Note: This option is available only if Fortify Weblnspect
Enterprise is integrated with Fortify Software Security
Center.

[Elpubics This button appears only after connecting to Fortify Weblnspect
Enterprise and is enabled after you have synchronized Fortify
Weblnspect with Fortify Software Security Center. It uploads
project version data through Fortify Weblnspect Enterprise to
Fortify Software Security Center.

Note: This option is available only if Fortify Weblnspect
Enterprise is integrated with Fortify Software Security
Center.

Buttons Available on the Standard Toolbar

Button Function
B Allows you to start a Basic Scan, a Web service scan, or an
enterprise scan.
. Allows you to open a scan or a report.
L Open ~

4 Compliance Manager Starts the Compliance Manager.

Starts the Policy Manager.

Ei]. Palicy Manager

Starts the Report Generator.

" | Repart

Allows you to schedule a scan to occur on a specific time and

4 Schedule

date. For more information, see "Schedule a Scan " on page 195.

Contacts the central Micro Focus database to determine if

t'a SmartUpdate

updates are available for your system and, if updates exist,
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Button Function

allows you to install them. For more information, see
"SmartUpdate" on page 262.

Launches the Fortify Weblnspect Enterprise Web Console
application. This button appears only if you are connected to
Fortify Weblnspect Enterprise.

F ‘WebInspect Enterprise WebConsole

Buttons Available on the "Manage Scans" Toolbar

Button Function

To open scans, select one or more scans and click Open (or

~+ Open
simply double-click an entry in the list). Fortify Weblnspect loads
the scan data and displays each scan on a separate tab.
 Rescan v To launch the Scan Wizard prepopulated with settings last used
for the selected scan, click Rescan > Scan Again.
To rescan only those sessions that contained vulnerabilities
revealed during a previous scan, select a scan and click Rescan >
Retest Vulnerabilities.
For more information, see "Reviewing and Retesting" on
page 243.
ife Rename To rename a selected scan, click Rename.
. Delsts To delete the selected scan(s), click Delete.
- To import a scan, click Import.
M Import
£ Export + To export a scan, export scan details, or export a scan to Fortify
Software Security Center, click the drop-down arrow on Export.
¥ Compare To compare scans, select two scans (using Ctrl + click) and click
Compare. For more information, see "Comparing Scans "on
page 185.
Connactions By default, Fortify Weblnspect lists all scans saved in the local
! |

SQL Server Express Edition and in a configured SQL Server
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Button Function

Standard Edition. To select one or both databases, or to specify
a SQL Server connection, click Connections.

& Refresh When necessary, click Refresh to update the display.

To select which columns should be displayed, click Columns. You
can rearrange the order in which columns are displayed using the
Move Up and Move Down buttons or, on the Manage Scans

] Columns
list, you can simply drag and drop the column headers.

Navigation Pane

When conducting or viewing a scan, the navigation pane is on the left side of the Fortify Weblnspect
window. It includes the Site, Sequence, Search, and Step Mode buttons, which determine the contents
(or "view") presented in the navigation pane.
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Description
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@ Search
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Navigation Pane

Buttons for changing the view
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If all buttons are not displayed, click the drop-down arrow at the bottom of the button list and select
Show More Buttons.

B0 =

Fl I 3

l’:ﬁExcluded Hnstsl’ﬁ?.ﬂ.llnwed Hosts
""""" 4 Show More Buttons o

‘ =l Cross-5ite Scripting: Reflected (.

hito-{{7ern wehannsacuritv oo

| site ¥ Show Fewer Buttons rch

qﬂé Sequence Mavyigation Pane Options. .. ::E
Add or Remove Buttons P —

S JLL W VUINETE0NTES | W IImorT

Site View

Fortify Weblnspect displays in the navigation pane only the hierarchical structure of the Web site or
Web service, plus those sessions in which a vulnerability was discovered. During the crawl of the site,
Fortify Weblnspect selects the check box next to each session (by default) to indicate that the session
will also be audited. When conducting a sequential crawl and audit (where the site is completely
crawled and then audited), you can exclude a session from the audit by clearing its associated

check box before the audit begins.

Site view also contains two pop-up tabs: Excluded Hosts and Allowed Hosts Criteria.

T+ | ] resources

—_—

- |lEg scripts
L VRS stats =
4 I 3

l%ﬁExcluded HDStSI:‘g}J.ﬁ.”DWEd Hosts Criteria

=] site

QE;Q Sequence

Excluded Hosts

If you click the Excluded Hosts tab (or hover your pointer over it), the tab displays a list of all
disallowed hosts. These are hosts that may be referenced anywhere within the target site, but cannot be
scanned because they are not specified in the Allowed Hosts setting (Default/Current Scan Settings >
Scan Settings > Allowed Hosts).

Using the Excluded Hosts tab, you can select an excluded host and click either Add to scan or Add
allowed host criteria.
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ltem  Description

1 Add to scan — Adding a host to the scan creates a node in the site tree representing the
host root directory. Fortify Weblnspect will scan that session. If you have selected the
option to log rejected sessions for invalid hosts (Default/Current Scan Settings > Scan
Settings > Session Storage), Fortify Weblnspect will scan the entire host.

2 Add to Allowed Host Criteria — Adding a host to the allowed host criteria adds the URL to
the list of allowed hosts in the Current Scan Settings. Fortify Weblnspect will include in the
scan any subsequent links to that host. However, if you add a host to the allowed host
criteria after Fortify Weblnspect has already scanned the only resource containing a link to
that host, the added host will not be scanned.

Allowed Hosts Criteria

If you click the Allowed Hosts Criteria tab (or hover your pointer over it), the tab displays the URLs
(or regular expressions) specified in the Fortify Weblnspect scan settings (under Allowed Hosts). If you
click either Delete or Add allowed host criteria, Fortify Weblnspect opens the Current Settings dialog
box, where you can add, edit, or delete allowed host criteria (a literal URL or a regular expression
representing a URL).
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1 Add Allowed Host Criteria — If you add an entry, Fortify Weblnspect will include in the scan
any subsequent links it encounters to hosts that match the criteria. However, if you specify
a host after Fortify Weblnspect has already scanned the only resource containing a link to
that host, the added host will not be scanned.

2 Delete - If you delete an entry from the allowed host list, the scan will still include any
resources that Fortify Weblnspect already encountered.

To save these settings for a future scan, select Save settings as (at the bottom of the left pane of the
Settings window).

You must pause the scan before you can modify the excluded hosts or allowed hosts criteria.
Furthermore, the scanning of added or deleted hosts may not occur as expected, depending on the
point at which you paused the scan. For example, if you add an allowed host after Fortify Weblnspect
has already scanned the only resource containing a link to the added host, the added host will not be
scanned.

Sequence View

Sequence view displays server resources in the order they were encountered by Fortify Weblnspect
during a scan.

Note: In both Site view and Sequence view, blue text denotes a directory or file that was "guessed"

Micro Focus Fortify Weblnspect (18.10) Page 59 of 427



User Guide
Chapter 3: User Interface Overview

by Fortify Weblnspect, rather than a resource that was discovered through a link. For example,
Fortify Weblnspect always submits the request "GET /backup/ HTTP/1.1" in an attempt to discover
if the target Web site contains a directory named "backup."

Search View

The Search view allows you to search across all sessions for various HTTP message components. For
example, if you select Request Method from the drop-down list and specify POST as the search string,
Fortify Weblnspect lists every session whose HT TP request uses the POST method.

Request Method -

POST -

Regular Expression

Match Whiale String

Search

RL

EI hkkps i fzero, webappsecurity com)'signin, btml (F
D hkkps i fzero, webappsecurity com)'signin, btml (F
D htkps i fzero, webappsecurity  com)'signin, btml (F
D hkkps i fzero, webappsecurity  com)'signin, btml (F
G hkkps i fzero, webappsecurity  com)sendFeedbac
D htkp:ffzero webappsecurity . comfForgotten-pa
D htkp:[fzero. webappsecurity, com/signin. hkml {F
D htkp: ffzero webappsecurity  com/signin, html {F
EI hkkps i fzero, webappsecurity com) admin/curren

To use the Search view:

1. Inthe navigation pane, click Search (at the bottom of the pane).

If all buttons are not displayed, click the Configure Buttons drop-down at the bottom of the
button list and select Show More Buttons.

From the top-most list, select an area to search.
In the combo box, type or select the string you want to locate.

If the string represents a regular expression, select the Regular Expression check box. For more
information, see "Regular Expressions" on page 283.

5. To find an entire string in the HTTP message that exactly matches the search string, select the
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Match Whole String check box. The exact match is not case-sensitive.

Note: This option is not available for certain search targets.

6. Click Search.

Step Mode View

Use Step Mode to navigate manually through the site, beginning with a session you select from either
the site view or the sequence view.

Follow the steps below to step through the site:

1. Inthe site or sequence view, select a session.
2. Click the Step Mode button.

If the button is not visible, click the Configure Buttons drop-down and select Show More
Buttons.

3. When Step Mode appears in the navigation pane, select either Audit as you browse or Manual
Audit from the Audit Mode list. Manual Audit is recommended.

Audit Mode: | Manual Audt v|
Browser: | Internet Explorer = |
| @ | | Browse | Finish

4. To use a different browser in Step Mode, select the browser from the Browser list.

5. Click Record [I

6. Click Browse.

The selected browser opens and displays the response associated with the selected session.
Continue browsing to as many pages as you like.

7. When done, return to Fortify Weblnspect and click Finish.

The new sessions are added to the navigation pane.

8. If you selected Manual Audit in step 3, click @+4«t, Fortify Weblnspect will audit all unaudited
sessions, including those you added (or replaced) through Step Mode.

Navigation Pane Icons

Use the following table to identify resources displayed in the navigation pane.
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Icons Used in the Navigation Pane

Ilcon Description

: Server/host: Represents the top level of your site's free structure.
= Blue folder: A folder discovered by "guessing" and not by crawling.

Yellow folder: A folder whose contents are available over your Web site.

B3 Grey folder: A folder indicating the discovery of an item via path tfruncation. Once the parent
is found, the folder will display in either blue or yellow, depending on its properties.

D File.

=" Query or post.
;I-""', DOM event.

Icons superimposed on a folder or file indicate a discovered vulnerability

Ilcon Description

A red dot with an exclamation point indicates the object contains a critical vulnerability. An
attacker might have the ability fo execute commands on the server or retrieve and modify
private information.

(S

A red dot indicates the object contains a high vulnerability. Generally, the ability to view source
code, files out of the Web root, and sensitive error messages.

C

A gold dot indicates the object contains a medium vulnerability. These are generally non-
HTML errors or issues that could be sensitive.

A blue dot indicates the object contains a low vulnerability. These are generally interesting
issues, or issues that could potentially become higher ones.

.

An'"i"in a blue circle indicates an informational item. These are interesting points in the site, or

®/

certain applications or Web servers.

A red check mark indicates a "best practice" violation.

&/
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Navigation Pane Shortcut Menu

If you right-click an item in the navigation pane while using the Site or Sequence view, a shortcut menu
presents the following options:

« Expand Children* - (Site View only) Expands branching nodes in the site free.

« Collapse Children* - (Site View only) Contracts branching nodes into the superior node.

o Check All* - (Site View only) Marks the check box the parent node and all children.

+ Uncheck All* - (Site View only) Removes the check mark from the parent node and all children.

o Generate Session Report* - (Site View only) Creates a report showing summary information, the
attack request and attack response, links to and from the URL, comments, forms, e-mail addresses,
and check descriptions for the selected session.

« Export Site Tree* - (Site View only) Saves the site tree in XML format to a location you specify.
e Copy URL - Copies the URL to the Windows clipboard.
o View in Browser - Renders the HTTP response in a browser.

« Links - (Site View only) Lists all resources at the target site that contain links to the selected
resource. The links may be rendered by HTML tags, scripts, or HTML forms. It also lists (under Linked
To) all resources that are referenced by links within the HTTP response for the selected session. If
you double-click a listed link, Fortify Weblnspect shifts focus in the navigation pane to the referenced
session. Alternatively, you can browse to the linked resource by viewing the session in the Web
browser (click Web Browser).

o Add - Allows you to add locations discovered by means other than a Fortify Weblnspect scan
(manual inspection, other tools, etc) for information purposes. You can then add any discovered
vulnerabilities to those locations so that a more complete picture of the site is archived for analysis.

« Page - A distinct URL (resource).

« Directory - A folder containing a collection of pages.
Choosing either Page or Directory invokes a dialog box that allows you to name the directory or
page and edit the HTTP request and response.

« Variation - A subnode of a location that lists particular attributes for that location. For example,
the login.asp location might have the variation: “(Query)
Username=12345&Password=12345&Action=Login”. Variations are like any other location in
that they can have vulnerabilities attached to them, as well as subnodes.

Choosing Variation invokes the Add Variation dialog box, allowing you to edit the variation
attributes, specify Post or Query, and edit the HTTP request and response.
o Vulnerability - A specific security threat.

Choosing Vulnerability invokes the Edit Vulnerabilities dialog box, allowing you to edit the
variation attributes, specify Post or Query, and edit the HTTP request and response. For more
information, see "Editing Vulnerabilities" on page 235.

« Edit Vulnerabilities - Allows you to edit a location that was added manually or edit a vulnerability.
For more information, see "Editing Vulnerabilities" on page 235.

+ Remove Location - Removes the selected session from the navigation pane (both Site and Sequence

Micro Focus Fortify Weblnspect (18.10) Page 63 of 427



User Guide
Chapter 3: User Interface Overview

views) and also removes any associated vulnerabilities.

Note: You can recover removed locations (sessions) and their associated vulnerabilities. See
"Recovering Deleted Items" on page 246 for details.

« Review Vulnerability - Allows you to retest the vulnerability, mark it as a false positive, or send it to
Micro Focus Application Lifecycle Management (ALM). For more information, see "Reviewing a
Vulnerability " on page 233.

« Mark as False Positive - Flags the vulnerability as a false positive and allows you to add a note.

+ Send to - Allows you convert the selected vulnerability to a defect and assign it to Micro Focus
Application Lifecycle Management (ALM), using the profile specified in the Fortify Weblnspect
application settings.

+ Remove Server - Deletes the server from the navigation pane and does not include the server in any
remaining scan activity. This command appears only when you right-click a server.

e Crawl - Recrawls the selected URL.

« Attachments - Allows you to create a note associated with the selected session, flag the session for
follow-up, add a vulnerability note, or add a vulnerability snapshot.

e Tools - Presents a submenu of available tools.

o Filter by Current Session - Restricts the display of items in the Summary pane to those having the
SummaryDatalD of the selected session.

* Command appears on shortcut menu only when the Navigation pane is using the Site view.
See Also

"User Interface Overview" on page 42

"Search View" on page 227

"Inspecting the Results" on page 223
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Information Pane

When conducting or viewing a scan, the information pane contains three collapsible information panels
and an information display area.

Scan Info
@ Dashboard
Traffic Monitor

Session Info *_
[ web Browser
[& HTTP Request
[& HTTP Response
Stack Traces
T
st
&P Links
Comments
& Text
WG Hiddens
] Forms
E-mail
B saipts
EAttachmenE
[;?Altack Info

Host Info Fo
% P3P Info
[ Axax
[ certificates
L) Comments.

€6 Cookies

= E-mai

ElFo

WG Hiddens

2 Scripts

@@ Broken Links

ltem

1™ Session Vulnerabilities: http:/ / zero.webappsecurity.com/ stats/

»

Muttiple Vulnerabilities Were Found

® Access Control: Unprotected File

& Privacy Violation: Autocomplate

& Cred 1M - Insecure T

& Trangoor r Pr ign. n i in Form 3

Summary: Access Control: Unprotected File
Vulnerability 10: 10228

CWE ID: 548

Kingdom: Environment

Logfie and/or statistic directories were discovered w ithin your w eb application during a Directory Enumeration scan. Risks associated with an
attacker discovering a direclory on your application server depend upon what type of directory is discovered, and w hat types of fies are
contained within & The primary threat, other than ing files taini itive information, is that an attacker can utiize the information
discovered in thal directory to perform other types of altacks. Recc ions include resiricting access lo important direclories or fies by
adopling a "need to know " requirement for both the document and server root, and turning off features such as Automatic Direclory Listings that
provide nformation that could be utiized by an attacker w hen formulating or conducting an attack

Fix
How to remediate the issue.

For Security Operations:

You should evaluale the production requirements for the found directory. ¥ the directory is not required for production operation, then the
directory and its contents should be removed or restricled by a server access control han More i ion about mp ing access
control schemes can be found in the References. Automatic directory indexing should also be disabled, if applicable.

For Development:

This problem will be resolved by the web application server administrator. In general, do not rely on "hidden’ directories w ithin the w eb root that
can conlain sensilive resources or web applications. Assume an attacker knows about the exislence of al direclories and fies on your web
site, and protect them w ith proper access controls.

Description
Scan Info panel (See "Scan Info Panel Overview " on the next page)
Session Info panel (See "Session Info Panel Overview " on page 77)
Host Info panel (See "Host Info Panel Overview" on page 85)

Information display area

Select the type of information to display by clicking on an item in one of these three information panels
in the left column.

Tip: If you follow a link when viewing the vulnerability information, click the highlighted session in
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the navigation pane to return.

See Also

"Summary Pane" on page 92

"User Interface Overview" on page 42
"Navigation Pane" on page 55

"Scan Info Panel Overview " below
"Session Info Panel Overview " on page 77

"Host Info Panel Overview" on page 85

Scan Info Panel Overview

The Scan Info panel has the following choices:

¢ Dashboard

o Traffic Monitor
o Attachments
o False Positives

Dashboard

The Dashboard selection displays a real-time summary of the scan results and a graphic representation
of the scan progress. This section is displayed only if you select this option from the Default or Current
settings. For additional information, see "Dashboard" on page 69.

Dashboard Image

2 @ Scan Dashboard

Scan Info

Traffic Monitor

o | Audited: 149 of 521

| Verified: 0 of 448

(crawled:S140f559 | Network
| .ﬁ——m
| Smart Audited: 15 of 521 ] . - L
5 ]

% | | Reflection Audited: 0 of 0

iy P3P Info

3 Aax Yulnerabilities

[ Certificates

2 Comments

\5 Cockies

| E-mails

(3 7oms p—y P P

R Hiddens Critical High Madum Low Info Best

B Scripts Practices

(@ BrokenLinks

G oronen) Attack Type attacks @ [*] ™) [%] 7] 7]

(@@ Offsite Links (&l Manipulation 3,743 2 1 1 0 0 0

Parameters i Exploratory 7,494 2 5 2 16 [i] [i]
¥ Other 2,842 i 3 H 26 1 7

Scan
Type: Site:
Skakus: Running
Agent: Mot Detected
Client: FF
Duration: 00:09:58
Policy: Standard
Deleted Items: o
Crawl
Hosts: 1
Sessions: 440
Audit
Attacks Sent 14,079
Issues: 66
Network
Total Requests: 15,899
Faied Requests: o0
Seript Includes: 10
Matro Requests: 0
404 Probes: 201
404 Check Redirects: 113
Verify Requests: 0
Logouts: o
Macro Playbacks: (1]
AR Requests: 1)
Script Events: 1,185
Kiobytes Sent: 16,267%
Kilobytes Received 35,899

Micro Focus Fortify Weblnspect (18.10)

Page 66 of 427



User Guide
Chapter 3: User Interface Overview

Traffic Monitor

Fortify Weblnspect displays in the navigation pane only the hierarchical structure of the Web site or
Web service, plus those sessions in which a vulnerability was discovered. (For more information, see
"Navigation Pane" on page 55.) The Traffic Monitor selection allows you to display and review every
HTTP request sent by Fortify Weblnspect and the associated HTTP response received from the web
server.

The Traffic Monitor is available only if Traffic Monitor Logging was enabled prior o conducting the
scan

In Fortify Weblnspect 10.50, the Traffic Monitor was converted into a new standalone Traffic Viewer
tool. For more information, see "Traffic Monitor" on page 220.

Traffic Monitor Image

The following image depicts the Traffic Monitor as it appears for traffic session data from Fortify
Weblnspect 10.40 and earlier versions.

© Dashboxd SAHTTP Editor @) Session = () Refresh  Auto Scroll (7] Columns
e —— g r——r
[ Attachments 71282014 11:00:23 ... zero.webappsecurty.... (GET 404 Not Found | Extersion Addition |0 S5
i False Posives _ | 7/28j2014 10:00:23 ... X e |GET 404 Not Found | Known Jti_pvt funiqueperri.cnf
e |GET 404 Mot Found | Enown Jadkminfwebatis. pl
Sesshon Info & 404 Not Found | Krvown frest-coi
(@ Vulnerabily | Justornr Accounts WabServics. smoxwsdlm" 020 <n NS5[ -4 [STVLE=xss:6] " xpracsion k(007531 }) >
Eweb Browser v |GET 404 Not Found | Extension Repla... | [p2 badext123
féhmmm 3 ... |GET 404 Mot Found | Known Jeeriphsehop.pl
7/28/2014 11:00:23 ... | zero.webappsecurty.... |GET | 404 Not Found | Known JadminjdFes.cgl
[EHTTPResparse 7/28/2014 11:00:23 ... zero.websppescurty.... |GET 404 Mot Found | Krewn Jedt.pl
- 71282014 11:00:23 ... zero.webappsecurty.... (GET | 404 NotFound | Extension Addition | fCustomerAccounts/WiebService. asmresx e
ot [Feauest Viever | Respates vever ]
Sy stens & Rowm [ detaks [ e | " Raw | Browser | hex |
b (Select s requestaction) ) KRRy Sesrch et - A ClRegex| | chunked, Mo Compression T sarch Test . 3 [iRegex
BTee ICET /vy ="420<e X35/ 7" /STVLEmxss: a7/ | HITP/L.1 500 Incesnal Server Bevor
upression (alerc(097531))> HTTR/1.1 Jave: Mon, 28 Jul 2014 15:02:11 GMT
;| Referer: http://zero. ity cons s/vebservicetesting? |=|[Server: Microsofe-IIS/6.0
Jhes ~By: ASP.NET
Version: 2.0.£0727 £
che 1: privace
Mosilia/s.0 (Windows NT 6.1; WOW64; rviZ2.0) Gecko/Z0i00M01 ¥ text/plain: charset=utf-g
lattachmeants atox/22.0 cos angeh: 44
[FAttack Info Bosc: zerc.webappsecurity.com Il )
- lconnection: Keev-Alive ¥eb service descrivtion was not found.
Attachments

The Attachments selection displays a list of all session notes, vulnerability notes, flags for follow-up,
and vulnerability screenshots that have been added to the scan. Each attachment is associated with a
specific session. This form also lists scan notes (that is, notes that apply to the entire scan rather than to
a specific session).

You can create a scan note, or you can edit or delete an existing attachment.

To create a scan note, click the Add menu (in the information display area).

To edit an attachment, select the attachment and click Edit.

To create attachments in other area of the Fortify Weblnspect user interface, you can either:

¢ Right-click a session in the navigation pane and select Attachments from the shortcut menu, or

o Right-click a URL on the Vulnerabilities tab of the summary pane and select Attachments from the
shortcut menu.

Micro Focus Fortify Weblnspect (18.10) Page 67 of 427



User Guide
Chapter 3: User Interface Overview

Fortify Weblnspect automatically adds a note to the session whenever you send a defect to Micro Focus
Application Lifecycle Management (ALM).

For more information, see "Attachments - Scan Info" on page 75.

Attachments Image

9 eshboard dhadd Edit View x Delete
@ Traffic Monitor

- Type Associated With Date Added Name Size URL

Ay False Postves Screenshot Vulnerability - Cross-Site Scripting 7/28/2014 1:54 PM XSS on Confirm Transfer Fund 1624 KB http://zero.webappsecurity.com:80/acctxfer

Session Info 2
(g vulnerabilty

B web Brawser

[& HTTP Request

[ZHTTP Response

[Sloetats
"y Steps

& Links.

L Comments
[E) Tet

] Forms
Description Preview
o E-mail

B sorpes Image of XSS on Confirm Transfer Funds page.
S attechments

|3 attack info

False Positives

This feature lists all URLs that Fortify Weblnspect originally flagged as containing a vulnerability,
but which a user later determined were false positives. Note that this option is not displayed until
someone actually designates a vulnerability as a false positive.

Click the URL associated with a false positive to view a note that may have been entered when the user
removed the vulnerability.

To reassign the vulnerability and remove the URL from the False Positive list, select a URL and click
Mark as Vulnerability.

You can import from a previous scan a list of vulnerabilities that were identified as being false positives.
Fortify Weblnspect then correlates these false positives from a previous scan with vulnerabilities
detected in the current scan and flags the new occurrences as false positives.

For more information, see "False Positives" on page 76.
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False Positives Image

Scan Info

1 - {» Scan False Positives

© Dashboard D Mark As Vulnerability . Edit Description & Import False Positives
@ e -
] Attachments m_;\m\muhi\ily ]
3 -
- = Risk | URL Vulnarabiity St Souree
Serson Tt B |5 stave: actve Faise Positves (8 items)
(@ vulnessbily & Vulnerability: Backup File (Appended bak) (1 item)
[Elweb Browser ™ Active =
[BHTTP Request

LA S vuinerability: Possible Server Path Disclosure (unix) (1 item)
[EHTIPResponse

[*] http:/ 2660 webappsec... Possible Server Path Di.. Active False Positives  Site: hatp://zero webagpsacurity.com/ (Current Scan)

Stadk Traces

E Vulnerability: Form Auta Complete Active (1 item)

Eoetsse @] Matrowebippsec.. Form Auto Complete A_ Actve Faise Positives _ Site. hetp:/sera.webagpiecurity com) (Current Scan]
“\St.“ = Vulnerability: Potential filename found in comments (1 item)
ﬁ’::u - (7] higcffzero.webapgsec.. Potential filename fou.. Active False Positives  Site: hitp:/fzero webappseourity.com/ (Current Scan)
(2 Comment
[B) Tet
Y Hidders =
[ Forms _—

- Description

Scripts
amachments
R attock info o

See Also

"Session Info Panel Overview " on page 77
"Host Info Panel Overview" on page 85
"User Interface Overview" on page 42
"Dashboard" below

"Traffic Monitor" on page 220

"Attachments - Scan Info" on page 75

Dashboard

The Dashboard selection displays a real-time summary of the scan results and a graphic representation

of the scan progress.
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Dashboard Image

The following image displays the Scan Dashboard with a scan in progress.

“8 (®) Scan Dashboard

Scan Info
——
Traffic Monitor
stachment  Audited: 149 of 521 )
[ smart Audited: 15 of 521 ] = A
| verified: 0 of 448 ] ;
% | | Reflection Audited: 0 of 0 |
% P3P Info
[ AJAX Yulnerabilities
[ Certificates
L= Comments
B Cookies
(il E-mails
CJroms pua—y P p——
G Hiddens Critical High Medium Low Iréo Best
"‘}Scriﬂs Practices
3 brokealine Attack Type Attacks o [*] ] (%] (7] v
(@ Offsite Links (&l Manipulation 3,743 2 1 1 0 0 0
Paramelers i Exploratory 7,494 2 5 2 16 1] a
¥ Other 2,842 0 3 2 26 1 7

Scan
Type: Sike:
Stakus: Running
Agent: Mok Detected
Client: FF
Duration: 00:09:58
Policy: Standard
Deleted Items: [
Crawl
Hosts: 1
Sessions: 440
Audit
Attacks Sent 14,079
Issues: 68
Network
Total Requests: 15,899
Faied Requests: 0
Seript Includes: 10
Macro Requests: (1]
404 Probes: 201
404 Check Redirects: 113
Verify Requests: 0
Logaouts: 0
Macro Playbacks: 0
AJAX Requests: 1]
Seript Events: 1,185
Kiobytes Senk: 16,267
Kilobytes Received: 35,894K

Progress Bars

Each bar represents the progress being made through that scanning phase.

 Crawled: 2100f301

w 47 of 246

[ Smart Audited: 12 of 246

[ Verified: 0 of 147

[ Reflection Audited: 0 of 0

l
l
l
l
l

Progress Bar Descriptions

The following table describes the progress bars.

Progress Bar Description
Crawled

Audited

Number of sessions crawled / total number of sessions to crawl.

Number of sessions audited / total number of sessions to audit.

The total number includes all checks except those pertaining to server type,

which are handled by smart audit.
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Progress Bar Description

Smart Audited Number of sessions audited using smart audit / total number of sessions for
smarf audif.

For smart audit, Fortify Weblnspect detects the type of server on which the Web
application is hosted. Fortify Weblnspect runs checks that are specific to the
server type and avoids checks that are not valid for the server type.

Verified Number of persistent XSS vulnerable sessions verified / total number of
persistent XSS vulnerable sessions to verify.

When persistent XSS auditing is enabled, Fortify Weblnspect sends a second
request to all vulnerable sessions and examines all responses for probes that
Fortify Weblnspect previously made. When probes are located, Fortify
Weblnspect will record links between those pages internally.

Reflection Number of persistent XSS vulnerable linked sessions audited / total number of
Audited persistent XSS vulnerable linked sessions to audit.

When persistent XSS auditing is enabled, this represents the work required for
auditing the linked sessions found in the verification step for persistent XSS.

Progress Bar Colors

- Smart Audited: 316 of 518

I
@ 2 ©

1. Dark green indicates sessions that have been processed.

2. Light green indicates excluded, aborted, or rejected sessions (sessions that were considered for
processing, but were skipped due to settings or other reasons).

3. Light gray indicates the unprocessed sessions.
Activity Meters

Fortify Weblnspect polls information about the activity occurring in the scan and displays the datain
activity meters. The data presents a real-time snapshot of the scan activity. This information can help
you to determine whether the scan is stalled or actively running.
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Metwork

‘Analysis

o

Activity Meter Descriptions

The following table describes the activity meters.

Meter

Network

Analysis

Description

The amount of data being sent and received by Fortify Weblnspect.

The chart shows this data as B, KB, or MB sent/received over the last one
second.

The amount of work being done per second by Fortify Weblnspect in processing
all threads.

Vulnerabilities Graphics

The following table describes the Vulnerabilities bar graph and grid.

Graphic

Vulnerability
Graph

Attack Stats
Grid

Description

Total number of issues identified for the scan per severity level.

Number of attacks made and issues found, categorized by attack type and audit
engine.

Statistics Panel - Scan

The following table describes the Scan section of the statistics panel.

Iltem
Type
Scan Status

Agent

Micro Focus Fortify Weblnspect (18.10)

Description
Type of scan: Site, Service, or Site Retest.
Status: Running, Paused, or Complete.

Refers to the Fortify Weblnspect Agent and states either Detected or Not
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Item Description

Detected. For certain checks (such as SQL injection, command execution, and
cross-site scripting), Fortify Weblnspect Agent intercepts Fortify Weblnspect
HTTP requests and conducts runtime analysis on the target module. If this
analysis confirms that a vulnerability exists, Fortify Weblnspect Agent appends
the stack trace to the HTTP response. Developers can analyze this stack trace to
investigate areas that require remediation.

Client The rendering engine specified for the scan. Options are:

o |IE (Internet Explorer)
o FF (Firefox)

e iPhone

o iPad

e Android

¢ Windows Phone

e WindowsRT

Duration Length of time scan has been running (can be incorrect if the scan terminates
abnormally).

Policy Name of the policy used for the scan. For a retfest, the field contains a dash ("-",

because the retest does not use the entire policy. For more information, see
"Retest Vulnerabilities" on page 244.

Deleted Items The number of sessions and vulnerabilities removed by the user from the scan.

To remove a session, right-click a session in the Navigation pane and select
Remove Location from the shortcut menu. For more information, see
“Navigation Pane" on page 55.

To remove a vulnerability, right-click a vulnerability in the Summary pane and
select Ignore Vulnerability from the shortcut menu. For more information, see
"Summary Pane" on page 92.

To restore sessions or vulnerabilities that have been deleted:

1. On the Scan Dashboard, click the number associated with deleted items.
The Recover Deleted Items window appears.

2. Select either Vulnerabilities or Sessions from the drop-down menu.

3. Select one or more items.

4. Click Recover.
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Statistics Panel - Crawl

The following table describes the Crawl section of the statistics panel.

Item Description
Hosts Number of hosts included in the scan.
Sessions Total number of sessions (excluding AJAX requests, script and script frame

includes, and WSDL includes).

Statistics Panel - Audit

The following table describes the Audit section of the statistics panel.

Item Description
Attacks Sent Total number of attacks senf.
Issues Total number of issues found (all vulnerabilities, as well as best practices).

Statistics Panel - Network

The following table describes the Network section of the statistics panel.
Item Description
Total Requests Total number of requests made.
Failed Requests  Total number of failed requests.
Script Includes Total number of script includes.

Macro Requests  Total number of requests made as part of macro execution.

404 Probes Number of file not found probes made to determine file not found status.
404 Check Number of times a 404 probe resulted in a redirect.
Redirects

Verify Requests Requests made for detection of stored parameters.

Logouts Number of times logout was detected and login macro executed.
Macro Number of times macros have been executed.
Playbacks
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Item Description

AJAX Requests  Total number of AJAX requests made.
Script Events Total number of script events processed.
Kilobytes Sent Total number of kilobytes sent.

Kilobytes Total number of kilobytes received.
Received

See Also
"Scan Info Panel Overview " on page 66
"Session Info Panel Overview " on page 77

"Host Info Panel Overview" on page 85

Attachments - Scan Info

The Attachments selection displays a list of all session notes, vulnerability notes, flags for follow-up,
and vulnerability screenshots that have been added to the scan. Each attachment is associated with a
specific session. This form also lists scan notes (that is, notes that apply to the entire scan rather than to
a specific session).

You can create a scan note, or you can edit or delete an existing attachment.
To view an attachment, select the attachment and click View (or simply double-click the attachment).

To create a scan note, click the Add menu (in the information display area). For more information, see
"Information Pane " on page 65.

To edit an attachment, select the attachment and click Edit. Note that screenshots cannot be edited.

These functions are also available by right-clicking an attachment and selecting an option from the
shortcut menu. You may also select Go to session, which opens the Session Info - Attachments pane
and highlights in the navigation pane the session associated with that attachment.

To create attachments in other areas of the Fortify Weblnspect user interface, do one of the following:

¢ Right-click a session in the navigation pane and select Attachments from the shortcut menu. For
more information, see "Navigation Pane" on page 55.

¢ Right-click a URL on the Vulnerabilities tab of the summary pane and select Attachments from the
shortcut menu. For more information, see "Summary Pane" on page 92.

Fortify Weblnspect automatically adds a note to the session whenever you send a defect to Micro Focus
Application Lifecycle Management (ALM).

See Also

"Scan Info Panel Overview " on page 66
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False Positives

This feature lists all URLs that Fortify Weblnspect originally flagged as containing a vulnerability
and which a user later determined were false positives.

Importing False Positives

You can also import from a previous scan a list of vulnerabilities that were analyzed as being false
positive. Fortify Weblnspect then correlates these false positives from a previous scan with
vulnerabilities detected in the current scan and flags the new occurrences as false positives.

To illustrate, suppose a cross-site scripting vulnerability was detected in Scan No. 1 at URL
http://www.mysite.com/foo/bar and, after further analysis, someone flagged it as a false positive. If you
import false positives from Scan No. 1 into Scan No. 2 of www.mysite.com, and if that second scan
detects a cross-site scripting vulnerability at the same URL Chttp://www.mysite.com/foo/bar), then
Fortify Weblnspect automatically changes that vulnerability to a false positive.

Inactive / Active False Positives Lists

Imported false positives are loaded first into a list labeled "Inactive False Positives." If a false positive in
that list is matched with a vulnerability in the current scan, the item is moved from the Inactive False
Positives list to the Active False Positives list. Unmatched items remain in the Inactive False Positives list.

Loading False Positives

False positives from other scans can be manually loaded into the current scan at any time. Alternatively,
you may instruct the Scan Wizard, while initiating a scan, that false positives are to be loaded from a
specific file; in this case, Fortify Weblnspect correlates the false positives as they are encountered during
the scan. You can also see (on the scan dashboard) the false positives matched while the scan is
running.

Working with False Positives

1. Select False Positives from the Scan Info panel.

2. If necessary, click the plus sign = next to a vulnerability description to display the associated URLs
and state.

3. Click a URL to view a comment (at the bottom of the Information pane) that may have been
entered when the user removed the vulnerability.

4. To import false positives from other scans, click Import False Positives.

5. To change a false positive back to a vulnerability, select an item from the Active False Positive list
and click Mark as Vulnerability.

6. Toremove an item from the Inactive False Positive list, select the item and click Remove From
Inactive.

7. To edit a comment associated with a false positive, select the item and click Edit Comment.

For information on how to designate a vulnerability as a false positive, see "Navigation Pane Shortcut
Menu" on page 63 or "Vulnerabilities Tab" on page 93.

For more information on the Fortify Weblnspect window, see "User Interface Overview" on page 42.
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Session Info Panel Overview

Fortify Weblnspect lists each session created during a scan in the navigation pane using either the Site
view or Sequence view. Select a session and then click one of the options in the Session Info panel to
display related information about that session.

In the following example scan, Fortify Weblnspect sent the HTTP request GET /stats/stats.html
HTTP/1.1.

To see the vulnerability:

1. Select Stats.html in the navigation pane.
2. Inthe Session Info panel, click Vulnerability.

/St Poge
site | ScanInfo 3 Bl ™ session vulnerabilitios: hitp:/ / zero.webappsecurity.com/ stats/
@V o »|| @ Dashboard
g & @ TrafficMonisar
Y e log et
T Attachments " [
@ g errors . Muttiple Vuinerabilities Were Found
Vg et Ak FalsePostves
Vg mages
4 R nchude Session Info 2
5 [EY wnking | |(@ veinerabiiey
o Vg logn B BElwebsronse .-
-G sorets [3 HTTP Request =
+ Vg = * Imnmes m
o [ test |G HTTP Response
@ Vg testing
T user 5] Detats
I wasvel 3 feps
TG WIsvCe D s
Y web
2 scctrgstr.asp : Surmmary: Access Control: Unprotected File
V[ sccxsum.asp B Tet Vuinerability ID: 10220
JI[@ acctsum.asp Y middes -
S scctder.amp - E.
- ] Forms
@ W2 sccoderconfim.asp
[ scctderconfem.asp
@ 1 acctxderdone.asp -|| esowes " -
= ~ . T Attachments discovered in that diectory 10 perform other types of altacks. Recommendations include restricting access 1o mportant drectories of fles by

Options Available

The following table lists the options available in the Session Info panel. Some options appear only for
specific scans (Basic Scan or Web Service Scan). Also, options are enabled only if they are relevant to the
selected session; for example, the Forms selection is not available if the session does not contain a form.

Option Description

Vulnerability Displays the vulnerability information for the session selected in the navigation
pane.

Web Browserl Displays the server's response as rendered by a Web browser for the session

selected in the navigation pane.

HTTP Request Displays the raw HTTP request sent by Fortify Weblnspect to the server hosting
the site you are scanning.

HTTP Response Displays the server's raw HTTP response to Fortify Weblnspect's request.
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Option

Stack Traces

Details®

Steps!

Links?!

Commentsl

Textl

Hiddens®

Description

If the response contains one or more attack signatures (indicating that a
vulnerability has been discovered) you can tab from one attack signature to the
next by clicking these buttons:

< 8>

If you select a Flash (swf) file, Fortify Weblnspect displays HTML instead of
binary data. This allows Fortify Weblnspect to display links in a readable format.

This feature is designed to support Fortify Weblnspect Agent when it is installed
and running on the target server.

For certain checks (such as SQL injection, command execution, and cross-site
scripting), Fortify Weblnspect Agent intercepts Fortify Weblnspect HTTP
requests and conducts runtime analysis on the target module. If this analysis
confirms that a vulnerability exists, Fortify Weblnspect Agent appends the stack
trace to the HTTP response. Developers can analyze this stack trace to
investigate areas that requires remediation.

Lists request and response details, such as the size of the response and the
request method. Note that the Response section contains two entries for
content type: returned and detected. The Returned Content Type indicates the
media type specified in the Content-Type entity-header field of the HTTP
response. Detected Content Type indicates the actual content-type as
determined by Fortify Weblnspect.

Displays the route taken by Fortify Weblnspect to arrive at the session selected
in the navigation pane or the URL selected in the summary pane. Beginning with
the parent session (at the top of the list), the sequence reveals the subsequent
URLs visited and provides details about the scan methodology.

This option lists (under Linked From) all resources at the target site that contain
links to the selected resource. The links may be rendered by HTML tags, scripts,
or HTML formes. It also lists (under Linked To) all resources that are referenced
by links within the HTTP response for the selected session.

Displays all comments (in HTML) embedded in the HTTP response.

Displays all text contained in the HTTP response for the session selected in the
navigation pane.

Displays the name attribute of each input element whose control type is
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Option Description
"hidden."
Formsl Displays the HTML interpreted by the browser to render forms.
E-maill Displays all e-mail addresses included in the response.
Scriptsl Displays all client-side scripts embedded in the server's response.
Attachments Displays all notes, flags, and screenshots associated with the selected object.

To create an attachment, you can either:

o Right-click a session (Basic or Guided Scan) or an operation or vulnerability
(Web service scan) in the navigation pane and select Attachments from the
shorfcut menu, or

¢ Right-click a URL on the Vulnerabilities tab of the summary pane and select
Attachments from the shortcut menu, or

o Select a session (Basic Scan) or an operation or vulnerability (Web service
scan) in the navigation pane, then select Attachments from the Session Info
panel and click the Add menu (in the information pane).

Fortify Weblnspect automatically adds a note to the session information
whenever you send a defect to Micro Focus Application Lifecycle Management
(ALM).

Attack Infol Displays the attack sequence number, URL, name of the audit engine used, and
the result of the vulnerability test. Attack information is usually associated with
the session in which the attack was created and not with the session in which it
was detected. If attack information does not appear for a selected vulnerable
session, select the parent session and then click Attack Info.

XML Request? Displays the SOAP envelope embedded in the request (available when selecting
an operation during a Web Service Scan).

XML Response? Displays the SOAP envelope embedded in the response (available when
selecting an operation during a Web Service Scan).

Web Service Displays the web service schema and values embedded in the request (available
Request? when selecting an operation during a Web Service Scan).

Web Service Displays the web service schema and values embedded in the response
Response? (available when selecting an operation during a Web Service Scan).

1 Basic or Guided Scan only
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2 Web Service Scan only

Most options provide a Search feature at the top of the information pane, allowing you to locate the
text you specify. To conduct a search using regular expressions, select the Regex button before clicking
Find.

Tip: If you follow a link when viewing the vulnerability information, click the highlighted session in
the navigation pane to return.

See Also

"User Interface Overview" on page 42
"Host Info Panel Overview" on page 85
"Navigation Pane" on page 55

"Scan Info Panel Overview " on page 66
"Summary Pane" on page 92

"Regular Expressions" on page 283

Vulnerability

This option displays the vulnerability information for the session selected in the navigation pane or for
the vulnerability selected in the summary pane. It typically includes a description of the vulnerability,
vulnerability ID, Common Weakness Enumeration (CWE) ID, Kingdom, implications Chow this
vulnerability may affect you), and instructions on how to fix the vulnerability.

Web Browser

This option displays the server's response as rendered by a Web browser for the session selected in the
Navigation pane.

HTTP Request

This option displays the raw HTTP request (for the session selected in the navigation pane) sent by
Fortify Weblnspect to the server hosting the site you are scanning.

HTTP Response

This option displays the server's raw HTTP response to Fortify Weblnspect's request, for the session
selected in the navigation pane.

If the response contains one or more aftack signatures (indicating that a vulnerability has been
discovered) you can tab from one attack signature to the next by clicking these buttons:

< &>

If you select a Flash (.swf) file, Fortify Weblnspect displays HTML instead of binary data. This allows
Fortify Weblnspect to display links in a readable format.
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Stack Traces

This feature is designed to support Fortify Weblnspect Agent when it is installed and running on the
target server.

For certain checks (such as SQL injection, command execution, and cross-site scripting), Fortify
Weblnspect Agent intercepts Fortify Weblnspect HTTP requests and conducts runtime analysis on the
target module. If this analysis confirms that a vulnerability exists, Fortify Weblnspect Agent appends
the stack trace to the HTTP response. Developers can analyze this stack frace to investigate areas that
require remediation.

Details

This option lists request and response details, such as the size of the response and the request method,
for the session selected in the navigation pane.

Note that the Response section contains two enftries for content type: returned and detected. Returned
Content Type indicates the media type specified in the Content-Type entity-header field of the HTTP
response. Detected Content Type indicates the actual content-type as determined by Fortify
Weblnspect.

Steps

This option displays the route taken by Fortify Weblnspect to arrive at the session selected in the
navigation pane or the URL selected in the summary pane. Beginning with the parent session (at the
top of the list), the sequence reveals the subsequent URLs visited and provides details about the scan
methodology.

Links

This option lists (under Linked From) all resources at the target site that contain links to the selected
resource. The links may be rendered by HTML tags, scripts, or HTML forms.

It also lists (under Linked To) all resources that are referenced by links within the HTTP response for
the selected session.

If you double-click a listed link, Fortify Weblnspect shifts focus in the navigation pane to the referenced
session. Alternatively, you can browse to the linked resource by viewing the session in the Web browser
(click Web Browser). For more information, see "Navigation Pane" on page 55.

Comments: Session Info

This option displays all comments embedded in the HTTP response for the session selected in the
navigation pane.

Developers sometimes leave critical information in comments that can be used to breach the security of
a site. For example, something as seemingly innocuous as a comment referencing the required order of
fields in a table could potentially give an attacker a key piece of information needed to compromise the
security of your site.
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Use the Search feature at the top of the information pane to locate the text you specify. To conduct a
search using regular expressions, select the Regex button before clicking Find.

You can copy comments to your clipboard by highlighting the text and selecting Copy from the

shortcut menu.

Text

This option displays all fext contained in the HTTP response for the session selected in the navigation
pane. For more information, see "Navigation Pane" on page 55.

Hiddens: Session Info

Fortify Weblnspect analyzes all forms and then lists all controls of the type "hidden" (i.e., controls that
are not rendered but whose values are submitted with a form). Developers often include parameters in
hidden controls that can be edited and resubmitted by an attacker.

Use the Search feature at the top of the information pane to locate the text you specify. To conduct a
search using regular expressions, select the Regex button before clicking Find.

You can copy the HTML text to your clipboard by highlighting the text and selecting Copy from the

shortcut menu.

Forms: Session Info

Fortify Weblnspect lists all HTML forms discovered for the session selected in the navigation pane.

Use the Search feature at the fop of the information pane to locate the text you specify. To conduct a
search using regular expressions, select the Regex button before clicking Find.

You can copy forms to your clipboard by highlighting the text and selecting Copy from the shortcut
menu.

For more information on the Fortify Weblnspect window, see "User Inferface Overview" on page 42.

E-Mail
Fortify Weblnspect lists all email addresses contained in the session selected from the navigation pane.

Use the Search feature at the top of the information pane to locate the text you specify. To conduct a
search using regular expressions, select the Regex button before clicking Find.

You can copy email addresses to your clipboard by highlighting the text and selecting Copy from the

shortcut menu.

Scripts - Session Info

Fortify Weblnspect lists all scripts discovered in a session.

Use the Search feature at the fop of the information pane to locate the text you specify. To conduct a
search using regular expressions, select the Regex button before clicking Find. For more information,
see "Regular Expressions" on page 283.
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You can copy the script to your clipboard by highlighting the text and selecting Copy from the shortcut
menu.

For more information on the Fortify Weblnspect window, see "User Inferface Overview" on page 42.

Attachments - Session Info

You can associate the following attachments with a session:

e Session Note

Flag Session for Follow Up

Vulnerability Note

Vulnerability Screenshot

Note: You can also associate a note with a scan and view all attachments that have been added to
the scan by selecting Attachments in the Scan Info panel.

The Attachments selection displays a list of all notes, flags, and screenshots that have been associated
with the selected session.

Viewing an Attachment

To view an attachment:

o Select the attachment and click View (or simply double-click the attachment).

Adding a Session Attachment
To add a session attachment:

1. Do one of the following to select a session:
o On the Vulnerabilities tab or the Information tab in the Summary pane, right-click a vulnerable
URL. For more information, see "Summary Pane" on page 92.

« On the Navigation pane, right-click a session or URL. For more information, see "Navigation
Pane"on page 55

2. On the shortcut menu, click Attachments and select an attachment type.

Note: An alternative method is to select a session in the Navigation pane, click Attachments in
the Session Info panel, and then select a command from the Add menu (in the information
display area). For more information, see "Information Pane " on page 65.

3. Enter a comment related to the type of attachment you selected.
4. Select the check box next to one or more vulnerabilities.
5. If you selected Vulnerability Screenshot:

a. Enter a name for the screenshot in the Name box. Maximum length is 40 characters.

b. Click the Browse button ... to locate the graphic file or, if you captured the image in memory,
click Copy from Clipboard.

6. Click OK.
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Editing an Attachment
To edit an attachment:

1. Do one of the following:

¢ To view all attachments that have been added to the scan, click Attachments in the Scan Info
panel.

e To view only those attachments that have been added to a specific session, click Attachments
in the Session Info panel and then click a session in the Navigation pane. You can also select a
URL in the Summary pane.

2. Select an attachment and click Edit.

3. Modify the comments as required.

Note: Screenshot attachments cannot be edited.

4. Click OK.

Tip: Add, Edit, View, and Delete functions are also available by right-clicking an attachment in the
information display area and selecting an option from the shortcut menu.

Attack Info

For the session selected in the navigation pane, this option displays the attack sequence number, URL,
name of the audit engine used, and the result of the vulnerability test.

Attack information is usually associated with the session in which the attack was created and not with
the session in which it was detected. If attack information does not appear for a selected vulnerable
session, select the parent session and then click Attack Info.

Also, attack information for non-vulnerable sessions will not appear unless you have enabled the
appropriate session storage option in the default settings. For more information, see "Session Storage"
on page 325.

Web Service Request

This option displays the web service schema and values embedded in the request (available when
selecting an operation during a Web Service Scan). It is available only during a Web Service scan.

Web Service Response

This option displays the web service schema and values embedded in the response (available when
selecting an operation during a Web Service Scan). It is available only during a Web Service scan.

XML Request

This option displays the associated XML schema embedded in the selected request (available when
selecting the WSDL object during a Web Service scan).
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XML Response

This option displays the associated XML schema embedded in the response for the session selected in
the navigation pane (available when selecting the WSDL object during a Web Service scan).

Host Info Panel Overview

When you click any item listed in this collapsible panel, Fortify Weblnspect displays all instances of that
item type that were discovered during a crawl or audit of the site (or host).

If you double-click an item, Fortify Weblnspect highlights in the navigation pane the session that
contains that item. You can copy items (such as e-mail addresses) to your clipboard by highlighting the
text and selecting Copy from the shortcut menu.

In most cases, you can use the Search feature at the top of the information pane to locate the text you
specify. To conduct a search using regular expressions, select the Regex button before clicking Find.

Note: The Host Info panel is not displayed when conducting a Web Service scan.

In the following illustration, selecting Cookies displays a list of all sessions in which cookies were
detected. If you select an item from the list, Fortify Weblnspect displays the cookies associated with the

selected session.

Host Info Panel Image

Scan Info ¥ *:}h Host Cookies: hitp: [ [ zero.webappsecurity.com: 80 (173)
Session Info ¥ | Search for: 2 A Fd ] Regex |
oot il x| Souce L Post Data ~
Start Macro hetp: [ zero. wabippsecunty. com:B0iopin] . asp e ST S0 o SINEr S CHpcT i, .
= P3P Info Hirrd http: [fzenn. webappserurity. com: 80 bankiogn. as. ..
[ Anax Cookie Parsm Manipuation  http:[fzene. webappsecurity. oom: 50
[+ ] Certificates Hernl hittp: [[zero. webappsecurity com: B0 /banklogin.as. ..
Cito Search Mn:!n.hebmuﬁ.m:m.m
it fizero, webappseourty . oom: 80 o
" Cookdes Path Trunesticn bt [ zero. websppsecunty. com: 80 banklogn_ssp
i E-mails Html bt [fzeno. webappoaurity. com: B0 join. a5p
] Forms Hirl hetp:fizero. webappsecunty. com: 50 Tor got. asp
8y Hidders Html http:ffzero. webappsecurity. com: B0 bankiogin.as... |
) Saricts Hirl hittp: [fzero. webappsaurity. com: 80 /banklogn. as. .. -
" L. .
.-§.'_ Broken Links Fet=Cookie: KeyedsVarZsSecond+ValusiVarlesFPirstéValue: pachs/s —
Sat-Cookie: Secondsfatsal+Chocolate; paths/
-‘}F\. i
dy Offsits Lrks Zet-Coskis: FirseCoskissChocolanetChip: parks/
1t Farameters
Options Available
The Host Info options are described in the following table.
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Option

P3P Info

AJAX

Certificates

Comments

Cookies

E-Mails

Forms

Hiddens

Scripts

Broken Links

Offsite Links

Parameters

P3P Info

Description

Displays Platform for Privacy Preferences Project (P3P) information. For more
information, see "P3P Info" below.

Displays a list of all pages containing an AJAX engine, as well as the AJAX
requests. For more information, see "AJAX" on the next page.

Displays a list of all certificates associated with the site. For more information,
see "Certificates" on page 88.

Displays a list of all URLs containing comments. For more information, see
"Comments - Host Info" on page 88.

Displays a list of all URLs containing cookies. For more information, see
"Cookies" on page 89.

Displays a list of all URLs containing e-mail addresses in the response. For more
information, see "E-Mails - Host Info" on page 89.

Displays a list of all URLs containing forms. For more information, see "Forms -
Host Info" on page 89.

Displays a list of all URLs containing input elements whose control type is
"hidden." For more information, see "Hiddens - Host Info" on page 0.

Displays a list of all URLs containing client-side scripts embedded in the server's
response. For more information, see "Scripts - Host Info" on page 90.

Displays a list of all URLs containing hyperlinks to missing targets. For more
information, see "Broken Links" on page 91.

Displays a list of all URLs containing hyperlinks to other sites. For more
information, see "Offsite Links" on page 91.

Displays a list of all URLs containing embedded parameters. For more
information, see "Parameters" on page 91.

This option displays Platform for Privacy Preferences Project (P3P) information.

The World Wide Web Consortium's P3P enables Web sites to express their privacy practicesin a
standard format that can be retrieved automatically and interpreted easily by user agents. P3P user
agents allow users to be informed of site practices (in both machine- and human-readable formats) and
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to automate decision-making based on these practices when appropriate. Thus users need not read the
privacy policies at every site they visit.

A P3P-compliant Web site declares in a policy the kind of information it collects and how that
information will be used. A P3P-enabled Web browser can decide what to do by comparing this policy
with the user's stored preferences. For example, a user may set browser preferences so that information
abouft their browsing habits should not be collected. When the user subsequently visits a Web site
whose policy states that a cookie is used for this purpose, the browser automatically rejects the cookie.

P3P User Agents

Microsoft Internet Explorer 6 can display P3P privacy policies and compare the P3P policy with your
own settings to decide whether or not to allow cookies from a particular site.

The Privacy Bird (originally developed by AT&T), which you can find at hitp://www.privacybird.com/, is
a fully featured P3P user agent that automatically searches for privacy policies at every Web site the
user visits. It then compares the policy with the user's stored privacy preferences and notifies the user of
any discrepancies.

See Also

"Host Info Panel Overview" on page 85

AJAX

AJAX is an acronym for Asynchronous JavaScript and XMLHttpRequest.

If you select this option, Fortify Weblnspect displays all pages containing an AJAX engine, as well as the
AJAX requests.

Scan Info 3 E AJAX Sessions: http: [ [ officerdoofy:80 (141)
& Dashboard Type URL -
E Motes AJAX Page | hitp://officerdoofy: 30/ Sample Web Site./ Always VisibleControl / Always VisibleControl aspx

AJAX Page | http://officerdoofy: 80/ SampleWeb Site/HoverMenuHoverMenu .aspx

AJAX Page | http://officerdonfy: 80/ SampleWeb Site/Mumeric Up Down./MumercUp Down.aspx
AJAX Page |http://officerdoofy:80/Sample\Web Site/PopupContral /PopupControl aspx

AJAX Page |http://officerdoofy: 80/ Sample\Web Site./Rating/Rating.aspx

(& Traffic Monitor

Host Info % LA Page |http://officerdoofy: 20/ SampleWebSite, Reorder st/ ReorderList aspx
Py P3P Info AJAK Page | http://officerdanfy: 20/ SampleVVeb Site/ Texd BoxWatermarnk, Text Box Watemark .aspx
m AJAK Page | hitp://officerdoofy: 80/ SampleWeb Site/ Toggle Button/ Toggle Button .aspx
(] Certificates AJAK Page | http://officerdonfy: 20/ SampleWeb Site/Update Panel Animation./ Update Fanel Animation . aspx
___I AJAX Page | hitp://officerdoofy: 80/ SampleWeb Site. ValidatorZalloutValidatorCallout . aspx
i Comments AJAX Page | http://officerdoofy: 280/ Sample\Web Site/ Always VisibleControl / Always VisibleControl aspx
(i@ Cookies AJAX Page | hitp://officerdocfy: B0/ Sample Web Site/Cascading Drop Down,/Cascading Drop Down aspx
i E-mails AJAX Page |http://officerdoofy: 80/ SampleVWeb SiteConfirmButton./ConfirmButton . aspx
|j Forms 818% Pane | kitn- S fnffirerdnofe- 807 Samnle Weh Sita Dnan Do S Denn Down asm ¥
T This page uses AJAXin scrpt
5 Hiddens
2 seript
(0 Broken Links
/& Offsite Links
@l Parameters
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There are two types of AJAX line items in this view:

e AJAX Page (asillustrated above)
e Request

If you click an item in the list, Fortify Weblnspect displays "This page uses AJAX in script" (for a Page
type) or it lists the query and/or POST data parameters (for a Request type).

How AJAX Works

AJAX s not a technology per se, but a combination of existing technologies, including HTML or
XHTML, Cascading Style Sheets, JavaScript, the Document Object Model, XML, XSLT, and the
XMLHttpRequest object. When these technologies are combined in the AJAX model, Web applications
are able to make quick, incremental updates to the user interface without reloading the entire browser

page.

Instead of loading a Web page at the start of the session, the browser loads an AJAX engine that is
responsible for both rendering the user interface and communicating with the server. Every user action
that normally would generate an HT TP request takes the form of a JavaScript call to the AJAX engine
instead. Any response to a user action that does not require communication with the server (such as
simple data validation, editing data in memory, and even some navigation) is handled by the engine. If
the engine needs to communicate with the server — submitting data for processing, loading additional
interface code, or retrieving new data — the engine makes those requests asynchronously, usually
using XML, without stalling a user's interaction with the application.

Certificates

A certificate states that a specific Web site is secure and genuine. It ensures that no other Web site can
assume the identity of the original secure site. A security certificate associates an identity with a public
key. Only the owner of the certificate knows the corresponding private key, which allows the owner to
make a "digital signature" or decrypt information encrypted with the corresponding public key.

Comments - Host Info

Developers sometimes leave critical information in comments that can be used to breach the security of
a site. For example, something as seemingly innocuous as a comment referencing the required order of
fields in a table could potentially give an attacker a key piece of information needed to compromise the
security of your site.

To view discovered comments:

1. Select Comments from the Host Info panel to list all URLs that contain comments.
2. Click a URL to view the comments it contains.

3. Double-click an entry to locate in the navigation pane the session that contains the comment.
Focus switches to the Comments choice in the Session Info panel.

Use the Search feature at the top of the information pane to locate the text you specify. To conduct a
search using regular expressions, select the Regex button before clicking Find.

You can copy comments to your clipboard by highlighting the text and selecting Copy from the
shortcut menu.
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If you double-click a URL, Fortify Weblnspect highlights in the navigation pane the session that
contains the URL.

Cookies

A cookie contains information (such as user preferences or configuration information) stored by a
server on a client for future use. Cookies appear in two basic forms: as individual files or as records
within one contiguous file. Often, there are multiple sets, the result of multiple browsers being installed
in differing locations. In many cases, "forgotten” cookies contain revealing information that you would
prefer others not see.

To view discovered cookies:
1. Select Cookies from the Host Info panel fo list all URLs in which cookies were found during a crawl
or audit.
2. Click a URL to view the cookies it contains.

3. Double-click an entry to locate in the navigation pane the session that contains the cookie. Focus
switches to the HTTP Response choice in the Session Info panel.

Use the Search feature at the top of the information pane to locate the text you specify. To conduct a
search using regular expressions, select the Regex button before clicking Find.

You can copy cookie code to your clipboard by highlighting the text and selecting Copy from the
shortcut menu.

If you double-click a URL, Fortify Weblnspect highlights in the navigation pane the session that
contains the URL.

E-Mails - Host Info

Fortify Weblnspect lists all email addresses discovered during a scan. To view the email addresses:

1. Select E-mail from the Host Info panel to list all URLs that contain email addresses.
2. Click a URL to view the email addresses it contains.

3. Double-click an entry to locate in the navigation pane the session that contains the email address.
Focus switches to the E-mail choice in the Session Info panel.

Use the Search feature at the top of the information pane to locate the text you specify. To conduct a
search using regular expressions, select the Regex button before clicking Find.

You can copy email addresses to your clipboard by highlighting the text and selecting Copy from the
shortcut menu.

If you double-click a URL, Fortify Weblnspect highlights in the navigation pane the session that
contains the URL.

Forms - Host Info

Fortify Weblnspect lists all HTML forms discovered during a scan.

1. Select Forms from the Host Info panel to list all URLs that contain forms.
2. Click a URL to view the source HTML of the form it contains.
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3. Double-click an entry to locate in the navigation pane the session that contains the form. Focus
switches to the Forms choice in the Session Info panel.

Use the Search feature at the top of the information pane to locate the text you specify. To conduct a
search using regular expressions, select the Regex button before clicking Find.

You can copy forms to your clipboard by highlighting the text and selecting Copy from the shortcut
menu.

If you double-click a URL, Fortify Weblnspect highlights in the navigation pane the session that
contains the URL.

Hiddens - Host Info

Fortify Weblnspect analyzes all forms and then lists all controls of the type "hidden" (i.e., controls that
are not rendered but whose values are submitted with a form). Developers often include parametersin
hidden controls that can be edited and resubmitted by an attacker.

1. Select Hiddens from the Host Info panel to list all URLs that contain hidden conftrols.

2. Click a URL to view the name and value attributes of the "hidden" controls contained in that URL.

3. Double-click an entry to locate in the navigation pane the session that contains the hidden control.
Focus switches to the Hiddens choice in the Session Info panel.

Use the Search feature at the fop of the information pane to locate the text you specify. To conduct a
search using regular expressions, select the Regex button before clicking Find.

You can copy the HTML text to your clipboard by highlighting the text and selecting Copy from the
shorfcut menu.

If you double-click a URL, Fortify Weblnspect highlights in the navigation pane the session that
contains the URL.

Scripts - Host Info

Fortify Weblnspect lists all scripts discovered during a scan. To view the discovered scripts:

1. Select Scripts from the Host Info panel to list all URLs that contain scripfts.
2. Click a URL fo view the script it contains.
3. Double-click an entry to locate in the navigation pane the session that contains the script.

Use the Search feature at the top of the information pane to locate the text you specify. To conduct a
search using regular expressions, select the Regex button before clicking Find.

You can copy a script to your clipboard by highlighting the text and selecting Copy from the shortcut
menu.

If you double-click a URL, Fortify Weblnspect highlights in the navigation pane the session that
contains the URL.

For more information on the Fortify Weblnspect window, see "User Interface Overview" on page 42.
See Also

"Host Info Panel Overview" on page 85
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"Navigation Pane" on page 55

"Regular Expressions" on page 283

Broken Links

Fortify Weblnspect finds and documents all non-working hyperlinks on the site. To locate broken links:

1. Select Broken Links from the Host Info panel to list all URLs that contain non-working hyperlinks.

2. Double-click an entry to locate in the navigation pane the session that contains a broken link. Focus
switches to the HTTP Response choice in the Session Info panel.

Use the Search feature at the top of the information pane to locate the text you specify. To conduct a
search using regular expressions, select the Regex button before clicking Find.

You can copy the HTML text to your clipboard by highlighting the text and selecting Copy from the
shortcut menu.

If you double-click a URL, Fortify Weblnspect highlights in the navigation pane the session that
contains the URL.

Offsite Links

Fortify Weblnspect finds and documents all hyperlinks to other sites.
To examine hyperlinks to other sites:

1. Select Offsite Links from the Host Info panel to list all URLs that contain hyperlinks to other sites.

2. Double-click an entry to locate in the navigation pane the session that contains the offsite link.
Focus switches to the HTTP Response choice in the Session Info panel.

Use the Search feature at the fop of the information pane to locate the text you specify. To conduct a
search using regular expressions, select the Regex button before clicking Find.

You can copy the HTML text to your clipboard by highlighting the text and selecting Copy from the
shorfcut menu.

If you double-click a URL, Fortify Weblnspect highlights in the navigation pane the session that
contains the URL.

For more information on the Fortify Weblnspect window, see "User Inferface Overview" on page 42.

Parameters

A parameter can be either of the following:

o A query string submitted as part of the URL in the HTTP request (or contained in another header).
o Data submitted using the Post method.

To list all URLs that contain parameters:

1. Select Parameters from the Host Info panel.

2. Click a URL to view the parameters it contains.
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3. Double-click an entry to locate in the navigation pane the session that contains the parameter. For
more information, see "Navigation Pane" on page 55.

Use the Search feature at the top of the information pane to search the selected URL for the text you
specify. To conduct a search using regular expressions, select the Regex button before clicking Find.
For more information, see "Regular Expressions" on page 283.

You can copy fext to your clipboard by highlighting the text and selecting Copy from the shortcut
menu.

If you double-click a URL, Fortify Weblnspect highlights in the navigation pane the Session that
contains the URL.

For more information on the Fortify Weblnspect window, see "User Interface Overview" on page 42.
See Also

"Host Info Panel Overview" on page 85

Summary Pane

When conducting or viewing a scan, use the horizontal summary pane at the bottom of the window to
view a centralized display of vulnerable resources, quickly access vulnerability information, and view
Fortify Weblnspect logging information.

Note: You can also group and filter results on all tabs except Scan Log. For more information, see
"Using Filters and Groups in the Summary Pane" on page 228.

Severity . 7 RORE
Chedk
Path Method | Vuln Param Parameters Kingdom Response Length
http:/{zero.webappsecurity.com/account/ GET - Errars 15096
http:/fzero.webappsecurity.com/bank/online-stateme... POST accountld (Postjaccountld=1%0d%0a3P|Header.... Errars 14513
[= Privacy Viclation: Credit Card Number (1 item)
http:/fzero. webappsecurity.com/bank/account-summa... GET - Security Features 14677
[=] Privacy Viclation: Social Security Number (1 item)
http://zero.webappsecurity.com /admin/users. html GET - Security Features 11631
= 5QL Injection {2 items)
http:/{zero.webappsecurity.com/bank/online-stateme...  POST accountld [Postlaccountld=1%09AND%09{select... Input Validaticn and Representation 13236 -
) vulnerabilities | @ Information | [7] Best Practices | || Scan Log | W) Server Information |

This pane has the following tabs:

¢ Vulnerabilities

e Not Found

o Information

o Best Practices

e Scan Log

¢ Server Information
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Vulnerabilities Tab

The Vulnerabilities tab lists information about each vulnerability discovered during an audit of your
Web presence.

To select the information you want to display, right-click the column header bar and choose Columns
from the shortcut menu.

Group by Field
v Group by Box
Columns 3 Severity

Check

Save as Default View Check ID

Reset Default View Path

Reset Factory Settings Methad

Wuln Param

] | ]|

Parameters
Manual
Location
CWEID

v  Kingdom

v Application
Published Status
Pending Status

v FResponse Length

The available columns are:
« Severity: A relative assessment of the vulnerability, ranging from low to critical. See below for
associated icons.

o Check: A Fortify Weblnspect probe for a specific vulnerability, such as cross-site scripting,
unencrypted log-in form, etc.

o Check ID: The identification number of a Fortify Weblnspect probe that checks for the existence of a
specific vulnerability. For example, Check ID 742 tests for database server error messages.

« Path: The hierarchical path to the resource.
e Method: The HTTP method used for the attack.

o Stack: Stack trace information obtained from Fortify Weblnspect Agent . Column is available only
when Fortify Weblnspect Agent is enabled during scan.

¢ Vuln Param: The name of the vulnerable parameter.

o Parameters: Names of parameters and values assigned to them.
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o Manual: Displays a check mark if the vulnerability was manually created.

o Duplicates: Vulnerabilities detected by Fortify Weblnspect Agent that are traceable to the same
source. Column is available only when Fortify Weblnspect Agent is enabled during scan.

o Location: Path plus parameters.
o CWE ID: The Common Weakness Enumeration idenfifier(s) associated with the vulnerability.

« Kingdom: The category in which this vulnerability is classified, using a taxonomy of software security
errors developed by the Fortify Software Security Research Group.

o Application: The application or framework in which the vulnerability is found, such as ASP.NET or
Microsoft IIS server.

« Pending Status: The status (assigned automatically by Fortify Weblnspect or manually) if this scan
were to be published.

« Published Status: The status as it exists in Software Security Center, if previously published.

+ Reproducible: Values may be Reproduced, Not Found/Fixed, or New. Column is available for Site
Retests only (Retest Vulnerabilities).

+ Response Length: The response size in bytes for the vulnerable session.

The severity of vulnerabilities is indicated by the following icons.

Critical High = Medium  Low

g 0 v ©

If you click an item in the list, the program highlights the related session in the navigation pane and
displays associated information in the information pane. For more information, see "Navigation Pane"
on page 55 and "Information Pane " on page 65.

With a session selected, you can also view associated information by selecting an option from the
Session Info panel.

For Post and Query parameters, click an entry in the Parameters column to display a more readable
synopsis of the parameters.

If you right-click an item in the list, a shortcut menu allows you to:

e Copy URL - Copies the URL to the Windows clipboard.
o Copy Selected Item(s) - Copies the text of selected items to the Windows clipboard.
« Copy All ltems - Copies the text of all items to the Windows clipboard.

+ Export - Creates a comma-separated values (csv) file containing either all items or selected items and
displays it in Microsoft Excel.

o View in Browser - Renders the HTTP response in a browser.

« Filter by Current Value - Restricts the display of vulnerabilities to those that satisfy the criteria you
select. For example, if you right-click on "Post" in the Method column and then select Filter by
Current Value, the list displays only those vulnerabilities that were discovered by sending an HTTP
request that used the Post method.

Note: The filter criterion is displayed in the combo box in the upper right corner of the summary
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pane. Alternatively, you can manually enter or select a filtering criterion using this combo box.
For additional details and syntax rules, see "Using Filters and Groups in the Summary Pane" on
page 228.

« Change SSC Status - Change the status of a vulnerability/issue before publishing to Fortify
Software Security Center.

Note: This option is available only when connected to Fortify Weblnspect Enterprise that is
integrated with Fortify Software Security Center.

« Change Severity - Allows you to change the severity level.

« Edit Vulnerability - Displays the Edit Vulnerabilities dialog box, allowing you to modify various
vulnerability characteristics. For more information, see "Editing Vulnerabilities" on page 235.

o Rollup Vulnerabilities - Available if multiple vulnerabilities are selected; allows you to roll up the
selected vulnerabilities into a single instance that is prefixed with the tag “[Rollup]” in Fortify
Weblnspect, Fortify Weblnspect Enterprise, and reports. For more information, see "About
Vulnerability Rollup" on page 238.

Note: If you have selected a rolled up vulnerability, this menu option is Undo Rollup
Vulnerabilities.

« Review Vulnerability - Available if one vulnerability is selected; allows you to retest the vulnerable
session, mark it as false positive or ignored, or send it to Micro Focus Application Lifecycle
Management (ALM). For more information, see "Reviewing a Vulnerability " on page 233. This option
is also invoked if you double-click a vulnerability.

« Mark as - Flags the vulnerability as either a false positive (and allows you to add a note) or as
ignored. In both cases, the vulnerability is removed from the list. You can view a list of all false
positives by selecting False Positives in the Scan Info panel. You can view a list of false positives and
ignored vulnerabilities by selecting Dashboard in the Scan Info panel, and then clicking the
hyperlinked number of deleted items in the statistics column.

Note: You can recover "false positive" and "ignored" vulnerabilities. See "Recovering Deleted
Items" on page 246 for details.

« Send to - Converts the vulnerability o a defect and adds it to the Micro Focus Application Lifecycle
Management (ALM) database.

+ Remove Location - Removes the selected session from the navigation pane (both Site and
Sequence views) and also removes any associated vulnerabilities.

Note: You can recover removed locations (sessions) and their associated vulnerabilities. See
"Recovering Deleted Items" on page 246 for details.

o Crawl - Recrawls the selected URL.
e Tools - Presents a submenu of available tools.

« Attachments - Allows you to create a note associated with the selected session, flag the session for
follow-up, add a vulnerability note, or add a vulnerability screenshot.

If you right-click a group heading, a shortcut menu allows you to:
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« Collapse/Expand All Groups
o Collapse/Expand Group

o Copy Selected ltem(s)

« Copy All Items

« Change Severity

e« Mark as

e Sendto

¢ Remove Location

Not Found Tab

This tab appears only after connecting to Fortify Weblnspect Enterprise and after synchronizing a scan
with Software Security Center. It lists vulnerabilities that were detected by a previous scan in a specific
project version, but were not detected by the current scan. These vulnerabilities are not included in
counts on the dashboard and are not represented in the site or sequence view of the navigation pane.

The shortcut menu options, grouping, and filtering capabilities are a subset of those described for the
Vulnerabilities tab.

Information Tab

The Information tab lists information discovered during a Fortify Weblnspect scan. These are not
considered vulnerabilities, but simply identify interesting points in the site or certain applications or Web
servers. When you click a listed URL, the program highlights the related item in the navigation pane.

The shortcut menu options, grouping, and filtering capabilities are the same as described for the
Vulnerabilities fab.

Best Practices Tab

The Best Practices tab lists issues detected by Fortify Weblnspect that relate to commonly accepted
best practices for Web development. Items listed here are not vulnerabilities, but are indicators of overall
site quality and site development security practices (or lack thereof).

The shortcut menu options, grouping, and filtering capabilities are the same as described for the
Vulnerabilities fab.

Scan Log Tab

Use the Scan Log tab to view information about your Fortify Weblnspect scan action. For instance, the
time at which certain audit methodologies are applied against your Web presence are listed here.
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Z€3Error [ 1+ Warnings [2] @Messages | = Detail
Time Lewvel Message };
6/27/2012 8:19:25 AM  Info Scan Start, ScanlD:941fb508-4d44-4e39-33d3-0861c7367b2f Version:2.30.43.0, Lo-mtionzc:...‘
6/27/2012 8:21:15 AM  Info Scanner Retry Start:
6/27/2012 3:2115 AM  Info Scanner Retry Stop: =
6/27/2012 8:21:16 AM  Infa Recommendation Modules Started:
6/27/2012 3:21:16 AM  Infa Starting Recommendation Module: Web Macro:
6/27/2012 8:21:16 AM  Info Starting Recommendation Module: Network Authentication:
6/27/2012 3:21:16 AM  Info Starting Recommendation Module: File Mot Found:
£/27/2012 3:21:16 AM  Info Completed Recommendation Module: File Not Found:
6/27/2012 8:21:16 AM  Info Completed Recommendation Module: Network Authentication:
6/27/2012 8:21:16 AM  Info Starting Recommendation Module: Web Service: i_T‘

| 0Vulnerabi|ities| f Not FOUHdl O Information | [7] Best Practir:es| || Scan Log | ) Server Information |

You can select the logging level (Debug, Info, Warn, Error, or Fatal) using the Logging option on the
Application Settings window. For more information, see "Application Settings: Logging" on page 383.

You can filter the type of messages displayed using the Errors, Warnings, and Messages buttons at
the top of the pane. To view detailed information about a specific entry in the scan log, select an entry
and then click Detail.

You can also right-click an entry and select the following options from the shortcut menu:

o Copy selected row to clipboard.
o Copy all items to clipboard.
« Get more information about this message.

Server Information Tab

This tab lists items of interest pertaining to the server. Only one occurrence of an item or event is listed
per server.

See Also

"User Interface Overview" on page 42

"Using Filters and Groups in the Summary Pane" on page 228
"Reviewing a Vulnerability " on page 233

"About Vulnerability Rollup" on page 238

Micro Focus Fortify Monitor

The Micro Focus Fortify Monitor program, represented by an icon in the notification area of the
taskbar, provides a context menu that allows you to:

o Start/stop the sensor service
o Start/stop the scheduler service
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« Configure Enterprise Server sensor
o Start/configure the Weblnspect API

Start Sensor
L, Stop Scheduler
| Start Weblnspect API

Configure Sensor

Configure Weblnspect API

Exit

Pop-up messages also appear whenever certain events occur.

This feature is provided primarily for users who install Fortify Weblnspect as a standalone scanner, but
subsequently want to connect to Fortify Weblnspect Enterprise.
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This chapter describes the various types of scans that Fortify Weblnspect can perform, as well as
instructions on how to run those scans. It includes procedures for scheduling scans, and importing,
exportfing, and managing scans that have completed.

Guided Scan Overview

Guided Scan directs you through the best steps for configuring a scan tailored to your application.

The first time you initiate a Guided Scan, Fortify Weblnspect launches a tutorial. You can close the
tutorial at any time, or click Tutorial in the top right corner or the wizard screen to launch the tutorial.

The Guided Scan progress display in the left pane allows you to easily see your progress as you specify
settings for your scan. The right pane displays the scan options on each wizard page.

The Guided Scan Wizard allows you to:

« Verify connectivity to your application

o Test the entire application or only workflows

¢ Record your login procedure

« Review suggested configuration changes

o Explore your application to ensure proper coverage

Guided Scans are template based; you can select to use either a Predefined Template or a Mobile
Template.

Predefined Templates

There are three predefined templates options to choose from:
« Standard Scan: use this option to when you are interested in coverage. Larger sites could take days
when using this tfemplate.

o Quick Scan: use this option when focusing on breadth and performance rather than digging deep.
Especially good for very large sites.

o Thorough Scan: use to perform an exhaustive crawl on your site. It is recommended that you split
your site into parts and only scan smaller chunks of your site with these settings. Not recommended
for large sites.
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Mobile Templates

There are two mobile template options to choose from:

« Mobile Scan: use this option to scan a mobile site from the machine where your instance of Fortify
Weblnspect or Fortify Weblnspect Enterprise is installed. Fortify Weblnspect or Fortify Weblnspect
Enterprise will fetch the mobile version of the site rather than the full site when this option is chosen.

« Native Scan: use this option to manually crawl a native mobile application and capture the Web
traffic as a workflow macro. Generate the traffic on an Android, Windows, or iOS device or software
emulator (CAndroid and iOS only) running a mobile application.

After selecting a Guided Scan template, the stages and steps are displayed in the left pane, allowing you
to easily navigate among them and specify the settings for your scan.

See Also
"Using the Predefined Template" on the next page
"Using the Mobile Scan Template" on page 117

"Using the Native Scan Template" on page 134

Running a Guided Scan

The first time you initiate a Guided Scan, Fortify Weblnspect launches a tutorial. You can close the
tutorial at any time, or click Tutorial in the top right corner or the wizard screen to launch the tutorial.

The Guided Scan progress display in the left pane allows you to easily see your progress as you specify
settings for your scan. The right pane displays the scan options on each wizard page.

The first page of the Guided Scan presents you with the option to select the type of scan to run. There
are three main types to choose from.

Predefined Template (Standard, Quick, or Thorough)

There are three Predefined templates options to choose from:
o Standard Scan: Default scan setftings are designed to focus more on coverage than performance.
Larger sites could take days to crawl with these settings.

e Quick Scan: A scan that focuses on breadth and performance rather than digging deep. Especially
good for very large sites.

« Thorough Scan: Thorough scan settings are designed to perform an exhaustive crawl of your site. I
is recommended that your split your site up into parts and only scan smaller chunks of your site with
these settings. Not recommended for large sites.

For more information, see "Using the Predefined Template" on the next page.
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Mobile Scan Template

This template emulates a mobile device while scanning a Web application.

For more information, see "Using the Mobile Scan Template" on page 117.

Native Scan Template

This template manually crawls a native mobile application and captures Web traffic as a workflow macro.

For more information, see "Using the Native Scan Template" on page 134,
See Also
"Guided Scan Overview " on page 99

"Fortify Weblnspect Policies" on page 394

Using the Predefined Template

The Guided Scan wizard will step you through the necessary stages and steps required to scan your
Web site. If you need to return to a previous step or stage, click the back navigation button, on click the
step in the Guided Scan free to be taken directly there.

Launching a Guided Scan

To launch a Guided Scan:

o For Fortify Weblnspect users, click the Start a Guided Scan option in the left pane, or select File >
New > Guided Scan from the menu bar.

o For Fortify Weblnspect Enterprise users, click Guided Scan under Actions on the Web Console.

The Guided Scan wizard launches and presents a list of Guided Scan templates. There are three

Predefined templates options to choose from:

« Standard Scan: use this option to when you are interested in coverage. Larger sites could take days
when using this femplate.

o Quick Scan: use this option when focusing on breadth and performance rather than digging deep.
Especially good for very large sites.

o Thorough Scan: use to perform an exhaustive crawl on your site. It is recommended that you split
your site into parts and only scan smaller chunks of your site with these settings. Not recommended
for large sites.

Choose one of the Predefined Templates.
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About the Site Stage

During the Site stage, you will:

o Verify the Web site you want to scan

e Choose ascan type

Verifying Your Web Site

To verify your Web site:

1

In the Start URL box, type or select the complete URL or IP address of the site to scan.

If you enter a URL, it must be precise. For example, if you enter MYCOMPANY.COM, Fortify
Weblnspect or Fortify Weblnspect Enterprise will not scan WWW.MYCOMPANY.COM or any other
variation (unless you specify alternatives in the Allowed Hosts setting).

An invalid URL or IP address results in an error. If you want to scan from a certain point in your
hierarchical tree, append a starting point for the scan, such as
http://www.myserver.com/myapplication/.

Scans by IP address do not pursue links that use fully qualified URLs (as opposed to relative
paths).

Note: Fortify Weblnspect supports Internet Protocol version 6 (IPv6) addresses in web site
and web service scans. When you specify the Start URL, you must enclose the IPv6 address in
brackets. For example:

o http://[::1]
Fortify Weblnspect scans "localhost."
o http://[fe80::20c:29ff:fe32:baell/subfolder/
Fortify Weblnspect scans the host at the specified address starting in the "subfolder"
directory.
o http://[fe80:20c:29ff.fe32:bae1]:8080/subfolder/
Fortify Weblnspect scans a server running on port 8080 starting in "subfolder."

Fortify Weblnspect and Fortify Weblnspect Enterprise support both Internet Protocol version 4
(IPV4) and Internet Protocol version 6 (IPV6). IPV6 addresses must be enclosed in brackets.

(Optional) To limit the scope of the scan to an area, select the Restrict to Folder check box, and
then select one of the following options from the list:

Directoryonly (self). Fortify Weblnspect and Fortify Weblnspect Enterprise will crawl and/or audit
only the URL you specify. For example, if you select this option and specify a URL of
www.mycompany/one/two/, Fortify Weblnspect or Fortify Weblnspect Enterprise will assess only
the "two" directory.

Directory and subdirectories. Fortify Weblnspect or Fortify Weblnspect Enterprise will begin
crawling and/or auditing at the URL you specify, but will not access any directory that is higher in
the directory tree.
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Directory and parent directories. Fortify Weblnspect or Fortify Weblnspect Enterprise will begin
crawling and/or auditing at the URL you specify, but will not access any directory that is lower in
the directory tree.

For information about limitations to the Restrict to folder scan option, see "Restrict to Folder
Limitations" on page 174.

3. Click Verify.

If the website is set up to be authenticated with a client certificate using a common access card
(CAQ), then Guided Scan will prompt you with the following message:

The site <URL > is requesting a client certificate. Would you like to configure one now?
To configure a client cerfificate using a CAC:
a. Click Yes.
The Select a Client Certificate window appears.
b. Under Certificate Store, select Current User.
A list of available certificates appears in the Certificate area.
¢. Locate and select a certificate that is prefixed with “(SmartCard)”.
Details about the certificate and a PIN field appear in the Certificate Information area.
d. If aPINisrequired, type the PIN for the CAC in the PIN field, and then click Test.

Note: If a PIN is required and you do not enter the PIN at this point, you must enter the
PIN in the Windows Security window each time it prompts you for it during the scan.

4. If you must access the target site through a proxy server, click Proxy in the lower left of the main
screen to display the Proxy Settings area, and then select an option from the Proxy Settings list:

o Direct Connection (proxy disabled)

o Autodetect proxy settings: Use the Web Proxy Autodiscovery Protocol (WPAD) to locate a
proxy autoconfig file and use this to configure the browser's Web proxy settings.

« Use Internet Explorer proxy settings: Import your proxy server information from Internet
Explorer.

« Use Firefox proxy settings: Import your proxy server information from Firefox.

« Configure proxy settings using a PAC File: Load proxy settings from a Proxy Automatic
Configuration (PAC) file. If you select this option, click Edit to enter the location (URL) of the
PAC.

« Explicitly configure proxy settings: Specify proxy server settings as indicated. If you select
this option, click Edit to enter proxy information.

Note: Electing to use browser proxy settings does not guarantee that you will access the
Internet through a proxy server. If the Firefox browser connection settings are configured for
"No proxy," or if the Internet Explorer setting "Use a proxy server for your LAN" is not selected,
then a proxy server is not used.

When the Web site or directory structure appears, you have successfully verified your connection
fo the Start URL.
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5. Click Next.

The Choose Scan Type window appears.

Choosing a Scan Type

1. Typein aname for your scan in the Scan Name box.
2. Select one of the following scan types:
o Standard: Fortify Weblnspect or Fortify Weblnspect Enterprise perform an automated analysis,
starting from the target URL. This is the normal way to start a scan.

« Workflows: If you select this option, an additional Workflows stage is added to the Guided scan.

3. Inthe Scan Method areg, select one of the following scan methods:

o Crawl Only. This option completely maps a site's hierarchical data structure. After a crawl has
been completed, you can click Audit to assess an application’s vulnerabilities.

o Crawl and Audit. Fortify Weblnspect or Fortify Weblnspect Enterprise map the site’s
hierarchical data structure and audits each resource (page). Depending on the default settings
you select, the audit can be conducted as each resource is discovered or after the entire site is
crawled. For information regarding simultaneous vs. sequential crawl and audit, see "Scan
Settings: Method " on page 309.

o Audit Only. Fortify Weblnspect or Fortify Weblnspect Enterprise apply the methodologies of
the selected policy to determine vulnerability risks, but does not crawl the Web site. No links on
the site are followed or assessed.

4. Inthe Policy area, select a policy from the Policy list. For information about managing policies, see
the "Policy" chapter in the Tools Guide for Fortify Weblnspect Products.

5. Inthe Crawl Coverage area, select the level of coverage you want using the Crawl Coverage slider.
For more information on crawl coverage levels, see "Coverage and Thoroughness" on page 158.

6. Inthe Single-Page Applications area, select Enable SPA support for crawling and auditing single-
page applications (SPAs). When enabled, the DOM script engine finds JavaScript includes, frame
and iframe includes, CSS file includes, and AJAX calls during the crawl, and then audits all traffic
generated by those events.

For more information, see "About Single-page Application Scans" on page 182.
7. Click the Next button.
The Login stage appears with Network Authentication highlighted in the left pane.

About the Login Stage

If the application you intend to scan requires login credentials, you can use the login stage to either
select a pre-existing login macro or record one for use with the scan.

If your application does not require login credentials, you can skip this section of the Guided Scan
wizard by clicking through the options without assigning values, or clicking Application in the Guided
Scan free to skip to the next stage.
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In this stage you can:

o Configure network authorization
o Configure application authorization

o Create or assign a login macro

Network Authentication Step

If your application requires either network or application level authentication, you can assign it here.

Configuring Network Authentication

If your network requires user authentication, you can configure it here. If your network does not require
user authentication, click the Next navigation button or the next appropriate step in the Guided Scan
tree to continue on.

To configure network authentication:

1. Click the Network Authentication checkbox.

2. Select a Method from the drop-down list of authentication methods. The authentication methods
are:

Automatic

Allow Fortify Weblnspect to determine the correct authentication type.

Automatic detection slows the scanning process. If you know and specify one of the other
authentication methods, scanning performance is noticeably improved.

Basic

A widely used, industry-standard method for collecting user name and password information.

a. The Web browser displays a window for a user to enter a previously assigned user name and
password, also known as credentials.

b. The Web browser then attempts to establish a connection to a server using the user's
credentials.

c. If auser's credentials are rejected, the browser displays an authentication window to re-enter
the user's credentials. Internet Explorer allows the user three connection attempts before
failing the connection and reporting an error to the user.

d. If the Web server verifies that the user name and password correspond to a valid user account,
a connection is established.

The advantage of Basic authentication is that it is part of the HTTP specification and is supported
by most browsers. The disadvantage is that Web browsers using Basic authentication transmit
passwords in an unencrypted form. By monitoring communications on your network, an attacker
can easily intercept and decode these passwords using publicly available tools. Therefore, Basic
authentication is not recommended unless you are confident that the connection between the user
and your Web server is secure.
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NT LAN Manager (NTLM)

NTLM is an authentication process that is used by all members of the Windows NT family of
products. Like its predecessor LanMan, NTLM uses a challenge/response process to prove the
client’s identity without requiring that either a password or a hashed password be sent across the
network.

Use NTLM authentication for servers running lIS. If NTLM authentication is enabled, and Fortify
Weblnspect has to pass through a proxy server to submit its requests to the Web server, Fortify
Weblnspect may not be able to crawl or audit that Web site.

Caution! After configuring Fortify Weblnspect for NTLM authentication and scanning the
NTLM-protected sites, you might want to disable the NTLM authentication settings to prevent
any potential problem.

Digest

The Windows Server operating system implements the Digest Authentication protocol as a security
support provider (SSP), a dynamic-link library (DLL) that is supplied with the operating system.
Using digest authentication, your password is never sent across the network in the clear, but is
always transmitted as an MD5 digest of the user's password. In this way, the password cannot be
determined by sniffing network traffic.

Kerberos

Kerberos uses the Needham-Schroeder protocol as its basis. It uses a trusted third party, termed a
Key Distribution Center (KDC), which consists of two logically separate parts: an Authentication
Server (AS) and a Ticket Granting Server (TGS). The client authenticates itself to AS, then
demonstrates to the TGS that it is authorized to receive a ticket for a service (and receives it). The
client then demonstrates to a Service Server that it has been approved to receive the service.

Negotiate

The Negotiate authentication protocol begins with the option to negotiate for an authentication
protocol. When the client requests access to a service, the server replies with a list of authentication
protocols that it can support and an authentication challenge based on the protocol that is its first
choice.

For example, the server might list Kerberos and NTLM, and send a Kerberos challenge. The client
examines the contents of the reply and checks to determine whether it supports any of the
specified protocols. If the client supports the preferred protocol, authentication proceeds. If the
client does not support the preferred protocol, but does support one of the other protocols listed
by the server, the client lets the server know which authentication protocol it supports, and the
authentication proceeds. If the client does not support any of the listed protocols, the
authentication exchange fails.

3. To use aclient certificate for network authentication, select Client Certificate.

4. Inthe Certificate Store area, select one of the following, and then select either the My or Root
radio button:

o Local Machine. Fortify Weblnspect uses a certificate on the local machine based on your
selection in the Certificate Store area.
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o Current User. Fortify Weblnspect uses a certificate for the current user based on your selection
in the Certificate Store area.

5. To view certificate details in the Certificate Information area, select a certificate.
6. Click the Next button.
The Application Authentication page appears.

Application Authentication Step

If your site requires authentication, you can use this step to create, select, or edit a login macro to
automate the login process and increase the coverage of your site. A login macro is a recording of the
activity that is required to access and log in to your application, typically by entering a user name and
password and clicking a button such as Log In or Log On.

The following options are available for login macros:

"Using a Login Macro without Privilege Escalation " below
"Using Login Macros for Privilege Escalation" below
"Using a Login Macro when Connected to Fortify Weblnspect Enterprise" on the next page

"Using a Selenium Macro" on page 109

Using a Login Macro without Privilege Escalation

To use a login macro:

1. Select the Use a login macro for this site check box.
2. Do one of the following:
o To use a pre-recorded login macro, click the ellipsis button (...) fo browse for a saved macro. If
you are using a Selenium macro, see "Using a Selenium Macro" on page 109.
¢ To edit an existing login macro shown in the Login Macro field, click Edit.
¢ To record a new macro, click Create.
For details about recording a new login macro or using an existing login macro, see the "Unified
Web Macro Recorder" chapter in the Tools Guide for Fortify Weblnspect Products.
3. Click the Next button.

If you selected a Standard scan, the Optimization Tasks page appears. If you selected a Workflows
scan, the Manage Workflows page appears.

Using Login Macros for Privilege Escalation

If you selected the Privilege Escalation policy or another policy that includes enabled Privilege
Escalation checks, at least one login macro for a high-privilege user account is required. For more
information, see "About Privilege Escalation Scans" on page 180. To use login macros:

1. Select the High-Privilege User Account Login Macro check box. This login macro is for the
higher-privilege user account, such as a Site Administrator or Moderator account.

2. Do one of the following:
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e To use a pre-recorded login macro, click the ellipsis button (..) fo browse for a saved macro. If
you are using a Selenium macro, see "Using a Selenium Macro" on the next page.

o To edit an existing login macro shown in the Login Macro field, click Edit.
e To record a new macro, click Create.
For details about recording a new login macro or using an existing login macro, see the "Unified

Web Macro Recorder" chapter in the Tools Guide for Fortify Weblnspect Products.

After recording or selecting the first macro and clicking the next arrow, a "Configure Low Privilege
Login Macro" prompt appears.

3. Do one of the following:

o To perform the scan in authenticated mode, click Yes. For more information, see "About
Privilege Escalation Scans" on page 180.

Guided Scan returns to the Select Login Macro window for you fo create or select a low-privilege
login macro. Continue to Step 4.

o To perform the scan in unauthenticated mode, click No. For more information, see "About
Privilege Escalation Scans" on page 180.

The Application Authentication Step is complete. If you selected a Standard scan, the
Optimization Tasks page appears. If you selected a Workflows scan, the Manage Workflows
page appears.

4. Select the Low-Privilege User Account Login Macro check box. This login macro is for the lower-
privilege user account, such as a viewer or consumer of the site content.

5. Do one of the following:
o To use a pre-recorded login macro, click the ellipsis button (...) fo browse for a saved macro. If

you are using a Selenium macro, see "Using a Selenium Macro" on the next page.

¢ To edit an existing login macro shown in the Login Macro field, click Edit.
¢ To record a new macro, click Create.
For details about recording a new login macro or using an existing login macro, see the "Unified
Web Macro Recorder" chapter in the Tools Guide for Fortify Weblnspect Products.

6. Afterrecording or selecting the second macro, click the Next button.

If you selected a Standard scan, the Optimization Tasks page appears. If you selected a Workflows
scan, the Manage Workflows page appears.

Using a Login Macro when Connected to Fortify Weblnspect Enterprise

For a Fortify Weblnspect that is connected to Fortify Weblnspect Enterprise, you can download and use
a login macro from the Fortify Weblnspect Enterprise macro repository.
1. Select the Use a login macro for this site check box.
2. Click Download.
The Download a Macro from Fortify Weblnspect Enterprise window appears.

3. Select the Project and Project Version from the drop-down lists.
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4,
5.

Select a repository macro from the Macro drop-down list.
Click OK.

Note: Selecting a repository macro automatically syncs the Project and Project Version on the
Final Review page under Automatically Upload Scan to WIE.

Using a Selenium Macro

Fortify Weblnspect supports integration with Selenium browser automation. When you click the Import
button and select a Selenium macro to import, Fortify Weblnspect detects that a Selenium macro is
being used. Fortify Weblnspect opens Selenium and plays the macro. The macro must include a logout
condition. If a logout condition does not exist, you can add one using the Logout Conditions Editor just
as with any other macro. However, all other edits must be done in the Selenium IDE.

1.
2.

Select the Use a login macro for this site check box.

Click the ellipsis button (...) fo browse for a saved Selenium macro.
The Import Macro window appears.

Select Selenium IDE Test Case (*.*) from the file type drop-down list.

Note: Selenium macros do not have a specific file extension and can be any type of text file,
including XML.

Locate and select the file, and then click Open.
The Import Selenium Script window appears.

(Optional) To view and/or adjust how Selenium behaves during macro replay, click the Settings
plus (+) sign.

The Settings area expands and the default settings become visible. Make changes as necessary.
Click Verify.

Fortify Weblnspect plays the macro, displaying the verification progress and status in the Import
Selenium Script window.

Did the macro play successfully?

o If yes, the message "Successfully verified macro" appears. Contfinue with Step 8.

¢ If no, an error message appears. Use the error message to debug and correct the error in
Selenium, and return to Step 2 of this procedure to try the import again.

Continue according to the following table.

To... Then...

Specify a logout condition a. Click Edit logout conditions.

The Logout Conditions Editor appears. Currently,
only Regex is supported.

b. Add alogout condition and click OK.
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To... Then...
Export the Selenium script to use a. Click Export.
elsewhere The Selenium script import window opens.

b. Navigate to the desired directory and type a File
name for the scripf.

c. Select the Save as Type.

Note: If you changed the settings in the Import
Selenium Script window, they will not be saved
when exporting the file as a Selenium Import
(" file. However, if you export the file as a
Fortify Weblnspect Selenium macro
(*.webmacro) file, the settings will be saved.

d. Click Save.

About the Workflows Stage

The Workflows stage only appears if you selected Workflows as the Scan Type in the Site stage. If you
chose Standard, the Workflows stage will not appear. You can create a Workflow macro to ensure
Fortify Weblnspect audits the pages you specify in the macro. Fortify Weblnspect audits only those
URLs included in the macro and does not follow any hyperlinks encountered during the audit. A logout
signature is not required. This type of macro is used most often to focus on a particular subsection of
the application.

Important! If you use a login macro in conjunction with a workflow macro or startup macro or
both, all macros must be of the same type: all .webmacro files, all Burp Proxy captures, or all
Selenium macros. You cannot use different types of macros in the same scan.

To complete the Workflows settings, click any of the following in the Workflows table:
¢ Record. Opens the Unified Web Macro Recorder, allowing you to create a macro.

o Edit. Opens the Unified Web Macro Recorder and loads the selected macro.

o Delete. Removes the selected macro (but does not delete it from your disk).

o Import. Opens a standard file-selection window, allowing you to select a previously recorded
.webmacro file, Burp Proxy captures, or a Selenium macro. If using a Selenium macro, you will need to
click Verify for Fortify Weblnspect to play the macro. If the macro does not play successfully, the
Import Selenium Script window displays an error. You will need to debug and correct the errorin
Selenium, and return fo this procedure to try the import again.

Note: If you have installed Micro Focus Unified Functional Testing (UFT) on your computer,
then Fortify Weblnspect detects this automatically and displays an option to import a UFT .usr
file.

Micro Focus Fortify Weblnspect (18.10) Page 110 of 427



User Guide
Chapter 4: Working with Scans

See "Importing Micro Focus Unified Functional Testing (UFT) Files in a Guided Scan " on
page 116.

« Export. Opens a standard file-selection window, allowing you to save a recorded macro.

After you specify and play a workflow macro, it appears in the Workflows table and its Allowed Hosts
are added to the Guided Scan > Workflows > Workflows > Manager Workflow page. You can
enable or disable access to particular hosts. For more information, see "Scan Settings: Allowed Hosts" on
page 328.

To Add Burp Proxy results

If you have run Burp Proxy security tests, the traffic collected during those tests can be imported into a
Workflow macro, reducing the time it would otherwise take to rescan the same areas.

To add Burp Proxy results to a workflow macro:

1. If you are not on the Workflows screen, click on the Manage Workflows step in the Guided Scan
free.

2. Click the Import button.
The Import Macro file selector appears.

3. Change the file type box filter from Web Macro (*.webmacro) to Burp Proxy (*.®).

4. Navigate to your Burp Proxy files and select the desired file.

5. Click Open.

About the Active Learning Stage

During the Active Learning stage:

o The Weblnspect Profiler is run to see if any settings need to be modified.
« Set scan optimization option if necessary.
« Navigate to key locations in your site that should be fully exercised.

Using the Profiler

The Weblnspect Profiler conducts a preliminary examination of the target Web site to determine if
certain settings should be modified. If changes appear to be required, the Profiler returns a list of
suggestions, which you may accept or reject.

For example, the Profiler may detect that authorization is required to enter the site, but you have not
specified a valid user name and password. Rather than proceed with a scan that would return
significantly diminished results, you could follow the Profiler’s suggestion to configure the required
information before continuing.

Similarly, your settings may specify that Fortify Weblnspect should not conduct "file-not-found"
detection. This process is useful for Web sites that do not return a status "404 Not Found" when a client
requests a resource that does not exist (they may instead return a status "200 OK," but the response
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contains a message that the file cannot be found). If the Profiler determines that such a scheme has
been implemented in the target site, it would suggest that you modify the Fortify Weblnspect setting to
accommodate this feature.

To launch the Profiler:

1. Click Profile.
The Profiler runs. For more information, see "Server Profiler" on page 222.
Results appear in the Optimize scan for box in the Settings section.

2. Accept or reject the suggestions that appear in the Optimize scan for drop-down box. To reject the
suggestion, select None or an alternate from the drop-down menu.

3. If necessary, provide any requested information.

4, Click the Next button.
Several options may be presented even if you do not run the Profiler, as described in the following
sections.
Autofill Web Forms

Select Auto-fill Web forms during crawl if you want Fortify Weblnspect to submit values for input
controls on forms it encounters while scanning the target site. Fortify Weblnspect will extract the values
from a prepackaged default file or from a file that you create using the Web Form Editor. See the "Web
Form Editor" chapter in the Tools Guide for Fortify Weblnspect Products. You may:

1. Click the ellipsis button (...) to locate and load a file.

2. Click Edit to edit the selected file (or the default values) using the Web Form Editor.

3. Click Create to open the Web Form Editor and create a file.
Add Allowed Hosts
Use the Allowed Host settings to add domains to be crawled and audited. If your Web presence uses

multiple domains, add those domains here. For more information, see "Scan Settings: Allowed Hosts" on
page 328.

To add allowed domains:

1. Click Add.

2. Inthe Specify Allowed Host window, enter a URL (or a regular expression representing a URL) and
click OK.

Reuse Identified False Positives

Select scans containing vulnerabilities that were changed to false positives. If those false positives
match vulnerabilities detected in this scan, the vulnerabilities will be changed to false positives. For more
information, see "False Positives" on page 76.

To reuse identified false positives:

1. Select Import False Positives.

N

Click Select Scans.

W

Select one or more scans containing false positives from the same site you are now scanning.
Click OK.

Ea
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Apply Sample Macro

Fortify Weblnspect’s example banking application, zero.webappsecurity.com, uses a Web form login. If
you scan this site, select Apply sample macro to run the prepackaged macro containing the login
script.

Traffic Analysis

Select Launch and Direct Traffic through Web Proxy fo use the Web Proxy tool to examine the
HTTP requests issued by Fortify Weblnspect and the responses returned by the target server.

While scanning a Web site, Fortify Weblnspect displays in the navigation pane only those sessions that
reveal the hierarchical structure of the Web site, plus those sessions in which a vulnerability was
discovered. However, if you select Enable Traffic Monitor, Fortify Weblnspect adds the Traffic
Monitor button o the Scan Info panel, allowing you to display and review each HTTP request sent by
Fortify Weblnspect and the associated HTTP response received from the server.

Message

If the Profiler does not recommend changes, the Guided Scan wizard displays the message "No settings
changes are recommended. Your current scan settings are optimal for this site."

The Enhance coverage of your web site task appears highlighted in the left pane.
Enhance coverage of your web site

To enhance coverage of your application, navigate to key locations in your application to enhance
coverage.

When using the Enhance Coverage of Your Web Site feature in Guided Scan in conjunction with the
Privilege Escalation policy, the explored locations are collected while authenticated with the high-
privilege login macro.

See "Unified Web Macro Recorder" in the Tools Guide for Fortify Weblnspect Products for detailed
information about using the Web Macro Recorder to navigate key locations in your application for
Guided Scan to use during the scan.

See the Guided Scan Tutorial for more information about how to use this page of the Guided Scan
wizard. To launch the tutorial, click Tutorial in the upper right corner of the page.

Web Form Values

Guided Scan recorded all of the web form values that you entered while you explored your Web site.
Here you can review and modify the values, which are part of the scan settings that are saved with the
scan. In the Web Forms section of the toolbar, you can click Export to save the values to a separate file
or click Import to use an existing set of values. The scan settings, including the web form values, serve
as defaults that you can modify in future scans.

Click Next.

The Final Review page appears with Configure Detailed Options highlighted in the left pane.

About the Settings Stage

To configure detailed options, specify any of the following settings.
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Reuse Identified False Positives
Select the False Positives box to reuse false positives that Fortify Weblnspect has already identified.
Traffic Analysis

1. To use the Web Proxy tool, select Launch and Direct Traffic through Web Proxy to use the Web
Proxy tool to examine the HTTP requests issued by Fortify Weblnspect and the responses
returned by the target server.

Web Proxy is a stand-alone, self-contained proxy server that you can configure and run on your
desktop. Web Proxy allows you to monitor traffic from a scanner, a Web browser, or any other tool
that submits HTTP requests and receives responses from a server. Web Proxy is a tool for a
debugging and penetration scan; you can view every request and server response while browsing a
site.

2. Select the Traffic Monitor box to display and review each HTTP request sent by Fortify
Weblnspect and the associated HTTP response received from the server.

While scanning a Web site, Fortify Weblnspect displays only those sessions that reveal the
hierarchical structure of the Web site, plus those sessions in which a vulnerability was discovered.
However, if you select Enable Traffic Monitor, Fortify Weblnspect allows you to display and
review each HTTP request sent by Fortify Weblnspect and the associated HTTP response received
from the server.

3. Click Next.
The Validate Settings and Start Scan page appears with Configure Detailed Options highlighted in
the left pane.

Validate Settings and Start Scan

Options on this page allow you to save the current scan settings and, if Weblnspect is integrated with
Weblnspect Enterprise, to interact with Weblnspect Enterprise.

1. To save your scan settings as an XML file, select Click here to save settings. Use the standard
Save as window to name and save the file.

2. If Weblnspect is integrated with Weblnspect Enterprise, a Templates section appears in the toolbar.
Continue according fo the following table.

If you want to... Then...

Save the current scan settings as a templatein = a. Do one of the following:

the WeblInspect Enterprise database o Click Save in the Templates section of
Note: When editing an existing template, the foolbar.
the Save is actually an update. You can o Select Click here to save template.
save any edits to settings and change the The Save Template window appears.

Template Name. However, you cannot . .
P Y b. Select a project from the Project drop-

change the Project, Project Version, or
Global Template settings.

down list.

c. Select a project version from the Project
Version drop-down list.
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If you want to...

Load scan settings from a template

Then...

d.

f.

Type a name in the Template field.

Click Load in the Templates section of the
toolbar.

A confirmation message appears advising
that your current scan settings will be lost.

Click Yes.
The Load Template window appears.

Select a project from the Project drop-
down list.

Select a project version from the Project
Version drop-down list.

Select the template from the Template
drop-down list.

Click Load.

Guided Scan returns to the Site Stage for you
to verify the Web site and step through the
settings from the femplate.

3. If Weblnspect is integrated with Weblnspect Enterprise, the Weblnspect Enterprise section appears
on this page. You can interact with Weblnspect Enterprise as follows:

a. Select a project from the Project drop-down list.

b. Select a project version from the Project Version drop-down list.

¢. Continue according to the following table.

To run the scan...

With a sensor in Weblnspect
Enterprise

In Weblnspect

Micro Focus Fortify Weblnspect (18.10)

Then...

Select Run in Weblinspect Enterprise.

. Select a sensor from the Sensor drop-down list.

ii. Select a Priority for the scan.

Select Run in Weblnspect.

ii. If you want to automatically upload the scan

results to the specified project and project
version in Weblnspect Enterprise, select Auto
Upload to Weblnspect Enterprise.
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To run the scan... Then...
Note: If the scan does not complete
successfully, it will not be uploaded to

Weblnspect Enterprise.

In the Scan Now area, review your scan settings, and then click Start Scan to begin the scan.

Importing Micro Focus Unified Functional Testing (UFT) Files in a Guided Scan

If you have the Micro Focus Unified Functional Testing application installed, Fortify Weblnspect detects
it and allows you to import a UTF file Cusr) into your workflow scan to enhance the thoroughness and
attack surface of your scan. For more information, see Unified Functional Testing on the Micro Focus
Web site.

To import a UTF Cusr) file into a Fortify Weblnspect Guided Scan:

1

Launch a Guided Scan, and then select Workflow Scan as the Scan Type. Additional text appears
under the Workflows scan option: Micro Focus Unified Functional Testing has been detected. You
can import scripts to improve the thoroughness of your security test.

2. Click the Next button.

3. Inthe Authentication section, Application Authentication is automatically selected. Complete the

fields as indicated.

On the Manage Workflows screen, click Import. The Import Scripts dialog box appears. On the
Import Scripts dialog box, you may:

e Type the filename.

o Browse to your file by clicking to locate your file with a .usr extension. Select Micro Focus
Unified Functional Testing from the drop-down file type, and then navigate to the file.

o Click Edit to launch the Micro Focus Unified Functional Testing application.

(Optional) On the Import Scripts dialog box, you may select either of the following opftions:
+ Show Micro Focus Unified Functional Testing Ul during import

o Open script result after import

Select the file to import, and then click Import. After your file is successfully imported, the file

appears in the Workflows table.

Select one of the following from the Workflows table:

¢ Record - launches the Weblnspect Unified Macro Recorder. For more information, see "Unified
Web Macro Recorder" in the Tools Guide for Fortify Weblnspect Products.

o Edit - allows you to modify the file using the Unified Web Macro Recorder. See "Unified Web
Macro Recorder" in the Tools Guide for Fortify Weblnspect Products.

o Delete - deletes the script from the Workflows table.
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o Import - import another file.

o Export - saves a file in .webmacro format with the name and location you specify.

8. Click the Next button.

When the first .usr script file is added to the list, its name (or default name) appears in the
Workflows table and an Allowed Hosts table is added to the pane.

Adding another .usr scripft file can add more allowed hosts. Any host that is enabled is available to
all the listed workflow .usr script files, not just the workflow.usr file for which it was added. The
Guided Scan will play all the listed workflow files and make requests to all the listed allowed hosts,
whether or not their check boxes are selected. If a check box for an allowed host is selected, Fortify
Weblnspect will crawl or audit the responses from that host. If a check box is not selected, Fortify
Weblnspect will not crawl or audit the responses from that host. In addition, if a particular workflow
.usr script uses parameters, a Macro Parameters table is displayed when that workflow macro is
selected in the list. Edit the values of the parameters as needed.

9. After you have completed changes or additions to the Workflows table, proceed in the Guided Scan
wizard to complete your settings and run the scan. For more information about recording a new
login macro or using an existing login macro, see the "Unified Web Macro Recorder" chapter in the
Tools Guide for Fortify Weblnspect Products.

See Also

"Guided Scan Overview " on page 99

Using the Mobile Scan Template

Using the Mobile Scan template to create a mobile Web site scan allows you to scan the mobile version
of a Web site using the desktop version of your browser from within Fortify Weblnspect or Fortify
Weblnspect Enterprise.

A Mobile Scan is nearly identical to a Web site scan and mirrors the settings options you will find when
using one of the Predefined templates to do a Standard, Thorough, or Quick scan. The only difference
is that you need to select a user agent header to allow your browser to emulate a mobile browser.

Fortify Weblnspect and Fortify Weblnspect Enterprise come with four mobile user agent options to
choose from, but you can create a custom option and create a user agent for another version of
Android, Windows Phone, or other mobile device. For information creating a user agent header, see
Creating a Custom User Agent Header.

Launching a Mobile Scan

To launch a Mobile Scan:

1. Log into Fortify Weblnspect or Fortify Weblnspect Enterprise.

2. Start a Guided Scan:
a. For Fortify Weblnspect, click Start a Guided Scan on the Fortify Weblnspect Start page.
b. For Fortify Weblnspect Enterprise, click Guided Scan under Actions on the Web Console.
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Select Mobile Scan from the Mobile Templates section.
Click the Mobile Client icon in the tool bar.

Select the Rendering Engine you want to use.

ISAEE L

Select the User Agent that represents the agent string you want your rendering engine to present
to the site. If you created your own user string, it will appear as Custom. If the user agent is not
listed, you can create a custom user agent. See Creating a Custom User Agent Header.

The Guided Scan wizard displays the first step in the Native Mobile Stage: Verify Web Site.

Creating a Custom User Agent Header

Fortify Weblnspect and Fortify Weblnspect Enterprise include user agents for Android, Windows, and
iOS devices. If you are using one of these options, you do not need to create a custom user agent
header. If you want your Web browser to idenfify itself as a different mobile device or a specific OS
version, create a custom user agent header.

To create a custom user agent:

1. Click the Advanced icon in the Guided Scan tool bar.

2. The Scan Settings window appears.

3. Inthe Scan Seftings column, select Cookies/Headers.

4, Inthe Append Custom Headers section of the settings area, double-click the User-Agent string.
The Specify Custom Header box appears.

5. Type in User-Agent: followed by the user agent header string for the desired device.

6. Click OK.

The new custom user agent will now be available to select as your Mobile Client.

About the Site Stage

During the Site stage, you will:

o Verify the Web site you want to scan

e Choose ascan type

Verifying Your Web Site

To verify your Web site:

1. Inthe Start URL box, type or select the complete URL or IP address of the site to scan.

If you enter a URL, it must be precise. For example, if you enter MYCOMPANY.COM, Fortify
Weblnspect or Fortify Weblnspect Enterprise will not scan WWW.MYCOMPANY.COM or any other
variation (unless you specify alternatives in the Allowed Hosts setting).

An invalid URL or IP address results in an error. If you want to scan from a certain point in your
hierarchical tree, append a starting point for the scan, such as
http://www.myserver.com/myapplication/.
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Scans by IP address do not pursue links that use fully qualified URLs (as opposed to relative
paths).

Fortify Weblnspect and Fortify Weblnspect Enterprise support both Internet Protocol version 4
(IPV4) and Internet Protocol version 6 (IPV6). IPV6 addresses must be enclosed in brackets.

Note: Fortify Weblnspect supports Internet Protocol version 6 (IPv6) addresses in web site
and web service scans. When you specify the Start URL, you must enclose the IPvé address in
brackets. For example:
o http://[::1]
Fortify Weblnspect scans "localhost."
o http://[fe80::20c:29ff:fe32:baell/subfolder/
Fortify Weblnspect scans the host at the specified address starting in the "subfolder"
directory.
o http://[fe80::20c:29ff:fe32:bae1]:8080/subfolder/

Fortify Weblnspect scans a server running on port 8080 starting in "subfolder."

2. (Optional) To limit the scope of the scan to an area, select the Restrict to Folder check box, and
then select one of the following options from the list:

o Directory only (self). Fortify Weblnspect and Fortify Weblnspect Enterprise will crawl and/or
audit only the URL you specify. For example, if you select this option and specify a URL of
www.mycompany/one/two/, Fortify Weblnspect or Fortify Weblnspect Enterprise will assess
only the "two" directory.

¢ Directory and subdirectories. Fortify Weblnspect or Fortify Weblnspect Enterprise will begin
crawling and/or auditing at the URL you specify, but will not access any directory that is higher
in the directory tree.

¢ Directory and parent directories. Fortify Weblnspect or Fortify Weblnspect Enterprise will begin
crawling and/or auditing at the URL you specify, but will not access any directory that is lower in
the directory tree.

For information about limitations to the Restrict to folder scan option, see "Restrict to Folder
Limitations" on page 174.
3. Click Verify.

If the website is set up to be authenticated with a client certificate using a common access card
(CAQ), then Guided Scan will prompt you with the following message:

The site <URL > is requesting a client certificate. Would you like to configure one now?
To configure a client certificate using a CAC:
a. Click Yes.
The Select a Client Certificate window appears.
b. Under Certificate Store, select Current User.
A list of available certificates appears in the Certificate area.
¢. Locate and select a certificate that is prefixed with “(SmartCard)”.

Details about the certificate and a PIN field appear in the Certificate Information area.
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d. If aPINisrequired, type the PIN for the CAC in the PIN field, and then click Test.

Note: If a PIN is required and you do not enter the PIN at this point, you must enter the
PIN in the Windows Security window each time it prompts you for it during the scan.

4. If you must access the target site through a proxy server, click Proxy in the lower left of the main
screen to display the Proxy Settings area, and then select an option from the Proxy Settings list:

o Direct Connection (proxy disabled)

o Autodetect proxy settings: Use the Web Proxy Autodiscovery Protocol (WPAD) to locate a
proxy autoconfig file and use this to configure the browser's Web proxy settings.

o Use Internet Explorer proxy settings: Import your proxy server information from Internet
Explorer.

o Use Firefox proxy settings: Import your proxy server information from Firefox.

« Configure proxy settings using a PAC File: Load proxy settings from a Proxy Automatic
Configuration (PAC) file. If you select this option, click Edit to enter the location (URL) of the
PAC.

« Explicitly configure proxy settings: Specify proxy server settings as indicated. If you select
this option, click Edit to enter proxy information.

Note: Electing to use browser proxy settings does not guarantee that you will access the
Internet through a proxy server. If the Firefox browser connection settings are configured for
"No proxy," or if the Internet Explorer setting "Use a proxy server for your LAN" is not selected,
then a proxy server is not used.

When the Web site or directory structure appears, you have successfully verified your connection
to the Start URL.

5. Click Next.

The Choose Scan Type window appears.

Choosing a Scan Type

1. Typein aname for your scan in the Scan Name box.
2. Select one of the following scan types:
« Standard: Fortify Weblnspect or Fortify Weblnspect Enterprise perform an automated analysis,
starting from the target URL. This is the normal way to start a scan.

o Workflows: If you select this option, an additional Workflows stage is added to the Guided scan.

3. Inthe Scan Method areg, select one of the following scan methods:

o Crawl Only: This option completely maps a site's hierarchical data structure. After a crawl has
been completed, you can click Audit to assess an application’s vulnerabilities.

o Crawl and Audit: Fortify Weblnspect or Fortify Weblnspect Enterprise map the site’s
hierarchical data structure and audits each resource (page). Depending on the default settings

Micro Focus Fortify Weblnspect (18.10) Page 120 of 427



User Guide
Chapter 4: Working with Scans

you select, the audit can be conducted as each resource is discovered or after the entire site is
crawled. For information regarding simultaneous vs. sequential crawl and audit, see "Crawl and
Audit Mode" on page 310.

o Audit Only: Fortify Weblnspect or Fortify Weblnspect Enterprise apply the methodologies of
the selected policy to determine vulnerability risks, but does not crawl the Web site. No links on
the site are followed or assessed.

4. Inthe Policy area, select a policy from the Policy list. For information about managing policies, see
the "Policy" chapter in the Tools Guide for Fortify Weblnspect Products.

5. Inthe Crawl Coverage area, select the level of coverage you want using the Crawl Coverage slider.
For more information on crawl coverage levels, see "Coverage and Thoroughness" on page 158.

6. Inthe Single-Page Applications area, select Enable SPA support for crawling and auditing single-
page applications (SPAs). When enabled, the DOM script engine finds JavaScript includes, frame
and iframe includes, CSS file includes, and AJAX calls during the crawl, and then audits all traffic
generated by those events.

For more information, see "About Single-page Application Scans" on page 182.
7. Click the Next button.
The Login stage appears with Network Authentication highlighted in the left pane.

About the Login Stage

If the application you intend to scan requires login credentials, you can use the login stage to either
select a pre-existing login macro or record one for use with the scan.

If your application does not require login credentials, you can skip this section of the Guided Scan
wizard by clicking through the options without assigning values, or clicking Application in the Guided
Scan free to skip to the next stage.

In this stage you can:

« Configure network authorization

« Configure application authorization
o Create or assign a login macro

Network Authentication Step

If your application requires either network or application level authentication, you can assign it here.

Configuring Network Authentication

If your network requires user authentication, you can configure it here. If your network does not require
user authentication, click the Next navigation button or the next appropriate step in the Guided Scan
tree to continue on.
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To configure network authentication:

1. Click the Network Authentication checkbox.

2. Select a Method from the drop-down list of authentication methods. The authentication methods
are:

Automatic

Allow Fortify Weblnspect to determine the correct authentication type.

Automatic detection slows the scanning process. If you know and specify one of the other
authentication methods, scanning performance is noticeably improved.

Basic

A widely used, industry-standard method for collecting user name and password information.

a. The Web browser displays a window for a user to enter a previously assigned user name and
password, also known as credentials.

b. The Web browser then attempts to establish a connection to a server using the user's
credentials.

c. If auser's credentials are rejected, the browser displays an authentication window to re-enter
the user's credentials. Internet Explorer allows the user three connection attempts before
failing the connection and reporting an error to the user.

d. If the Web server verifies that the user name and password correspond to a valid user account,
a connection is established.

The advantage of Basic authentication is that it is part of the HTTP specification and is supported
by most browsers. The disadvantage is that Web browsers using Basic authentication transmit
passwords in an unencrypted form. By monitoring communications on your network, an attacker
can easily intercept and decode these passwords using publicly available tools. Therefore, Basic
authentication is not recommended unless you are confident that the connection between the user
and your Web server is secure.

NT LAN Manager (NTLM)

NTLM is an authentication process that is used by all members of the Windows NT family of
products. Like its predecessor LanMan, NTLM uses a challenge/response process to prove the
client’s identity without requiring that either a password or a hashed password be sent across the
network.

Use NTLM authentication for servers running lIS. If NTLM authentication is enabled, and Fortify
Weblnspect has to pass through a proxy server to submit its requests to the Web server, Fortify
Weblnspect may not be able to crawl or audit that Web site.

Caution! After configuring Fortify Weblnspect for NTLM authentication and scanning the
NTLM-protected sites, you might want to disable the NTLM authentication settings to prevent
any potential problem.

Digest

The Windows Server operating system implements the Digest Authentication protocol as a security
support provider (SSP), a dynamic-link library (DLL) that is supplied with the operating system.
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Using digest authentication, your password is never sent across the network in the clear, but is
always transmitted as an MD5 digest of the user's password. In this way, the password cannot be
determined by sniffing network traffic.

Kerberos

Kerberos uses the Needham-Schroeder protocol as its basis. It uses a trusted third party, termed a
Key Distribution Center (KDC), which consists of two logically separate parts: an Authentication
Server (AS) and a Ticket Granting Server (TGS). The client authenticates itself to AS, then
demonstrates to the TGS that it is authorized to receive a ticket for a service (and receives it). The
client then demonstrates to a Service Server that it has been approved to receive the service.

Negotiate

The Negotiate authentication protocol begins with the option to negotiate for an authentication
protocol. When the client requests access to a service, the server replies with a list of authentication
protocols that it can support and an authentication challenge based on the protocol that is its first
choice.

For example, the server might list Kerberos and NTLM, and send a Kerberos challenge. The client
examines the contents of the reply and checks to determine whether it supports any of the
specified protocols. If the client supports the preferred protocol, authentication proceeds. If the
client does not support the preferred protocol, but does support one of the other protocols listed
by the server, the client lets the server know which authentication protocol it supports, and the
authentication proceeds. If the client does not support any of the listed protocols, the
authentication exchange fails.

3. To use aclient certificate for network authentication, select Client Certificate.

Note: You can add a client certificate to a Windows phone, but the only way to subsequently
remove it is to restore the phone to its default settings.

4. In the Certificate Store areq, select one of the following, and then select either the My or Root
radio button:

o Local Machine. Fortify Weblnspect uses a certificate on the local machine based on your
selection in the Certificate Store area.

o Current User. Fortify Weblnspect uses a certificate for the current user based on your selection
in the Certificate Store area.

5. To view certificate details in the Certificate Information area, select a certificate.
6. Click the Next button.
The Application Authentication page appears.

Application Authentication Step

If your site requires authentication, you can use this step to create, select, or edit a login macro to
automate the login process and increase the coverage of your site. A login macro is a recording of the
activity that is required to access and log in to your application, typically by entering a user name and
password and clicking a button such as Log In or Log On.

The following options are available for login macros:
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e "Using a Login Macro without Privilege Escalation " below
e "Using Login Macros for Privilege Escalation" below
¢ "Using a Login Macro when Connected to Fortify Weblnspect Enterprise" on the next page

¢ "Using a Selenium Macro" on the next page

Using a Login Macro without Privilege Escalation

To use a login macro:

1. Select the Use a login macro for this site check box.
2. Do one of the following:
o To use a pre-recorded login macro, click the ellipsis button (...) fo browse for a saved macro. If
you are using a Selenium macro, see "Using a Selenium Macro" on the next page.
e To edit an existing login macro shown in the Login Macro field, click Edit.
e To record a new macro, click Create.
For details about recording a new login macro or using an existing login macro, see the "Unified
Web Macro Recorder" chapter in the Tools Guide for Fortify Weblnspect Products.
3. Click the Next button.

If you selected a Standard scan, the Optimization Tasks page appears. If you selected a Workflows
scan, the Manage Workflows page appears.

Using Login Macros for Privilege Escalation

If you selected the Privilege Escalation policy or another policy that includes enabled Privilege
Escalation checks, at least one login macro for a high-privilege user account is required. For more
information, see "Abouft Privilege Escalation Scans" on page 180. To use login macros:

1. Select the High-Privilege User Account Login Macro check box. This login macro is for the
higher-privilege user account, such as a Site Administrator or Moderator account.

2. Do one of the following:
o To use a pre-recorded login macro, click the ellipsis button (..) fo browse for a saved macro. If

you are using a Selenium macro, see "Using a Selenium Macro" on the next page.

¢ To edit an existing login macro shown in the Login Macro field, click Edit.
e To record a new macro, click Create.
For details about recording a new login macro or using an existing login macro, see the "Unified
Web Macro Recorder" chapter in the Tools Guide for Fortify Weblnspect Products.

After recording or selecting the first macro and clicking the next arrow, a "Configure Low Privilege
Login Macro" prompt appears.

3. Do one of the following:

e To perform the scan in authenticated mode, click Yes. For more information, see "About
Privilege Escalation Scans" on page 180.
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Guided Scan returns to the Select Login Macro window for you fo create or select a low-privilege
login macro. Continue to Step 4.

o To perform the scan in unauthenticated mode, click No. For more information, see "About
Privilege Escalation Scans" on page 180.

The Application Authentication Step is complete. If you selected a Standard scan, the
Optimization Tasks page appears. If you selected a Workflows scan, the Manage Workflows
page appears.

Select the Low-Privilege User Account Login Macro check box. This login macro is for the lower-

privilege user account, such as a viewer or consumer of the site content.

Do one of the following:

o To use a pre-recorded login macro, click the ellipsis button (...) fo browse for a saved macro. If
you are using a Selenium macro, see "Using a Selenium Macro" below.

¢ To edit an existing login macro shown in the Login Macro field, click Edit.

e To record a new macro, click Create.

For details about recording a new login macro or using an existing login macro, see the "Unified

Web Macro Recorder" chapter in the Tools Guide for Fortify Weblnspect Products.

After recording or selecting the second macro, click the Next button.

If you selected a Standard scan, the Optimization Tasks page appears. If you selected a Workflows
scan, the Manage Workflows page appears.

Using a Login Macro when Connected to Fortify Weblnspect Enterprise

For a Fortify Weblnspect that is connected to Fortify Weblnspect Enterprise, you can download and use
a login macro from the Fortify Weblnspect Enterprise macro repository.

1.
2.

Select the Use a login macro for this site check box.
Click Download.
The Download a Macro from Fortify Weblnspect Enterprise window appears.

Select the Project and Project Version from the drop-down lists.

4, Select a repository macro from the Macro drop-down list.

5.

Click OK.

Note: Selecting a repository macro automatically syncs the Project and Project Version on the
Final Review page under Automatically Upload Scan to WIE.

Using a Selenium Macro

Fortify Weblnspect supports integration with Selenium browser automation. When you click the Import
button and select a Selenium macro to import, Fortify Weblnspect detects that a Selenium macro is
being used. Fortify Weblnspect opens Selenium and plays the macro. The macro must include a logout
condition. If a logout condition does not exist, you can add one using the Logout Conditions Editor just
as with any other macro. However, all other edits must be done in the Selenium IDE.
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1. Select the Use a login macro for this site check box.

2. Click the ellipsis button (...) fo browse for a saved Selenium macro.
The Import Macro window appears.

3. Select Selenium IDE Test Case (*.*) from the file type drop-down list.

Note: Selenium macros do not have a specific file extension and can be any type of text file,
including XML.

4. Locate and select the file, and then click Open.
The Import Selenium Script window appears.

5. (Optional) To view and/or adjust how Selenium behaves during macro replay, click the Settings
plus (+) sign.

The Settings area expands and the default settings become visible. Make changes as necessary.
6. Click Verify.

Fortify Weblnspect plays the macro, displaying the verification progress and status in the Import
Selenium Script window.

7. Did the macro play successfully?

o If yes, the message "Successfully verified macro" appears. Continue with Step 8.

o If no, an error message appears. Use the error message to debug and correct the error in
Selenium, and return to Step 2 of this procedure to try the import again.

8. Continue according to the following table.

To... Then...

Specify a logout condition a. Click Edit logout conditions.

The Logout Conditions Editor appears. Currently,
only Regex is supported.

b. Add alogout condition and click OK.

Export the Selenium script to use a. Click Export.
elsewhere The Selenium script import window opens.

b. Navigate to the desired directory and type a File
name for the scripf.

c. Select the Save as Type.

Note: If you changed the settings in the Import
Selenium Script window, they will not be saved
when exporting the file as a Selenium Import
. file. However, if you export the file as a
Fortify Weblnspect Selenium macro
(*.webmacro) file, the settings will be saved.
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To... Then...

d. Click Save.

About the Workflows Stage

The Workflows stage only appears if you selected Workflows as the Scan Type in the Site stage. If you
chose Standard, the Workflows stage will not appear.

You can create a Workflow macro to ensure Fortify Weblnspect audits the pages you specify in the
macro. Fortify Weblnspect audits only those URLs included in the macro and does not follow any
hyperlinks encountered during the audit.

You can create multiple Workflows macros; one for each use case on your site. A logout signature is not

required. This type of macro is used most often to focus on a particular subsection of the application. If

you select multiple macros, they will all be included in the same scan. In addition to allowing you to select
multiple macros, you can also import Burp proxy captures and add them to your scan.

Important! If you use a login macro in conjunction with a workflow macro or startup macro or
both, all macros must be of the same type: all .webmacro files, all Burp Proxy captures, or all
Selenium macros. You cannot use different types of macros in the same scan.

To complete the Workflows settings, click any of the following in the Workflows table:

¢ Record. Opens the Unified Web Macro Recorder, allowing you to create a macro.
o Edit. Opens the Unified Web Macro Recorder and loads the selected macro.
o Delete. Removes the selected macro (but does not delete it from your disk).

o Import. Opens a standard file-selection window, allowing you to select a previously recorded
.webmacro file, Burp Proxy captures, or a Selenium macro. If using a Selenium macro, you will need to
click Verify for Fortify Weblnspect to play the macro. If the macro does not play successfully, the
Import Selenium Script window displays an error. You will need to debug and correct the error in
Selenium, and return fo this procedure to try the importf again.

Note: If you have installed Micro Focus Unified Functional Testing (UFT) on your computer,
then Fortify Weblnspect detects this automatically and displays an option to import a UFT .usr
file.

For more information, see "Importing Micro Focus Unified Functional Testing (UFT) Files in a
Guided Scan" on page 133.

o Export a recorded macro. After a macro is selected or recorded, you may optionally specify allowed
hosts. Opens a standard file-selection window, allowing you to save a recorded macro.

After you specify and play a workflow macro, it appears in the Workflows table and its Allowed Hosts
are added to the Guided Scan > Workflows > Workflows > Manager Workflow page. You can
enable or disable access to particular hosts. For more information, see "Scan Settings: Allowed Hosts" on
page 328.
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Adding Burp Proxy Results

If you have run Burp Proxy security tests, the traffic collected during those tests can be imported into a
Workflows macro, reducing the time it would otherwise take to rescan the same areas.

Adding Burp Proxy Results

To add Burp Proxy results to a workflow macro:

1. If you are not on the Workflows screen, click on the Manage Workflows step in the Guided Scan
free.

2. Click the Import button.
The Import Macro file selector appears.

3. Change the file type box filter from Web Macro (*.webmacro) to Burp Proxy (*.*).

4. Navigate to your Burp Proxy files and select the desired file.

5. Click Open.

About the Active Learning Stage

During the Active Learning stage:

o The Weblnspect Profiler is run to see if any settings need to be modified.
o Set scan optimization option if necessary.

« Navigate to key locations in your site that should be fully exercised.

Using the Profiler

The Weblnspect Profiler conducts a preliminary examination of the target Web site to determine if
certain settings should be modified. If changes appear to be required, the Profiler returns a list of
suggestions, which you may accept or reject.

For example, the Profiler may detect that authorization is required to enter the site, but you have not
specified a valid user name and password. Rather than proceed with a scan that would return
significantly diminished results, you could follow the Profiler’s suggestion to configure the required
information before continuing.

Similarly, your settings may specify that Fortify Weblnspect should not conduct "file-not-found"
detection. This process is useful for Web sites that do not return a status "404 Not Found" when a client
requests a resource that does not exist (they may instead return a status "200 OK," but the response
contains a message that the file cannot be found). If the Profiler determines that such a scheme has
been implemented in the target site, it would suggest that you modify the Fortify Weblnspect setting to
accommodate this feature.

To launch the Profiler:

1. Click Profile.
The Profiler runs. For more information, see "Server Profiler" on page 222.
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Results appear in the Optimize scan for box in the Settings section.
2. If necessary, provide any requested information.
3. Click the Next button.
Several options may be presented even if you do not run the Profiler, as described in the following
secfions.

Autofill Web Forms

Select Auto-fill Web forms during crawl if you want Fortify Weblnspect to submit values for input
controls on forms it encounters while scanning the target site. Fortify Weblnspect will extract the values
from a prepackaged default file or from a file that you create using the Web Form Editor. See the "Web
Form Editor" chapter in the Tools Guide for Fortify Weblnspect Products. You may:

1. Click the browser button to locate and load afile.

2. Click Edit to edit the selected file (or the default values) using the Web Form Editor.

3. Click Create to open the Web Form Editor and create a file.
Add Allowed Hosts
Use the Allowed Host settings to add domains to be crawled and audited. If your Web presence uses

multiple domains, add those domains here. For more information, see "Scan Settings: Allowed Hosts" on
page 328.

To add allowed domains:

1. Click Add.

2. In the Specify Allowed Host window, enter a URL (or a regular expression representing a URL) and
click OK.

Reuse Identified False Positives

Select scans containing vulnerabilities that were changed to false positives. If those false positives
match vulnerabilities detected in this scan, the vulnerabilities will be changed to false positives. For more
information, see "False Positives" on page 76.

To reuse identified false positives:

1. Select Import False Positives.
2. Click Select Scans.
3. Select one or more scans containing false positives from the same site you are now scanning.
4. Click OK.
Apply Sample Macro
Fortify Weblnspect’s example banking application, zero.webappsecurity.com, uses a Web form login. If

you scan this site, select Apply sample macro to run the prepackaged macro containing the login
script.

Traffic Analysis

Select Launch and Direct Traffic through Web Proxy fo use the Web Proxy tool to examine the
HTTP requests issued by Fortify Weblnspect and the responses returned by the target server.
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While scanning a Web site, Fortify Weblnspect displays in the navigation pane only those sessions that
reveal the hierarchical structure of the Web site, plus those sessions in which a vulnerability was
discovered. However, if you select Enable Traffic Monitor, Fortify Weblnspect adds the Traffic
Monitor button to the Scan Info panel, allowing you to display and review each HTTP request sent by
Fortify Weblnspect and the associated HTTP response received from the server.

Message

If the Profiler does not recommend changes, the Guided Scan wizard displays the message "No settings
changes are recommended. Your current scan settings are optimal for this site."

Click Next.
The Enhance coverage of your web site task appears highlighted in the left pane.
Enhance coverage of your web site

To enhance coverage of your application, navigate to key locations in your application to enhance
coverage.

When using the Enhance Coverage of Your Web Site feature in Guided Scan in conjunction with the
Privilege Escalation policy, the explored locations are collected while authenticated with the high-
privilege login macro.

See "Unified Web Macro Recorder" in the Tools Guide for Fortify Weblnspect Products for detailed
information about using the Web Macro Recorder to navigate key locations in your application for
Guided Scan to use during the scan.

See the Guided Scan Tutorial for more information about how to use this page of the Guided Scan
wizard. To launch the tutorial, click Tutorial in the upper right corner of the page.

Web Form Values

Guided Scan recorded all of the web form values that you entered while you explored your Web site.
Here you can review and modify the values, which are part of the scan settings that are saved with the
scan. In the Web Forms section of the toolbar, you can click Export to save the values to a separate file
or click Import to use an existing set of values. The scan settings, including the web form values, serve
as defaults that you can modify in future scans.

Click Next.
The Final Review page appears with Configure Detailed Options highlighted in the left pane.

About the Settings Stage

To configure detailed options, specify any of the following settings.

Reuse Identified False Positives

Select the False Positives box to reuse false positives that Fortify Weblnspect has already identified.
Traffic Analysis

1. To use the Web Proxy tool, select Launch and Direct Traffic through Web Proxy to use the Web
Proxy tool to examine the HTTP requests issued by Fortify Weblnspect and the responses
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returned by the target server.

Web Proxy is a stand-alone, self-contained proxy server that you can configure and run on your
desktop. Web Proxy allows you to monitor traffic from a scanner, a Web browser, or any other tool
that submits HTTP requests and receives responses from a server. Web Proxy is a tool for a
debugging and penetration scan; you can view every request and server response while browsing a
site.

2. Select the Traffic Monitor box to display and review each HTTP request sent by Fortify
Weblnspect and the associated HTTP response received from the server.

While scanning a Web site, Fortify Weblnspect displays only those sessions that reveal the
hierarchical structure of the Web site, plus those sessions in which a vulnerability was discovered.
However, if you select Enable Traffic Monitor, Fortify Weblnspect allows you to display and
review each HTTP request sent by Fortify Weblnspect and the associated HTTP response received
from the server.

3. Click Next.

The Validate Settings and Start Scan page appears with Configure Detailed Options highlighted
in the left pane.

Validate Settings and Start Scan

Options on this page allow you to save the current scan settings and, if Weblnspect is integrated with
Weblnspect Enterprise, to interact with Weblnspect Enterprise.

1. To save your scan settings as an XML file, select Click here to save settings. Use the standard
Save as window to name and save the file.

2. If Weblnspect is integrated with Weblnspect Enterprise, a Templates section appears in the toolbar.
Continue according to the following table.

If you want to... Then...

Save the current scan settings as a templatein =~ a. Do one of the following:

the Weblnspect Enterprise database o Click Save in the Templates section of

Note: When editing an existing template, the foolbar.
the Save is actually an update. You can o Select Click here to save template.
save any edits to settings and change the The Save Template window appears.

Template Name. However, you cannot
change the Project, Project Version, or
Global Template settings.

b. Select a project from the Project drop-
down list.

c. Select a project version from the Project
Version drop-down list.

d. Type a name in the Template field.

Load scan settings from a template a. Click Load in the Templates section of the
toolbar.

A confirmation message appears advising
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If you want to... Then...

that your current scan settings will be lost.
b. Click Yes.
The Load Template window appears.

c. Select a project from the Project drop-
down list.

d. Select a project version from the Project
Version drop-down list.

e. Select the template from the Template
drop-down list.

f. Click Load.

Guided Scan returns to the Site Stage for you
to verify the Web site and step through the
settings from the template.

3. If Weblnspect is integrated with Weblnspect Enterprise, the Weblnspect Enterprise section appears
on this page. You can interact with Weblnspect Enterprise as follows:

a. Select a project from the Project drop-down list.
b. Select a project version from the Project Version drop-down list.

¢. Continue according to the following table.

To run the scan... Then...
With a sensor in Weblnspect i. Select Run in Weblnspect Enterprise.
Enterprise i

. Select a sensor from the Sensor drop-down list.

iii. Select a Priority for the scan.

In Weblnspect i. Select Run in Weblnspect.

ii. If you want to automatically upload the scan
results to the specified project and project
version in Weblnspect Enterprise, select Auto
Upload to Weblinspect Enterprise.

Note: If the scan does not complete
successfully, it will not be uploaded to
Weblnspect Enterprise.

4. Inthe Scan Now area, review your scan settings, and then click Start Scan to begin the scan.
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Importing Micro Focus Unified Functional Testing (UFT) Files in a Guided Scan

If you have the Micro Focus Unified Functional Testing application installed, Fortify Weblnspect detects
it and allows you to import a UTF file Cusr) into your workflow scan to enhance the thoroughness and
attack surface of your scan. For more information, see Unified Functional Testing on the Micro Focus
Web site.

To import a UTF Cusr) file into a Fortify Weblnspect Guided Scan:

1. Launch a Guided Scan, and then select Workflows Scan as the Scan Type. Additional text appears
under the Workflows scan option: Micro Focus Unified Functional Testing has been detected. You
can import scripts to improve the thoroughness of your security test.

2. Click the Next button.

3. Inthe Authentication section, Application Authentication is automatically selected. Complete the
fields as indicated.

4. On the Manage Workflows screen, click Import. The Import Scripts dialog box appears. On the
Import Scripts dialog box, you may:

o Type the filename.

o Browse to your file by clicking to locate your file with a .usr extension. Select Micro Focus
Unified Functional Testing from the drop-down file type, and then navigate to the file.

o Click Edit to launch the Micro Focus Unified Functional Testing application.

5. (Optional) On the Import Scripts dialog box, you may select either of the following options:
+ Show Micro Focus Unified Functional Testing Ul during import
o Open script result after import
6. Select the file o import, and then click Import. After your file is successfully imported, the file
appears in the Workflows table.
7. Select one of the following from the Workflows table:
¢ Record - launches the Weblnspect Unified Macro Recorder. For more information, see "Unified

Web Macro Recorder" in the Tools Guide for Fortify Weblnspect Products guide.

« Edit - allows you to modify the file using the Unified Web Macro Recorder. See "Unified Web
Macro Recorder" in the Tools Guide for Fortify Weblnspect Products.

o Delete - deletes the script from the Workflows table.
o Import - imports another file.
o Export - saves a file in .webmacro format with the name and location you specify

8. Click the Next button.

When the first .usr script file is added to the list, its name (or default name) appears in the
Workflows table and an Allowed Hosts table is added to the pane.

Adding another .usr script file can add more allowed hosts. Any host that is enabled is available to
all the listed workflow .usr script files, not just the workflow.usr file for which it was added. The
Guided Scan will play all the listed workflow files and make requests to all the listed allowed hosts,
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whether or not their check boxes are selected. If a check box for an allowed host is selected, Fortify
Weblnspect will crawl or audit the responses from that host. If a check box is not selected, Fortify
Weblnspect will not crawl or audit the responses from that host. In addition, if a particular
workflows .usr script uses parameters, a Macro Parameters table is displayed when that workflow
macro is selected in the list. Edit the values of the parameters as needed.

9. After you have completed changes or additions to the Workflows table, proceed in the Guided Scan
wizard to complete your settings and run the scan. For more information about recording a new
login macro or using an existing login macro, see the "Unified Web Macro Recorder" chapter in the
Tools Guide for Fortify Weblnspect Products.

See Also

"Guided Scan Overview " on page 99

Using the Native Scan Template

Fortify Weblnspect and Fortify Weblnspect Enterprise allow you to scan the back-end traffic generated
by your Android or iOS app or service. Traffic can be generated by running your application on an
Android, Windows, or iOS device, or by running the software through an Android or iOS emulator.

The Guided Scan wizard includes a tutorial that runs the first time you launch a Guided Scan. If you
don't require the tutorial, you can close it at any time and return to it later by clicking the Tutorial
button at the top right of the display.

The Guided Scan wizard will step you through the necessary stages and steps required o scan your
application back-end traffic. If you need to return to a previous step or stage, click the back navigation
button, or click the step in the Guided Scan free to be taken directly there.

Setting Up Your Mobile Device

Running a native scan requires that you configure the mobile device to work with a secure proxy. In
order to do that, you will need to:

o Set up a Mobile Device/Emulator Proxy (see "Setting the Mobile Device Proxy Address" on page 137)
o Install a Trusted Certificate (see "Adding a Trusted Cerfificate" on page 137)

Guided Scan Stages

A Guided Scan using a mobile femplate consists of four or five stages, each of which has one or more
steps. The stages are:

Native Mobile: where you choose a device or emulator, configure device/emulator proxy, and select the
type of scan you want to run.

Login: where you define the type of authentication if back-end of your mobile application requires it.

Application: where you run your app, record Web traffic, and identify the hosts and RESTful endpoints
to include in your scan.
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Settings: where you review and validate your choices and run the scan.

Supported Devices

Fortify Weblnspect and Fortify Weblnspect Enterprise support scanning the back-end traffic on
Android, Windows, and iOS devices.

Android Device Support

Any Android device, such as an Android-based phone or tableft.
Windows Device Support

Any Windows device, such as a Windows phone or Surface tablet.
iOS Device Support

Any iOS device, such as aiPhone or iPad, running the latest version of iOS.

Supported Development Emulators

In addition to support for Android and iOS devices, you can run your application through your Android
or iOS emulator in your development environment. When scanning traffic generated via your device
emulator, you must ensure that the development machine is on the same network as Fortify Weblnspect
or Fortify Weblnspect Enterprise and that you have set up a proxy between Fortify Weblnspect or
Fortify Weblnspect Enterprise and your development machine.

Launching a Native Scan

In order to launch a Native Scan, you will need to make sure your device or emulator is on the same
network as Fortify Weblnspect. In addition, you need to have authorization and access to the ports on
the machine where you are running Fortify Weblnspect in order to successfully create a proxy
connection.

To launch a Native Scan:

1. Open Fortify Weblnspect or Fortify Weblnspect Enterprise.
2. Start a Guided Scan:
o For Fortify Weblnspect, click Start a Guided Scan on the Fortify Weblnspect Start page.

o For Fortify Weblnspect Enterprise, click Guided Scan under Actions on the Web Console.

3. Select Native Scan from the Mobile Templates section.
The Guided Scan wizard displays the first step in the Native Mobile stage: Choose Device/Emulator.
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About the Native Mobile Stage

The first stage in the process is the Native Mobile stage. In this stage you will:

o Set up the device or emulator to use a proxy connection.

¢ Logthe device or emulator on to the same network as your instance of Fortify Weblnspect or Fortify
Weblnspect Enterprise.

o Install a client certificate on your device or emulator.
o Name the scan for future reference.

o Select a scan method.

o Select a scan policy.

o Select the crawl coverage amount.

Choose Device/Emulator Type Step

After launching the Guided Scan, you are provided with the options described in the following table.

Option Description

Profile The type of device or emulator you want to scan. Select a type from the drop-
down menu. For more information, see "Selecting a Profile" below.

Mobile The IP address and port number for the proxy that Fortify Weblnspect or Fortify

Device/Emulator = Weblnspect Enterprise creates for listening to the traffic between your device or

Proxy emulator and the Web service or application being tested. Unless the IP address
and/or port are reserved for other activities, use the default settings. For more
information, see "Setting the Mobile Device Proxy Address" on the next page.

Trusted The port and URL to acquire a client certificate for your device or emulator. To
Certificate download and install the certificate on your device or emulator, see "Adding a
Trusted Cerfificate" on the next page.

Selecting a Profile

To set the device profile, select one of the following from the Profile drop-down fextbox:

¢ iOS Device - An iPad or iPhone running the latest version of iOS.

e iOS Simulator - The iOS emulator that is part of the iOS SDK.

o Android Device - A phone or tablet running the Android operating system.
¢ Android Emulator - The Android emulator that is part of the Android SDK.
o Windows Device - A Windows phone or Surface tablet.
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Setting the Mobile Device Proxy Address

The Mobile Device/Emulator Proxy section lists the Host IP address and the Port number that will be
used to establish a proxy connection between your device or emulator and Fortify Weblnspect or
Fortify Weblnspect Enterprise. Use the suggested settings unless the IP address or port number are
unavailable on your system.

Note: If you are unable to connect to the server or access the Internet after setting your proxy, you
may need to open up or change the port on your firewall specified in the Native Mobile stage. If it
still does not work, you may need to select a different IP address. The IP address presented in the

Fortify Weblnspect/Weblnspect Enterprise interface allows you to click the address and select an
alternate from a drop-down list.

To set up a proxy on an iOS device:

1. Run the Settings application.

2. Select Wi-Fi.

3. Select the Wi-Fi network you are using to connect to Fortify Weblnspect or Fortify Weblnspect
Enterprise.

4. Scroll down to the HTTP Proxy section and select Manual.
The screen displays the network configuration options for the network your device is connected to.

5. Scroll down further and type in the Server IP address and the Port number provided by Fortify
Weblnspect or Fortify Weblnspect Enterprise. If you don't have this information, see "Choose
Device/Emulator Type Step" on the previous page.

6. In Fortify Weblnspect or Fortify Weblnspect Enterprise, click the Verify button in the Trusted
Certificate section to verify the connection is working properly.
The Verify activity progress bar appears.

7. Launch the default browser on your device and visit any site to verify that Fortify Weblnspect or
Fortify Weblnspect Enterprise is able to see the back-end traffic.
If everything is configured properly, after a few moments, the Verify activity progress bar will state
that the traffic has been successfully verified.

8. Click OK fo dismiss the verification progress bar and then click Next to select a scan type.

To set up a proxy on an Android or Windows device, consult your operator’s instructions.

Adding a Trusted Certificate

If your site requires a secure connection, each time you run a scan, Fortify Weblnspect or Fortify
Weblnspect Enterprise generates a unique client certificate for your device or emulator. You will need to
install the certificate into the device’s (or emulator’s) certificate repository.

Note: You can add a client cerfificate to a Windows phone, but the only way to subsequently
remove it is to restore the phone to its default settings.
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There are three ways to add a certificate:

o Scan the QR code from the Trusted Certificate section of Guided Scan (requires QR reader software).
e Type the address into the built-in browser on your device or device emulator.

o Copy the certificate to your system clipboard for applying later (used when scanning with a device
emulator).

Choose the option that best suits your needs.

Note: After completing the scan, you should remove the certificate from the repository on your
device. See "Post Scan Steps " on page 148.
To Add a Certificate to an iOS device or emulator:

1. After scanning the QR code or typing the provided URL info your browser, the Install Profile page
appears.

Note: The Weblnspect Root certificate status will display as Not Trusted until you add it to
your root chain.

2. Tap the Install button.

A warning screen will appear stating that the certificate is not trusted. Once you add the certificate
to the certificate repository on your device or emulator, the warning will go away.

3. Tap Install on the Warning screen.

The display changes to that of the current network your device or emulator is connected to. Make
sure it is connected to the same network as Fortify Weblnspect or Fortify Weblnspect Enterprise.

Choose Scan Type Step

After setting up your device or emulator to work with Fortify Weblnspect or Fortify Weblnspect
Enterprise during the first part of the Native Mobile stage, you will need to select the type of scan you
would like to run.

Set the options listed below:

Option Description

Scan Name Type a name for the scan so that later you can identify the scan on the Manage Scans
page.

Scan Choose the type of scan you want from the following list:

Method
Crawl Only: maps the attack surface of the specified workflow(s).

Crawl and Audit: maps the attack surface of the specified workflow(s) and scans for
vulnerabilities.

Audit Only: only attack the specified workflows.
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Option Description

Policy Select a policy for the scan from the drop-down menu. For more information on
policies, see "Fortify Weblnspect Policies" on page 394. For information on creating
and editing policies, see the "Policy Manager" chapter in the Tools Guide for Fortify

Weblnspect Products.
Crawl Select the level of coverage you want using the Crawl Coverage slider.
Coverage
Enable When this option is selected for crawling and auditing single-page applications

SPA support = (SPAs), the DOM script engine finds JavaScript includes, frame and iframe includes,
CSS file includes, and AJAX calls during the crawl, and then audits all fraffic
generated by those events.

For more information, see "About Single-page Application Scans" on page 182.

About the Login Stage

If the application you intend to scan requires login credentials, you can use the login stage to either
select a an existing login macro or record one for use with the scan.

If your application does not require login credentials, you can skip this section of the Guided Scan
wizard by clicking through the options without assigning values, or clicking the next step in the Guided
Scan free to skip to the next stage.

In this stage you can:

o Configure network authorization
o Configure application authorization

o Create or assign a login macro

Network Authentication Step

If your application requires either network or application level authentication, you can assign it here.

Configuring Network Authentication

If your network requires user authentication, you can configure it here. If your network does not require
user authentication, click the Next navigation button or the next appropriate step in the Guided Scan
tree to continue on.

To configure network authentication:

1. Click the Network Authentication checkbox.

2. Select a Method from the drop-down list of authentication methods. The authentication methods
are:
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Automatic

Allow Fortify Weblnspect to determine the correct authentication type.

Automatic detection slows the scanning process. If you know and specify one of the other
authentication methods, scanning performance is noticeably improved.

Basic

A widely used, industry-standard method for collecting user name and password information.

a. The Web browser displays a window for a user to enter a previously assigned user name and
password, also known as credentials.

b. The Web browser then attempts fo establish a connection to a server using the user's
credentials.

c. If auser's credentials are rejected, the browser displays an authentication window to re-enter
the user's credentials. Internet Explorer allows the user three connection attempts before
failing the connection and reporting an error to the user.

d. If the Web server verifies that the user name and password correspond to a valid user account,
a connection is established.

The advantage of Basic authentication is that it is part of the HT TP specification and is supported
by most browsers. The disadvantage is that Web browsers using Basic authentication transmit
passwords in an unencrypted form. By monitoring communications on your network, an attacker
can easily intercept and decode these passwords using publicly available tools. Therefore, Basic
authentication is not recommended unless you are confident that the connection between the user
and your Web server is secure.

NT LAN Manager (NTLM)

NTLM is an authentication process that is used by all members of the Windows NT family of
products. Like its predecessor LanMan, NTLM uses a challenge/response process to prove the
client’s identity without requiring that either a password or a hashed password be sent across the
network.

Use NTLM authentication for servers running IIS. If NTLM authentication is enabled, and Fortify
Weblnspect has to pass through a proxy server to submit its requests to the Web server, Fortify
Weblnspect may not be able to crawl or audit that Web site.

Caution! After configuring Fortify Weblnspect for NTLM authentication and scanning the
NTLM-protected sites, you might want to disable the NTLM authentication settings to prevent
any potential problem.

Digest

The Windows Server operating system implements the Digest Authentication protocol as a security
support provider (SSP), a dynamic-link library (DLL) that is supplied with the operating system.
Using digest authentication, your password is never sent across the network in the clear, but is
always transmitted as an MD5 digest of the user's password. In this way, the password cannot be
determined by sniffing network fraffic.
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Kerberos

Kerberos uses the Needham-Schroeder protocol as its basis. It uses a frusted third party, termed a
Key Distribution Center (KDC), which consists of two logically separate parts: an Authentication
Server (AS) and a Ticket Granting Server (TGS). The client authenticates itself fo AS, then
demonstrates to the TGS that it is authorized to receive a ticket for a service (and receives it). The
client then demonstrates to a Service Server that it has been approved to receive the service.

Negotiate

The Negotiate authentication protocol begins with the option to negotiate for an authentication
protocol. When the client requests access to a service, the server replies with a list of authentication
protocols that it can support and an authentication challenge based on the protocol that is its first
choice.

For example, the server might list Kerberos and NTLM, and send a Kerberos challenge. The client
examines the contents of the reply and checks to determine whether it supports any of the
specified protocols. If the client supports the preferred protocol, authentication proceeds. If the
client does not support the preferred protocol, but does support one of the other protocols listed
by the server, the client lets the server know which authentication protocol it supports, and the
authentication proceeds. If the client does not support any of the listed protocols, the
authentication exchange fails.

3. Typein the User Name and Password.

Configuring a Client Certificate

If your network is set up to accept a client certificate rather than a user name and password, you can
configure Fortify Weblnspect or Fortify Weblnspect Enterprise to provide the client certificate upon
request.

To configure a client certificate:

1. Select the Client Certificate check box.
2. Do one of the following:

o To use a certificate that is local to the computer and is global to all users on the computer, select
Local Machine.

o To use a certificate that is local to a user account on the computer, select Current User.

Note: Certificates used by a common access card (CAC) reader are user certificates and are
stored under Current User.

3. Do one of the following:

o To select a certificate from the "Personal" ("My") certificate store, select My from the drop-down
list.

o To select a trusted root cerfificate, select Root from the drop-down list.

4, Does the website use a common access card (CAC) reader?
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o If yes, do the following:
i. Select a certificate that is prefixed with “(SmartCard)” from the Certificate list.

Information about the selected certificate and a PIN field appear in the Certificate
Information area.

ii. If aPINisrequired, type the PIN for the CAC in the PIN field.

Note: If a PIN is required and you do not enter the PIN at this point, you must enter the
PIN in the Windows Security window each time it prompts you for it during the scan.

iii. Click Test.
If you entered the correct PIN, a Success message appears.

o If no, select a certificate from the Certificate list.
Information about the selected certificate appears below the Certificate list.

Application Authentication Step

If your site requires authentication, you can use this step to create, select, or edit a login macro to
automate the login process and increase the coverage of your site. A login macro is a recording of the
activity that is required to access and log in to your application, typically by entering a user name and
password and clicking a button such as Log In or Log On.

The following options are available for login macros:

¢ "Using a Login Macro without Privilege Escalation " below
¢ "Using Login Macros for Privilege Escalation" on the next page
¢ "Using a Login Macro when Connected to Fortify Weblnspect Enterprise" on page 144

e "Using a Selenium Macro" on page 144

Using a Login Macro without Privilege Escalation

To use a login macro:

1. Select the Use a login macro for this site check box.
2. Do one of the following:
e To use a pre-recorded login macro, click the ellipsis button (..) fo browse for a saved macro. If
you are using a Selenium macro, see "Using a Selenium Macro" on page 144.
o To edit an existing login macro shown in the Login Macro field, click Edit.

e Torecord a new macro, click Create.

For details about recording a new login macro or using an existing login macro, see the "Unified
Web Macro Recorder" chapter in the Tools Guide for Fortify Weblnspect Products.
3. Click the Next button.

The Application Authentication Step is complete. Proceed to the Application Stage to run your
application.
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Using Login Macros for Privilege Escalation

If you selected the Privilege Escalation policy or another policy that includes enabled Privilege
Escalation checks, at least one login macro for a high-privilege user account is required. For more
information, see "About Privilege Escalation Scans" on page 180. To use login macros:

1

Select the High-Privilege User Account Login Macro check box. This login macro is for the
higher-privilege user account, such as a Site Administrator or Moderator account.

Do one of the following:

e To use a pre-recorded login macro, click the ellipsis button (..) fo browse for a saved macro. If
you are using a Selenium macro, see "Using a Selenium Macro" on the next page.

o To edit an existing login macro shown in the Login Macro field, click Edit.

e To record a new macro, click Create.

For details about recording a new login macro or using an existing login macro, see the "Unified

Web Macro Recorder" chapter in the Tools Guide for Fortify Weblnspect Products.

After recording or selecting the first macro and clicking the next arrow, a "Configure Low Privilege
Login Macro" prompt appears.

Do one of the following:

o To perform the scan in authenticated mode, click Yes. For more information, see "About
Privilege Escalation Scans" on page 180.

Guided Scan returns to the Select Login Macro window for you fo create or select a low-privilege
login macro. Continue to Step 4.

o To perform the scan in unauthenticated mode, click No. For more information, see "About
Privilege Escalation Scans" on page 180.
The Application Authentication Step is complete. Proceed to the Application Stage.

Select the Low-Privilege User Account Login Macro check box. This login macro is for the lower-

privilege user account, such as a viewer or consumer of the site content.

Do one of the following:

e To use a pre-recorded login macro, click the ellipsis button (..) o browse for a saved macro. If
you are using a Selenium macro, see "Using a Selenium Macro" on the next page.

¢ To edit an existing login macro shown in the Login Macro field, click Edit.

e To record a new macro, click Create.

For details about recording a new login macro or using an existing login macro, see the "Unified

Web Macro Recorder" chapter in the Tools Guide for Fortify Weblnspect Products.

After recording or selecting the second macro, click the Next button.

The Application Authentication Step is complete. Proceed to the Application Stage to run your
application.
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Using a Login Macro when Connected to Fortify Weblnspect Enterprise

For a Fortify Weblnspect that is connected to Fortify Weblnspect Enterprise, you can download and use
a login macro from the Fortify Weblnspect Enterprise macro repository.

1.
2.

Select the Use a login macro for this site check box.
Click Download.
The Download a Macro from Fortify Weblnspect Enterprise window appears.

Select the Project and Project Version from the drop-down lists.

4. Select a repository macro from the Macro drop-down list.

5.

Click OK.

Note: Selecting a repository macro automatically syncs the Project and Project Version on the
Final Review page under Automatically Upload Scan to WIE.

Using a Selenium Macro

Fortify Weblnspect supports integration with Selenium browser automation. When you click the Import
button and select a Selenium macro to import, Fortify Weblnspect detects that a Selenium macro is
being used. Fortify Weblnspect opens Selenium and plays the macro. The macro must include a logout
condition. If a logout condition does not exist, you can add one using the Logout Conditions Editor just
as with any other macro. However, all other edits must be done in the Selenium IDE.

1.
2.

8.

Select the Use a login macro for this site check box.

Click the ellipsis button (...) fo browse for a saved Selenium macro.
The Import Macro window appears.

Select Selenium IDE Test Case (*.*) from the file type drop-down list.

Note: Selenium macros do not have a specific file extension and can be any type of text file,
including XML.

Locate and select the file, and then click Open.

The Import Selenium Script window appears.

(Optional) To view and/or adjust how Selenium behaves during macro replay, click the Settings
plus (+) sign.

The Settings area expands and the default settings become visible. Make changes as necessary.
Click Verify.

Fortify Weblnspect plays the macro, displaying the verification progress and status in the Import
Selenium Script window.

Did the macro play successfully?

o If yes, the message "Successfully verified macro" appears. Continue with Step 8.

o If no, an error message appears. Use the error message to debug and correct the error in
Selenium, and return to Step 2 of this procedure to try the import again.

Continue according to the following table.
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To... Then...

Specify a logout condition a. Click Edit logout conditions.

The Logout Conditions Editor appears. Currently,
only Regex is supported.

b. Add alogout condition and click OK.

Export the Selenium script to use a. Click Export.
elsewhere The Selenium script import window opens.

b. Navigate to the desired directory and type a File
name for the script.

c. Select the Save as Type.
Note: If you changed the settings in the Import
Selenium Script window, they will not be saved
when exporting the file as a Selenium Import
. file. However, if you export the file as a

Fortify Weblnspect Selenium macro
(*.webmacro) file, the settings will be saved.

d. Click Save.

About the Application Stage

The Application Stage is where you run your application. During the application stage:

¢ Run the mobile application to generate and collect Web traffic.

o ldentify the hosts and RESTful endpoints you want to include.

Run Application Step

To run the application and generate and collect Web traffic:

1. Click the Record button.

2. Exercise the application, navigating through the interface as your customers will.
3. When you have generated enough traffic, click the Stop button.

4. Click Play to verify your workflow.

Finalizing Allowed Hosts and RESTful Endpoints

After running the application and collecting Web traffic, a list will be generated of the Allowed Hosts
and potential RESTful Endpoints.
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To select the hosts to include in your audit, click the check boxes in the Enabled column of the Allowed
Hosts table.

The list of RESTful endpoints is generated by listing every possible combination that could be a
RESTful endpoint. Select the actual RESTful endpoints from the list by selecting their Enabled check
boxes. To reduce the list to a more likely subset, click the Detect button. Heuristics are applied, filtering
out some of the less likely results. Select the Enabled check boxes from the resultant list.

If Fortify Weblnspect or Fortify Weblnspect Enterprise didn’t find all of the RESTful endpoints, you can
add them manually.

To set up a new RESTful endpoint rule:

1. Click the New Rule button.
A new rule input box appears in the RESTful Endpoints table.
2. Following the sample format in the input box, type in a RESTful Endpoint.
To Import a List of RESTful Endpoints:

1. Click the Import button.

A file selector appears.
2. Select a Web Application Description Language (wadl) file.
3. Click OK.

About the Settings Stage

During the final stage, you can set a number of options that affect how the collected traffic is audited.
The available options vary, based on the selections you have made.

Final Review Step

Configure Detailed Options

The Configure Detailed Options step allows you to set detailed options. These options will change from
scan to scan, as they are dependent on the choices made in the Guided Scan wizard. Some of the
options include:

Reuse Identified False Positives. Select a previous scan to identify vulnerabilities that have already
been identified as false positives.

Traffic Analysis. You can use a self-contained proxy server on your desktop. With it you can monitor
traffic from a scanner, a browser, or any other tool that submits HTTP requests and received responses
from a server. You can also enable the Traffic Monitor and display the hierarchical structure of the Web
site or Web service in a Fortify Weblnspect navigation pane. It allows you to display and review every
HTTP request sent by Fortify Weblnspect and the associated HTTP response received from the server.

Scan Mode. A crawl-only feature. Allows you to set Discovery (Path Truncation) Path truncation allows
you to make requests for known directories without file names. This can cause directory listings to be
displayed. You can also select the Passive Analysis (Keyword Search) option to examine every response
from the Web server for (error messages, directory listings, credit card numbers, etc.) not properly
protected by the Web site.
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Validate Settings and Start Scan

Options on this page allow you to save the current scan settings and, if Weblnspect is integrated with
Weblnspect Enterprise, to interact with Weblnspect Enterprise.

1. To save your scan settings as an XML file, select Click here to save settings. Use the standard
Save as window to name and save the file.

2. If Weblnspect is integrated with Weblnspect Enterprise, a Templates section appears in the toolbar.
Continue according to the following table.

If you want to... Then...

Save the current scan settings as a templatein = a. Do one of the following:

the Weblnspect Enterprise database o Click Save in the Templates section of

Note: When editing an existing template, the foolbar.
the Save is actually an update. You can o Select Click here to save template.
save any edits to settings and change the The Save Template window appears.

Template Name. However, you cannot
change the Project, Project Version, or
Global Template settings.

b. Select a project from the Project drop-
down list.

c. Select a project version from the Project
Version drop-down list.

d. Type aname in the Template field.

Load scan settings from a template a. Click Load in the Templates section of the
toolbar.

A confirmation message appears advising
that your current scan settings will be lost.

b. Click Yes.
The Load Template window appears.

c. Select a project from the Project drop-
down list.

d. Select a project version from the Project
Version drop-down list.

e. Select the template from the Template
drop-down list.

f. Click Load.

Guided Scan returns to the Site Stage for you
to verify the Web site and step through the
settings from the template.
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3. If Weblnspect is integrated with Weblnspect Enterprise, the Weblnspect Enterprise section appears
on this page. You can interact with Weblnspect Enterprise as follows:

a. Select a project from the Project drop-down list.
b. Select a project version from the Project Version drop-down list.

¢. Continue according to the following fable.

To run the scan... Then...
With a sensor in Weblnspect i. Select Run in Weblnspect Enterprise.
Enterprise ii. Select asensor from the Sensor drop-down list.

ii. Select a Priority for the scan.

In Weblnspect i. Select Run in Weblnspect.

ii. If youwant to automatically upload the scan
results to the specified project and project
version in Weblnspect Enterprise, select Auto
Upload to Weblnspect Enterprise.

Note: If the scan does not complete
successfully, it will not be uploaded to
Weblnspect Enterprise.

4. In the Scan Now area, review your scan settings, and then click Start Scan to begin the scan.

Post Scan Steps

After you have completed your scan and run Fortify Weblnspect or Fortify Weblnspect Enterprise, you
will need to reset your Android, Windows, or iOS device or emulator to its former state. The following
steps show how to reset your iOS device to the way it was before you began. Steps for other devices
and emulators are similar, but depend on the version of the OS you are running.

To remove the Fortify Certificate on an iOS device:
Run the Settings application.

1. Select General from the Settings column.
2. Scrolldown to the bottom of the list and select Profile Weblnspect Root.
3. Tap the Remove button.

To Remove the Proxy Settings on an iOS device:

1. Run the Settings application.
2. Select Wi-Fi from the Settings column.
3. Tap the Network name.
Delete the Server IP address and the Port number.
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See Also

"Guided Scan Overview " on page 99

Running a Web Service Scan

When performing a Web service scan, Fortify Weblnspect crawls the WSDL site and submits a value for
each parameter in each operation it discovers. These values are extracted from a file that you must
create using the Web Service Test Designer. It then audits the site by attacking each parameter in an
attempt to detect vulnerabilities such as SQL injection.

See "Auditing Web Services " on page 231 for more information on how a Web services vulnerability
scan differs from other types of scan actions.

Note: If you conducted a Web Service scan using a version of Fortify Weblnspect prior to 9.00 and
attempt to import that scan into version 10.00 or later, results will be less than optimal. Fortify
recommends that you rescan your Web service using Fortify Weblnspect 10.00 or later. See
"Importing Legacy Web Service Scans " on page 208 for additional details.

Use the following procedure to conduct a Web Service scan.

1. On the Fortify Weblnspect Start Page, click Start a Web Service Scan.

The Web Service ScanWizard appears.
2. Enter a name for the scan in the Scan Name box.
3. Select one of the following:

o Configure a Web Service Scan - Enter or select the full path and name of a Web Service
Definition Language (WSDL) file, or click - o open a standard file-selection dialog box and
choose a WSDL file. You will import the WSDL file and later launch the Web Service Test
Designer to configure a file containing values for each operation in the service.

Note: For instructions on conducting a Web service scan of the Fortify Weblnspect test site,
see "Scanning Web Services at zero.webappsecurity.com" on page 38.

¢ Scan with Existing Design File - Click - to open a standard file-selection dialog box and
choose a Web Service Test Design (WSD) file that you previously created using the Web Service
Test Designer. This file contains values for each operation in the service.

4. Click Next.

Note: On any window presented by the Web Service Scan Wizard, you can click Settings (at the
bottom of the window) to modify the default settings or to load a settings file that you previously
saved. Any changes you make will apply to this scan only and will not be retained in the default
settings file. To make and retain changes to default settings, click the Fortify Weblnspect Edit menu
and select Default Scan Settings.
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Authentication and Connectivity

1

2.

If you need to access the target site through a proxy server, select NetworkProxy and then
choose an option from the Proxy Profile list:

o Autodetect: Use the Web Proxy Autodiscovery Protocol (WPAD) to locate a proxy autoconfig
file and use this to configure the browser's Web proxy settings.

o Use Internet Explorer: Import your proxy server information from Internet Explorer.

+ Use PAC File: Load proxy settings from a Proxy Automatic Configuration (PAC) file. If you
select this option, click Edit to enter the location (URL) of the PAC.

« Use Explicit Proxy Settings: Specify proxy server settings. If you select this option, click Edit
to enter proxy information.

o Use Mozilla Firefox: Import your proxy server information from Firefox.

Note: Electing to use browser proxy settings does not guarantee that you will access the
Internet through a proxy server. If the Firefox browser connection settings are configured for
"No proxy," or if the Internet Explorer setting "Use a proxy server for your LAN" is not selected,
then a proxy server will not be used.

If server authentication is required, select Network Authentication and then select
an authentication method and entfer your network credentials. The authentication methods are:

Automatic

Allow Fortify Weblnspect to determine the correct authentication type.

Automatic detection slows the scanning process. If you know and specify one of the other
authentication methods, scanning performance is noticeably improved.

Basic

A widely used, industry-standard method for collecting user name and password information.

a. The Web browser displays a window for a user to enter a previously assigned user name and
password, also known as credentials.

b. The Web browser then attempts to establish a connection to a server using the user's
credentials.

c. If auser's credentials are rejected, the browser displays an authentication window to re-enter
the user's credentials. Internet Explorer allows the user three connection attempts before
failing the connection and reporting an error to the user.

d. If the Web server verifies that the user name and password correspond to a valid user account,
a connection is established.

The advantage of Basic authentication is that it is part of the HTTP specification and is supported
by most browsers. The disadvantage is that Web browsers using Basic authentication transmit
passwords in an unencrypted form. By monitoring communications on your network, an attacker
can easily intercept and decode these passwords using publicly available tools. Therefore, Basic
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authentication is not recommended unless you are confident that the connection between the user
and your Web server is secure.

Digest

The Windows Server operating system implements the Digest Authentication protocol as a security
support provider (SSP), a dynamic-link library (DLL) that is supplied with the operating system.
Using digest authentication, your password is never sent across the network in the clear, but is
always transmitted as an MD5 digest of the user's password. In this way, the password cannot be
determined by sniffing network traffic.

Kerberos

Kerberos uses the Needham-Schroeder protocol as its basis. It uses a trusted third party, termed a
Key Distribution Center (KDC), which consists of two logically separate parts: an Authentication
Server (AS) and a Ticket Granting Server (TGS). The client authenticates itself to AS, then
demonstrates to the TGS that it is authorized to receive a ticket for a service (and receives it). The
client then demonstrates to a Service Server that it has been approved to receive the service.

Negotiate

The Negotiate authentication protocol begins with the option to negotiate for an authentication
protocol. When the client requests access to a service, the server replies with a list of authentication
protocols that it can support and an authentication challenge based on the protocol that is its first
choice.

For example, the server might list Kerberos and NTLM, and send a Kerberos challenge. The client
examines the contents of the reply and checks to determine whether it supports any of the
specified protocols. If the client supports the preferred protocol, authentication proceeds. If the
client does not support the preferred protocol, but does support one of the other protocols listed
by the server, the client lets the server know which authenftication protocol it supports, and the
authentication proceeds. If the client does not support any of the listed protocols, the
authentication exchange fails.

NT LAN Manager (NTLM)

NTLM is an authentication process that is used by all members of the Windows NT family of
products. Like its predecessor LanMan, NTLM uses a challenge/response process to prove the
client’s identity without requiring that either a password or a hashed password be sent across the
network.

Use NTLM authentication for servers running lIS. If NTLM authentication is enabled, and Fortify
Weblnspect has to pass through a proxy server to submit its requests to the Web server, Fortify
Weblnspect may not be able to crawl or audit that Web site.

Caution! After configuring Fortify Weblnspect for NTLM authentication and scanning the
NTLM-protected sites, you might want to disable the NTLM authentication setfings to prevent
any potential problem.

3. Click Next.
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Detailed Scan Configuration

1. If you are creating a design test file, a message prompts you to launch the Web Service Test
Designer. The Scan Wizard will not advance until you use the designer o create a WSD file.

2. If you already selected a design test file, you may click Design to open the Web Service Test
Designer and edit a web service design (WSD) file containing values that should be submitted to
the WSDL file during the scan.

3. (Optional) You may select the following options:
o Launch and Direct Traffic through Web Proxy. (This option is not available if you are scheduling
ascan.)

¢ Enable Traffic Monitor.

4, Click Next.

Congratulations

1. If you anticipate running this scan again, you can save the settings in an XML file. Click the Save
hyperlink to name and save the file.

When starting a scan through the Web Service Scan Wizard, you can click Settings (at the bottom
of the window) to load this settings file.

2. If you are scheduling a scan, you can also elect to generate a report when the scan completes.
Select the Generate Report check box, and then click the Select reports hyperlink.

3. Click Scan (or click Schedule, if you are scheduling a scan).

Running a Basic Scan

The options displayed by default on this and subsequent windows are extracted from the Fortify
Weblnspect default settings. Any changes you make will be used for this scan only. If you click Settings
(Default) at the bottom of the window to access the full complement of Fortify Weblnspect settings,
any selections you make are also temporary. To change the default settings, you must select Default
Scan Settings from the Edit menu. For more information, see "Default Scan Settings" on page 309.

Basic Scan Options

1. Inthe Scan Name box, enter a name or brief description of the scan.
2. Select one of the following scan modes:

o Crawl Only: This option completely maps a site's hierarchical data structure. After a crawl has
been completed, you can click Audit to assess an application’s vulnerabilities.

o Crawl and Audit: Fortify Weblnspect maps the site's hierarchical data structure and audits each
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resource (page). Depending on the default settings you select, the audit can be conducted as
each resource is discovered or after the entire site is crawled. For information regarding
simultaneous vs. sequential crawl and audit, see "Crawl and Audit Mode" on page 310.

o Audit Only: Fortify Weblnspect applies the methodologies of the selected policy to determine
vulnerability risks, but does not crawl the Web site. No links on the site are followed or assessed.

o Manual: Manual mode allows you to navigate manually to whatever sections of your application
you choose fo visit, using Firefox or Internet Explorer. It does not crawl the entire site, but
records information only about those resources that you encounter while manually navigating
the site. This feature is used most often to enter a site through a Web form logon page or o
define a discrete subset or portion of the application that you wanft o investigate. Once you
finish navigating through the site, you can audit the results to assess the security vulnerabilities
related to that portion of the site that you recorded.

Note: Manual mode is not available when scheduling scan.

3. Select one of the following scan types:

« Standard Scan: Fortify Weblnspect performs an automated analysis, starting from the target
URL. This is the normal way to start a scan.

« Manual Scan: Manual Crawl (Step Mode) allows you to navigate manually to whatever sections
of your application you choose to visit, using Firefox or Internet Explorer. This choice appears
only if you select the Manual Scan mode (above).

o List-Driven Scan: Perform a scan using a list of URLs to be scanned. Each URL must be fully
qualified and must include the protocol (for example, http:// or https://). You can use a text file,
formatted as comma-separated list or one URL per ling, or the XML file generated by the
FilesToURLs utility. For more information, see "FilesToURLs Utility " on page 306.

o To import a list, click Import.

o To build or edit a list using the Site List Editor, click Manage. For more information, see
"Using the Site List Editor " on page 163.

+ Workflow-Driven Scan: Fortify Weblnspect audits only those URLs included in the macro that
you previously recorded and does not follow any hyperlinks encountered during the audit. A
logout signature is not required. This type of macro is used most often to focus on a particular
subsection of the application. If you select multiple macros, they will all be included in the same
scan. You can use .webmacro files, Burp Proxy captures, or a Selenium macro. For more
information, see "Selecting a Workflow Macro " on page 218.

Important! If you use a login macro in conjunction with a workflow macro or startup macro
or both, all macros must be of the same type: all .webmacro files, all Burp Proxy captures, or
all Selenium macros. You cannot use different types of macros in the same scan.

4. If you select Standard Scan, follow these instructions:

a. Inthe Start URL box, type or select the complete URL or IP address of the site you want to
examine.

If you enter a URL, it must be precise. For example, if you enter MYCOMPANY.COM, Fortify
Weblnspect will not scan WWW.MYCOMPANY.COM or any other variation (unless you specify
alternatives in the Allowed Hosts setting).
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An invalid URL or IP address will result in an error. If you want to scan from a certain point in
your hierarchical tree, append a starting point for the scan, such as
http://www.myserver.com/myapplication/.

Scans by IP address will not pursue links that use fully qualified URLs (as opposed to relative
paths).

Fortify Weblnspect supports both Internet Protocol version 4 (IPV4) and Internet Protocol
version 6 (IPV6). IPV6 addresses must be enclosed in brackets. For more information, see
"Internet Protocol Version 6 " on page 308.

b. If you select Restrict to folder, you can limit the scope of the scan to the area you choose from
the drop-down list. The choices are:

o Directory only - Fortify Weblnspect will crawl and/or audit only the URL you specify. For
example, if you select this option and specify a URL of www.mycompany/one/two/, Fortify
Weblnspect will assess only the "two" directory.

o Directory and subdirectories - Fortify Weblnspect will begin crawling and/or auditing at
the URL you specify, but will not access any directory that is higher in the directory tree.

o Directory and parent directories - Fortify Weblnspect will begin crawling and/or auditing
at the URL you specify, but will not access any directory that is lower in the directory tree.

For information about limitations to the Restrict to folder scan option, see "Restrict to Folder
Limitations" on page 174.

5. If you select Manual Scan, do the following:
o Enter a Start URL and, if desired, select Restrict to folder. See Standard Scan (above).

o Inthe Browser drop-down list, select Firefox or Internet Explorer as the browser to use for the
manual scan.

6. If you select List-Driven Scan, do one of the following:

o Click Import and select a text file or XML file containing the list of URLs you want to scan.
o Click Manage fo create or modify a list of URLSs.

7. If you select Workflow-Driven Scan, do one of the following:

« Click Manage to select, edit, record, import, export, or remove a macro.

¢ Click Record and create a macro.

Note: You can include more than one macro in a scan.

8. Click Next.

Authentication and Connectivity

1. If you need to access the target site through a proxy server, select Network Proxy and then
choose an option from the Proxy Profile list:

o Autodetect: Use the Web Proxy Autodiscovery Protocol (WPAD) to locate a proxy autoconfig
file and use this to configure the browser's Web proxy settings.
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o Use Internet Explorer: Import your proxy server information from Internet Explorer.

o Use PAC File: Load proxy settings from a Proxy Automatic Configuration (PAC) file. If you
select this option, click Edit to enter the location (URL) of the PAC. For more information, see
"Configuring the Proxy Profile " on page 164.

« Use Explicit Proxy Settings: Specify proxy server settings. If you select this option, click Edit
to enter proxy information. For more information, see "Configuring the Proxy Profile " on
page 164,

« Use Mozilla Firefox: Import your proxy server information from Firefox.

Note: Electing to use browser proxy settings does not guarantee that you will access the
Internet through a proxy server. If the Firefox browser connection settings are configured for
"No proxy," or if the Internet Explorer setting "Use a proxy server for your LAN" is not selected,
then a proxy server will not be used.

2. Select Network Authentication if server authentication is required. Then select an authentication
method and enter your network credentials. The authentication methods are:

Basic

A widely used, industry-standard method for collecting user name and password information.

a. The Web browser displays a window for a user to enter a previously assigned user name and
password, also known as credentials.

b. The Web browser then attempts to establish a connection to a server using the user's
credentials.

c. If auser's credentials are rejected, the browser displays an authentication window to re-enter
the user's credentials. Internet Explorer allows the user three connection attempts before
failing the connection and reporting an error to the user.

d. If the Web server verifies that the user name and password correspond to a valid user account,
a connection is established.

The advantage of Basic authentication is that it is part of the HT TP specification and is supported
by most browsers. The disadvantage is that Web browsers using Basic authentication transmit
passwords in an unencrypted form. By monitoring communications on your network, an attacker
can easily intercept and decode these passwords using publicly available tools. Therefore, Basic
authentication is not recommended unless you are confident that the connection between the user
and your Web server is secure.

NT LAN Manager (NTLM)

NTLM is an authentication process that is used by all members of the Windows NT family of
products. Like its predecessor LanMan, NTLM uses a challenge/response process to prove the
client’s identity without requiring that either a password or a hashed password be sent across the
network.

Use NTLM authentication for servers running lIS. If NTLM authentication is enabled, and Fortify
Weblnspect has to pass through a proxy server to submit its requests to the Web server, Fortify
Weblnspect may not be able to crawl or audit that Web site.
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Caution! After configuring Fortify Weblnspect for NTLM authentication and scanning the
NTLM-protected sites, you might want to disable the NTLM authentication settings to prevent
any potential problem.

Automatic

Allow Fortify Weblnspect to determine the correct authentication type.

Automatic detection slows the scanning process. If you know and specify one of the other
authentication methods, scanning performance is noticeably improved.

Digest

The Windows Server operating system implements the Digest Authentication protocol as a security
support provider (SSP), a dynamic-link library (DLL) that is supplied with the operating system.
Using digest authentication, your password is never sent across the network in the clear, but is
always transmitted as an MD5 digest of the user's password. In this way, the password cannot be
determined by sniffing network traffic.

Kerberos

Kerberos uses the Needham-Schroeder protocol as its basis. It uses a trusted third party, termed a
Key Distribution Center (KDC), which consists of two logically separate parts: an Authentication
Server (AS) and a Ticket Granting Server (TGS). The client authenticates itself to AS, then
demonstrates to the TGS that it is authorized to receive a ticket for a service (and receives it). The
client then demonstrates to a Service Server that it has been approved to receive the service.

Negotiate

The Negotiate authentication protocol begins with the option to negotiate for an authentication
protocol. When the client requests access to a service, the server replies with a list of authentication
protocols that it can support and an authentication challenge based on the protocol that is its first
choice.

For example, the server might list Kerberos and NTLM, and send a Kerberos challenge. The client
examines the contents of the reply and checks to determine whether it supports any of the
specified protocols. If the client supports the preferred protocol, authentication proceeds. If the
client does not support the preferred protocol, but does support one of the other protocols listed
by the server, the client lets the server know which authentication protocol it supports, and the
authentication proceeds. If the client does not support any of the listed protocols, the
authentication exchange fails.

3. To configure a client certificate for a website, click Settings > Authentication and confinue as
follows:
a. Inthe Client Certificates area, select the Enable check box.
b. Click Select.
The Client Certificates window opens.
¢. Do one of the following:

o To use a certificate that is local fo the computer and is global to all users on the computer,
select Local Machine.
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o To use a certificate that is local fo a user account on the computer, select Current User.

Note: Certificates used by a common access card (CAC) reader are user certificates and
are stored under Current User.
d. Do one of the following:

o To select a certificate from the "Personal" ("My") certificate store, select My from the drop-
down list.

o To select a tfrusted root certificate, select Root from the drop-down list.
e. Does the website use a CAC reader?
o |f yes, do the following:
A. Select a certificate that is prefixed with “(SmartCard)” from the Certificate list.

Information about the selected certificate and a PIN field appear in the Certificate
Information area.

B. If aPINisrequired, type the PIN for the CAC in the PIN field.

Note: If a PIN is required and you do not enter the PIN at this point, you must enter
the PIN in the Windows Security window each time it prompts you for it during the

scan.
C. Click Test.

If you entered the correct PIN, a Success message appears.

o |If no, select a certificate from the Certificate list.

Information about the selected certificate appears below the Certificate list.
f. Click OK.

4. Select Site Authentication to use a recorded macro containing a user name and password that
allows you to log on to the target site. The macro must also contain a "logout condition," which

indicates when an inadvertent logout has occurred so Fortify Weblnspect can rerun this macro to
log on again.

e To use a pre-recorded Web Macro Recorder macro, click the ellipsis button (...) to select a macro.
If, after selecting the macro, you want to modify it using the Web Macro Recorder, click Edit.

Note: To erase the macro name, clear the Site Authentication check box.

e To use a pre-recorded Selenium macro:

i. Click the ellipsis button (..) fo browse for a saved Selenium macro.
The Select a Login Macro window appears.

ii. Select Selenium IDE Test Case (*.*) from the file type drop-down list.

Note: Selenium macros do not have a specific file extension and can be any type of
text file, including XML.

iii. Locate and select the file, and then click Open.

The Import Selenium Script window appears.
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Vi.

Vii.

viii.

iX.

(Optional) To view and/or adjust how Selenium behaves during macro replay, click the
Settings plus (+) sign.

The Settings area expands and the current settings become visible. Make changes as
necessary.

Click Verify.

Fortify Weblnspect plays the macro, displaying the verification progress and status in the
Import Selenium Script window.

Do one of the following:

o If the macro plays successfully, the message "Successfully verified macro" appears.
Continue with Step vii.

o If the macro does not play successfully, an error message appears. Use the error
message to debug and correct the error in Selenium, and return to Step i of this
procedure to try the import again.

To specify a logout condition, click Edit logout conditions.

The Logout Conditions Editor appears. Currently, only Regex is supported.
Add a logout condition and click OK.

Click OK to add the macro to the Scan Wizard.

e To create a new macro, click Record.

The Login Macro Parameters grid appears if, when recording the macro, you selected the
Smart Credentials option (when using the trafficcmode or event-based web macro recorders) or
if you created input parameters when using the TruClient web macro recorder. Enter a user
name and password. When scanning the page containing the input control associated with this
entry, Fortify Weblnspect will substitute these credentials for those used in the macro. This
feature allows you to create a macro using your user name and password, yet when other
persons run the scan using this macro, they can substitute their own user credentials.

Note: For help creating login parameters with the Web Macro Recorder, see Web Macro
Recorder Help.

5. Click Next.

Coverage and Thoroughness

1. To optimize settings for an application built using either Oracle Application Development
Framework Faces components or IBM WebSphere Portal, select Framework and then choose
Oracle ADF Faces or WebSphere Portal from the Optimize scan for list. Fortify may develop
other settings overlays and make them available through Smart Update.

For more information about scanning a WebSphere portal, see "WebSphere Portal FAQ "on
page 265.

2. Use the CrawlCoverage slider to specify the crawler settings.

This slider may or may not be enabled, depending on the scan mode you selected. The label
associated with this slider also depends on your selection. If enabled, the slider allows you to select
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one of four crawl positions. Each position represents a specific collection of settings, as represented
by the following labels:

Thorough

A Thorough crawl is an automated crawl that uses the following settings:
¢ Redundant Page Detection: OFF

e Maximum Single URL Hits: 10

e Maximum Web Form Submissions: 7

e Maximum Script Events Per Page: 2000

o Number of Dynamic Forms Allowed Per Session: Unlimited
e Include Parameters In Hit Count: True

Default

A Default crawl is an automated crawl that uses the following (default scan) settings:
¢ Redundant Page Detection: OFF

e Maximum Single URL Hits: 5

e Maximum Web Form Submissions: 3

o Create Script Event Sessions: OFF

e Maximum Script Events Per Page: 1000

o Number of Dynamic Forms Allowed Per Session: Unlimited
¢ Include Parameters In Hit Count: True

Moderate

A Normal crawl is an automated crawl that uses the following settings:
¢ Redundant Page Detection: OFF

e Maximum Single URL Hits: 5

o Maximum Web Form Submissions: 2

o Create Script Event Sessions: OFF

e Maximum Script Events Per Page: 300

o Number of Dynamic Forms Allowed Per Session: 1
o Include Parameters In Hit Count: False

Quick

A Quick crawl uses the following settings
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¢ Redundant Page Detection: ON

e Maximum Single URL Hits: 3

o Maximum Web Form Submissions: 1

o Create Script Event Sessions: OFF

e Maximum Script Events Per Page: 100

o Number of Dynamic Forms Allowed Per Session: 0
o Include Parameters In Hit Count: False

If you click Settings (to open the Advanced Settings dialog box) and change a setting that
conflicts with any setting established by one of the four slider positions, the slider creates a fifth
position labeled Customized Coverage Settings.

3. Select a policy from the AuditDepth (Policy) list.

This list may or may not be enabled, depending on the scan mode you selected in Step 1. For
descriptions of policies, see "Fortify Weblnspect Policies" on page 394.

4, Click Next.

Detailed Scan Configuration

Profiler

Fortify Weblnspect conducts a preliminary examination of the target Web site to determine if certain
settings should be modified. If changes appear to be required, the Profiler returns a list of suggestions,
which you may accept or reject.

For example, the Server Profiler may detect that authorization is required to enter the site, but you have
not specified a valid user name and password. Rather than proceed with a scan that would return
significantly diminished results, you could follow the Server Profiler's suggestion to configure the
required information before continuing.

Similarly, your settings may specify that Fortify Weblnspect should not conduct "file-not-found"
detection. This process is useful for Web sites that do not return a status "404 Not Found" when a client
requests a resource that does not exist (they may instead return a status "200 OK," but the response
contains a message that the file cannot be found). If the Profiler determines that such a scheme has
been implemented in the target site, it would suggest that you modify the Fortify Weblnspect setting to
accommodate this feature.

To launch the Profiler each time you access this page, select Run Profiler Automatically.
To launch the Profiler manually, click Profile. For more information, see "Server Profiler" on page 222.

Results appear in the Settings section.
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Settings

1. Accept or reject the suggestions. To reject, clear the associated check box.
2. If necessary, provide the requested information.
3. Click Next.
Several options may be presented even if you do not run the Profiler. They include:

o Auto fill Web forms

o Add allowed hosts

+ Reuse identified false positives
o Apply sample macro

o Trafficanalysis

Auto Fill Web Forms

Select Auto-fill Web forms during crawl if you want Fortify Weblnspect to submit values for input
controls on forms it encounters while scanning the target site. Fortify Weblnspect will extract the values
from a prepackaged default file or from a file that you create using the Web Form Editor. You may:

o Click the ellipsis button . to locate and load a file.
o Click Edit _«-ﬂ to edit the selected file (or the default values) using the Web Form Editor.

e Click Create :‘@J to open the Web Form Editor and create a file.

Add Allowed Hosts

Use the Allowed Host settings to add domains to be crawled and audited. If your Web presence uses
multiple domains, add those domains here. For more information, see "Scan Settings: Allowed Hosts" on
page 328.

To add allowed domains:

1. Click Add.

2. On the Specify Allowed Host window, enter a URL (or a regular expression representing a URL)
and click OK.

For more information about adding or editing Allowed Hosts, see "Specifying Allowed Hosts " on
page 166.

Reuse Identified False Positives

Select scans containing vulnerabilities that were changed to false positives. If those false positives
match vulnerabilities detected in this scan, the vulnerabilities will be changed to false positives. For more
information, see "False Positives" on page 76.
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To reuse identified false positives:

1. Select Import False Positives.

2. Click SelectScans.

3. Select one or more scans containing false positives from the same site you are now scanning.
4. Click OK.

Note: You cannot import false positives when scheduling a scan or conducting an Enterprise scan.

Sample Macro

Fortify Weblnspect’s example banking application, zero.webappsecurity.com, uses a Web form login. If
you scan this site, select Apply sample macro to run the sample macro containing the login script.

Traffic Analysis

Select Launch and Direct Traffic through Web Proxy to use the Web Proxy tool fo examine the
HTTP requests issued by Fortify Weblnspect and the responses returned by the target server.

While scanning a Web site, Fortify Weblnspect displays in the navigation pane only those sessions that
reveal the hierarchical structure of the Web site, plus those sessions in which a vulnerability was
discovered. However, if you select Enable Traffic Monitor, Fortify Weblnspect adds the Traffic
Monitor button to the Scan Info panel, allowing you to display and review each HTTP request sent by
Fortify Weblnspect and the associated HTTP response received from the server.

Message

If the profiler does not recommend changes, the Scan Wizard displays the message, "No settings
changes are recommended. Your current scan settings are optimal for this site."

Congratulations

The contents of this window vary, depending your choices and configuration.

Upload to Fortify Weblinspect Enterprise Scan Template

When connected to an enterprise server (Fortify Weblnspect Enterprise), you can send the settings for
this scan to Fortify Weblnspect Enterprise, which will create a scan template. However, you must be
assigned to a role that allows you to create scan templates.

Save Settings

You can save the settings you configured for this scan, which would allow you to reuse the settings for
a future scan.

Micro Focus Fortify Weblnspect (18.10) Page 162 of 427



User Guide
Chapter 4: Working with Scans

Generate Reports

If you are scheduling a scan, you can instruct Fortify Weblnspect to generate a report when the scan
completes.

1.
2.
3.

Select Generate Reports.
Click the Select reports hyperlink.
(Optional) Select a report from the Favorites list.

A "favorite" is simply a named collection of one or more reports and their associated parameters. To
create a favorite once you have selected reports and parameters, click the Favorites list and select
Add to favorites.

4. Select one or more reports.

Provide information for any parameters that may be requested. Required parameters are outlined
inred.

Click Next.

7. If you select Automatically Generate Filename, the name of the report file will be formatted as

10.

11.

12.
13.

<reportname> <date/time>.<extension>. For example, if creating a compliance report in pdf
format and the report is generated at 6:30 on April 5, the file name would be "Compliance
Report 04_05_2009 06_30.pdf." This is useful for recurring scans.

Reports are written to the directory specified for generated reports in the Application settings.

If you did not select Automatically Generate Filename, enter a name for the file in the Filename
box.

Select the report format from the Export Format list.

If you selected multiple reports, you can combine then all into one report by selecting Aggregate
reports into one report.

Select a template that defines the headers and footers used for the report and, if necessary,
provide the requested parameters.

Click Finished.
Click Schedule.

Using the Site List Editor

When performing a List-Driven Scan using the Basic Scan Wizard, you can build or edit the list of URLs
using the Site List Editor.

To access the Site List Editor:

« Click Manage under the List-Driven Scan option in the Basic Scan Wizard.

To add individual URLs manually:

1
2.

Click Add.

Enter a URL that you want to include in the scan. If you do not specify the protocol, the editor will
add "http://" to the beginning of the URL.

Repeat as necessary.
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To add URLs specified in a text file or XML file:

1. Click Import.
2. Using the standard file-selection window, locate the file and click Open.

3. Repeat as necessary.

Note: The editor does not check for duplicates. If you import two lists and both lists contain
the same URL, that URL will be listed twice.

Also, each URL must include the protocol (for example, http:// or https://). Unlike manual
entry, the editor will not automatically add a protocol to the beginning of an imported URL.

To edit an enfry:

e Clicka URL.

To delete an entry:

e Select a URL and click Delete.

See Also

"Running a Basic Scan" on page 152

Configuring the Proxy Profile

When performing a Basic Scan and using proxy settings from a Proxy Automatic Configuration (PAC)
file or specifying Explicit Proxy Settings, you can configure the proxy options in the Proxy Profile
window.

To access the Proxy Profile window:

o Click Edit under Network Proxy in the Basic Scan Wizard.

Configure proxy using a PAC file

Load proxy settings from a Proxy Automatic Configuration (PAC) file. Specify the file location in the
URL box.

Explicitly configure proxy
Configure a proxy by entering the requested information.

1. Inthe Server box, type the URL or IP address of your proxy server, followed (in the Port box) by
the port number (for example, 8080).

2. Fromthe Type list, select a protocol for handling TCP traffic through a proxy server: SOCKS4,
SOCKSS5, or standard.

3. If authentication is required, select a type from the Authentication list:

Automatic

Allow Fortify Weblnspect to determine the correct authentication type.
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Automatic detection slows the scanning process. If you know and specify one of the other
authentication methods, scanning performance is noticeably improved.

Basic

A widely used, industry-standard method for collecting user name and password information.

a. The Web browser displays a window for a user to enter a previously assigned user name and
password, also known as credentials.

b. The Web browser then attempts to establish a connection to a server using the user's
credentials.

c. If auser's credentials are rejected, the browser displays an authentication window to re-enter
the user's credentials. Internet Explorer allows the user three connection attempts before
failing the connection and reporting an error to the user.

d. If the Web server verifies that the user name and password correspond to a valid user account,
a connection is established.

The advantage of Basic authentication is that it is part of the HT TP specification and is supported
by most browsers. The disadvantage is that Web browsers using Basic authentication transmit
passwords in an unencrypted form. By monitoring communications on your network, an attacker
can easily intercept and decode these passwords using publicly available tools. Therefore, Basic
authentication is not recommended unless you are confident that the connection between the user
and your Web server is secure.

Digest

The Windows Server operating system implements the Digest Authentication protocol as a security
support provider (SSP), a dynamic-link library (DLL) that is supplied with the operating system.
Using digest authentication, your password is never sent across the network in the clear, but is
always transmitted as an MD5 digest of the user's password. In this way, the password cannot be
determined by sniffing network fraffic.

Kerberos

Kerberos uses the Needham-Schroeder protocol as its basis. It uses a trusted third party, termed a
Key Distribution Center (KDC), which consists of two logically separate parts: an Authentication
Server (AS) and a Ticket Granting Server (TGS). The client authenticates itself to AS, then
demonstrates to the TGS that it is authorized to receive a ticket for a service (and receives it). The
client then demonstrates to a Service Server that it has been approved to receive the service.

Negotiate

The Negotiate authentication protocol begins with the option to negotiate for an authentication
protocol. When the client requests access to a service, the server replies with a list of authentication
protocols that it can support and an authentication challenge based on the protocol that is its first
choice.

For example, the server might list Kerberos and NTLM, and send a Kerberos challenge. The client
examines the contents of the reply and checks to determine whether it supports any of the
specified protocols. If the client supports the preferred protocol, authentication proceeds. If the
client does not support the preferred protocol, but does support one of the other protocols listed
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by the server, the client lets the server know which authentication protocol it supports, and the
authentication proceeds. If the client does not support any of the listed protocols, the
authentication exchange fails.

NT LAN Manager (NTLM)

NTLM is an authentication process that is used by all members of the Windows NT family of
products. Like its predecessor LanMan, NTLM uses a challenge/response process to prove the
client’s identity without requiring that either a password or a hashed password be sent across the
network.

Use NTLM authentication for servers running IIS. If NTLM authentication is enabled, and Fortify
Weblnspect has to pass through a proxy server to submit its requests to the Web server, Fortify
Weblnspect may not be able to crawl or audit that Web site.

Caution! After configuring Fortify Weblnspect for NTLM authentication and scanning the
NTLM-protected sites, you might want to disable the NTLM authentication settings to prevent
any potential problem.

4. If your proxy server requires authentication, enter the qualifying user name and password.

5. If you do not need to use a proxy server to access certain IP addresses (such as internal testing
sites), enter the addresses or URLs in the Bypass Proxy For box. Use commas to separate entries.

See Also

"Running a Basic Scan" on page 152

Specifying Allowed Hosts

Specify an Allowed Host to add domains to be crawled. If your Web presence uses multiple domains,
add those domains here. For example, if you were scanning "Wlexample.com," you would need o add
"Wlexample2.com" and "Wlexample3.com" here if those domains were part of your Web presence and
you wanted to include them in the crawl or audit.

You can also use this feature to scan any domain whose name contains the text you specify. For
example, suppose you specify www.myco.com as the scan target and you enter "myco" as an allowed
host. As Fortify Weblnspect scans the target site, if it encounters a link to any URL containing "myco," it
will pursue that link and scan that site's server, repeating the process until all linked sites are scanned.
For this hypothetical example, Fortify Weblnspect would scan the following domains:

e www.myco.com:80

e contact.myco.com:80

e wWwwl.myco.com

o ethics.myco.com:80

e contact.myco.com:443

e wow.myco.com:80

e mycocorp.com:80

e www.interconnection.myco.com:80

Note that if you specify a port number, then the allowed host must be an exact match.
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Specifying Allowed Hosts

To specify (add) allowed hosts:

1. On the Detailed Scan Configuration page of the Basic Scan Wizard, click Add.
2. On the Specify Allowed Host dialog box, enter a URL (or a regular expression representing a URL).

Note: When specifying the URL, do not include the protocol designator (such as http:// or
https://).

3. If you entered a regular expression for the allowed host, select Use Regular Expression.

For assistance creating a regular expression, click L (to the right of the Allowed Host box).

4. Click OK.

Editing Allowed Hosts

To edit allowed hosts:
1. On the Detailed Scan Configuration page of the Basic Scan Wizard, select a host and then click
Edit.
2. On the Edit Allowed Host dialog box, edit the URL (or the regular expression representing the
URL).

Note: When editing the URL, do not include the protocol designator (such as http:// or
https://).

3. Click OK.
See Also

"Running a Basic Scan" on page 152

Multi-User Login Scans

Note: This feature is a technology preview. Technology preview features are currently
unsupported, may not be functionally complete, and are not suitable for deployment in production.
However, these features are provided as a courtesy and the primary objective is for the feature to
gain wider exposure with the goal of full support in the future.

Applications that only allow a single active login session per user prevent multi-threaded scanning. With
multiple logins, the threads invalidate each other's state, resulting in slow scan times.

A solution to this problem is to convert the recorded credentials in a login macro to parameters and use
multiple login accounts with the same application privileges. When you use parameters in the login
macro, you can hand edit the scan settings so that each scan thread uses a different username and
password, which allows the scan to run across multiple threads. Each thread has a different login
session, resulting in faster scan fimes.
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Process Overview

Follow this process to use multi-user logins and run a scan across multiple threads.

Stage Description

1 Configure a Basic Scan or a Guided Scan, and select the Record option for Site
Authentication. For more information, see "Running a Basic Scan" on page 152
and "Running a Guided Scan " on page 100.

The Web Macro Recorder appears.

2. In the Web Macro Recorder, record a login macro. For more information, see
"Using the Unified Web Macro Recorder" on page 219.

3. When prompted to select an object to indicate successful login, select an object
that appears on the authenticated page, but is not user-specific such as the user
name.

4, Upon successful replay of the macro and detection of a logout condition, you
will see the message “The macro is complete.”

Replace the login credentials with parameters in the Macro as described in
"Adding Parameters to the Macro" on the next page.

5. Play the macro once more to ensure that it works.
6. Continue configuring your scan as usual.
7. On Step 5 of 5 (the Congratulations window of the scan wizard), click Save to

save the macro with the parameters, and then click Cancel.

8. In Notepad, open the macro XML file you saved with parameters. For more
information about the login and thread parameters, see "Understanding Login
and Thread Parameters in the Macro" on page 170.

Create additional threads in the macro as described in "Setting Additional
Threads" on page 171.

Important! The number of configured users should equal the number of
configured shared requestor threads. For more information, see "Scan
Settings: Requestor" on page 320.

9. Conduct your scan using the hand-edited login macro with parameters and
additional threads.
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Adding Parameters to the Macro

To convert the login credentials o parameters in the macro:

1. Inthe TruClient sidebar, expand the Sign in step.

= Mavigate to "hitpfzero webappsecur.. comflogin.html”
+| Sign in

= Wit for Setlings

&«

&

&

2. Inthe step where the user name (user ID, login name, and so on) is typed, open the Step Editor.

&«

= Click an Login texthox
= Type"username" in Login texthox
= Click on Password passwordbox

5 Type sessssssss i Password passwordhbog

= Click on Signin button

&«

i
v

&

&«

3. In the Arguments section of the Step Editor, select the value for the user name, including the

opening and closing quotation marks.

4, Right-click, and then select Create New parameter from Selection....

T 2 L B W@
= Type "username” in Login textbox

B

+ Step

T Arquments

* Yalue: e g |

"y

Clear: Defaul ©ut Text Ctrl+x
Typing Interal: |Fun-tir Copy Text Crl+C

Paste Text Ctrl 4+
» Object

» Mew pararneter fram Selection. ..

F Transactions

h

Rl
Replace selection with parameter
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The Enter Parameter Name dialog box appears.

Enter Parameter Mame ®

Farameter Mame [NewParam?

Original Value  MEEEE

If the parameter name you use does not
already exist, it wil be added as a type
'File' and the Criginal “alue will be set to
'Username’.

] Cancel

In the Parameter Name field, type a name for the user name parameter and click OK.
In the step where the password is typed, open the Step Editor.
In the Arguments section of the Step Editor, select the value for the password.

© N o WU

Right-click, and then select Create New parameter from Selection....
The Enter Parameter Name dialog box appears.
9. Inthe Parameter Name field, type a name for the password parameter and click OK.

Return to Stage 5 of the "Process Overview" on page 168.

Understanding Login and Thread Parameters in the Macro

Inside the macro are two XML elements that define the logins and threads to be used during the scan.
These elements are:

e <WebMacroParameters> - This element is found inside the <SitelLoginParameters> element
and will be the login credentials for the first thread. This thread would be considered thread [0].

e <ThreadSitelLoginParameters> — This element can be set for multiple logins (or threads). If no
additional logins are set here, then the macro with parameters functions as a normal login macro.

Each additional thread after the first thread—which is thread [0]—must have its own

<WebMacroParameters> element inside the <ThreadSiteLoginParameters> element. You can
find details on setting additional threads in "Setting Additional Threads" on the next page.
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Setting Additional Threads

To set additional threads in the macro:

1. In Notepad, locate the <ThreadSitelLoginParameters /> tagasshown below.

<SitelLoginParameters>
<WebMacroParameters>

<MacroName>LoginMacrol</MacroName>

<Parameters>
<KeyPairOfStringString>
<Key>username</Key>
<Value>username</Value>
</KeyPairOfStringString>
<KeyPairOfStringString>
<Key>password</Key>
<Value>password</Value>
</KeyPairOfStringString>
</Parameters>
</WebMacroParameters>
</SitelLoginParameters>
<ThreadSitelLoginParameters />

Edit the line fo remove the / to create the opening <ThreadSitelLoginParameters> XML tag.
2. Place your cursor at the end of the <ThreadSiteLoginParameters> line and press Enter twice.

3. Type</ThreadSiteLoginParameters>.You should now have lines of code similar to the

following :

<SitelLoginParameters>
<WebMacroParameters>

<MacroName>LoginMacrol</MacroName>

<Parameters>
<KeyPairOfStringString>
<Key>username</Key>
<Value>username</Value>
</KeyPairOfStringString>
<KeyPairOfStringString>
<Key>password</Key>
<Value>password</Value>
</KeyPairOfStringString>
</Parameters>
</WebMacroParameters>
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</SitelLoginParameters>
<ThreadSitelLoginParameters>

</ThreadSitelLoginParameters>

4. Select all lines of code starting with <WebMacroParameters> through

</WebMacroParameters> and press CTRL C.

5. Place your cursor on the blank line you created between the <ThreadSiteLoginParameters>

and </ThreadSitelLoginParameters> tags, and press CTRL V.

The <WebMacroParameters> element is copied to the new thread. You should now have lines of

code similar to the following :

<SitelLoginParameters>
<WebMacroParameters>
<MacroName>LoginMacrol</MacroName>
<Parameters>
<KeyPairOfStringString>
<Key>username</Key>
<Value>username</Value>
</KeyPairOfStringString>
<KeyPairOfStringString>
<Key>password</Key>
<Value>password</Value>
</KeyPairOfStringString>
</Parameters>
</WebMacroParameters>
</SitelLoginParameters>
<ThreadSitelLoginParameters>
<WebMacroParameters>
<MacroName>LoginMacrol</MacroName>
<Parameters>
<KeyPairOfStringString>
<Key>username</Key>
<Value>username</Value>
</KeyPairOfStringString>
<KeyPairOfStringString>
<Key>password</Key>
<Value>password</Value>
</KeyPairOfStringString>
</Parameters>
</WebMacroParameters>
</ThreadSitelLoginParameters>
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6. Append the <MacroName> with [1] fo indicate the thread count, which is the second thread. In
our example, the code now looks as follows:

<MacroName>LoginMacrol[1]</MacroName>

7. Change the username value for the second thread. In our example, the code now looks as follows:

<KeyPairOfStringString>
<Key>username</Key>
<Value>username2</Value>

</KeyPairOfStringString>

8. Change the password value for the second thread. In our example, the code now looks as follows:

<KeyPairOfStringString>
<Key>password</Key>
<Value>password2</Value>

</KeyPairOfStringString>

Your <ThreadSitelLoginParameters> element code should now appear similar to the following:

<ThreadSitelLoginParameters>
<WebMacroParameters>
<MacroName>LoginMacrol[1]</MacroName>
<Parameters>
<KeyPairOfStringString>
<Key>username</Key>
<Value>username2</Value>
</KeyPairOfStringString>
<KeyPairOfStringString>
<Key>password</Key>
<Value>password2</Value>
</KeyPairOfStringString>
</Parameters>
</WebMacroParameters>
</ThreadSitelLoginParameters>

9. Do you want to set additional threads?

o If yes, do the following:

i. Position your cursor at the beginning of </ThreadSiteLoginParameters> line and
press Enter.

ii. Repeat Steps 4 through 8 for each additional thread you want running during the scan.

Each time, increment by one the number you append to the <MacroName>, suchas [2],
[3],andsoon.

e If no, save the XML file.
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Now, each thread will have its own macro and set of parameters, allowing multiple users and threads in
the scan. You are now ready to conduct your scan using the macro. Return to Stage 9 of the "Process
Overview" on page 168.

Known Limitations

The following known limitations apply to the multi-user login feature:

o When using this feature, Fortify Weblnspect does not detect several login-related Securebase checks.

o This feature currently supports only shared requestor threads. Using default scan settings with
separate crawl and audit threads is not supported. For more information, see "Scan Settings:
Requestor" on page 320.

o Currently, Fortify Weblnspect does not use the login credentials for the first user defined in the

<WebMacroParameters> element inside the <SiteLoginParameters> element, which is thread
[O]. Fortify Weblnspect starts a scan using thread [1], which is the second defined user.

¢ The scan does not distribute the work equally among the multiple users logged in. For example, one
configured user might use up to 75% of the scan activities while all other users are allocated to the
remaining 25% of scan activities.

Restrict to Folder Limitations

This topic describes limitations to the Restrict to folder scan option when JavaScript include files are
encountered or when a login or workflow macro is used.

JavaScript Include Files

During a scan, the crawler and JavaScript engine might access external JavaScript include files. These
files are not actively audited, so no attacks are sent over HTTP. However, passive inspection can reveal
issues with JavaScript include files, and these files will be listed in the site tree.

Login Macros

If you use a login macro, then sessions requested in the macro will be listed in the site tree. The sessions
will be passively audited, meaning that no attacks will be sent, but vulnerabilities such as weak
encryption, unencrypted login forms, and so on might be revealed.

Workflow Macros

If you use a workflow macro in a Crawl and Audit scan or a Crawl Only scan, then the scan might violate
the Restrict to folder option. The assumption is that you wish to visit the URLs included in the workflow
macro.
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Running an Enterprise Scan

An enterprise scan provides a comprehensive overview of your Web presence from an enterprise
network perspective. Fortify Weblnspect will automatically discover all available ports for a range of IP
addresses. You can then select which servers to assess for vulnerabilities from all servers that are
discovered.

To start an Enterprise Scan:

1. Do one of the following to launch the Enterprise Scan Wizard:

On the Fortify Weblnspect Start Page, click Start an Enterprise scan.
Click File > New > Enterprise Scan.
Click the drop-down arrow on the New icon (on the toolbar) and select Enterprise Scan.

On the Fortify Weblnspect Start Page, click Manage Scheduled Scans, click Add, and then
select Enterprise Scan.

2. On Step 1 of the Enterprise Scan Wizard, specify when you want to conduct the scan. The choices
are:

Immediately: The scan will run immediately after finishing the Scheduled Scan Wizard.

Run Once Date / Time: Modify the date and time when the scan should begin. You can click the
drop-down arrow to reveal a calendar for selecting the date.

Recurrence Schedule: Use the slider to select a frequency (Daily, Weekly, or Monthly). Then
specify the time when the scan should begin and (for Weekly or Monthly) provide other
schedule information.

3. Click Next.

4. On Step 2 of the Enterprise Scan Wizard, in the Enterprise Scan Name box, enfer a unique name
for this enterprise scan.

5. At this point, you can perform one or more of the following functions:
¢ Instruct Fortify Weblnspect to discover all available servers within a range of IP

addresses and ports that you specify.
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To discover Web servers:

i. Click Discover.

The Search for Web Servers window appears.

Search For, Web Servers
Search Addrezzes

1P 4/IP'YE Addresses [or ranges) Ports [ar ranges)
[ | 20443 | Pause
Example: 192.168.0.1-192.168.0.12,172.16.10.20; 2001:0c Example: 80-100;443 Feset
Total IP addresses specified: 0 Tatal ports specified: 2

Dizcovered End Paints
Selection IP Address Part | dentification

i. Inthe lPV4/IPV6 Addresses (or ranges) box, type one or more |IP addresses or a range
of IP addresses.

o Use a semicolon to separate multiple addresses.
Example: 172.16.10.3;172.16.10.44;188.23.102.5

o Use adash or hyphen to separate the starting and ending IP addresses in a range.
Example: 10.2.1.70-10.2.1.90.

Note: IPV6 addresses must be enclosed in brackets. See "Internet Protocol Version 6"
on page 308.

ii. Inthe Ports (or ranges) box, type the ports you want to scan.

o Use a semicolon to separate multiple ports.
Example: 80;8080;443

o Use adash or hyphen to separate the starting and ending portsin a range.
Example: 80-8080.

iv. (Optional) Click Settings to modify the number of sockets and timeout parameters used
for the discovery process.

v. Click Start to initiate the discovery process.
Results display in the Discovered End Points area.
e Click an entry in the IP Address column to view that site in a browser.

¢ Click an entry in the Identification column to open the Session Properties window,
where you can view the raw request and response.
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vi. To remove a server from the list, clear the associated check box in the Selection column.
vii. Click OK.

The IP addresses appear in the "Hosts to Scan" list.
o Enter individual URLs or IP addresses of hosts to scan.

To manually enter a list of URLs or IP addresses you want to scan.
i. Click Add.
The Scan Wizard opens.
ii. Provide the information described in Basic Scan.
iii. Repeat for additional servers.

« Import a list of servers that you want to scan (using a list that you previously created).

If you previously used the Enterprise Scan feature or the Web Discovery tool to detect servers
and then exported your findings to a text file, you can load those results by clicking Import and
then selecting the saved file.

Edit the 'Hosts to Scan' List

After building a list of servers using one or more of the above methods, you can modify the list.
To modify the settings for a specific scan:

1. Select aserver.
2. Click Edit.
The Scan Wizard opens.
3. Change the settings.
4. Click Finish (on the Edit Basic Scan window).

To delete a server from the list:

1. Select aserver.
2. Click Delete.

Export a List

To save the "Hosts to Scan" list:

1. Click Export.
2. Using a standard file-selection window, specify the file name and location.

Start the Scan

To begin the enterprise scan, click Schedule. Each server's scan results will automatically be saved upon
completion in your default Scans folder. The name of the server, along with a date and time stamp, will
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be included in the file name.

Note: Fortify Weblnspect licenses permit users to scan specific IP addresses or a range of
addresses. If a server has an IP address that is not permitted by your license, that server will not be
included in the scan.

Running a Manual Scan

A manual scan (also referred to as Step Mode) is a Basic Scan option that allows you to navigate
manually to whatever sections of your application you choose to visit, using Firefox or Internet
Explorer. It does not crawl the entire site, but records information only about those resources that you
encounter while manually navigating the site. This feature is used most often to enter a site through a
Web form logon page or to define a discrete subset or portion of the application that you want o
investigate. Once you finish navigating through the site, you can audit the results to assess the security
vulnerabilities related to that portion of the site that you recorded.

To conduct a manual scan:

1. On the Fortify Weblnspect Start Page, select Start A Basic Scan.

2. Follow the instructions for configuring a Basic Scan as described in Basic Scan Wizard, selecting
Manual as the scan method. For more information, see "Running a Basic Scan" on page 152.

3. Click Scan.
4. When Firefox or Internet Explorer opens, use it to navigate through the site, visiting the areas you
want to record.
Note: If you want to visit cerfain areas of the application without recording the sessions,

return to Fortify Weblnspect and click the Pause button _u | displayed in the Step Mode view

of the Navigation pane. To resume recording sessions, click the Record button ' = |. For more
information, see "Navigation Pane" on page 55.

5. When done, close the browser.
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Fortify Weblnspect displays the Step Mode view in the Navigation pane, which lists the URL of
each resource you visited.

Audit Mode: | Manual Sudik

Browser: [Firefnx - ]

4

= .}"‘ htkp: ) fzero, webappsecurity . com)

.D htkps i fzero, webappsecurity  con
.D htkps i fzero, webappsecurity  con
D htkps i fzero, webappsecurity  con
.|:°j hkkps i fzero, webappsecurity  con

|:‘ htkps i fzero, webappsecurity  con

- .,_, htkps i fzero, webappsecurity  con

|53 http:fizero.webappsecurity . con

+-[W]E5] hitp:ffzero.webappsecurity. con

|53 http:fizero.webappsecurity . con
|53 http:fizero.webappsecurity.con
|53 http:fizero.webappsecurity.con
|53 http:fizero.webappsecurity.con
|53 http:fizero.webappsecurity.con
|53 http:fizero.webappsecurity.con
|53 http:fizero.webappsecurity.con
|53 http:fizero.webappsecurity.con
|53 http:fizero.webappsecurity.con
E htkp: ffzero webappsecarity, con

I I

-~

|__ﬁ htkp: ffzero. webappsecurity. con

5] site

H,_s Sequence

kﬂ%ﬂ Step Mode

LR

6. Do one of the following:

e To resume browsing the application, select a session and click Browse.

o To import the sessions into the scan, click Finish. You can exclude an individual session from the

7. To audit the recorded sessions, click %4t (on the toolbar).
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About Privilege Escalation Scans

Privilege escalation vulnerabilities result from programming errors or design flaws that grant an attacker
elevated access to an application and its data. Fortify Weblnspect can detect privilege escalation
vulnerabilities by conducting either a low-privilege or unauthenticated crawl followed by a high-
privilege crawl and audit in the same scan. Fortify Weblnspect includes a Privilege Escalation policy as
well as privilege escalation checks that can be enabled in other policies, including custom policies. In
Guided Scan, Fortify Weblnspect automatically detects when you have selected a policy with privilege
escalation checks enabled, and prompts you for the required login macro(s).

Two Modes of Privilege Escalation Scans

Fortify Weblnspect can perform privilege escalation scans in two modes, determined by the number of
login macros you use:

o Authenticated Mode - This mode uses two login macros: one for low-privilege access and one for
high-privilege access. In this mode, a low-privilege crawl is followed by a high-privilege crawl and
audit. You can perform this type of scan using Guided Scan. For more information, see "Running a
Guided Scan " on page 100.

Note: When using the Enhance Coverage of Your Web Site feature in Guided Scan in
conjunction with the Privilege Escalation policy, the explored locations are collected while
authenticated with the high-privilege login macro.

« Unauthenticated Mode - This mode uses only a high-privilege login macro. In this mode, the low-
privilege crawl is actually an unauthenticated crawl. Any privilege escalation detected during this scan
is moving from unauthenticated to high privilege. You can perform this type of scan using Guided
Scan (and providing only a high-privilege login macro) or the Basic Scan wizard. For more
information, see "Running a Basic Scan" on page 152.

What to Expect During the Scan

When conducting a scan with privilege escalation checks enabled, Fortify Weblnspect first performs a
low-privilege crawl of the site. During this crawl, the Site view is not populated with the hierarchical
structure of the Web site. Nor are vulnerabilities populated in the Summary pane. However, you can
confirm that the scan is actively working by clicking the Scan Log tab in the Summary pane. You will see
messages in the log indicating the "Scan Start" time and the "LowPrivilegeCrawlStart" time. When the
low-privilege crawl of the site is complete, the high-privilege crawl and audit phase of the scan occurs.
During this phase, the Site view will be populated and any vulnerabilities found will appear in the
Summary pane. For more information, see "Summary Pane" on page 92.

Regex Patterns Used to Identify Restricted Pages

If your site includes restricted pages that are blocked using text such as “Forbidden,” “Restricted,” or
“Access Denied,” the Privilege Escalation check includes a regex pattern that determines that these
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pages are forbidden for the current user. Therefore, these pages are not identified as being vulnerable
for privilege escalation. However, if your site uses other privilege restriction text that does not match
the built-in regex pattern, you must modify the regex to include your own text patterns. Otherwise, the
Privilege Escalation check may generate false positives for those pages.

Modifying Regex for Privilege Restriction Patterns
1. Click Edit > Default Scan Settings.

The Default Settings window appears.
2. Select Attack Exclusions in the Audit Settings group.
3. Click Audit Inputs Editor....
The Audit Inputs Editor appears
4. Select Check Inputs.
5. Select check 11388 Privilege Escalation.

The Privilege Restriction Patterns appear in the right pane. By default, the pattern is as follows:

‘forbidden|restricted|access\sdenied| (?:operation\snot\s
(?:allowed|permitted|authorized))|(?:you\s(?:do\snot|don’t)\shave\s
(?:access|permission|authorization))|(?:you\s(?:are\snot|aren’t)\s
(?:allowed|permitted|authorized))’

6. Using regex syntax, add any new forbidden action words that are used in your site.

7. Click OK to save the revised Check Inputs.
8. Click OK to close the Default Settings window.

Effect of Crawler Limiting Settings on Privilege Escalation Scans

Fortify Weblnspect audits each parameter value during a scan. Therefore, a Privilege Escalation scan is
sensitive to settings that limit the crawler, such as:

o Limit maximum single URL hits o

¢ Include parameters in hit count

o Limit maximum Web form submission to

o Perform redundant page detection

For example, if you set “Limit maximum single URL hits t0” 1 and the site contains links such as:

index.php?id=2
index.php?id=1
index.php?id=3
then during the high-privilege scan, Fortify Weblnspect finds “index. php?id=1" and during the low-

privilege scan, it finds “index. php?id=3". In this scenario, Fortify Weblnspect will mark
“index.php?id=1" with a Privilege Escalation vulnerability. This vulnerability will be a false positive.

For more information, see "Scan Settings: General" on page 313.
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Effect of Parameters with Random Numbers on Privilege
Escalation Scans

If the site contains parameters with random numbers, you can add the parameter to the list of HTTP
Parameters Used For State to exclude such sessions from audit and reduce the number of false
positives.

For example, for the following parameter:
index.php?_ =1440601463586

index.php?_=1440601465662
index.php?_ =1440601466365

you would add the parameter to the list of HTTP Parameters Used For State as shown below:

HTTP Parameters sed For Stake

Parameter Query Post Cuskam
. e
["] Enable CSRF

For more information, see "Scan Settings: HTTP Parsing " on page 329.
See Also

"Running a Basic Scan" on page 152

"Using the Predefined Template" on page 101

"Using the Mobile Scan Template" on page 117

"Using the Native Scan Template" on page 134

About Single-page Application Scans

This topic describes single-page application (SPA) support for crawling and auditing the Document
Object Model (DOM) of an application.

Important! This version of SPA support is provided as a technology preview.
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Technology Preview

Technology preview features are currently unsupported, may not be functionally complete, and are not
suitable for deployment in production. However, these features are provided as a courtesy and the
primary objective is for the feature to gain wider exposure with the goal of full support in the future.

The Challenge of Single-page Applications

Developers use JavaScript frameworks such as AngularJS, ExtJS, and Ember.js to build SPAs. These
frameworks make it easier for developers to build applications, but more difficult for security testers to
scan those applications for security vulnerabilities.

Traditional sites use simple back-end server rendering, which involves constructing the complete HTML
web page on the server side. SPAs and other “Web 2.0” sites use front-end DOM rendering, or a mix of
front-end and back-end DOM rendering. With SPAs, if the user selects a menu item, the entire page can
be erased and recreated with new content. However, the event of selecting the menu item does not
generate a request for a new page from the server. The content update occurs without reloading the
page from the server.

With traditional vulnerability testing, the event that triggered the new content might destroy other
events that were previously collected on the SPA for audit. Through its SPA support, Weblnspect
offers a solution to the challenge of vulnerability testing on SPAs.

Enabling SPA Support

When you enable SPA support, the DOM script engine finds JavaScript includes, frame and iframe
includes, CSS file includes, and AJAX calls during the crawl, and then audits all traffic generated by
those events.

You can enable SPA support in the scan settings or in Guided Scan.
See also

"Scan Settings: Content Analyzers" on page 318

"Using the Predefined Template" on page 101

"Using the Mobile Scan Template" on page 117

"Using the Native Scan Template" on page 134
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Scan Status

Unless otherwise specified, the scan status is read directly from the database. Scan statuses are
described in the following table.

Status Description

Running A scheduled scan or a scan initiated through the command-line interface (CLI) is
currently running on the local machine.

Locked Another instance of Fortify Weblnspect has initiated the scan, which is running and its
heartbeat has not expired.

Note: Applies to remote SQL Server (full version) only.

Open A user on the local machine has the scan open in Fortify Weblnspect. The user may be
the current user (in which case, the scan can be seen on the Scan tab) or it may be
another user on the same machine (when using Terminal services, for example). The
state stored in the scan database is ignored.

Interrupted = The Fortify Weblnspect or CLI instance that was last using the scan crashed. The
following conditions must be met:

¢ The remote database has a status of "Running."
e The heartbeat has expired.

e Thescan is not open on the local machine.
Incomplete = The user has paused the scan and closed it. It has not finished running.

Complete The scan has finished.

Updates to Information in the Scan Manager

The scan manager is not intended to give real-time status information on any of the scans currently
being displayed, with three notable exceptions:

o A new scan has been created or opened. In this case, the scan manager will list the new scan with a
status of Open.

o A scan that was previously opened by the current user is closed. For example, a user opens/creates a
scan, then closes it. The status in the scan manager for the scan is updated to reflect the status of the
scan at the fime it was closed (for example, Completed, Incomplete, etc.). All statistics will be
refreshed for the single scan only.

o The duration field is not always accurate or available while a scan is open. Therefore, when a scan is in
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the Open, Running, or Locked state, the Duration column will show that the value is unavailable
(instead of a number the user will see "-".

To see any other status changes or updated count information, the user MUST click the refresh button.
See Also

"Scheduled Scan Status " on page 201

Opening a Saved Scan

Use one of the following procedures to open a saved file containing the results of a previous scan.
Using the Menu or Tool bar:

o Click File > Open > Scan.
o Click the drop-down arrow on the Open button and select Scan.
From the Start Page tab:

o Click Start a Basic Scan.
e On the Home pane, click an entry in the Recently Opened Scans list.
+ On the Manage Scans pane, select a scan and click Open (or double-click the scan name).

Fortify Weblnspect loads the scan data and displays it on a separate tab.

Comparing Scans

You can compare the vulnerabilities revealed by two different scans of the same target and use this
information to:

o Verify fixes: Compare vulnerabilities detected in the initial scan with those in a subsequent scan of the
same site after the vulnerabilities were supposedly fixed.
¢ Check on scan health: Change scan settings and verify that those changes expand the attack surface.

o Find new vulnerabilities: Determine if new vulnerabilities have been intfroduced in an updated version
of the site.

¢ Investigate Issues: Pursue anomalies such as false positives or missed vulnerabilities.

« Compare authorization access: Conduct scans using two different user accounts to
discover vulnerabilities that are unique or common to both accounts.

Note: Data from both scans must be stored in the same database type (SQL Server Express Edition
or SQL Server Standard/Enterprise Edition).

Selecting Scans to Compare Scans

To compare two scans, do one of the following:
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o Fromthe Manage Scans page, select fwo scans and click Compare.
o From a tab containing an open scan (which will be Scan A in the comparison):

a. Click Compare.

b. Select a scan from the list on the Scan Comparison window. This scan will be Scan B in the

comparison.
c. Click Compare.

Note: If the open scan is a "site retest" (resulting from Rescan > Retest Vulnerabilities), Fortify
Weblnspect automatically selects the parent scan for comparison. For example, if you created a
scan named "zero," and then verified vulnerabilities for that scan, the resulting scan would be
named (by default) "site retest - zero." With the retest scan open, if you select Compare, Fortify

Weblnspect will compare "site retest - zero" with the parent scan "zero."

A warning message appears if the selected scans have different start URLs or used different scan
policies, or if the scans are of a different type (such as a Basic Scan vs. a Web service scan). You can

choose to continue, or you can terminate the function.
You cannot conduct a comparison if either of the scans is currently running.
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Reviewing the Scan Dashboard
The Scan Dashboard displays the scan comparison results.
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Scan Descriptions

-~ Scan A: Workflow: hittp://198.90.21.104/

Date: 8/6/2014 12:39:55 PM
Policy: Standard

Issues: 53

Unique/Total: 13 f 33

Coverage: 60.61 % Overlap

The Scan A and Scan B boxes provide the following information of the scans:

o Scan A or Scan B: Name of the scan.
« Date: Date and time the original scan was conducted.
¢ Policy: Policy used for the scan; see "Fortify Weblnspect Policies" on page 394 for more information.

o Issues: Total number of issues identified on the Vulnerabilities tab, the Information tab, and the Best
Practices tab, as well as false positives detected.

« Unique/Total: Number of unique sessions created for this scan (that is, the number of sessions that
appear in this scan and not the other scan), compared to the total number of sessions for this scan.

« Coverage: Percentage of sessions that are common to both scans.

The Venn Diagram

The Venn diagram depicts the session coverage of Scan A (represented by a yellow circle) and the
session coverage of Scan B (represented by a blue circle). The intersection of the two sets is
represented by the green overlap. (In prior releases, the Venn diagram represented the overlap of
vulnerabilities.)

The Venn diagram is scaled to reflect the actual relationship between the sets.

Several examples of session coverage overlap are illustrated below.

C0De9®

No Intersection 50% Intersection = A Encompasses Most of A Complete
B Intersects B Intersection

Vulnerabilities Bar Chart

In separate groupings for each vulnerability severity and for False Positives, the bottom of the Scan
Dashboard displays a set of bar charts that show the number of vulnerabilities found in Scan A, in Scan

Micro Focus Fortify Weblnspect (18.10) Page 187 of 427



User Guide
Chapter 4: Working with Scans

B, and in their intersection (Intersect). The same color coding is used as in the Venn diagram. These bar
charts do not change based on the selected Compare Mode.

Effect of Scheme, Host, and Port Differences on Scan Comparison

Fortify Weblnspect does not ignore the scheme, host, and port when comparing scans from two
duplicate sites that are hosted on different servers.

For example, the following site pairs would not be correlated in a scan comparison because of
differences in scheme, host, or port:

o Scheme
o Site A - http://zero.webappsecurity.com/

o Site B - https://zero.webappsecurity.com/

o Host
o Site A - http://dev.foo.com/index.html?parl=123&par2=123

o Site B - http://qa.foo.com/index.html?parl=123&par2=123

o Port
o Site A - http://zero.webappsecurity.com:80/

o Site B - http://zero.webappsecurity.com:8080/

Compare Modes

You can select one of the following options in the Compare Mode section to the left of the Scan
Dashboard to display different data in the Sequence area in the left pane (the data in the Scan
Dashboard is not affected):

o Mutual Exclusion: Lists sessions that appear in Scan A or Scan B, but not in both scans
e Only In A: Lists sessions that appear only in Scan A

o Only in B: Lists sessions that appear only in Scan B

o Union (the default): Lists sessions that appear in Scan A, Scan B, or both Scans A & B

Session Filtering

The Sequence pane lists each session that matches the selected Compare Mode. An icon to the left of
the URL indicates the severity of the vulnerability, if any, for that session. The severity icons are:

Critical High = Medium  Low

2 e v 9
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At the top of the Sequence pane, you can specify a filter and click Filter to limit the set of displayed
sessions in the following ways:

« You can enfer the URL with only its starting characters, as a "starts with" match. Your entry must
begin with the protocol http:// or https://).

¢ You can search for an exact match by specifying the URL in quotes. Your entry must begin with the
quotes and protocol (*http:// or "hitps://)

¢ You can use an asterisk (*) as a wildcard character at the beginning or end of the string you enter.

¢ You can use asterisks (*) at both the beginning and end of the string you enter, which requires
matches to contain the string between the asterisks.

¢ You can enter a question mark (?) followed by a full query parameter string to find matches to that
query parameter.

Using the Session Info Panel

When you select a session in the Sequence pane, the Session Info panel opens below the Compare
Mode options. With a session selected, you can select an option in the Session Info panel to display
more details about that session to the right of the Session Info panel. If the session contains data for
both scans, the data for some functions such as Web Browser, HTTP Request, and Steps are shown in
a split view with Scan A on the left side and Scan B on the right side.

Note: The Steps option displays the path taken by Fortify Weblnspect to arrive at the session
selected in the Sequence pane or the URL selected in the Summary pane. Beginning with the
parent session (at the top of the list), the sequence reveals the subsequent URLs visited and
provides details about the scan methodology. In a scan comparison, if any of the steps for the
session are different between the scans, the In Both column is added to the Steps table (as the first
column). A value of Yes in the column for a particular step indicates that the step is the same for
that session for both scans A and B. A value of No in the column for a particular step indicates that
the step is different for that session between scans A and B.

Using the Summary Pane to Review Vulnerability Details

When comparing scans, the horizontal Summary pane at the bottom of the window provides a
centralized table of vulnerable resources and allows you to quickly access vulnerability information. You
can drag the horizontal divider above the table to show or hide more of the Summary pane.

The Vulnerabilities tab at the bottom of the page is selected by default. The Information and Best
Practices tabs display analogous data.

The set of entries (rows) displayed in the table depends on the option selected for Compare Mode, as
reflected in the Link column in the table.

Grouping and Sorting Vulnerabilities

For information on grouping and sorting vulnerabilities, see "Summary Pane" on page 92 and "Using
Filters and Groups in the Summary Pane" on page 228.
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Filtering Vulnerabilities

You can click the filter icon () at the right of any column heading to open a filter that allows you to
choose a variety of conditions regarding that column that must be met in order for a vulnerability (row)
to remain listed in the table after filtering. The available conditions include the full set of current values
in the column, and you can also specify logical expressions regarding the content of that column.

For example, in the filter for the Vuln Parameter column, suppose you:

1. Leave the top set of check boxes as is.

2. Below the Show rows with value that text, select Contains from the drop-down menu.
3. Typeldin the text box below the drop-down menu.

4, Click Filter.

Then the table will show only rows that contain the text "Id" in the Vuln Parameter column. This would
include rows for which the value of Vuln Parameter is accountld or payeeld or any other entry that
includes "Id."

You can specify filters for multiple columns, one column at a time, and they will all be applied.

If a filter for a column has been specified, its icon becomes a darker blue than the icons for unused
filters.

To quickly clear afilter, click Clear Filter while the filter is open to be specified.

Working with Vulnerabilities

Right-clicking an item in the Summary pane displays a shortcut menu containing the following
commands:

e Copy URL: Copies the URL to the Windows clipboard.

o Copy Selected Item(s): Copies the text of selected items to the Windows clipboard.

o Copy All Items: Copies the text of all items to the Windows clipboard.

« Export: Creates a comma-separated values (csv) file containing either all items or selected items and
displays it in Microsoft Excel.

o View in Browser: Renders the HTTP response in a browser.

+ Review Vulnerability: Allows you to retest the vulnerability. If the vulnerability was detected in only
one scan, the Vulnerability Review window opens; if the vulnerability was detected in both scans, you
are first prompted to select a scan. See "Reviewing a Vulnerability " on page 233 for more
information.

Note: For Post and Query parameters, click an entry in the Parameters column to display a more
readable synopsis of the parameters.

See also
"Summary Pane" on page 92

"Using Filters and Groups in the Summary Pane" on page 228
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Manage Scans

To manage scans:

1. On the Start Page, click Manage Scans.

mm Manage Schedule ]

A list of scans appears in the right-hand pane of the Start Page.

By default, Fortify Weblnspect lists all scans saved in the SQL Server Express Edition on your
machine and in SQL Server Standard Edition (if configured). The current state of the scan is
indicated in the Status column. For more information, see "Scan Status " on page 184.

2. (Optional) To group scans into categories based on the column headings, drag the heading and
drop it on the grouping area.

3. Use the toolbar buttons to perform the functions listed below.

To open scans, select one or more scans and click Open (or simply double-click an entry in the
list). Fortify Weblnspect loads the scan data and displays each scan on a separate tab.

To launch the Scan Wizard prepopulated with settings last used for the selected scan, click
Rescan > Scan Again.

To reuse a scan, click Rescan and select the reuse option you want from the drop-down menu.
For more information, see "Reusing Scans" on the next page.

To rescan only those sessions that contained vulnerabilities revealed during a previous scan,
select a scan and click Rescan > Retest Vulnerabilities.

To merge scans, select two scans (using Ctrl + click), right-click and select Merge. For more
information, see "Incremental Scan" on page 193.

To rename a selected scan, click Rename.
To delete the selected scan(s), click Delete.
To import a scan, click Import.

To export a scan or scan details, or to export a scan to Software Security Center, click the drop-
down button on Export.

To compare scans, select two scans (using Ctrl + click) and click Compare.

By default, Fortify Weblnspect lists all scans saved in the local SQL Server Express Edition and in
a configured SQL Server Standard Edition. To select one or both databases, or to specify a SQL
Server connection, click Connections.

When necessary, click Refresh to update the display.

To select which columns should be displayed, click Columns. You can rearrange the order in
which columns are displayed using the Move Up and Move Down buttons or, on the Manage
Scans list, you can simply drag and drop the column headers.
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Note: You can also perform most of these functions by right-clicking an entry and selecting a
command from the shortcut menu. In addition, you can also choose to generate a report. For more
information, see "Generating a Report" on page 248.

See Also
"Managing Scheduled Scans " on page 197
"Start Page " on page 46

Reusing Scans

Reusing a scan uses data from a previous scan to assist a new scan. Two scans are involved when
conducting a reuse scan:

e Thereuse scan is the new scan being conducted.

e The source or baseline scan is the scan from which data is used to reduce the work and time needed
to complete a reuse scan.

Reuse Options

Four options for scan reuse are available:

¢ Reuse Incremental — find new attack surface. This scan performs a normal crawl and compares each
session to the baseline scan. Only new sessions that did not exist in the baseline scan are audited. For
more information, see "Incremental Scan" on the next page.

+ Reuse Crawl — import the crawl sessions from the baseline scan. This scan does not perform a crawl,
but performs an audit on all sessions from the baseline scan.

+ Reuse Remediation — look for vulnerabilities that were found in the baseline scan. This scan creates
a policy that includes only those checks that flagged in the baseline scan, and audits the site again
using this custom policy. Therefore, this scan looks at only the checks that flagged in the baseline
scan.

+ Reuse Crawl Remediation — reuse the crawl from the baseline scan. This scan uses the crawl from
the baseline scan to look for vulnerabilities that were found in the baseline scan.

Difference between Remediation Scans and Retest Vulnerability

Remediation scans apply a reduced policy that is derived directly from the flagged vulnerabilities in the
baseline scan to all sessions in the remediation scan, rather than to just the sessions that were
vulnerable in the baseline scan.

For example, a baseline scan found cross-site scripting (XSS) on session A but not session B.
Subsequently, XSS was fixed on session A, but created on session B. Using the Retest Vulnerabilities
option will not find the vulnerability on session B, but a remediation scan will find it. Therefore, a
remediation scan will evaluate all of the known attack surface area for previously found vulnerabilities.
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Guidelines for Reusing Scans

Follow these guidelines when reusing scans:

e The baseline scan must be available on the machine where the reuse scan is executed.

e The baseline scan does not need to be in the same database as the reuse scan.

Reusing a Scan

To reuse a scan:

1. Do one of the following:

o Froman open scan, click Rescan and select the reuse option you want from the drop-down
menu.

« On the Manage Scans page, right-click a scan, click Rescan, and then select the reuse option you
want from the menu.

¢ Onthe Manage Scans page, select a scan, click Rescan and select the reuse option you want
from the drop-down menu.

For information about the rescan options, see "Reuse Options" on the previous page.
2. Using the Scan Wizard, you may optionally modify the settings that were used for the original scan.
Tip: For incremental scans, it might be beneficial to change settings to discover new attack

surface. However, changing settings is not recommended for remediation scans.

Note: By default, the type of reuse scan you selected is prepended to the baseline scan name
and a-1is appended to the end.

3. On the last step of the Scan Wizard, click Scan.
See Also
"Incremental Scan" below

"Reviewing and Retesting" on page 243

Incremental Scan

Incremental scanning provides a way for you to find and audit the areas of your web application that
change over time, while keeping all findings in a single scan. This involves performing incremental scans
and merging these scans back into the baseline scan. For more information about incremental scans and
baseline scans, see "Reusing Scans" on the previous page.
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Merging Baseline and Incremental Scans

You can merge the baseline scan and the incremental scan into a single scan. Then you can use the
aftack surface of the combined scans for future incremental scans.

After conducting an incremental scan, if you select the incremental scan and the baseline scan and then
right click, you will see a Merge option.

Important! You must click the baseline scan from which the incremental scan was derived to see
the Merge option enabled.

When you click Merge, the incremental scan is merged into the baseline scan. The baseline scan now
contains the union of the 2 scans. After merging, the resulting scan becomes the new baseline scan. You
can continuously perform incremental-merge-incremental-merge indefinitely to create a process for
continuous or deferred auditing. For more information, see "Incremental Scan with Continuous or
Deferred Audit" below.

To merge scans:

1. Inthe Manage Scans page, select the baseline scan and the incremental scan.
2. Right-click and select Merge.

Log enfries, including the baseline and incremental scan IDs, are written fo the scan log when scans are
merged.

Incremental Scan with Continuous or Deferred Audit

Incremental scanning provides the ability to perform continuous audit or deferred audit.
Incremental with Continuous Audit

With incremental scanning, you can put in place a process for continuous audit. This process would be
as follows:

1. Create a baseline scan.

2. When an incremental scan is needed:

a. Create an incremental audit scan from the baseline scan. During this scan, new surface is
audited.

b. Merge the incremental scan with the baseline scan. The merged scan becomes the new baseline
scan. For more information, see "Merging Baseline and Incremental Scans" above.

Delete the incremental scan.
d. Returnto Step 2.
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Incremental with Deferred Audit

With incremental scanning, you can put in place a process for deferred audit. This process would be as
follows:

1. Create a baseline scan.
2. When a new incremental scan is needed:
a. Create an incremental crawl-only scan from the baseline scan.

b. Merge the incremental scan with the baseline scan. The merged scan becomes the new baseline
scan. For more information, see "Merging Baseline and Incremental Scans" on the previous
page.

c. Delete the incremental scan.

d. If new attack surface is found, resume the baseline audit and audit the new surface.

e. Returnto Step 2.

See Also

"Reusing Scans" on page 192

Schedule a Scan

You can schedule a Basic Scan, a Web Service Scan, or an Enterprise Scan to occur at a date and time of
your choosing.

The options and settings you select are saved in a special file and accessed by a Windows service that
starts Fortify Weblnspect (if necessary) and initiates the scan. It is not necessary for Fortify Weblnspect
to be running at the time you specify for the scan o begin.

Note: To access scheduled scans after they are complete, select the Start Page tab and click
Manage Scans.

To schedule a scan:

1. Do one of the following:
o Click the Schedule icon on the Fortify Weblnspect toolbar.

o Click Manage Scheduled Scans on the Fortify Weblnspect Start Page.

2. When the Manage Scheduled Scans window appears, click Add.
3. Inthe Type of Scan group, choose one of the following:
« Basic Scan

e Web Service Scan
o Enterprise Scan

4. To conduct the scan one time only, select Run Once and then edit the Start Date and Time. If you
click the drop-down arrow, you can use a calendar to select the date.
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5. To scan a site periodically:

a. Select Recurring (or Recurrence Schedule), then specify the start fime and choose a
frequency: Daily, Weekly, or Monthly.

b. If you select Weekly or Monthly, provide the additional requested information.
6. Click Next.
See Also

"Running a Basic Scan" on page 152
"Running a Web Service Scan "on page 149
"Running an Enterprise Scan " on page 175

"Configuring Time Interval for Scheduled Scan " below

Configuring Time Interval for Scheduled Scan

To configure when to run a scan or to set up recurring scans:

1. Inthe Type of Scan group, choose one of the following:
e BasicScan

o Web Service Scan
e Enterprise Scan

2. To conduct a scan now, select Immediately.
3. To conduct a one-time-only scan at a later date or fime:
a. Select Run Once.
b. Modify the date and time when the scan should begin.

Tip: Click the drop-down arrow to reveal a calendar for selecting the date.
4. To scan a site periodically:
a. Select Recurring.
b. Specify the time when the scan should start.
¢. Choose a frequency: Daily, Weekly, or Monthly.

5. Click Next.
See Also

"Running a Basic Scan" on page 152
"Enter a name for the scan in the Scan Name box." on page 149

"At this point, you can perform one or more of the following functions:" on page 175
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Managing Scheduled Scans

You can instruct Fortify Weblnspect to conduct a scan at a time and date you specify. The options and
settings you select are saved in a special file and accessed by a Windows service that starts Fortify
Weblnspect (if necessary) and initiates the scan. It is not necessary for Fortify Weblnspect to be running
at the time you designate the scan o begin.

Note: Scheduled scans, when complete, do not appear in the Recent Scans list that displays on the
Fortify Weblnspect Start page. To access scheduled scans after they are complete, select the Start
page and click Manage Scans.

On the Start Page, click Manage Schedule.

Home | Manage Scans mﬂﬂgﬁ_{ﬂgj]

A list of scans you previously scheduled appears in the right-hand pane of the Start Page.

The current state of the scan is indicated in the Status column. For more information, see "Scheduled
Scan Status " on page 201.

You can perform the following tasks:

Delete a Scan

o To delete a scan from the list, select a scan and click Delete.

Edit Scan Settings

¢ To edit settings for a scheduled scan, select a scan and click Edit.

Run a Scan Immediately

o To run a scan immediately, without waiting for the scheduled time, select a scan and click Start (or
right-click a scan and select Start Scan from the shortcut menu). As with all scheduled scans, the
scan runs in the background and does not appear on a tab.

Stop a Scheduled Scan

e To stop a scheduled scan, select a scan that is running and click Stop (or right-click a running scan
and select Stop Scan from the shortcut menu).

Schedule a Scan

To schedule a scan:

1. Click Add.
2. Inthe Type of Scan group, choose one of the following:

e BasicScan

e Web Service Scan

Micro Focus Fortify Weblnspect (18.10) Page 197 of 427



User Guide
Chapter 4: Working with Scans

o Enfterprise Scan

3. Specify when you want to conduct the scan. The choices are:
o Immediately

¢ Run Once: Modify the date and time when the scan should begin. You can click the drop-down
arrow to reveal a calendar for selecting the date.

o Recurrence Schedule: Use the slider to select a frequency (Daily, Weekly, or Monthly). Then
specify the time when the scan should begin and (for Weekly or Monthly) provide other
schedule information.

4. Click Next.
5. Enter the settings for the type of scan you selected.

6. For Web Site and Web Service Scans only, you can elect to run a report at the conclusion of the
scan:

a. Select Generate Reports and click the Select Reports hyperlink.
b. Confinue with Selecting a Report (below).
7. To schedule the scan without generating a report, click Schedule.

Selecting a Report

If you opted to include a report with the scheduled scan, the Scheduled Scan Report Wizard appears:

Scheduled Scan Report Wizard (Step 1 of 2) Image
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'_'_._J Scheduled Scan Report Wizard @
Select a Report
: : Step 1 of 2

Select the reports yeu would like to run after the scan finishes

Favorites: [ >
Standard Reports Alert View L]
[C] Aggregate There are no inputs for this report.

Alert View

[] Attack Status Crawled URLS &

Compliance Included Session Details:
Crawled URLS
Cookies

[T] Developer Reference

[F] Duplicates PostData

[ Executive Summary [ Request

False Positive ["] Response

[C] QA Summary False Positive %
[] Scan Difference

[[] Scan Lag Included Session Details:

[E] Trend Request

[0 vulnerability Response

[T Vulnerability (Legacy) Stack Trace (if available)

Next > ] [ Cancel

1. (Optional) Select a report from the Favorites list.

A "favorite" is simply a named collection of one or more reports and their associated parameters. To
create a favorite once you have selected reports and parameters, click the Favorites list and select

Add to favorites.

Select one or more reports.

Provide information for any parameters that may be requested. Required parameters are outlined

in red.
4, Click Next.

The Configure Report Settings window appears.

Configuring Report Settings

Scheduled Scan Report Wizard (Step 2 of 2) Image
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'__._J Scheduled Scan Report Wizard @

Configure Report Settings

Step 2 of 2

Select options below to use when generating the report(s)

Options
Automatically generate filename | autc-gen-filename Export Format: |PDF = |

[C] Aggregate reports into one report

Headers and Footers
Header/Footer Report: | HP Default bl

Caver page title: Web Application Assessment Report

Cover page Company:

[T] Use custom image
Cover page image:

[[] Use custom image
Footer logo image:

F_DRTIF\

[ < Back | [ Finished ] [ Cancel |

1. If you select Automatically Generate Filename, the name of the report file will be formatted as
<reportname> <date/time>.<extension>. For example, if creating a compliance report in pdf
format and the report is generated at 6:30 on April 5, the file name would be "Compliance
Report 04_05_2009 06_30.pdf." This is useful for recurring scans.

Reports are written o the directory specified for generated reports in the Application settings.

2. If you did not select Automatically Generate Filename, enter a name for the file in the Filename
box.

3. Select the report format from the Export Format list.

If you selected multiple reports, you can combine then all info one report by selecting Aggregate
reports into one report.

5. Select a template that defines the headers and footers used for the report and, if necessary,
provide the requested parameters.

6. Click Finished.
7. Click Schedule.
See Also

"Start Page " on page 46
"Manage Scans "on page 191

"Scheduled Scan Status " on the next page
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Stopping a Scheduled Scan

To halt a scheduled scan while it is running, select the scan from the Manage Schedule list and click

e =il (or right-click the scan and select Stop Scan from the shortcut menu).

To restart a stopped scan, select the scan from the Manage Schedule list and click Start (or right-
click the scan and select Start Scan from the shortcut menu).

Scheduled Scan Status

The status of each scheduled scan appears in the Last Run Status column on the Manage Schedule
pane. The possible statuses are defined in the following table.

Status Definition

Failure Fortify Weblnspect was unable to perform the scan.

Success The scan was conducted without error.

Not Yet Run The scan is queued to run at the scheduled time, which has not yet occurred.

Skipped The scheduled scan was not run because the service was down for some period
of time.

Stopping The user clicked the Stop button, but the scan has not yet stopped.

Stopped The scan has been stopped by the user.

Running The scheduled scan is in progress.

Running with The scan could not stop; see log for further details.

Error

Exporting a Scan

Use the Export Scan function to save information collected during a Fortify Weblnspect crawl or audit.

Note: When exporting to Fortify Software Security Center, after exporting to the .fpr format, you
must manually upload the .fpr file to Fortify Software Security Center. Fortify does not support
uploading both Fortify Weblnspect FPR artifacts and Fortify Weblnspect Enterprise FPR artifacts
to the same project version in Fortify Software Security Center.
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Follow the steps below to export a scan.

1. Do one of the following:

¢ Open ascan (or click a tab containing an open scan), click File > Export and select either Scan
or Scan to Software Security Center

¢ Onthe Manage Scans pane of the Start page, select a scan, click the drop-down arrow on the
Export button and select either Export Scan or Export Scan to Software Security Center.

The Export a Scan window (or the Export Scan to Software Security Center window) appears.

r ~N
Export a Scan u—J@ X
Scrub Data
Type Replace Match Add
D S55M EEEC S M A Edit
7] Credit Card  XO00OOGOCOMXO0 NJA =

[[] 1P Address  XXXOOLI00CKXK NJA

Attachments
Add
Delete
[/] Bxport Logs Export “ Cancel
Ready

L

2. The Scrub Data group contains, by default, three non-editable regular expression functions that
will substitute X's for each digit in a string formatted as a Social Security number, credit card
number, or IP address. To include a search-and-replace function, select its associated check box.
This feature prevents any sensitive data from being included in the export.

3. To create a Scrub Data function:
a. Click Add.
b. On the Add Scrub Entry window, select either Regex or Literal from the Type list.

¢. Inthe Match box, enter the string (or a regular expression representing a string) that you want

to locate. If using a regular expression, you can click the ellipsis button . to open the Regular
Expression Editor, with which you can create and test your regular expression.

d. Inthe Replace box, enter the string that will replace the target specified by the Match string.
e. Click OK.
4, If you are exporting to Software Security Center, go to Step 7.
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5. If you want o include an attachment:
a. Inthe Attachments group, click Add.

b. Using the standard file-selection window, navigate to the directory that contains the file you
want to aftach.

c. Select afile and click Open.
6. Toinclude the scan's log files, select Export Logs.
7. Click Export.
8. Using the standard file-selection window, select a location and click Save.
See Also

"Importing a Scan " on page 207

"Exporting Scan Details " below

Exporting Scan Details

Use this function to save information collected during a Fortify Weblnspect crawl or audit.

1. Open ascan, or click a tab containing a scan.
2. Click File > Export > Scan Details.

The Export Scan Details window appears.
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Export Scan Details

Settings
Detals ||:|:Imments v| Plese select the details to export and the format
Expart Format: iXML " | to uze.

Details Description

Ewxpartz all comments located within responzes. Comments include:
HTML Comments: <l-- my comment -

C ztyle commentz: /¢ My comment’ or ' My comment "

Maote: Commentz are bazebd encoded when exported in ML

Scrub Data
Type Replace M atch [ &dd ]
[]i55M PSSR I A, Edit
(] Credit Card soidddiddddddd N
] 1P Address sl bl b M A
Export ][ Cancel ]
Ready

3. From the Details list, select the type of information you want to export. The options are as follows:

Micro Focus Fortify Weblnspect (18.10)

Comments
Emails

Full (all details)
Hidden Fields
Offsite Links
Parameters
Requests
Script
Sessions

Set Cookies

URLs
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o Vulnerabilities
o Web Crawl Dump
o Site Tree Dump

e Web Forms
Note: Not all choices are available for a Web Service scan.

4, Choose a format (either Text or XML) from the Export Format list.

5. The Scrub Data group contains, by default, three non-editable regular expression functions that
will substitute X's for each digit in a string formatted as a Social Security number, credit card
number, or an IP address. To include this search-and-replace function for a data type, select its
associated check box. This feature prevents any sensitive data from being included in the export.

6. To create a Scrub Data function:
a. Click Add.
b. On the Add Scrub Entry window, select either Regex or Literal from the Type list.

¢. Inthe Match box, enter the string (or a regular expression representing a string) that you want

to locate. If using a regular expression, you can click the ellipsis button i to open the Regular
Expression Editor, with which you can create and test your regular expression.

d. Inthe Replace box, enter the string that will replace the target specified by the Match string.
e. Click OK.
7. Click Export.

8. Using a standard file-selection window, specify a name and location for the exported file and click
Save.

See Also

"Exporting a Scan "on page 201

Export Scan to Software Security Center

This feature allows you to export the results of a Fortify Weblnspect scan in a format (fpr format) that
can be consumed by Fortify Software Security Center.

Note: After exporting to the .fpr format, you must manually upload the .fpr file to Fortify Software
Security Cenfter. Fortify does not support uploading both Fortify Weblnspect FPR artifacts and
Fortify Weblnspect Enterprise FPR artifacts to the same project version in Fortify Software Security
Center.

1. Do one of the following:

¢ Open a scan (or click a tab containing an open scan) and click File > Export > Scan to
Software Security Center.

¢ On the Manage Scans pane of the Start page, select a scan, click the drop-down arrow on the
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Export button and select Export Scan to Software Security Center.

The Export Scan to Software Security Center window appears.

2. The Scrub Data group contains, by default, three non-editable regular expression functions that
will substitute X's for each digit in a string formatted as a Social Security number, credit card
number, or IP address. To include a search-and-replace function, select its associated check box.
This feature prevents any sensitive data from being included in the export.

3. To create a Scrub Data function:
a. Click Add.
b. On the Add Scrub Entry window, select either Regex or Literal from the Type list.

¢. Inthe Match box, enter the string (or a regular expression representing a string) that you want

to locate. If using a regular expression, you can click the ellipsis button .. to open the Regular
Expression Editor, with which you can create and test your regular expression.

d. Inthe Replace box, enter the string that will replace the target specified by the Match string.
e. Click OK.
4. Click Export.

5. Using the standard file-selection window, select a location and click Save.

Exporting Protection Rules to Web Application
Firewall

To generate and save a full export (.xml) file based on vulnerabilities detected by Fortify Weblnspect
during a scan of your web application:

1. Open the scan of interest (or click a tab containing an open scan) and click File > Export >
Protection Rules to Web Application Firewall.

2. Specify the scrub data types in the same way as for the File > Export > Scan option. The Scrub
Data group contains, by default, three non-editable regular expression functions that will
substitute an X for each digit in a string formatted as a Social Security Number, credit card number,
or IP address. To include this search-and-replace function for a data type, select its associated
check box. This feature prevents any sensitive data from being included in the export.

3. Click Export.
4. Specify the path and filename to which you want to save the exported data and click Save.

A full export (.xml) file is saved as you specified.
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Importing a Scan

To import a scan:

1. Click File > Import Scan.
2. Using a standard file-selection window, select an option from the Files Of Type list:
¢ Scan files (*.scan) - scan files designed for or created by Fortify Weblnspect versions beginning
with 7.0.

o SPA files (*.spa) - scan files created by versions of Fortify Weblnspect prior to release 7.0.

3. Choose a file and click Open.
If attachments were exported with the scan, those attachments will be imported and saved in a

subdirectory of the imported scan. The default location is C: \Users\<username>\AppData\HP\HP

WebInspect\ScanData\Imports\<DirectoryName>\<filename>, where DirectoryName is the ID
number of the exported/imported scan.

See Also

"Exporting a Scan "on page 201

Importing False Positives

You can import from a previous scan a list of vulnerabilities that were analyzed as being false positive.
Fortify Weblnspect then correlates these false positives from a previous scan with vulnerabilities
detected in the current scan and flags the new occurrences as false positives.

Select a scan containing false positives from the same site you are now scanning.
Note: You cannot import false positives when scheduling a scan or conducting an Enterprise scan.

To import false positives:

1. Inthe scan currently being conducted, select False Positives in the Scan Info panel.
The Scan False Positives window appears.

2. Click Import False Positives.
The Select a Scan to Import False Positives window appears.

3. Select the checkbox(es) for the scan or scans from which you want to import false positives, and
click OK.

The Importing False Positives window appears, displaying the progress of the import.
4. When the import is complete, do one of the following:

o Click Details to view a log file for the import.

o Click Close to view the false positive(s) in the Scan False Positives window.
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Importing Legacy Web Service Scans

Fortify Weblnspect 10.00 and later offer minimal support for Web Service scans that were created with
versions of Fortify Weblnspect earlier than 9.00. These scans do not contain all the information
required to render them properly in the current user interface and will exhibit the following attributes:
e The tree view may not show the correct structure.

o Even if the operations do not appear in the tree view, the vulnerabilities will appear in the
vulnerability list. You should be able to select these vulnerabilities and view the vulnerability
information, as well as the request and the response.

« Nothing will display in the XmlGrid.

¢ The rescan functionality should launch the Web Services scan wizard and select the first option
having the selected WSDL already populated. This should force the Web Service Test Designer to
open on page 3.

o The "Vulnerability Review" feature should be disabled.

o Allreports should work as in previous Fortify Weblnspect releases.

e The Scan view should render in "ReadOnly" mode, which disables the Start, Audit and Current
Settings buttons.

Fortify recommends that you rescan your Web service.

Changing Import/Export Settings

If you require different settings for different scan actions, you can save your settings in an XML file and
load them when needed. You can also reload the Fortify Weblnspect factory default settings.

Tip: You can also create, edit, delete, import, and export scan settings files from the Manage
Settings window. Click Edit and select Manage Settings

To import, export, or restore settings:

1. Click Edit > Default Settings.
The Default Settings window appears.
2. To export setftings:
a. Click Save settings as (at the bottom of the left pane).
b. On the Save Scan Settings window, select a folder and enter a file name.
¢. Click Save.
3. To import settings:
a. Click Load settings from file (at the bottom of the left pane).
b. On the Open Scan Settings File window, select a file.
c. Click Open.
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4. Torestore factory default settings:
a. Click Restore factory defaults (at the bottom of the left pane).

b. When prompted to confirm your selection, click Yes.

Downloading a Scan from Enterprise Server

Use the following procedure to download a scan from the enterprise server (Fortify Weblnspect
Enterprise) to Fortify Weblnspect.
1. Click the Enterprise Server menu and select Download Scan.
2. Onthe Download Scan(s) window, select one or more scans from the list of available scans.
3. Click OK.

The downloaded scan is added to the list of scans on the Manage Scans pane. The scan date becomes
the date you downloaded the scan, not the date on which the site originally was scanned. For more
information, see "Manage Scans " on page 191.

Log Files Not Downloaded

Log files, including traffic session files, are not downloaded when downloading sensor scans from
Fortify Weblnspect Enterprise to Fortify Weblnspect. To obtain and view the log files for the scan, you
must manually export the scan from Fortify Weblnspect Enterprise and then import the scan into
Fortify Weblnspect. For more information, see "Importing a Scan " on page 207.

See Also

"Uploading a Scan to Enterprise Server" below

Uploading a Scan to Enterprise Server

Use the following procedure to upload a scan file from Fortify Weblnspect to an enterprise server
(Fortify Weblnspect Enterprise).
1. Click the Fortify Weblnspect Enterprise Server menu and select Upload Scan.
2. On the Upload Scan(s) window, select one or more Fortify Weblnspect scans from the Scan Name
column.

Note: To access scans in a different database, click Connections and, in the Database
application settings, change options under Connection Settings for Scan Viewing.

3. Foreach scan, select a Project and Project Version from the appropriate drop-down lists.

The program attempts to select the correct project and project version based on the "Scan URL" in
the scan file, but you may select an alternative.

4. Click Upload.
See Also
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"Downloading a Scan from Enterprise Server" on the previous page

Running a Scan in Enterprise Server

This feature is designed for users who prefer to configure a scan in Fortify Weblnspect rather than
Fortify Weblnspect Enterprise. You can modify the settings and run the scan in Fortify Weblnspect,
repeating the process until you achieve what you believe to be the optimal settings. You can then send
the open scan's settings to Fortify Weblnspect Enterprise, which creates a scan request and places it in
the scan queue for the next available sensor.

To run a scan in Weblnspect Enterprise:

1. Open ascan.

2. If you are not connected to an enterprise server, click the Enterprise Server menu and select
Connect to Weblinspect Enterprise.

3. Click the Scan menu and select Run in Weblnspect Enterprise (or simply click the appropriate
button on the toolbar).

4, On the Run Scan in Weblnspect Enterprise dialog box, enter a name for the scan.

B Run Scan in Weblnspect Enterprise

Scan Name:
Project: Bill Payment Processor v

Project Version: [11 w

[ OK ] [ Cancel ]

5. Select a Project and a Project Version.
6. Click OK.

If you pass all permission checks, the scan is created and the priority assigned to the scan is the highest
priority allowed by your role Cup to 3, which is the default).

Transferring Settings to/from Enterprise Server

Use this feature to:
o Create a Fortify Weblnspect Enterprise scan template based on a Fortify Weblnspect settings file and
upload it from Fortify Weblnspect to an enterprise server (Fortify Weblnspect Enterprise).

o Create a Fortify Weblnspect settings file based on an enterprise server scan template and download
it to Fortify Weblnspect.

Fortify Weblnspect settings files and Fortify Weblnspect Enterprise scan templates do not have the
same format; not all settings in one format are replicated in the other. Note the warnings that follow
descriptions of the conversion procedure.
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Creating a Fortify Weblnspect Enterprise Scan Template

To create a Fortify Weblnspect Enterprise scan template:

1.
2.

Click the Fortify Weblnspect Enterprise Server menu and select Transfer Settings.

On the Transfer Settings window, select a Fortify Weblnspect settings file from the Local Settings
File list.

(Optional) Click View to review the settings as they appear in a Fortify Weblnspect settings file. To
continue, click Close.

Note: This is a read-only file. Any changes you make will not be persisted.

Select the Project and Project Version to which the template will be transferred in Fortify
Weblnspect Enterprise.

5. If necessary, click Refresh to ensure the lists include the latest settings files and scan templates.

6. Enter the name of the scan template that will be created. You cannot duplicate the name of an

7.

existing template.
Click Upload.

All femplate settings that are not extracted from Fortify Weblnspect will use the Fortify Weblnspect
Enterprise template default settings.

The scan template will not specify the policy used by the Fortify Weblnspect settings file. Instead, it
will contain the "Use Any" option.

Any client cerfificate information that may be included in the Fortify Weblnspect settings file is
transferred to the scan template, but the certificates are not transmitted.

All Fortify Weblnspect settings are preserved in the scan template, even if they are not used by
Fortify Weblnspect Enterprise. Therefore, if you subsequently create a Fortify Weblnspect settings
file based on the scan template you created from the original settings file, the Fortify Weblnspect
settings will be retained.

Creating a Fortify Weblnspect Settings File

To create a Fortify Weblnspect settings file:

1.
2.

Click the Fortify Weblnspect Enterprise Server menu and select Transfer Settings.

Select the Project and Project Version from which the template will be transferred in Fortify
Weblnspect Enterprise.

On the Transfer Settings window, select a scan template from the list.

4. (Optional) Click View to review the settings as they would appear in a Fortify Weblnspect settings

file. To continue, click Close.

Note: This is a read-only file. Any changes you make will not be persisted.

5. If necessary, click Refresh to ensure the lists include the latest settings files and scan templates.

6. Click Download.

Micro Focus Fortify Weblnspect (18.10) Page 211 of 427



User Guide
Chapter 4: Working with Scans

7.

Using a standard file-selection window, name the settings file, select a location in which to save if,
and click Save.

The Fortify Weblnspect settings file will not specify the policy used by the scan template. Instead, it will
specify the Standard policy.

Publishing a Scan (Fortify Weblnspect Enterprise
Connected)

Note: This topic applies only if Fortify Weblnspect Enterprise is integrated with Fortify Software
Security Center.

Use the following procedure to transmit scan data from Fortify Weblnspect to a Fortify Software
Security Center server, via Fortify Weblnspect Enterprise.

Note: For information about managing the Fortify Software Security Center status of
vulnerabilities when conducting multiple scans of the same Web site or application, see "Integrating
with Fortify Weblnspect Enterprise and Fortify Software Security Center " on the next page.

1

Configure Fortify Weblnspect Enterprise and Fortify Software Security Center.

2. Runascan in Fortify Weblnspect (or use an imported or downloaded scan).

5.

Micro Focus Fortify Weblnspect (18.10)

Click the Enterprise Server menu and select Connect to Weblnspect Enterprise. You will be
prompted to submit credentials.

If a scan is open on a tab that has focus, and you want to publish only that scan:

a. Click ﬁﬁynchmnize

b. Select a project and version, then click OK.

¢. Examine the results. Columns will appear in the Summary pane specifying "Published Status"
and "Pending Status." The Published Status is the status of the vulnerability the last time this
scan was published to Fortify Weblnspect Enterprise. The Pending Status is what the status of
the vulnerability will be after this scan is published. Depending on the Pending Status, you can
modify it to specify whether the vulnerability has been resolved or is still existing (see Step 7
below). In addition, a new tab named "Not Found" appears; this tab contains vulnerabilities
that were detected in previous scans but not in the current scan. You can add screenshots and
comments to vulnerabilities or mark vulnerabilities as false positive or ignored. You can also
review and retest vulnerabilities, modifying the scan results until you are ready to publish.

—

d. Click [=/Publish G 10 step 7.

To select from a list of scans:

a. Click the Enterprise Server menu and select Publish Scan.

b. On the Publish Scan(s) to Software Security Center dialog box, select one or more scans.

c. Select a project and project version.
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d. Click Next. Fortify Weblnspect automatically synchronizes with Fortify Software Security
Center.

6. Fortify Weblnspect lists the number of vulnerabilities to be published, categorized by status and
severity.

To determine the status, Fortify Weblnspect compares previously submitted vulnerabilities
(obtained by synchronizing with Fortify Software Security Center) with those reported in the
current scan. If this is the first scan submitted to a project version, all vulnerabilities will be "New."

If a vulnerability was previously reported, but is not in the current scan, it is marked as "Not
Found." You must determine if it was not found because it has been fixed or because the scan was
configured differently (for example, you may have used a different scan policy, or you scanned a
different portion of the site, or you terminated the scan prematurely). When examining the results
(step 40), you can change the "pending status" of individual vulnerabilities detected by all but the
first scan (by right-clicking a vulnerability in the Summary pane). However, when publishing, you
must specify how Fortify Weblnspect should handle any remaining "Not Found" vulnerabilities.

To retain these "Not Found" vulnerabilities in Fortify Software Security Center (indicating that they
still exist), select Retain: Assume all vulnerabilities still marked "Not Found" in the scan are
still present.

To remove them (implying that they have been fixed), select Resolve: Assume all vulnerabilities
still marked "Not Found" in the scan are fixed.

7. If this scan was conducted in response to a scan request initiated at Fortify Software Security
Center, select Associate scan with an "In Progress" scan request for the current project
version.

8. Click Publish.

Integrating with Fortify Weblnspect Enterprise and
Fortify Software Security Center

Note: This topic applies only if Fortify Weblnspect Enterprise is integrated with Fortify Software
Security Center.

Fortify Software Security Center is a suite of tightly integrated solutions for idenftifying, prioritizing, and
fixing security vulnerabilities in software. It uses Fortify Static Code Analyzer to conduct static analysis
and Fortify Weblnspect to conduct dynamic application security testing. Fortify Weblnspect Enterprise
provides a central location for managing multiple Fortify Weblnspect scanners and correlating scan
results that can be published directly to individual project versions within Fortify Software Security
Center.
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Fortify Weblnspect Enterprise maintains a history of all vulnerabilities for a particular Fortify Software
Security Center project version. After Fortify Weblnspect conducts a scan, it synchronizes with Fortify
Weblnspect Enterprise to obtain that history, compares vulnerabilities in the scan with those in the
history, and then assigns a status fo each vulnerability. The statuses are described in the following
table.

Fortify Software

Security Center

Status Description

New A previously unreported issue.

Existing A vulnerability in the scan that is already in the history.

Not Found A vulnerability in the history that is not found in the scan. This can occur
because (a) the vulnerability has been remediated and no longer exists, or
(b) because the latest scan used different settings, or scanned a different
portion of the site, or for some other reason did not discover the
vulnerability.

Resolved A vulnerability that has been fixed.

Reintroduced A vulnerability that appears in a current scan but was previously reported
as "Resolved."

Still an Issue A vulnerability that was "Not Found" in the current scan does, in fact, exist.

To change the Fortify Software Security Center status for an individual vulnerability, right-click a
vulnerability on the Vulnerability tab and select Modify Pending Status. This option appears only
after connecting to Fortify Weblnspect Enterprise and is enabled only after you have synchronized
Fortify Weblnspect with Software Security Center.

The following example demonstrates a hypothetical series of scans for integrating vulnerabilities into
Fortify Software Security Center.

First scan

1. Scan the target site with Fortify Weblnspect. In this example, assume that only one vulnerability
(Vuln A) is discovered.

2. Examine the results. You can add screenshots and comments to vulnerabilities or mark
vulnerabilities as false positive or ignored. You can also review, retest, and delete vulnerabilities.

3. Synchronize the scan with a project version in Fortify Software Security Center, then publish the
scan.
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Second scan

1. The second scan again reveals Vuln A, but also discovers four more vulnerabilities (Vulns B, C, D,
and B).

2. Synchronize the scan with the project version in Fortify Software Security Center.

3. Now examine the results. If you added audit data (such as comments and screenshots) to Vuln A
when publishing the first scan, the data will be imported into the new scan.

4. Publish the scan to Fortify Software Security Center. Vuln A will be marked "Existing," Vulns B-E will
be marked "New," and five items will exist in the Fortify Software Security Center system.

Third scan

1. The third scan discovers Vulns B, C, and D, but not Vuln A or Vuln E.
2. Synchronize the scan with the project version in Fortify Software Security Center.

3. Afterretesting Vuln A, you determine that it does, in fact, exist. You change its pending status fo
"Still an Issue."

4. After retesting Vuln E, you determine that it does not exist. You change its pending status to
"Resolved."

5. Publish the scan to Fortify Software Security Center. Vulns B, C, and D will be marked
"Existing." Five items will exist in the Fortify Software Security Center system.

Fourth Scan

The fourth scan does not find Vuln A or Vuln B. The scan does find Vulns C, D, E, and F.
Synchronize the scan with the project version in Fortify Software Security Cenfer.
Vuln E was previously declared to be resolved and so its status is set to “Reinfroduced.”

F NP

You examine the vulnerabilities that were not found (A and B, in this example). If you determine
that the vulnerability still exists, update the pending status to “Still an Issue.” If a retest verifies that
the vulnerability does not exist, update the pending status to “Resolved.”

5. Publish the scan to Fortify Software Security Center. Vulns C and D remain marked "Existing."

Synchronize with Fortify Software Security Center

Note: This topic applies only if Fortify Weblnspect Enterprise is integrated with Fortify Software
Security Center.

Use this dialog box to specify a project and version and synchronize with Fortify Software Security
Center. Fortify Weblnspect then downloads a list of vulnerabilities from Fortify Software Security
Center, compares the downloaded vulnerabilities fo the vulnerabilities in the current scan, and assigns
an appropriate status (New, Existing, Reintroduced, or Not Found) to the vulnerabilities in the current
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scan. For detailed information, see "Integrating with Fortify Weblnspect Enterprise and Fortify Software
Security Center " on page 213.

To synchronize with Fortify Software Security Center:

1. Click Synchronize on the toolbar.
2. Select a project.

3. Select a project version.

4. Click OK.
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This chapter describes certain tools available in Fortify Weblnspect, such as the Server Profiler and
Unified Web Macro Recorder. It also describes how to inspect the scan results and work with
vulnerabilities discovered during the scan. It describes using the Weblnspect API, Regular Expressions,
and the Fortify Weblnspect policies. This chapter also includes information about Compliance
Templates and the reporting capabilities of Fortify Weblnspect.

For more information about all tools available in Fortify Weblnspect, see the Tools Guide for Fortify
Weblnspect Products.

Using Macros

Use the Web Macro Recorder tool to record login macros. A macro is a recording of the events that
occur when you access and log in to a website. You can subsequently instruct Fortify Weblnspect to
begin a scan using this recording. Macros that were recorded in a Basic Scan or a Guided Scan can be
used in either type of scan.

There are two types of macros:

¢ Alog-in macro is a recording of the events that occur when you access and log in to a Web site using
the event-based Web Macro Recorder. You can subsequently instruct Fortify Weblnspect to begin a
scan using this recording. You can specify a log-in macro when you select Site Authentication on
Step 2 of the Guided Scan Wizard.

o A workflow macro is a recording of HTTP events that occur as you navigate through a Web site using
the session-based Web Macro Recorder. Fortify Weblnspect audits only those URLs included in the
macro that you previously recorded and does not follow any hyperlinks encountered during the
audit. You can specify a workflow macro when you select a Workflows scan in the Guided Scan or
Basic Scan wizards.

Any activity you record in a macro will override the scan settings. For example, if you specify a URL in
the Excluded URL setting, and then you actually navigate to that URL when creating a macro, Fortify
Weblnspect will ignore the exclusion when it crawls and audits the site.

Note: When you play a macro, Fortify Weblnspect will not send any cookie headers that may have

been incorporated in the recorded macro. Macros that were recorded in a Basic Scan or a Guided
Scan can be used in either type of scan.

Using Selenium Macros

Fortify Weblnspect supports integration with Selenium browser automation. When you click the Import
button in Guided Scan, the Scan Wizard, or Authentication Scan Settings and select a Selenium macro to
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import, Fortify Weblnspect detects that a Selenium macro is being used. Fortify Weblnspect opens
Selenium and plays the macro.

For login macros, the macro must include a logout condition. If a logout condition does noft exist, you
can add one using the Logout Conditions Editor just as with any other macro. However, all other edits
must be done in the Selenium IDE.

During the replay, there is full-support of Selenium integration. This means that Fortify Weblnspect
does not record the sessions. Instead, it opens a new Selenium browser each time and replays the login
macro just as it does with the Unified Web Macro Recorder’s TruClient technology.

Important! If you use a login macro in conjunction with a workflow macro or startup macro or
both, all macros must be of the same type: all .webmacro files, all Burp Proxy captures, or all
Selenium macros. You cannot use different types of macros in the same scan.

See Also

"Scan Settings: Authentication" on page 345
"Running a Guided Scan " on page 100
"Selecting a Workflow Macro " below

"Using the Unified Web Macro Recorder" on the next page

Selecting a Workflow Macro

When conducting a Workflow-driven Scan, you can select or create one or more macros that will be used
to navigate your Web site.

¢ Record - opens the Web Macro Recorder, allowing you to create a macro

o Edit - opensthe Web Macro Recorder and loads the selected macro

« Remove - removes the selected macro (but does not delete it from your disk)

« Import - opens a standard file-selection window, allowing you to select a previously recorded
.webmacro file, Burp Proxy captures, or a Selenium macro. For more information, see "Importing a
Selenium Workflow Macro" on the next page.

Important! If you use a login macro in conjunction with a workflow macro or startup macro or
both, all macros must be of the same type: all .webmacro files, all Burp Proxy captures, or all
Selenium macros. You cannot use different types of macros in the same scan.

o Export - opens a standard file-selection window, allowing you to save a recorded macro
Once a macro is selected or recorded, you may optionally specify allowed hosts.
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Importing a Selenium Workflow Macro

To use a pre-recorded Selenium workflow macro:

1. Click Manage.
The Select Workflow-Driven Scan Macros window appears.
2. Click Import.
The Import a Web Macro window appears.
3. Select Selenium IDE Test Case (*.*) from the file type drop-down list.

Selenium macros do not have a specific file extension and can be any type of text file, including
XML.

4, Locate and select the file, and then click Open.
The Import Selenium Script window appears.

5. (Optional) To view and/or adjust how Selenium behaves during macro replay, click the Settings
plus (+) sign.

The Settings area expands and the current settings become visible. Make changes as necessary.
6. Click Verify.

Fortify Weblnspect plays the macro, displaying the verification progress and status in the Import
Selenium Script window.

7. Do one of the following:

« If the macro plays successfully, the message "Successfully verified macro" appears. Continue with

Step 8.

o If the macro does not play successfully, an error message appears. Use the error message to

debug and correct the error in Selenium, and return to Step 1 of this procedure to try the import

again.
8. Click OK fo add the macro to the list of macros.
The Allowed Hosts section is populated with the list of hosts accessed during the verification.
9. (Optional) To import another Selenium script to use in the workflow-driven scan, return to Step 2.
10. Click OK.
See Also

"Using Macros" on page 217

Using the Unified Web Macro Recorder

The Web Macro Recorder can be launched in several ways—while configuring a Guided Scan or a Basic
Scan, or outside of either scan in what is known as “stand-alone” mode.
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The Web Macro Recorder operates by default using underlying Firefox browser technology to record
and play macros. It can also operate using Internet Explorer browser technology (also referred to here
as |IE technology) to record and display web traffic data. Note the following:

« Web Macro Recorder does not support the recording of Flash or Silverlight applications.

¢ The TruClient technology used in the Web Macro Recorder is an adaptation of the Ajax TruClient
technology originally developed for use with Micro Focus LoadRunner and Micro Focus Performance
Center. It does not incorporate or support all the capabilities of the fully-featured version in those
products.

« When you play a macro, Fortify Weblnspect does not send any cookie headers that may have been
incorporated in the recorded macro.

o If aURL isin a macro, the request is always sent when the macro is played, regardless of any
exclusion rules in scan settings.

« When launching the Web Macro Recorder, you may receive the following error message:
“Excin ev handl: TypeError: this.oRoot.enable is not a function.”
This can occur if the McAfee SiteAdvisor is installed. Simply acknowledge the message and continue.

See Also

"Using Macros" on page 217

Traffic Monitor

Fortify Weblnspect normally displays in the navigation pane only the hierarchical structure of the Web
site or Web service, plus those sessions in which a vulnerability was discovered. The Traffic Monitor
allows you to display and review every HTTP request sent by Fortify Weblnspect and the associated
HTTP response received from the web server.

The Traffic Monitor is not available if Traffic Monitor Logging was not enabled prior to conducting the
scan. You can enable the feature in the default settings (click Edit > Default

Settings > Settings > General) or when you start a scan through the Scan Wizard (by selecting
Enable Traffic Monitor on the Detailed Scan Configuration window under Settings).

Traffic Session Data from Different Versions of Fortify
Weblnspect

In Fortify Weblnspect 10.50, the Traffic Monitor was converted into a standalone Traffic Viewer tool
that incorporates functionality from both the original Traffic Monitor and the WebProxy tool. Traffic
session files for the standalone Traffic Viewer use a different format that is no longer compatible with
the Traffic Monitor from Fortify Weblnspect 10.40 and earlier versions. If you open a scan that was
conducted using Fortify Weblnspect 10.40 or earlier, the traffic session data is not converted to the new
format. Instead, the data appears in the original Traffic Monitor in the information pane. When viewing
data from a scan conducted using Fortify Weblnspect 10.50 or later, the standalone Traffic Viewer tool
is launched. For more information about the standalone Traffic Viewer tool, refer to the Traffic Viewer
tool online help or the Tools Guide for Fortify Weblnspect Products.
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Traffic Monitor for Fortify Weblnspect 10.40 and Earlier Versions

The following paragraphs describe the original Traffic Monitor as it appears for traffic session data from
Fortify Weblnspect 10.40 and earlier versions.

Traffic Monitor Image
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Button Functionality

Buttons at the top of the information display area are described in the following table.

Button Description

HTTP Opens the HTTP editor loaded with the selected request and response session.
Editor

Session | Offers three choices:
+ Navigate to Session: Navigate to the correlated session on this request in the site
free.

+ Navigate to Parent Session: Navigate to the correlated parent session on this
request in the site tree.

« Highlight Parent Session: Moves focus to the parent session of the selected session.
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Button Description
Refresh = Updates display with most current information.

Auto Automatically updates traffic monitor view with the latest traffic from Fortify Weblnspect
Scroll crawl and audit while scan is running. While in auto scroll mode, sorting is ascending by
fime, so user cannot sort without pausing the scan.

Columns | Allows user to select which traffic monitor database columns are displayed.

See Also

"Scan Info Panel Overview " on page 66

Server Profiler

Use the Server Profiler to conduct a preliminary examination of a Web site to determine if certain Fortify
Weblnspect settings should be modified. If changes appear to be required, the Profiler returns a list of
suggestions, which you may accept or reject.

For example, the Server Profiler may detect that authorization is required to enter the site, but you have
not specified a valid user name and password. Rather than proceed with a scan that would return
significantly diminished results, you could follow the Server Profiler's prompt to configure the required
information before continuing.

Similarly, your settings may specify that Fortify Weblnspect should not conduct "file-not-found"
detection. This process is useful for Web sites that do not return a status "404 Not Found" when a client
requests a resource that does not exist (they may instead return a status "200 OK," but the response
contains a message that the file cannot be found). If the Profiler determines that such a scheme has
been implemented in the target site, it would suggest that you modify the Fortify Weblnspect setting to
accommodate this feature.

The Server Profiler can be selected during a Guided Scan, or enabled in the Application settings. For
specific information, see "Application Settings: Server Profiler" on page 380.

Using the Server Profiler

You can use either of fwo methods to invoke the Server Profiler:
Launch Server Profiler as a Tool
Follow these steps to launch the Server Profiler:

1. Click the Fortify Weblnspect Tools menu and select ServerProfiler.
2. Inthe URL box, enter or select a URL or IP address.

3. (Optional) If necessary, modify the Sample Size. Large Web sites may require more than the
default number of sessions to sufficiently analyze the requirements.

4. Click Analyze.
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The Profiler returns a list of suggestions (or a statement that no modifications are necessary).
5. To reject a suggestion, clear its associated check box.
6. For suggestions that require user input, provide the requested information.
7. (Optional) To save the modified settings to a file:

a. Click Save Settings.

b. Using a standard file-selection window, save the settings to a file in your Settings directory.

Invoke Server Profiler when Starting a Scan
Follow these steps to launch the profiler when beginning a scan:

1. Startascan using one of the following methods:
o On the Fortify Weblnspect Start Page, click Start a Basic Scan.

o Click File > New > Basic Scan.
o Click the drop-down arrow on the New icon (on the toolbar) and select Basic Scan.

o On the Fortify Weblnspect Start Page, click Manage Scheduled Scans, click Add, and then
select Basic Scan.

2. On step 4 of the Scan Wizard (Detailed Scan Configuration), click Profile (unless Run Profiler
Automatically is selected).
The Profiler returns a list of suggestions (or a statement that no modifications are necessary).
3. Toreject a suggestion, clear its associated check box.
4. For suggestions that require user input, provide the requested information.
5. Click Next.

Inspecting the Results

This topic describes inspecting the results for a Basic Scan and a Web Services Scan.

Basic Scan

As soon as you start a Basic Scan, Fortify Weblnspect begins scanning your Web application and
displays in the navigation pane an icon depicting each session (using either the Site or Sequence view).
It also reports possible vulnerabilities on the Vulnerabilities tab and Information tab in the summary
pane. For more information, see "Navigation Pane" on page 55 and "Summary Pane" on page 92.

If you click a URL listed in the summary pane, the program highlights the related session in the
navigation pane and displays its associated information in the information pane. For more information,
see "Information Pane " on page 65.

Sometimes the attack that detected a vulnerable session is not listed under attack information. That is, if
you select a vulnerable session in the navigation pane and then click Attack Info in the Session Info
panel, the attack information does not appear in the information pane. This is because attack
information is usually associated with the session in which the attack was created and not with the
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session in which it was detected. When this occurs, select the parent session and then click Attack Info.
For more information, see "Session Info Panel Overview " on page 77.

Working with One or More Vulnerabilities

If you right-click one or more vulnerabilities in the summary pane, a shortcut menu allows you to:

e Copy URL - Copies the URL to the Windows clipboard.

o Copy Selected Item(s) - Copies the text of selected items to the Windows clipboard.

« Copy All ltems - Copies the text of all items to the Windows clipboard.

o Export - Copies the item to a CSV file.

« View in Browser - Available if one vulnerability is selected; renders the HTTP response in a browser.

o Filter by Current Value - Available if one vulnerability is selected; restricts the display of
vulnerabilities to those that satisfy the criteria you select. For example, if you right-click on "Post" in
the Method column and then select Filter by Current Value, the list displays only those
vulnerabilities that were discovered by sending an HTTP request that used the Post method.

Note: The filter criterion is displayed in the combo box in the upper right corner of the summary
pane. Alternatively, you can manually enter or select a filtering criterion using this combo box.
For additional details and syntax rules, see "Using Filters and Groups in the Summary Pane" on
page 228.

« Change Severity - Allows you to change the severity level.

« Edit Vulnerability - Available if one vulnerability is selected; displays the Edit Vulnerabilities dialog,
allowing you to modify various vulnerability characteristics. For more information, see "Editing
Vulnerabilities" on page 235.

o Rollup Vulnerabilities - Available if multiple vulnerabilities are selected; allows you to roll up the
selected vulnerabilities into a single instance that is prefixed with the tag “[Rollup]” in Fortify
Weblnspect, Fortify Weblnspect Enterprise, and reports. For more information, see "About
Vulnerability Rollup" on page 238.

Note: If you have selected a rolled up vulnerability, this menu option is Undo Rollup
Vulnerabilities.

« Review Vulnerability - Available if one vulnerability is selected; allows you to retest the vulnerable
session, mark it as a false positive, or send it to Micro Focus Application Lifecycle Management
(ALM). For more information, see "Reviewing a Vulnerability " on page 233.

« Mark as - Flags the vulnerability as either a false positive (and allows you o add a note) or as
ignored. In both cases, the vulnerability is removed from the list. You can view a list of all false
positives by selecting False Positives in the Scan Info panel. You can view a list of false positives and
ignored vulnerabilities by selecting Dashboard in the Scan Info panel, and then clicking the
hyperlinked number of deleted items in the statistics column.

Note: You can recover "false positive" and "ignored" vulnerabilities. See "Recovering Deleted
Items" on page 246 for details.

« Send to - Converts the vulnerability fo a defect and adds it fo the Micro Focus Application Lifecycle
Management (ALM) database.
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+ Remove Location - Removes the selected session from the navigation pane (both Site and
Sequence views) and also removes any associated vulnerabilities.

Note: You can recover removed locations (sessions) and their associated vulnerabilities. See
"Recovering Deleted Items" on page 246 for details.

o Crawl - Available if one vulnerability is selected; re-crawls the selected URL.
o Tools - Available if one vulnerability is selected; presents a submenu of available tools.

« Attachments - Available if one vulnerability is selected; allows you to create a note associated with
the selected session, flag the session for follow-up, add a vulnerability note, or add a vulnerability
screenshot.

Working with a Group

If you right-click a group, a shortcut menu allows you to:

o Collapse/Expand All Groups
o Collapse/Expand Group

o CopyURL

o Copy Selected Item(s)

e CopyAllltems

e Export

¢ Change Severity

o Rollup Vulnerabilities

e Markas

e Sendto

¢ Remove Location

Understanding the Severity

The relative severity of a vulnerability listed in the summary pane is identified by its associated icon, as
described in the following table.

Icon Description

[ Critical A vulnerability wherein an attacker might have the ability to execute commands
on the server or retrieve and modify private information.

High Generally, the ability to view source code, files out of the Web root, and sensitive
error messages.

21 Medium Indicates non-HTML errors or issues that could be sensitive.

Low Interesting issues, or issues that could potentially become higher ones.
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Icon Description
(@ Information An interesting point in the site, or detection of certain applications or Web
servers.

Working in the Navigation Pane

You can also select an object or session in the navigation pane and investigate the session using the
options available on the Session Info panel. For more information, see "Navigation Pane" on page 55
and "Session Info Panel Overview " on page 77.

Web Services Scan

Web services are programs that communicate with other applications (rather than with users) and
answer requests for information. Most Web services use Simple Object Access Protocol (SOAP) to send
XML data between the Web service and the client Web application that initiated the information
request. XML provides a framework to describe and contain structured data. The client Web application
can readily understand the returned data and display that information to the end user.

Web Services Scan Image
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A client Web application that accesses a Web service receives a Web Services Definition Language
(WSDL) document so that it understands how to communicate with the service. The WSDL document
describes the procedures included in the Web service, the parameters those procedures expect, and the
type of return information the client Web application will receive.
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After selecting a session object in the navigation pane or on the Vulnerabilities tab of the summary
pane, you can select options from the Session Info panel. For more information, see "Navigation Pane"
on page 55, "Summary Pane" on page 92, and "Session Info Panel Overview " on page 77.

See Also

"Reviewing and Retesting" on page 243
"Auditing Web Services " on page 231
"Editing Vulnerabilities" on page 235
"User Interface Overview" on page 42
"Reviewing a Vulnerability " on page 233

"Recovering Deleted Items" on page 246

Search View

The Search view allows you to search across all sessions for various HTTP message components. For
example, if you select Response Raw from the drop-down and specify set-cookie as the search string,
Fortify Weblnspect lists every session whose raw HTTP response includes the "set-cookie" command.

|Respu:unse Raw b |

| set-cookie v |
|:| Regular Expression
Match Whaole String

IIRL i

B,http:,l',l'zer-:u.webappsecurity.u:u:um:BD,l'u:u:u:uHetest,l'Seth
D http: ffzero, webappsecurity . conn: 80  Forgak. asp -
"‘;'.'.*http:,l',l'zer-:u.webappsecurity.u:u:um:SD,l'Fu:urgu:utE.asp (e
D htkp: ffzero, webappsecurity . comn &80 join, asp
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< [ >

To use the Search view:

1. Inthe navigation pane, click Search (at the bottom of the pane). For more information, see

“Navigation Pane" on page 55.

If all buttons are not displayed, click the Configure Buttons drop-down at the bottom of the

button list and select Show More Buttons.
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From the top-most list, select an area to search.
In the combo box, type or select the string you wanft o locate.

If the string represents a regular expression, select the Regular Expression check box. For more
information, see "Regular Expressions" on page 283.

5. To find an entire string in the HT TP message that exactly matches the search string, select the
Match Whole String check box. The exact match is not case-sensitive.

This option is not available for certain search targets.
6. Click Search.
See Also

"User Interface Overview" on page 42

Using Filters and Groups in the Summary Pane

This topics describes how to use filters and groups in the Summary Pane.

Using Filters
You can display a subset of items that match the criteria you specify using either of two methods:
o Enter filter criteria using the combo box in the top right corner of the pane.

Note: Click the filter criteria box and press CTRL + Space to view a pop-up list of all available
filter criteria, and then enter a value for that criterion.

¢ Right-click a value in any column and select Filter by Current Value from the shortcut menu.

This filtering capability is available on all Summary pane tabs except Scan Log.

No Filters

The following example shows unfiltered items on the Vulnerabilities tab.

Summary Pane with No Filters Image
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Filtered by Method:Get

The following example is rendered after entering "Method:Get" in the filter criteria box.

Summary Pane with Filters Image

— Method:Get ~ - (¥ |2
Chedk
Path Method | Vuln Param Parameters Kingdom Response Length
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Environment 46

¥ Vulnerabilities | @ Information | [7] Best Practices | | Scan Log | 0 Server Information|

Note that the filtering criteria (Method:Get) appears in the combo box, which also contains a red X. Click
it fo remove the filter and return the list to the original contents.

Specifying Multiple Filters

To specify multiple filters when typing criteria in the filter criteria combo box, insert a comma between
filters (such as Parameter:noteid, Method:GET).

Filter Criteria

You can enter the following identifiers:

check - Check name

cookienamerp - Cookie name in the HTTP response
cookienamerq - Cookie name in the HTTP request
cookievaluerp - Cookie value in the HTTP response
cookievaluerq - Cookie value in the HTTP request
duplicates - Duplicates detected by Fortify Weblnspect Agent
filerg - File name and extension in the HTTP request
headernamerp - Header name in the HTTP response
headernamerq - Header name in the HTTP request
headervaluerp - Header value in the HTTP response
headervaluerq - Header value in the HTTP request
location - Path plus parameters identifying the resource

manual - A location added manually (syntax is manual:True or manual:False)

method - HTTP method (GET, POST)
methodrq - Method specified in HTTP request
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e parameters - Parameters specified in the HTTP request

o path - Path identifying the resource (without parameters)
e rawrp - Raw HTTP response

e rawrqg - Raw HTTP request

« sessiondataid - Session data identifier (right-click on a session in the Navigation pane and select Filter
by Current Session)

« severity - Severity assigned to a vulnerability (critical, high, medium, low)

o stack - Stack tracereturned by Fortify Weblnspect Agent (syntax is stack: True or stack:False)
o statuscode - HTTP status code

o typerq - Type of request: query, post, or SOAP

e vparam - The vulnerability parameter

Using Groups

You can group items into categories based on the column headings. To do so, simply drag the heading
and drop it on the grouping area at the top of the pane.

Vulnerabilities in the following illustration are grouped by risk and then by check name.

Summary Pane Using Groups Image
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If you right-click a column header, Fortify Weblnspect displays the following shortcut menu:

o Group by Field - Groups vulnerabilities according to the field you selected.

¢ Group by Box - Shows the "Group By" area in which you can arrange grouping by column headers.
e Columns - Allows you to select which columns are displayed.

¢ Save as Default View - Saves the current grouping paradigm as the default for all scans.

o Reset Default View - Restores the grouping paradigm to the default view that you created.

o Reset Factory Settings - Restores the grouping paradigm to the original view (Severity > Check).
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Web Services

Web services are programs that communicate with other applications (rather than with users) and
answer requests for information. Most Web services use Simple Object Access Protocol (SOAP) to send
XML data between the Web service and the client Web application that initiated the information
request. Unlike HTML, which only describes how Web pages are displayed, XML provides a framework
to describe and contain structured data. The client Web application can readily understand the returned
data and display that information to the end user.

A client Web application that accesses a Web service receives a Web Services Description Language

(WSDL) document so that it understands how to communicate with the service. The WSDL document
describes what programmed procedures the Web service includes, what parameters those procedures
expect, and the type of return information the client Web application will receive.
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Options Available from the Session Info Panel

The following table describes the options that are available from the Session Info panel.

Option

Vulnerability

HTTP Request

Definition

Displays the vulnerability information for the session selected in the navigation

pane. For more information, see "Navigation Pane" on page 55.

Displays the raw HTTP request sent by Fortify Weblnspect to the server hosting
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Option

HTTP Response

Stack Traces

Attachments

Web Service
Request

Web Service
Response

XML Request

Definition
the site you are scanning.

Displays the server's raw HTTP response to Fortify Weblnspect's request.

Note: If you select a Flash (.swf) file, Fortify Weblnspect displays HTML
instead of binary data. This allows Fortify Weblnspect to display links in a
readable format.

This feature is designed to support Fortify Weblnspect Agent when it is installed
and running on the target server. For certain checks (such as SQL injection,
command execution, and cross-site scripting), Fortify Weblnspect Agent
intercepts Fortify Weblnspect HTTP requests and conducts runtime analysis on
the target modaule. If this analysis confirms that a vulnerability exists, Fortify
Weblnspect Agent appends the stack trace fo the HTTP response. Developers
can analyze this stack frace to investigate areas that requires remediation.

Displays all notes, flags, and screenshots associated with the selected session.
To create an attachment, do one of the following:

¢ Right-click an operation or vulnerability in the navigation pane and select
Attachments from the shortcut menu.

¢ Right-click a URL on the Vulnerabilities tab of the summary pane and select
Attachments from the shortcut menu. For more information, see "Summary
Pane" on page 92.

o Select an operation or vulnerability in the navigation pane, then select
Attachments from the Session Info panel and click the Add menu (in the
information pane).

Fortify Weblnspect automatically adds a note to the session information
whenever you send a defect to Micro Focus Application Lifecycle Management
(ALM).

Displays an exploded view of the SOAP envelope, header, and body elements
for the request.

Displays an exploded view of the SOAP envelope, header, and body elements
for the response.

Displays the associated XML schema embedded in the request (available when
selecting the WSDL object during a Web Service scan).
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Option Definition

XML Response Displays the associated XML schema embedded in the response (available when

selecting the WSDL object during a Web Service scan).

For more information on how to conduct a Web services vulnerability scan, see Web Service Scan.

Reviewing a Vulnerability

After you conduct a scan and report discovered vulnerabilities, developers may correct their code and
update the site. You can then open the original scan, select the once-vulnerable session (now
supposedly remediated), and select Review Vulnerability from the shortcut menu. Assuming that the
fundamental architecture of the site has not changed, you can verify that the threat no longer exists
without rescanning the entire site (which, in some cases, could require several hours or even days).

Alternatively, you can use this feature simply to double-check a reported vulnerability, even while the
scan is still running.

To review a vulnerability:

1

Right-click a session from the Navigation pane (or right-click a URL on the Vulnerability tab of the
Summary pane). For more information, see "Navigation Pane" on page 55 and "Summary Pane" on
page 92.

Select Review Vulnerability from the shortcut menu.
The Retest Vulnerability window appears.

If you want to access the site through Web Proxy, click Options and select Launch and Direct
Traffic through Web Proxy.

If multiple vulnerabilities are associated with the selected session, choose one from the
Vulnerabilities to Review list.

Use the tabs to display information about the original session (as selected in the lower pane under
the URL column):

o Browser - The server's response, as rendered in a browser.
¢ Request - The raw HTTP request message.
« Response - The raw HTTP response message.

o Stack Trace - A report of the active stack frames at a certain point in time during the execution
of a program. This tab is present only when Fortify Weblnspect Agent is running on the target
server.

o Vulnerability - A description of the vulnerability, its implications, and suggestions on how to fix
it.

o Attachments - Notes and screen shots, which you may add, view, edit, or delete.

To retest the session for the selected vulnerability, click Retest.
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Results of the retest appear on the Status bar and in the lower pane in the Response Match
Status column.

The statusis reported as either "Complete (Vulnerability Detected)" or "Complete (Vulnerability Not
Detected)."

Important! Fortify does not recommend retesting vulnerabilities in scans created using earlier
versions of Fortify Weblnspect. While retesting scans from earlier versions may work in many
instances, it is not always reliable because individual checks may not flag the same vulnerability
during a retest. Failure of a check to flag the same vulnerability while retesting a scan from an
earlier version of Fortify Weblnspect may not mean the vulnerability has been remediated.

The reliability of the reported findings is mitigated by the Response Match Status, which may have
the following values:

¢ Match - Theresource has not changed significantly; Fortify Weblnspect was able to access the
session via the same path used by the original scan.

¢ Inconclusive - Based on the HTTP response, the resource has changed in a manner that may or
may not substantiate the finding that a vulnerability has or has not been detected during the
retest.

« Different - The HTTP response is radically different from the response received during the
original scan, suggesting major changes to the resource.

7. If you think that Fortify Weblnspect has erroneously determined that the vulnerability exists, you
can remove the vulnerability by clicking Mark as and selecting False Positive from the drop-down
list.

8. Toignore the vulnerability, click Mark as and select Ignored from the drop-down list.

9. To convert one or more vulnerabilities to defects and add them to the Micro Focus Application
Lifecycle Management (ALM) database, click Send To and select Micro Focus ALM.

Note: If you access the Vulnerability Review window from the Vulnerability Compare window,
the Mark As and Send To buftons are not enabled.

See Also

"Reviewing and Retesting" on page 243

"Sending Vulnerabilities to Micro Focus ALM "on page 247
"Mark As False Positive" on page 240

Adding/Viewing Vulnerability Screenshot

To add a vulnerability screenshot:

1. Do one of the following to select a vulnerability:

¢ On the Vulnerabilities tab or the Information tab in the Summary pane, right-click a vulnerable
URL. For more information, see "Summary Pane" on page 92.
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« On the Navigation pane, right-click a vulnerable session or URL. For more information, see
“Navigation Pane" on page 55.

2. On the shortcut menu, click Attachments > Add Vulnerability Screenshot.

Note: An alternative method is to select a vulnerability, click Attachments in the Session Info
panel, and then select a command from the Add menu (in the information display area). For
more information, see "Information Pane " on page 65.

3. If you selected a session with multiple vulnerabilities, select the check box next to one or more
vulnerabilities.

4, Enter a name (40 characters max.) for the screenshot in the Name box.

5. Select an image file, using one of the following methods:

e Click the browse button . and choose a file with the standard file-selection window.
¢ Click Copy from Clipboard o save the contents of the Windows clipboard.
Note: You can specify only one image file even if you have selected multiple vulnerabilities.

6. (Optional) Enter a note related to the vulnerability screenshot you selected.
7. Click OK.

Viewing Screenshots for a Selected Session

You can view notes, flags, and screenshots for a selected session by clicking Attachments on the
Session Info panel.

Viewing Screenshots for All Sessions

You can view notes, flags, and screenshots for all sessions by clicking Attachments on the Scan Info
panel.

See Also

"Vulnerability Note" on page 242

"Flag Session for Follow-Up" on page 240
"Scan Note" on page 241

Editing Vulnerabilities

After Fortify Weblnspect assesses your application’s vulnerabilities, you may want o edit and save the
results for a variety of reasons, including:

o Security - If an HTTP request or response contains passwords, account numbers, or other sensitive
data, you may want to delete or modify this information before making the scan results available to
other personsin your organization.
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Correction - Fortify Weblnspect occasionally reports a “false positive.” This occurs when Fortify
Weblnspect detects indications of a possible vulnerability, but further investigation by a developer
determines that the problem does not actually exist. You can delete the vulnerability from the session
or delete the entire session. Alternatively, you can designate it as a false positive (right-click the
session in either the Site or Sequence view and select Mark As False Positive).

Severity Modification - If you disagree with Fortify Weblnspect’s ranking of a vulnerability, you can
assign a different level, using the following scale:

Range  Severity

0-9 Normal
10 Information
11-25 Low

26-50  Medium
51-75  High
76 -100  Critical

Record Keeping - You can modify any of the report fields associated with an individual vulnerability
(Summary, Execution, Recommendation, Implementation, Fixes, and References). For example, you
could add a paragraph to the Fixes section describing how you actually fixed the problem.

Enhancement - If you discover a new vulnerability, you could define it and add it to a session as a
custom vulnerability.

Editing a Vulnerable Session

To edit a vulnerable session:

1

Do one of the following to select a session:

¢ On the Vulnerabilities fab or the Information tab in the Summary pane, right-click a
vulnerable URL, or

¢ Onthe navigation pane, right-click a session or URL.

Select Edit Vulnerability from the shortcut menu.
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The Edit Vulnerabilities window opens.

Edit Yulnerabilities

Vulnerabilities

Check Mame Check Type  Severty  Probability Add Existing
Admin Section Reguire Authentication Yulherability — High Low
Add Custom

Wulnerability Detail

Check Mame: |f-\dmin Section Require Authentication |

Check Type: |Vu|nerabi|it_l,l vl Sewerity: Probability:
5 _-,-]- Implication I E xecution ]- Fix ]- Reference Info l

This policy states that any area of the website or web application that containg sensitive information or access to privileged
functionality such as remate site administration requires authentication before allowing access. The URL <bx ~FullRL™ </brhaz
failed this policy.

= —— ETTE

3. Select a vulnerability (if the session includes multiple vulnerabilities).

4. To add an existing vulnerability to the session (that is, one that exists in the database), click Add
Existing.
a. Onthe Add Existing Vulnerability window, enter part of a vulnerability name, or a complete
vulnerability ID number or type.

Note: The *and % characters can be used interchangeably as wildcards. However, a
wildcard is allowed only at the beginning, at the end, or at the beginning and end of a
string. If placed within a string (such as "mic*soft,"), these characters will not function as
wildcards.

b. Click Search.
c. Select one or more of the vulnerabilities returned by the search.
d. Click OK.
5. To add a custom vulnerability, click Add Custom.
You can then edit the vulnerability as described in Step 7.
6. To delete the vulnerability from the selected session, click Delete.

7. To modify the vulnerability, select different options from the Vulnerability Detail section. You
can also change the descriptions that appear on the Summary, Implication, Execution, Fix, and
Reference Info tabs.

8. Click OK to save the changes.
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About Vulnerability Rollup

Some sites contain a vulnerability class that is endemic throughout the site. For example, a cross-site
scripting vulnerability may exist in every POST and GET method for every parameter on an entire site
due to lack of input validation. This means that numerous cross-site scripting vulnerabilities will be listed
on the Vulnerabilities tab in the summary pane. To prevent overwhelming your development team, you
can roll up such vulnerabilities into a single instance that is prefixed with the tag “[Rollup]” in Fortify
Weblnspect, Fortify Weblnspect Enterprise, and reports.

What Happens to Rolled Up Vulnerabilities

When you select multiple vulnerabilities and use the rollup feature, all vulnerabilities except the first
selected vulnerability are marked as ignored. The first selected vulnerability remains visible and
represents the rollup. Although the rest of the selected vulnerabilities are marked as ignored, they do
not appear as ignored vulnerabilities in the Recover Deleted Items window.

Caution! Rolling up vulnerabilities indicates that they share the same root cause, and that fixing the
root cause will fix all rolled up vulnerabilities. Future scans will automatically ignore rolled up
vulnerabilities if found. If any of the rolled up vulnerabilities do not share the same root cause, they
will still be ignored.

Rollup Guidelines

The following guidelines apply to vulnerability rollup:

e Scans that include vulnerability rollups can be rescanned and bulk retested.

¢ Only the visible vulnerability is retested during bulk retest. The rest of the vulnerabilities are ignored
and will not show up as rolled up on the retest.

¢ Rollupislocal to a scan and is not propagated between scans.

o Rollup works only when you select multiple vulnerabilities that have not been rolled up. Inadvertently
selecting a currently rolled up vulnerability will prevent the Rollup Vulnerability option from
appearing in the shortcut menu.

¢ You can only undo arollup if you single select a vulnerability that is currently rolled up.

Rolling Up Vulnerabilities

To rollup vulnerabilities:

1. On the Vulnerabilities tab in the summary pane, select several vulnerabilities to rollup.

2. Right click and select Rollup Vulnerabilities from the shortcut menu.
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The following warning appears:

Rolling up these vulnerabilities indicates that they share the same root cause, and that fixing the
root cause will fix all rolled up vulnerabilities. Future scans will automatically ignore rolled up
vulnerabilities if found. If any of these vulnerabilities do not share the same root cause, they will still
be ignored. Do you wish to continue?

3. Do one of the following:
e Click OK to rollup the vulnerabilities.

o Click Cancel to leave the vulnerabilities as they are.

If you click OK, the selected vulnerabilities are rolled into a single instance and the check name is
prefixed with the tag “[Rollup]”, as shown below. Additionally, a note is added to the Attachments
on the Session Info panel detailing the URLs that were rolled up and affected by the same
vulnerability. For more information, see "Viewing Notes for a Selected Session" on page 243,

Severity
Check
Path Method Vuln Param Parameters Kingdom Application Respons
= ) Critical (71 items)
= [Rollup] Cross-Site Scripting: Reflected (1 item)

hitp:/fzere webappsecurity.com/acctxferconfirm.asp POST toAcet {Post)fromA... Input Validation and Representation 2362
= Access Control: Unprotected File (2 items)

hitp://fzer0 webappsecurity.com/cgi zip GET - Environment 51

http://zere webappsecurity.com,global.asa. bak GET = Enviranment Micresoft IS 241
=l Cross-Site Scripting: Reflected (B0 itams)

htp:f/zero webappsecurity.com/banklogin asp GET e {Queryjerr=1_. Input Validation and Representation 5008

http://zero webappsecurity.com/banklogin.asp GET err (Querylerr=... Input Validation and Representation ASPNet 5000

http:f/zere webappsecurity.com/cookietest/ShowCook... GET - Input Validation and Representation 414

http://zero webappsecurity.com/cookiztest/ShowCook... GET - Input Validation and Representation 303

Ie, —

Undoing Rollup

The rollup feature is reversible. To undo a rollup:

1. On the Vulnerabilities tab in the summary pane, right-click any vulnerability that has been rolled
up.
2. Select Undo Rollup Vulnerabilities.

The rollup is reversed, and the vulnerabilities appear on the Vulnerabilities tab. Additionally, the
note detailing the rolled up vulnerabilities is removed from the Attachments on the Session Info
panel.

Note: If you undo arollup in a scan that has been published to Fortify Software Security
Center, the note that was added fo the Attachments on the Session Info panel detailing the
roll up will be removed temporarily from Fortify Weblnspect, but will reappear after
synchronization with Fortify Software Security Center.

See Also

"Vulnerabilities Tab" on page 93
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Mark As False Positive

If you think that Fortify Weblnspect has erroneously determined that a session contains a vulnerability,
you can remove the vulnerability from the session.

To mark as false positive:

1. Select the check box associated with one or more URLs.
2. (Optional) Enter a comment.

3. (Optional) To notify Fortify Customer Support personnel that you have found what you believe to
be a false positive, select Send to Micro Focus Support.

If you select this option, you may also select Preview Data Upload, which allows you to view the
contents of the data being sent to Fortify Customer Support. At that time, you can copy the data
to the Windows clipboard, cancel the upload, or allow it to proceed (by clicking OK).

4. Click OK.

Tip: To view a list of all sessions that have been marked as false positives, select False Positives
from the Scan Info panel. Note that this option is not displayed unfil you actually declare a
vulnerability as a false positive.

Mark As Vulnerability

If you think that someone has erroneously reclassified a detected vulnerability as a false positive, you
can restore the vulnerability to its original session.

1. Select the check box associated with one or more URLs.
2. (Optional) Enter a comment.
3. Click OK.

Flag Session for Follow-Up

To flag a session for follow-up:

1. Do one of the following to select a session:

¢ On the Vulnerabilities tab or the Information tab in the Summary pane, right-click a vulnerable
URL.

« On the Navigation pane, right-click a session or URL.
2. On the shortcut menu, click Attachments > Flag Session for Follow Up.

Note: You can also flag a session for follow-up by selecting a vulnerability or session, clicking
Attachments in the Session Info panel, and then click the Add menu (in the information
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display area).

3. Enter a note related to the session you selected.
4, Click OK.

Viewing Flags for a Selected Session

You can view notes, flags, and screenshofts for a selected session by clicking Attachments on the
Session Info panel.

Viewing Flags for All Sessions

You can view notes, flags, and screenshots for all sessions by clicking Attachments on the Scan Info
panel.

Scan Note

To add a scan note:

1. Click Attachments on the Scan Info panel.

2. Click Add and select Scan Note.

3. On the Add Scan Note dialog box, enter a note related to the scan.
4. Click OK.

To delete a scan note (or any attachment):

1. Select the attachment.
2. Click Delete.
See Also

"Adding/Viewing Vulnerability Screenshot" on page 234
"Vulnerability Note" on the next page

"Flag Session for Follow-Up" on the previous page

Session Note

To add a session note:

1. Do one of the following to select a session:

¢ On the Vulnerabilities tab or the Information tab in the Summary pane, right-click a vulnerable
URL.

¢ On the Navigation pane, right-click a session or URL.
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2. On the shortcut menu, click Attachments > Add Session Note.

Note: You can also add a session note by selecting a vulnerability or session, clicking
Attachments in the Session Info panel, and then clicking the Add menu (in the information
display area).

3. Enter a note related to the session you selected.
4, Click OK.

Viewing Notes for a Selected Session

You can view notes, flags, and screenshots for a selected session by clicking Attachments on the
Session Info panel.

Viewing Notes for All Sessions

You can view notes, flags, and screenshots for all sessions by clicking Attachments on the Scan Info
panel.

See Also
"Information Pane " on page 65
"Navigation Pane" on page 55

"Summary Pane" on page 92

Vulnerability Note

To add a vulnerability note:

1. Do one of the following to select a vulnerability:
¢ On the Vulnerabilities tab or the Information tab in the Summary pane, right-click a vulnerable
URL. For more information, see "Summary Pane" on page 92.

« On the Navigation pane, right-click a vulnerable session or URL. For more information, see
"Navigation Pane" on page 55.

2. On the shortcut menu, click Attachments > Add Vulnerability Note.

Note: An alternative method is to select a vulnerability, click Attachments in the Session Info
panel, and then click the Add menu (in the information display area). For more information, see
"Information Pane " on page 65.

3. If you selected a session with multiple vulnerabilities, select the check box next to one or more
vulnerabilities.

4. Enter a note related to the vulnerability (or vulnerabilities) you selected.
5. Click OK.
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Viewing Notes for a Selected Session

You can view notes, flags, and screenshots for a selected session by clicking Attachments on the
Session Info panel. If the selected session includes rolled up vulnerabilities, a note in the Description
area details the URLs that were rolled up and affected by the same vulnerability. For more information,
see "About Vulnerability Rollup" on page 238.

Viewing Notes for All Sessions

You can view notes, flags, and screenshots for all sessions by clicking Attachments on the Scan Info
panel.

Reviewing and Retesting

Fortify Weblnspect offers several methods for reviewing or retesting discovered vulnerabilities. You
may:

¢ Retest an individual vulnerability

« Verify all vulnerabilities discovered in a scan

e Rescan the entire site

o Compare two scans of the same site

Review Individual Vulnerability

The Review feature is an extremely powerful tool for confirming that developers have fixed a specific
vulnerability without having to conduct an entirely new scan.

To review a vulnerability:

1. Open ascan.

2. Right-click a vulnerable session in the Navigation pane or right-click a single vulnerability on the
Vulnerability tab of the Summary pane. For more information, see "Navigation Pane" on page 55
and "Summary Pane" on page 92.

3. Select Review Vulnerability from the shortcut menu.
4. On the Vulnerability Review window, click Retest.

Fortify Weblnspect resubmits the entire vulnerability path to the server, compares each result to the
original response, and displays the percentage of retest responses that match the original. This
indicates whether the vulnerability was accurately reproduced. Each HTTP request and response for the
original session and the retest session can be compared side by side, instantly revealing any significant
variations. Once the item has been confirmed as a vulnerability, you can submit the defect to Micro
Focus Application Lifecycle Management (ALM).

Important! Fortify does not recommend retesting vulnerabilities in scans created using earlier
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versions of Fortify Weblnspect. While retesting scans from earlier versions may work in many
instances, it is not always reliable because individual checks may not flag the same vulnerability
during a retest. Failure of a check to flag the same vulnerability while retesting a scan from an earlier
version of Fortify Weblnspect may not mean the vulnerability has been remediated.

For more information, see "Reviewing a Vulnerability " on page 233.

Retest Vulnerabilities

This type of scan examines only those portions of the target site in which vulnerabilities were detected
during the original scan. Fortify Weblnspect does not conduct a new crawl of the site, but simply
retraces the path of vulnerable sessions (as recorded in the original scan) and attacks the resources
using the same checks previously employed.

To retest all vulnerabilities:

1. Do one of the following:

e Openascan.
¢ Select a scan on the Manage Scans pane of the Start page.

2. Click Rescan and select Retest Vulnerabilities.

The default name of the scan is "Site Retest - <original scan name>"; for example, the retest of a site
that originally resulted in a scan named MySite would produce a scan named Site Retest - MySite.
However, you can specify a different name when launching the scan.

Important! Fortify does not recommend retesting vulnerabilities in scans created using earlier
versions of Fortify Weblnspect. While retesting scans from earlier versions may work in many
instances, it is not always reliable because individual checks may not flag the same vulnerability
during a retest. Failure of a check to flag the same vulnerability while retesting a scan from an
earlier version of Fortify Weblnspect may not mean the vulnerability has been remediated.

3. Use the Vulnerability tab in the Summary pane to view the results. The grid contains an additional
column named "Reproducible," which may contain the following values:

« Not Found/Fixed - The vulnerability detected in the original scan was not found by the retest.
These vulnerabilities are displayed with gray text. You can conduct a vulnerability review and
retest of these items. The percentage in parentheses indicates a heuristic confidence level for
the determination.

« Complete - Both the original scan and the retest detected the same vulnerability. In other
words, the vulnerability still exists.

¢ New - The retest detected a vulnerability that was not reported in the original scan. This is most
likely attributable to content that was added to the resource after the original scan was
conducted.

Note: This bulk retest feature uses only those portions of a scan policy that revealed vulnerabilities

in the original scan. If new vulnerabilities have been introduced since then, they may be detectable
only by checks that were not used during the retest.
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Also, because the retest does not use the enfire policy, the name of the policy listed in the
dashboard statistics will be a dash (-).

For more information, see "Summary Pane" on page 92.

Rescan the Site

The Rescan feature allows you to transition easily from an open or selected scan into the scan wizard
with the original scan settings preloaded. You may wish to conduct an identical scan of an updated site
(using the same settings that were used for the original scan) to determine if previously discovered
vulnerabilities have been fixed and if new ones have been introduced. Alternatively, you might want to
tweak some of the settings to improve the crawl or audit.

There are also several options for reusing a scan: Reuse Incremental, Reuse Crawl, Reuse Remediation,
and Reuse Crawl Remediation. For more information, see "Reusing Scans" on page 192.

The rescan functionality is available in two areas: the Rescan button on the scan toolbar and the
Rescan button (and shortcut menu) for a selected scan on the Manage Scans pane.
1. Do one of the following:
o Open ascan, click Rescan and select Scan Again.

¢ On the Fortify Weblnspect Start page, click Manage Scans; then select a scan and click Rescan.
2. Using the Scan Wizard, you may optionally modify the settings that were used for the original scan.

Note: The scan name is set by default to <original_scan_name>-1. If you conduct a rescan of a
rescan, the integer appended to the default name will be incremented by one.

3. On the last step of the Scan Wizard, click Scan.

Note: You cannot rescan the results of a "Retest Vulnerabilities" function.

Compare Scans

This feature allows you to compare the vulnerabilities revealed by two different scans of the same
target. You can use this information to:

o Verify fixes: Compare vulnerabilities detected in the initial scan with those in a subsequent scan of a
site in which the vulnerabilities were supposedly fixed.

« Check on scan health: Change scan settings and verify that those changes expand the attack
surface.

o Find new vulnerabilities: Determine if new vulnerabilities have been introduced in an updated
version of the site.

« Investigate Issues: Pursue anomalies such as false positives or missed vulnerabilities.

« Compare authorization access: Conduct scans using two different user accounts to
discover vulnerabilities that are unique or common to both accounts.

« Compare two instances of the same site: Conduct scans on two instances of the same site, such as
Production vs. Development, and compare findings.

Micro Focus Fortify Weblnspect (18.10) Page 245 of 427



User Guide
Chapter 5: Using Fortify Weblnspect Features

Note: Data from both scans must be stored in the same database type (SQL Server Express Edition
vs. SQL Server Standard/Enterprise Edition).

To compare two scans, do one of the following:

o From the Manage Scans page, select two scans and click Compare.
e From atab containing an open scan (which will be Scan A in the comparison):
a. Click Compare.

b. Select a scan from the list on the Scan Comparison window. This scan will be Scan B in the
comparison.

c. Click Compare.
Note: If the open scan is a "site retest" (resulting from Rescan > Retest Vulnerabilities), Fortify
Weblnspect automatically selects the parent scan for comparison. For example, if you created a
scan named "zero," and then verified vulnerabilities for that scan, the resulting scan would be

named (by default) "site retest - zero." With the retest scan open, if you select Compare, Fortify
Weblnspect will compare "site retest - zero" with the parent scan "zero."

See Also
"Comparing Scans " on page 185

"Reviewing a Vulnerability " on page 233

Recovering Deleted Items

When you remove a session or "ignore" a vulnerability, Fortify Weblnspect deletes the item from the
Navigation pane (in both the Site and Sequence views) and from the Vulnerabilities tab in the
Summary pane. It also omits those items from any reports you may generate.

The number of deleted items is displayed on the Dashboard (under the Scan category). To recover
removed sessions and ignored vulnerabilities:
1. Click the highlighted number that appears next to the Deleted Items header.
The Recover Deleted Items window displays a list of deleted items.
Click the drop-down list to toggle between ignored vulnerabilities and removed sessions.

Select the check box next to one or more items you want to recover.

Ea A

To view detailed information about the items, select Show details when selected.
5. Click Recover and then click Yes when prompted to verify your selection.

Recovered vulnerabilities reappear in the Navigation pane in both the Site and Sequence views (along
with their parent sessions) and also reappear in the Vulnerabilities tab in the Summary pane.
Recovered sessions also reappear in the Navigation pane along with any child sessions and their
vulnerabilities.

See Also

"Session Info Panel Overview " on page 77
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Sending Vulnerabilities to Micro Focus ALM

You can convert one or more vulnerabilities to defects and add them to the Micro Focus Application
Lifecycle Management (ALM) database.

To send a vulnerability to your defect tracking system:

1. Right-click a vulnerability in either the Navigation pane or the Summary pane. For more
information, see "Navigation Pane" on page 55 and "Summary Pane" on page 92.

2. Select Send to and choose Micro Focus ALM.
3. Onthe Send to dialog box, choose a profile from the Profile list.

If you need to create or edit a profile, click Manage to access the Fortify Weblnspect Application
Settings. For more information, see "Application Settings: Micro Focus ALM" on page 392.

Note: If the selected profile maps a Fortify Weblnspect vulnerability to "Do not publish" (based
on its severity level), the vulnerability will not be exported.

4, To force the creation of a defect even if it has been previously reported, select Allow duplicate
defect assignment.

Fortify Weblnspect recognizes duplicates only within the same scan. If you scan a site and send a
specific vulnerability to ALM, you can prevent Fortify Weblnspect from sending that same
vulnerability if it is encountered again during that scan. However, if you conduct a subsequent scan
of that site and Fortify Weblnspect again encounters that same vulnerability, Fortify Weblnspect is
not programmatically aware that the vulnerability was sent to ALM during the previous scan.

5. To close this dialog box after sending the defect(s), select Close when finished.

6. If you have selected multiple vulnerabilities, you can exclude a vulnerability by removing the check
mark next to the ID number.

7. Click Send.

Additional Information Sent

Fortify Weblnspect will also add a note to the session information indicating that the defect was sent to
Micro Focus ALM, asiillustrated by the following example:

Defect #30 was created in Micro Focus ALM.
Check ID: 182

CheckName: Dan-o Log Information Disclosure
Profile: Thack

Server URL: http://qbakervm2003/qcbin
Project: test3

Priority: 3-High

Severity: 1-Low

Note: If you receive the error message, "Error authenticating with Micro Focus ALM," see Disabling
Data Execution Prevention.
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Disabling Data Execution Prevention

When you attempt to integrate with Micro Focus Application Lifecycle Management (ALM), you may
receive the error message:

Error authenticating with Micro Focus ALM.

If so, you must disable Microsoft's Data Execution Prevention (DEP). For instructions on changing DEP
settings, refer to your Windows documentation.

Generating a Report

You can launch the Report Generator using a variety of methods:

On the Start page, click Generate a Report in the left pane of the client area.

On the Fortify Weblnspect toolbar, click Reports.

Click the Reports menu and select Generate Report.

On the Manage Scans form, right-click a scan name and select Generate Report.

With a scan open, right-click a session in the Site view and select Generate Session Report. For more
information, see "Site View" on page 57.

When scheduling scans.

To generate a report:

. Launch the Report Generator using one of the options listed above.
. Select one or more scans from the Select a Scan window.
. (Optional) Click Advanced (at the bottom of the window) fo select options for saving reports and

for selecting a template for headers and footers.

4, Click Next.

. (Optional) Select a report from the Favorites list.

Tip: "Favorites" is simply a named collection of one or more reports and their associated
parameters. To create a favorite once you have selected reports and parameters, click the
Favorites list and select Add to favorites.

. Select one or more reports. See "Standard Reports" on page 251 for report descriptions.
. Provide information for any parameters that may be requested. An exclamation mark ‘¥ indicates a
required parameter.

. If you want to display each report on a separate tab (rather than combining all reports on one tab),
select Open Reports in Separate Tabs.

. Click Finish.
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Saving a Report

After Fortify Weblnspect generates and displays the report, you can save it by clicking Save As on the
Report Viewer toolbar.

Reports can be saved in the following formats:

Adobe Portable Data Format (.pdf)
Hypertext Markup Language Chtml)

Native Fortify Weblnspect internal format (.raw)

Rich Text Format (rif)
Text Ctxt)
Microsoft Excel (.xls)

See Also

"Standard Reports" on page 251

"Advanced Report Options" below

"Compliance Templates " on page 253

"Application Settings: Reports" on page 386

Advanced Report Options

The following table describes the advanced report options:

Option
Save reports to disk

Automatically
generate file name

Description
Select this option to output a report to a file.

If you select this option when saving the report to disk, the name of the
report file will be formatted as <reportname> <date/time>.<extension>.

For example, if creating a compliance report in pdf format and the report is
generated at 6:30 on April 5, the file name would be "Compliance
Report 04_05_2009 06_30.pdf." This is useful for recurring scans.

o If you select more than one report type, then <reportname> will be
"Combined Reports."

o Reports are written to the directory specified for generated reports in
the Application settings.

If you do not select Automatically generate filename, replace the default
name "auto-gen-filename" with a file name.
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Option Description

Export Format Select a report format.

Header/Footer Select a format for the report's header and footer, and then enter or select
Report the components.

Report Viewer

Use the toolbar to navigate through the report, print or save the report, and to add notes.

¢ 0 606629 @ ¢ @

|.—|3:| |E:JP_rint... ||:D |,—j-t. | @ = |.-_-:e m 100 < - |@ @ 35095 Eipackward 2 Forward |£:’7 |L‘;_-‘Save.¢\s

@ 0006 © © o o

Item Description

1 Show / Hide Table of Contents
2 Print Report

3 Copy

4 Search

5 Single Page View

6 Multi-Page View

7 Continuous Scroll

8 Zoom Out

9 ZoomIn

10 Magnification
11 Previous Page
12 Next Page

13 Current Page Number / Total Number of
Pages
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Item Description
14 Page Backward
15 Page Forward
16 Annotation (see "Adding a Note" below)

17 Save Report

Note: The Backward and Forward buttons function in the same manner as the Back and Forward
buttons on a browser. They navigate forward or backward one step in the history list.

Adding a Note

To add a note:

1. Click the Annotation icon.

Select a format.

Drag it to the report.

Right-click the note and select Properties.

AR

Select the Text property and enter the contents of the note.

Standard Reports

The following table describes the standard reports that are available.

Report Description

Aggregate This report is designed for multiple scans. You can select which severity
categories to report, report sections (server content and vulnerability
detail), and session information (responses and requests). Stack traces can
also be reported, when available.

Alert View This report lists all vulnerabilities sorted by severity, with a hyperlink to
each HTTP request that elicited the vulnerability. It also includes an
appendix that describes each vulnerability in detail.

Attack Status For each aftack agent (check) employed during the scan, this report lists
the vulnerability ID number, check name, vulnerability severity, whether or
not the check was enabled for the scan, whether or not the check passed or
failed (i.e., did or did not detect the vulnerability), and (if it failed) the
number of URLs where the vulnerability was detected. You can select to
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Report

Compliance

Crawled URLs

Developer Reference

Duplicates

Executive Summary

False Positives

QA Summary

Scan Difference

Scan Log

Trend

Description
report vulnerabilities of a certain severity as well as the pass/fail status.

This report provides a qualitative analysis by grading how well your
application complies with certain government-mandated regulations or
corporate-defined guidelines.

For each URL encountered during the crawl, this report lists any cookies
sent and the raw HTTP request and response.

Totals and detailed description of each form, JavaScript, e-mail, comment,
hidden control, and cookie discovered on the Web site. You can select one
or more of these reference types.

This report contains information about vulnerabilities detected by Fortify
Weblnspect Agent that were fraceable to the same source. It begins with a
bar chart comparing the total number of uncorrelated vulnerabilities to the
number of unique vulnerabilities.

This report lists basic statistics, plus charts and graphs that reflect your
application's level of vulnerability.

This report displays information about URLs that Fortify Weblnspect
originally classified as vulnerabilities, but were subsequently determined by
a user to be false positives.

This report lists the URLSs of all pages containing broken links, server
errors, external links, and timeouts. You can select one or more of these
categories.

This report compares two scans and reports the differences, such as
vulnerabilities, pages, and file-not-found responses that occur in one Web
site but not the other.

Sequential list of the activities conducted by Fortify Weblnspect during the
scan (as the information appears on the Scan Log tab of the summary
pane).

This report allows you to monitor your development team's progress
toward resolving vulnerabilities. For example, you save the results of your
initial scan and your team begins fixing the problems. Then once a week,
you rescan the site and archive the results. To quantify your progress, you
run a trend report that analyzes the results of all scans conducted to date.
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Report Description

The report includes a graph showing the number of vulnerabilities, by
severity, plotted on a timeline defined by the date on which each scan was
conducted. Important: To obtain reliable results, make sure you conduct
each scan using the same policy.

Vulnerability (Legacy) | This is a detailed report of each vulnerability, with recommendations
concerning remediation.

Vulnerability This report also presents detailed information about discovered
vulnerabilities, sorted by severity.

Compliance Templates

The available compliance femplates are described below. Additional templates may be downloaded
through SmartUpdate as they become available.

Template Description

21CFR11 Part 11 of Title 21 of the United States Code of Federal Regulation (commonly
abbreviated as “21 CFR 11”) includes requirements for electronic records and
electronic signatures. To assist medical companies in compliance, the US Food
and Drug Administration (FDA) has published guidance for the proper use of
electronic records and electronic signatures for records that are required to be
kept and maintained by FDA regulations. The guidance ouftlines "criteria under
which the agency considers electronic records, electronic signatures, and
handwritten signatures executed to electronic records to be trustworthy,
reliable, and generally equivalent to paper records and handwritten signatures
executed on paper."

Due to the law and FDA guidance, medical companies and organizations dealing
with highly sensitive medical information are being required to ensure that
electronic records and electronic signatures are trustworthy, reliable, and
generally an equivalent substitute for paper records and handwritten
signatures. As interaction between equipment, operators, and computers
becomes commonplace, it is important to establish a secure means to
communicate and store information.

Basel Il Basel Il is a round of deliberations by central bankers from around the world,
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Template Description

under the auspices of the Basel Committee on Banking Supervision (BCBS) in
Basel, Switzerland, aimed at producing uniformity in the way banks and banking
regulators approach risk management across national borders. The BCBS is the
international rule-making body for banking compliance. In 2004, central bank
governors and the heads of bank supervisory authorities in the Group of Ten
(G10) countries endorsed the publication of “International Convergence of
Capital Measurement and Capital Standards: a Revised Framework,” the new
capital adequacy framework commonly known as Basel II.

Basel Il essentially requires banks fo increase their capital reserves or
demonstrate that they can systematically and effectively control their credit and
operational risk. The framework defines operational risk as “the risk of loss
resulting from inadequate or failed internal processes, people and systems or
from external events,” and highlights hacking and information theft through
inadequate systems security as loss events. While banks around the world are
experts at managing risk by virtue of operating in global financial markets, they
are relatively new at understanding and controlling the risks inherent with
operating online banking systems and keeping customer data secure.

Banks that practice effective information and systems security are able to
demonstrate to regulators that they should qualify for lower capital reserves
through reduced operational risk. The Basel Il framework insists that banks
demonstrate that an effective system of policies and processes are in place to
protect information and that compliance to these policies and processes is
ensured, but is not prescriptive in how banks should implement security policies
and processes. The international standard ISO/ICE 17799 Code of Practice for
Information Security Management provides guidelines for implementing and
maintaining information security and is commonly used as a model for managing
and reporting operational risk related to information security in the context of
Basel Il.

CA OPPA The California Online Privacy Protection Act (OPPA) was established in 2003 to
require all businesses and owners of commercial web sites in the state of
California to conspicuously post and comply with a privacy policy that clearly
states the policies on the collection, use, and sharing of personal information.
The policy identifies the categories of personally identifiable information
collected about site visitors and the categories of third parties with whom the
operator may share the information.

Any business, organization, or individual that operates a Web site that collects
private personal information for a person residing in the state of California is
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Template Description

bound by the provisions of the law, so the California OPPA has a much greater
impact nationally than is typical for state legislation.

CASB 1386 California Senate Bill 1386 has established the most specific and restrictive
privacy breach reporting requirements of any state in the United States. The law
was enacted to force businesses, organizations, and individuals holding private
personal information for legitimate business purposes to inform consumers
immediately when their personal information has been compromised. The law
also gives consumers the right to sue businesses in civil court for damages
incurred through the compromise of information. Any business, organization, or
individual that holds private personal information for a person residing in the
state of California is bound by the provisions of the law.

COPPA The Children’s Online Privacy Protection Act (COPPA) was enacted in 2000 fo
protect the online collection of personal information about children under the
age of 13. COPPA’s goal was to protect children’s privacy and safety online in
recognition of the easy access that children often have to the Web. The law
requires that Web site operators post a privacy policy on the site and outlines
requirements for Web site operators to seek parental consent to collect
children’s personal information in certain circumstances.

The law applies not only to Web sites that are clearly directed toward children
but to any Web site that contains general audience content where the Web site
operators have actual knowledge that they are collecting personal information
from children. An operator must post a link to a notice of its information
practices on the home page of its Web site or online service and at each area
where it collects personal information from children. An operator of a general
audience site with a separate children's area must post a link to its notice on the
home page of the children's area.

DCID This directive establishes the security policy and procedures for storing,
processing, and communicating classified intelligence information in information
systems. For purposes of this directive, intelligence information refers to
sensitive compartmented information and special access programs for
intelligence under the purview of the Director of Central Intelligence.

DoD Application DISA Field Security Operations (FSO) conducts Application SRRs to provide a

Security minimum level of assurance to DISA, Joint Commands, and other Department of
Checklist Defense (DoD) organizations that their applications are reasonably secure
Version 2 against attacks that would threaten their mission. The complexity of most
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Template Description

mission critical applications precludes a comprehensive security review of all
possible security functions and vulnerabilities in the time frame allotted for an
Application SRR. Nonetheless, the SRR helps organizations address the most
common application vulnerabilities and identify information assurance (1A)
issues that pose an unacceptable risk to operations.

Ideally, IA controls are integrated throughout all phases of the development life
cycle. Integrating the Application Review process into the development lifecycle
will help to ensure the security, quality, and resilience of an application. Since the
Application SRR is usually performed close to or after the applications release,
many of the Application SRR findings must be fixed through patches or
modifications to the application infrastructure. Some vulnerabilities may require
significant application changes to correct. The earlier the Application Review
process is integrated into the development life cycle, the less disruptive the
remediation process will be.

DoD Application This compliance template reports all applicable web application components of

Security and the Application Security and Development Security Technical Implementation
Development Guide (STIG) Version 3, Release 1. The STIG provides security guidance for use
STIG V3 R2 throughout the application development lifecycle. Defense Information Systems

Agency (DISA) encourages sites to use these guidelines as early as possible in
the application development process.

EU Data The European Commission's Directive on Data Protection protects the

Protection fundamental rights of European Union citizens to privacy with respect to the
processing of personal data. The primary focus of the directive is on the
acceptable use and protection of personal data. Like all other European Union
privacy legislation, this directive also requires that personal data be collected,
stored, changed or disseminated only with a citizen's express consent and with
full disclosure as to the use of the data. The directive also prohibits the transfer
of personal data from European organizations to non-European Union nations
and organizations that do not adequately protect the safety and privacy of
personal data. The United States has developed a Safe Harbor framework for
U.S. organizations that are required to comply with this directive.

EU Directiveon  European Union Directive on Privacy and Electronic Communications is part of a

Privacy and broader "telecoms package" of legislation that governs the electronic

Electronic communications sector in the European Union. The directive reinforces a basic

Communications European Union principle that all member states must ensure the confidentiality
of communications made over public communications networks and the
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Template

FISMA

GLBA

HIPAA

1ISO17799

1S027001

Description

personal and private data inherent in those communications. The directive
governs the physical communication networks as well as the personal data that
is carried on it.

The United States Congress passed the E-Government Act of 2002 in
recognition of the importance of information security to the economic and
national security interests of the United States. Title lll of the act, entitled the
Federal Information Security Management Act (FISMA), tasked the National
Institute of Standards and Technology with developing standards and
guidelines to be used by all U.S. federal government agencies in implementing
adequate information security as part of their information systems, underpinned
by three security objectives for information systems: confidentiality, integrity
and availability. FISMA requires the head of each federal agency to provide
information security protections commensurate with the risk and magnitude of
the harm that may result from unauthorized access, use, disclosure, disruption,
modification or destruction of its information and information systems. The
protection should apply not only within the agency, but also within contractor or
other organizations working on behalf of the agency.

The Gramm-Leach-Bliley Act (GLBA) mandates that financial institutions must
protect consumers' personal financial information. The main provision affecting
Web application security in the financial industry is the GLBA Safeguards Rule.

The Health Insurance Portability and Accountability Act (HIPAA) mandates the
privacy and security of personal health information from the various threats and
vulnerabilities associated with information management.

This is the most commonly accepted international standard for information
security management. Use this policy as a baseline in crafting a compliance policy
to meet the needs of your organization and its security policy.

ISO/IEC 27001 is an information security management system standard
published in October 2005 by the International Organization for
Standardization and the International Electrotechnical Commission. The basic
objective is to help establish and maintain an effective information management
system using a continual improvement approach. ISO 27001 specifies the
requirements for the security management system itself. It is the standard, as
opposed to ISO 17799, against which certification is offered. Additionally, ISO
27001 is "harmonized" with other management standards, such as ISO 9001 and
ISO 14001.
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Template

JPIPA

NERC

NIST 800-53

OMB

OWASP Top Ten
2004/2007/2010

PCI Data

Description

Japan enacted the Personal Information Protection Act (JPIPA)in 2003 to
protect individuals' rights and personal information while preserving the
usefulness of information technology and personal information for legitimate
purposes. The law establishes responsibilities for businesses that handle
personal information for citizens of Japan and outlines potential fines and
punishments for organizations that do not comply. The act requires businesses
to communicate their purpose in collecting and using personal information.
They must also take reasonable steps to protect personal information from
disclosure, unauthorized use or destruction.

The North American Electric Reliability Council (NERC) was established in 1968
with the mission of ensuring that the electric system of the United States is
reliable, adequate and secure. After President Bill Clinton issued Presidential
Decision Directive 63 in 1998 to define infrastructure industries critical to the
United States' national economy and public well-being, the U.S. Department of
Energy designated the NERC fo act as the coordinating agency for the electricity
industry, which was named one of the eight critical infrastructure industries.

The United States Congress passed the E-Government Act of 2002 in
recognition of the importance of information security to the economic and
national interests of the United States. Title Ill of the act, entitled the Federal
Information Security Management Act (FISMA), tasked the National Institute of
Standards and Technology with developing standards and guidelines to be used
by all U.S. federal government agencies in implementing adequate information
security as part of their information systems, underpinned by three security
objectives for information systems: confidentiality, integrity, and availability.

This policy addresses major application security sections that were defined in
December 2004 by the Office of Management and Budget for federal agency
public Web sites. These are information resources funded in whole or in part by
the federal government and operated by an agency, contractor, or other
organization on behalf of the agency. They present government information or
provide services to the public or a specific non-federal user group and support
the proper performance of an agency function.

Many government agencies suggest testing for the Open Web Application
Security Project (OWASP) Top Ten Web application vulnerabilities as a best
practice in ensuring the security of your Web application.

The Payment Card Industry (PCI) Data Security Policy requires that all PCI Data
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Template

Security 1.2, 2.0

PIPEDA

Safe Harbor

Description

Security members, merchants, and service providers that store, process or
transmit cardholder data verify all purchased and custom Web applications,
including internal and external applications.

Canada's Personal Information Protection and Electronic Documents Act
(PIPEDA) is a new law that protects personal information in the hands of private
sector organizations and provides guidelines for the collection, use and
disclosure of that information in the course of commercial activity. The Act,
based on ten privacy principles developed by the Canadian Standards
Association, is overseen by the Privacy Commissioner of Canada and the Federal
Court. As of January 1, 2004, all Canadian businesses are required to comply
with the privacy principles set out by PIPEDA. The Act covers both traditional,
paper-based and on-line business.

The European Commission's Directive on Data Protection prohibits the transfer
of personal data from European organizations to non-European Union nations
and organizations that do not adequately protect the safety and privacy of
personal data. Upon passage of this comprehensive European legislation, all
businesses and organizations in the United States that share data with
European Union organizations were obligated to comply with the regulations,
which could have disrupted many types of trans-Atlantic business transactions.
Due to the differences in approaches taken by the United States and European
Union nations in protecting personal data privacy, the U.S. Department of
Commerce, in consultation with the European Commission, developed a
streamlined "Safe Harbor" framework through which U.S. organizations could
comply with the Directive on Data Protection.

Organizations participating in the Safe Harbor are committed to complying with
these seven principles designed to ensure that personal data is properly used,
controlled and protected: Notice, Choice, Onward Transfer, Access, Security,
Data Integrity and Enforcement. Of particular significance to information
technology:

¢ The Notice principle requires organizations to inform individuals about the
purposes for which it collects information, such as through a privacy policy.

o The Security principle states that organizations will take reasonable
precautions to protect personal data.

o The Enforcement principle mandates that organizations have procedures in
place for verifying that security commitments are satisfied, such as through
comprehensive security festing.
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Template Description

SANS CWE Top  The SANS (SysAdmin, Audit, Network, Security) Institute was established in

25 1989 as a cooperative research and education organization. The SANS
Common Weakness Enumeration (CWE) Top 25 Most Dangerous Software
Errors is a list of the most widespread and critical programming errors that can
lead to serious software vulnerabilities. They are dangerous because they
frequently allow attackers to completely take over the software, steal data, or
prevent the software from functioning. This compliance template reports all
applicable web application components of this list.

Sarbanes-Oxley = The Sarbanes-Oxley Act, which falls under the umbrella of the U.S. Securities
and Exchange Commission (SEC), was enacted on July 30, 2002. It focuses on
regulating corporate behavior for the protection of financial records, rather than
enhancing the privacy and security of confidential customer information.

UK Data The European Commission's Directive on Data Protection protects the

Protection fundamental rights of European Union citizens to privacy with respect to the
processing of personal data. The primary focus of the directive is on the
acceptable use and protection of personal data. The United Kingdom
implemented the protections mandated by the directive through its Data
Protection Act of 1998, summarized as follows:

o Personal data should be processed fairly and lawfully and only with consent.

o Personal data should be obtained only for specified and lawful purposes, and
should not be further processed in any manner incompatible with those
purposes.

o Personal data should be adequate, relevant and not excessive in relation to
the purpose or purposes for which they are processed.

o Personal data should be accurate and kept up to date.

o Personal data processed for any purpose should not be kept for longer than
is necessary for that purpose.

o Personal data should be processed in accordance with the rights of data
subjects.

o Appropriate technical and organizational measures should be taken against
unauthorized or unlawful processing of personal data and against accidental
loss or destruction of, or damage to, personal data.

o Personal data should not be transferred to a country or territory outside the
European Economic Area unless that country or territory ensures an
adequate level of protection for the rights and freedoms of data subjects in
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Template Description
relation to the processing of personal data.

WASC This compliance template is based on the Web Application Security Consortium
threat classes. The WASC Threat Classification is a cooperative effort to clarify
and organize the threats to the security of a web site. When used in conjunction
with the All Checks policy, you can generate a compliance report that includes
each vulnerability check contained in SecureBase.

Managing Settings

This feature allows you to create, edit, delete, import, and export scan settings files.

You can also load and save settings and restore factory default settings from the Default Settings
window. Click Edit and select Default Scan Settings.

From the Fortify Weblnspect Edit menu, select Manage Settings.

The Manage Settings window opens.

Creating a Settings File

To create a settings file:

1. Click Add.

2. On the Create New Settings window, change settings.

3. When finished, click OK.

4, Using a standard file-selection dialog box, name and save the file.

Editing a Settings File

To edit a settings file:

1. Select afile.

2. Click Edit.

3. On the Create New Settings window, change settings.
4, When finished, click OK.
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Deleting a Settings File

To delete a settings file:

1. Select afile.
2. Click Delete.

Importing a Settings File

To import a settings file:

1. Click Import.
2. Using a standard file-selection dialog box, select a settings file and click Open.

Exporting a Settings File

To export a settings file:

1. Select afile.

2. Click Export.

3. Using a standard file-selection dialog box, name the file and select a location.
4. Click Save.

Scanning with a Saved Settings File

To scan with a saved settings file:

1. Fromthe Fortify Weblnspect Edit menu, select Default Settings.
2. At the bottom of the Default Settings window, in the left column, click Load settings from file.
3. Using a standard file-selection dialog box, select the settings file you want to use and click Open.

The file you select is now your default settings file.

SmartUpdate

For installations connected to the Internet, the SmartUpdate feature contacts the Micro Focus data
center to check for new or updated adaptive agents, vulnerability checks, and policy information.
SmartUpdate will also ensure that you are using the latest version of Fortify Weblnspect, and will
prompt you if a newer version of the product is available for download.

You can configure Fortify Weblnspect settings to conduct a SmartUpdate each time you start the
application (select Application Settings from the Edit menu and choose Smart Update).
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You can also run SmartUpdate on demand through the Fortify Weblnspect user interface by selecting
Start SmartUpdate from the Fortify Weblnspect Start Page, by selecting SmartUpdate from the
Tools menu, or by clicking the SmartUpdate button on the standard toolbar. For more information, see
"Tools Menu "on page 49 and "Toolbars " on page 51.
For installations lacking an Internet connection, see "Performing a SmartUpdate (Offline)" on the next
page.

Caution! For enterprise installations, if SmartUpdate changes or replaces certain files used by

Fortify Weblnspect, the sensor service might stop and the sensor will display a status of "off line."
You must launch the Fortify Weblnspect application and restart the service. To do so:

1. Click Edit > Application Settings.
2. Select Run as a Sensor.
3. Click the Start button in the Sensor Status area.

Performing a SmartUpdate (Internet Connected)

To perform a SmartUpdate when Weblnspect is connected to the Internet:

1. Do one of the following:
o From the toolbar, click SmartUpdate.

o Select SmartUpdate from the Tools menu.
o Select Start SmartUpdate from the Fortify Weblnspect Start Page.

If updates are available, the SmartUpdater window opens with the Summary tab in view. The
Summary tab displays up to three separate collapsible panes for downloading the following:

o New and updated checks
o Fortify Weblnspect software
o SmartUpdate software

2. Select the check box associated with one or more of the download options.
3. (Optional) To view details about the checks being updated:
a. Click the Check Detail tab.

In the left paneis a list showing the ID, Name, and Version of checks being updated. The list is
grouped by Added, Updated, and Deleted.

b. To view the policies that include a specific check being updated, select the check in the list.
A list of affected policies appears in the Related Policies pane.
4. (Optional) To view details about the policies affected:
a. Click the Policy Detail tab.
In the left pane is an alphabetical list of the policies affected by the update.

Note: The list shows only those policies that are affected by updated checks. The Policy
Detail tab does not show other policy changes that could be included in the update, such
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as associafing new checks with a policy or changing a policy name.

b. To view the checks being updated in a specific policy, select the policy in the list.

A list showing the ID, Name, and Version of checks being updated appears in the Related
Checks pane. The list is grouped by Added, Updated, and Deleted.

5. To install the updates, click Download.

Downloading Checks without Updating Fortify Weblnspect
Engine updates are required for some checks to be run during scans. If you are not using the latest
version of Fortify Weblnspect, it is likely that some of the checks in your SecureBase cannot be run

during a scan. To fest your application with all the latest checks, ensure that you are using the most
recent version of Fortify Weblnspect.

Performing a SmartUpdate (Offline)
Follow this process to perform a SmartUpdate for Weblnspect that is offline.
Stage Description

1 Open a support case. Customer Support personnel will provide you with the
offline FTP server URL and login credentials (if needed). For more information,
see "Contact Customer Support" on page 425.

2. On a machine that can access the Infernet, access the offline FTP server.

3. Download the Weblnspect static SmartUpdate ZIP file.

4, On the machine where Weblnspect is installed, extract all files from the ZIP file.
5. Close Weblnspect.

6. Copy the extracted SecureBase.sdf and version.txt files to the directory where

your SecureBase data resides.

o If your systemis not FIPS enabled, then the default location is
C:\ProgramData\HP\HP Weblnspect\SecureBase.

o If your systemis FIPS enabled, then the location is C:\ProgramData\HP\HP
Weblnspect\FIPS\SecureBase.

Note: By default, these folders are hidden in Windows. Be sure to change
folder options to show hidden files.
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WebSphere Portal FAQ

How do you know if an application is running on WebSphere Portal?

WebSphere Portal applications typically have very long urls that begin with /wps/portal or
/wps/myportal followed by encoded sections. For example:

http://myhost.com/wps/portal/internet/customers/home/!ut/p/bl/fY7BcoIwFAC_
XS94T4QCx6Rpk6qlo20x5tIIShEIJoIDOq-vnfFq97YzelhQIEEddV8W-1zaozZ_rh6-
HjkRfrhERBZ4-EKESBmde5ggzEEVXmbXNGW7 -sIsKdgTW3c_
B3xmpzBfnacLv6QuIFfxVHKIGhmNFfzToue8nWdKgafx8jtaTIMIpB2zQPgqLp9GrADyeyOtvvL1F9S
nftm_
yOcbuw8Xbmvg2NN6412wlsQP27GAa3A09AEBIhmxxcnWH1k8kverBIBQ!!/d14/d5/L2dBISEVZOF
BIS9nQSEh/

Which versions of WebSphere Portal are supported?
Versions 6.1 and later are supported.
Why does Fortify Weblnspect require special settings to scan a WebSphere Portal application?

The encoded sections of the URL include what is called "navigation state," which contains information
about how to display elements in the current page (similar to VIEWSTATE in .Net) plus the navigation
history. It is this navigation history that is troublesome for automated crawlers. As the crawler visits
each link, the navigation state is being updated. This causes links on a page that the crawler may have
already visited to continuously change. Since these look like new links, the crawler visits them and
becomes trapped in an endless cycle.

When the WebSphere Portal overlay is selected, Fortify Weblnspect can decode the navigation statein a
URL and determine if the URL has already been visited. This prevents the crawler from continuously
visiting the same page over and over again.

How does Fortify Weblnspect decode the navigation state?

WebSphere Portal 6.1 and later include a URL decoding service. When the WebSphere Portal overlay is
selected, Fortify Weblnspect can pass a URL to the decoding service and evaluate the response to
determine if this URL has already been visited. Although the decoding service is on by default, it is
possible to turn it off in your WebSphere Portal server configuration. To get a good scan of your site
with Fortify Weblnspect, the decoding service must be enabled.

Is the navigation state just a special kind of session ID?

No. Navigation state does not contain any session information. Session is maintained via cookies.
Any special instructions when recording a login macro?

Make sure that the cookies JSESSIONID and LtpaToken are set as state parameters.

Why does the site tree contain deeply nested folders?

Fortify Weblnspect's site tree does not currently understand how to parse the navigation state in
WebSphere Portal URLs. It freats each section as a directory. These are, of course, not real directories.
You will generally need to drill down to the lowest level of each branch to see the real content.
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Is there any limitation on what types of attacks Fortify Weblnspect can perform on WebSphere
Portal applications?

Fortify Weblnspect can perform all manipulation attacks on WebSphere Portal applications. This
includes (but is not limited to) XSS, SQL Injection, CSRF, RFI, LFI and others. Fortify Weblnspect will not
perform any site search attacks when scanning a WebSphere Portal site. These include searching for
backup files (.bak, .old), hidden files, hidden directories and platform specific configuration files. The
reason for this exclusion is because almost any request will result in a 200 response to the default portal
view and so there is no way to distinguish between an error response and a valid response.

How can you tell if the crawler is working correctly on a WebSphere Portal site?

The WebSphere Portal decoding service must be enabled and reachable on the server for the crawler to
perform optimally. You can confirm if this is working by manually decoding a URL. Copy a URL from
your site and modify it like this:

http://myhost.com/wps/poc?uri=state: path with navigation
state>&mode=download

You should get an xml response. Alternatively, start a scan of your site with the WebSphere Portal
overlay selected. Enable Traffic Monitor or run the scan through the Web Proxy. You should see
periodic requests to the decoder service in the following format:

http://myhost.com/wps/poc?uri=state: path with navigation
state>&mode=download.

Another thing to consider is that the path of the decoding service can be changed on the server. If this

is the case, you will need to modify your scan settings manually. Contact Fortify Customer Support for
assistance.

It is also possible to modify the navigation state marker. By default this is ut/p. If this is changed from
the default on the server, you will need to modify your scan settings manually. Contact Fortify

Customer Support for assistance.

For more information, see "Contact Customer Support" on page 425.

Command Line Execution

You can initiate several Fortify Weblnspect functions via a command line interface using the program
Wl.exe. Use the following syntax when typing a command:

wi.exe -u url [-s file] [-db] [-ws file] [-olc][-n name] [-b filepath] [-d filepath -m filename] [-i[erxdi]
scanid] [-x|xdIxalxn] [-Framework name] [-CrawlCoverage name] [-ps policyID | -pc path] [-a[bndak]
{creds}] [-e[abcdefghijkimnopstul] file] [-v] [-1] [-r report_name -w favorite_name -ag -y report_type -f
report_export_file -g[phacxe] [-t compliance_template_file] [-?]

To run multiple scans from the command line, create and execute a batch file, using a format similar to
the following:

c:
cd \program files\HP\HP WebInspect
wi.exe -u http://172.16.60.19 -ps 4
wi.exe -u http://www.mywebsite.com
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wi.exe -u http://172.16.60.17
wi.exe -u http://172.16.60.16

Options

The options are defined in the following table. Itfems in italics require a value.

Category Parameter
General 2
-u {urf}
-s {filename}
-db

-ws {filename}
-0

-C

-n {name}

-b {filepath}

-d {filepath}

Micro Focus Fortify Weblnspect (18.10)

Definition
Show usage.

URL or IP address.

Caution 1: When using the -u parameter with -s
(a seftings file), be sure to specify an -x, -xa, -xd,
or -xn parameter to restrict a scan to folders, if
desired. Failure to do so may result in an
unrestricted audit under cerfain conditions.

Caution 2: If the URL contains an ampersand
(&), you must enclose the URL within quotation
marks.

Settings file

Note: Command line parameters take
precedence over values in a settings file.

Use database defined in settings file. If omitted,
Fortify Weblnspect defaults to database
connection defined in application settings.

Web Service Design file.
Audit only.
Crawl only.
Scan name.

Use given SecureBase file. For path, specify the
full path and file name.

Move database to filepath.

Page 267 of 427



User Guide
Chapter 5: Using Fortify Weblnspect Features

Category Parameter
-m {filename}
-v

-ie {scanid}

-ir {scanid}

-ix {scanid}

-id {scanid}
-ii {scanid} {file path}

Restrict to Root -X
Folder

Framework -framework {framework_
name}

Crawl Coverage -CrawlCoverage
{Coveragename}

Micro Focus Fortify Weblnspect (18.10)

Definition
Move database to filename.
Verbose output.

Disable telemetry data collection (for this scan
only).

Start configured scan with the specified scan ID
(GUID).

Resume scan with the specified scan ID (GUID).

Use existing scan with the specified scan ID
(GUID), but do not continue the scan.

Delete scan with the specified scan ID (GUID).
Import scan.

Restrict to directory only (self).

Restrict to directory and parents (ancestors).

Restrict to directory and subdirectories
(descendants).

Ignore “restrict to folder” rules in referenced
settings file.

Restrict to folder parameters (x|xalxblxn) can be
in their own category (as report or output).

Name of framework; currently only Oracle ADF
Faces (Oracle) and IBM WebSphere Portal
(WebSpherePortal) are supported. Optimizes
scanning of application built with either of these
technologies.

Values for Coveragename are:

Thorough = Exhaustive crawl of entire site
Default = Focus more on coverage than
performance

Moderate = Balance of coverage and speed
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Category Parameter

Audit Policy -ps {policy id}

Micro Focus Fortify Weblnspect (18.10)

Definition
Quick = Focus on breadth and performance

Use a non-custom policy. Values for policy id are
as follows:

Best Practices

1 =Standard

1012 = OWASP Top 10 Application Security
Risks 2013

By Type

3=SOAP

7 =Blank

1001 =SQL Injection

1002 = Cross-Site Scripting
1005 = Passive

1008 = Critical and High Vulnerabilities
1010 = Aggressive SQL Injection
1011 = NoSQL and Node.js
1013 = Mobile

1015 = Apache Struts

1016 = Transport Layer Security
1020 = Privilege Escalation

1021 = Server-side

1022 = Client-side

Deprecated

2 = Assault (Deprecated)

4 = Quick (Deprecated)

5 = Safe (Deprecated)

6 = Development (Deprecated)

16 = QA (Deprecated)

17 = Application (Deprecated)

18 = Platform (Deprecated)

1009 = OWASP Top 10 Application Security
Risks 2010 (Deprecated)

1014 = OpenSSL Heartbleed (Deprecated)
1018 = Standard (Deprecated)

1019 = Deprecated Checks

Hazardous
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Category Parameter Definition
1004 = All Checks

-pc{policy path} Use a custom policy. For path, specify the full
path and file name, such as:

C:\MyPolicies\MyCustomPolicy.policy

Authentication -ab "userid:pwd" Basic mode (user name and password).
-an "userid:pwd" NTLM mode (user name and password).
-ad "userid:pwd" Digest mode (user name and password).
-aa "userid:pwd" Automatic mode (user name and password).
-ak "userid:pwd" Kerberos mode (user name and password).
-am {macro path} Deprecated; use the -macro option.
Macro -macro {macro path} Web macro authentication.
Login Macro -Is "userid:pwd" Replace the SmartCredentials UserName and
Parameters Password with the supplied values.
-It" Replace existing TruClient login parameters that

nameOQ:valueO;namel:valuel; match the specified names.
..nameN:valueN"

Output -ea {filepath} Export scan in legacy full XML format.

-eb {filepath} Export scan details (Full) in legacy XML format.

-ec {filepath} Export scan details (Comments) in legacy XML
format.

-ed {filepath} Export scan details (Hidden Fields) in legacy
XML format.

-ee {filepath} Export scan details (Script) in legacy XML
format.

-ef {filepath} Export scan details (Set Cookies) in legacy XML
format.

-eg {filepath} Export scan details (Web Forms) in legacy XML
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Category Parameter

-eh {filepath}

-ei {filepath}

-ej {filepath}

-ek {filepath}

-el {filepath}

-em {folderpath}

-en {filepath}

-eo {filepath}

-ep {filepath}
-es {filepath}

-et {filepath}

-eu {filepath}

Reports - r {report_name}

For multiple reports,

separate report names with a

semicolon. All reports will be

Micro Focus Fortify Weblnspect (18.10)

Definition
format.

Export scan details (URLS) in legacy XML
format.

Export scan details (Requests) in legacy XML
format.

Export scan details (Sessions) in legacy XML
format.

Export scan details (E-mails) in legacy XML
format.

Export scan details (Parameters) in legacy XML
format.

Export scan details (Web Dump) in legacy XML
format.

Export scan details (Offsite Links) in legacy XML
format.

Export scan details (Vulnerabilities) in legacy
XML format.

Export scan in FPR format to specified file.
Export scan in .scan format to specified file.

Export scan with logs in .scan format to specified
file.

Export scan settings to specified file after
applying all other overrides.

Note: This parameter does not run the scan.
It exports the settings and exits.

Name of the report to run. Valid values for
report_name are:

Aggregate

Alert View

Page 271 of 427



User Guide
Chapter 5: Using Fortify Weblnspect Features

Category Parameter Definition

contained in a single file. Attack Status
Compliance
Crawled URLs
Developer Reference
Duplicates
Executive Summary
False Positive
QA Summary
Scan Difference
Scan Log
Trend
Vulnerability
Vulnerability (Legacy)

Note: Report names containing a space
must be enclosed in quotation marks.

-w {favorite_name} Name of the report favorite to run.
-ag Aggregate reportsin report favorite.
-y {report_type} The type of report: Standard or Custom.
-f {export_file} File path and file name where the report will be
saved.
-gp Export as Portable Document Format (PDF) file.
-gh Export as HTML file.
-ga Export as raw report file.
-gc Export as rich text format (RTF) file.
-gx Export as text file.
-ge Export as Excel file.
-t {filepath} Use specified compliance template file.
Scan Merge -ic{scan id} {scan name} Create a merge target scan. For more

information, see "Merging Scans" on page 274 in
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Category Parameter

-im /o:{option} {merge target

scan id} {source scan id1}
{source scan id2}

Scan Reuse -iz Jo:{option} {source scan
id} {settings filename}

Micro Focus Fortify Weblnspect (18.10)

Definition
this topic.

Merge scans. For more information, see
"Merging Scans" on the next page in this topic.
Choices for option are:

¢ Replace - Replace target session and
vulnerabilities with source session and
vulnerabilities.

¢ ReplaceMergeVulns - Replace target session
with source session, and add source
vulnerabilities to target scan.

o Skip - When session IDs are the same in both
scans, do not merge sessions or
vulnerabilities.

o SkipMergeVulns - When session IDs are the
same in both scans, do not replace target
session and copy vulnerabilities from source.

e Smart - Consider source and target policy and
times when merging.

Note: Create the merge target scan first,
using the "ic" parameter.

Create reuse scan settings. Choices for option
are:

¢ Incremental - Use same settings as source
scan, with a modified policy that disables
checks that flagged in source scan and that
should only flag once.

« Remediation - Use same settings as source
scan, with a modified policy that disables
checks that did not flag in source scan.

¢ ReuseCrawl - Use same settings as source
scan, with crawl sessions copied from source
scan.

¢ ReuseCrawlRemediation - Use same setfings
as source scan, with crawl sessions copied
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Category Parameter Definition

from source scan and a modified policy that
disables checks that did noft flag in source
scan.

The settings filename is the name of the
modified settings file being created.

Examples

The following examples illustrate command line execution as if executed from the Weblnspect home
directory:

wi.exe -u www.anywebsite.com -ps 1 -ab MyUsername:Mypassword

wi -u https://zero.webappsecurity.com -s c:\program
files\webinspect\scans\scripted\
-f c:\program files\webinspect\scans\scripted\zero051105.xml

If you do not specify a policy, Fortify Weblnspect will crawl (but not audit) the Web site.

If you specify an invalid policy number, Fortify Weblnspect will not conduct the scan.

Merging Scans

You cannot merge info an existing scan. You must first create a merge target using the "ic" parameter.

The scans to be merged are sorted by scan date and are merged in that order. Order is important
because information is lost when session IDs are the same in the two scans. When this occurs, by default
the earlier session and vulnerability are overwritten with the later session and vulnerability. To prevent
this when merging, you can choose another option for handling identical session IDs.

Note: Merging may work best with two scans that have few or no identical session IDs.
For all merge scan options, only sessions with an audit status of “Complete” in the source scan are

merged. Session Exclusions (excluded from audit) are not merged. See "Audit Settings: Attack
Exclusions" on page 368 for more information.

Hyphens in Command Line Arguments

You can use hyphens in command line arguments (output files, etc.) only if the argument is enclosed in
double quotes, as illustrated by the "export path" argument in the following command:

wi.exe -u http://zero.webappsecurity.com -ea "c:\ temp\command-line-test-
export.xml "
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Note: To initiate a command line, select Run from the Windows Start menu, type "cmd" in the Open
box, and click OK. This will ensure proper handling of long file names. The process, as it appears in
the Task Manager, is Wl.exe. Scan data will be cached temporarily in the Working directory and then
moved to the Scans directory.

Scanning a REST API Definition

You cannot scan a REST API directly from the start URL of a website because there are no links to
crawl. However, a well-defined REST API definition contains enough information to accurately describe
each endpoint along with the expected payload. You can use the REST API definition for your website
to automate the scanning of your REST API with Fortify Weblnspect. The WISwag.exe tool is a
command line tool that parses a REST API definition and converts it into a format that Fortify
Weblnspect understands.

Tip: Consider using the Server-side policy, which is designed specifically for scanning RESTful
services. For more information, see "Fortify Weblnspect Policies" on page 394.

Supported API Definitions and Protocols

The WISwag tool supports the following REST API definitions and protocols:

o Swagger RESTful APl Documentation Specification version 2.0 (now known as OpenAPI
Specification). For more information, visit the Swagger website at http://swagger.io/.

¢ Open Data (OData) protocol (versions 2, 3, and 4). For more information, visit the OData website at
http://www.odata.org/.

Tip: When using the WISwag tool with OData, if a POST fails to successfully create a request for
an entity set, view the error in the HT TP details tab of the Web Macro Recorder to determine the
requirements for the entity.

Process Overview

The process for scanning a REST APl is as follows.

Stage Description
1 Get the REST API definition from your development team.
2. Do one of the following:

« If you do not have a settings file, use the WISwag.exe tool to convert the REST API
definition info a Fortify Weblnspect settings file. This option also generates a
workflow macro and custom parameter rules, and embeds them in the settings file.
See "Converting the API Definition to a Settings File" on page 278.
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Stage

Description

o If you have a settings file, use the WISwag.exe tool to convert the REST API
definition into a Fortify Weblnspect workflow macro. See "Converting the API
Definition to a Macro" on page 278.

Use the webmacro or settings file fo conduct a scan of your REST API.

Note: You can conduct the scan using the Weblnspect user interface, command
line interface, or the Weblnspect REST API. For more information, see the
following topics:

e "Guided Scan Overview "on page 99

e "Running a Basic Scan" on page 152

e "Command Line Execution" on page 266

o "Fortify Weblnspect REST API " on page 286

WISwag.exe Parameters

The WISwag.exe parameters are defined in the following table.

Parameter

-a

Description

Generates a json-formatted, human readable version of the API definition in the
specified output file. The output file uses the .json extension. This parameter can be
useful for debugging because the API definition is baseb64 encoded in the generated

settings file. For more information, see "-s" on the next page.

Example:
-a ./<api-def_filename>.json

Generates custom parameter rules as a list of strings in the specified output file. The
output file uses the .txt extension. The generated text file can be imported into the
URL rewriting settings from the Advanced Settings in the Basic Scan Wizard. For
more information, see "Scan Settings: Custom Parameters" on page 333.

Example output:

/odata-v4-test/0OdatadService.svc/Products({ID})

/odata-v4-test/0OdatadService.svc/Categories({ID})

Generates http requests for each audit session to be scanned in the specifi